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Notice:

OMRON products are manufactured for use according to proper procedures by a qualified operator
and only for the purposes described in this manual.

The following conventions are used to indicate and classify precautions in this manual. Always heed
the information provided with them. Failure to heed precautions can result in injury to people or dam-
age to the product.

& DANGER Indicates information that, if not heeded, is likely to result in loss of life or serious injury.

&WARNING Indicates information that, if not heeded, could possibly result in loss of life or serious
injury.

&Caution Indicates information that, if not heeded, could result in relatively serious or minor injury,
damage to the product, or faulty operation.

OMRON Product References

All OMRON products are capitalized in this manual. The word “Unit” is also capitalized when it refers to
an OMRON product, regardless of whether or not it appears in the proper name of the product.

The abbreviation “Ch,” which appears in some displays and on some OMRON products, often means
“word” and is abbreviated “Wd” in documentation in this sense.

The abbreviation “PLC” means Programmable Controller and the abbreviation “PC” means personal
computer and are not used as abbreviations for anything else.

The abbreviation “PMSU” means Protocol Macro Support Unit and refers to the Communications

Board for the C200HX/HG/HE, Serial Communications Board for the CS, and Serial Communications
Units for the CS/CJ.

Visual Aids

The following headings appear in the left column of the manual to help you locate different types of
information.

Note Indicates information of particular interest for efficient and convenient opera-
tion of the product.

1,2,3... 1. Indicates lists of one sort or another, such as procedures, checklists, etc.

© OMRON, 1999

All rights reserved. No part of this publication may be reproduced, stored in aretrieval system, or transmitted, in any form,
or by any means, mechanical, electronic, photocopying, recording, or otherwise, without the prior written permission
of OMRON.

No patent liability is assumed with respect to the use of the information contained herein. Moreover, because OMRON is
constantly striving to improve its high-quality products, the information contained in this manual is subject to change without
notice. Every precaution has been taken in the preparation of this manual. Nevertheless, OMRON assumes no responsibility

for errors or omissions. Neither is any liahility assumed for damages resulting from the use of the information contained
in this publication.
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About this Manual:

The CX-Protocol is a Support Software for the protocol macro of the Windows 95 and Windows 98 ver-

sions.

This manual describes the installation and operation of the CX-Protocol and includes the sections

described below.

This manual is intended for the following personnel:
Personnel in charge of installing FA devices
Personnel designing FA systems
Personnel managing FA facilities

Name

Cat. No.

Contents

SYSMAC WS02-PSTC1-E
CX-Protocol
Operation Manual

W344-E1

Describes the use of the CX-Protocol to create protocol macros as
communications sequences to communicate with external devices.
(This manual)

SYSMAC CS Series
CS1G/H-CPULILIH
CS1G/H-CPULIC-EV1
Programmable Controllers
Operation Manual

W339-E1

Describes the installation and operation of the CS-series PLCs.

SYSMAC CJ Series
CJ1G/H-CPULIIH
CJ1G-CPULIT
Programmable Controllers
Operation Manual

W393-E1

Describes the installation and operation of the CJ-series PCs.

SYSMAC CS/CJ Series
CS1G/H-CPULIH
CS1G/H-CPULI-EV1
CJ1G/H-CPULIH
CJ1G-CPULI]

Programmable Controllers
Instructions Reference Manual

W340-E1

Describes the ladder diagram programming instructions
supported by CS/CJ-series PLCs.

SYSMAC CS/CJ Series
CQM1H-PRO-E1
C200H-PRO27-E,
CQM1-PROO01-E
Programming Consoles
Operation Manual

W341-E1

Provides information on how to program and operate
CS/CJ-series PLCs using a Programming Console.

SYSMAC CS/CJ Series
CS1G/H-CPULIH
CS1G/H-CPULI-EV1,
CS1W-SCB21/41,

CS1wW-SCcu21

CJ1G/H-CPULIH

CJi1G-cPULI

Communications Commands Refer-
ence Manual

W342-E1

Describes the C-series (Host Link) and FINS
communications commands used with CS/CJ-series PLCs.

SYSMAC WS02-CXPLIL-E
CX-Programmer
Operation Manual

Provides information on how to use the CX-Programmer, a program-
ming device that supports the CS/CJ-series PLCs.

SYSMAC CS/CJ Series
CS1W-SCB21/41,

CS1W-SCuU21

CJ1W-SCu41

Serial Communications Boards and
Serial Communications Unit Opera-
tion Manual

W336-E1

Describes the use of Serial Communications Unit and Boards to per-
form serial communications with external devices, including the
usage of standard system protocols for OMRON products.

&WARNING Failure to read and understand the information provided in this manual may result in per-
sonal injury or death, damage to the product, or product failure. Please read each section
in its entirety and be sure you understand the information provided in the section and
related sections before attempting any of the procedures or operations given.

Xi
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Please read this manual carefully and be sure you understand the information provided before
attempting to install and/or operate the CX-Protocol. Be sure to read the precautions provided in
the following section.

Section 1 Introduction outlines the Protocol Macro function and the CX-Protocol.

Section 2 Environment/Installing/Uninstalling/Starting/Editing outlines the functions of CX-Proto-
col and describes the operating environment, installation procedure, and the setting of the usage envi-
ronment.

Section 3 Protocol Macro describes details of the protocol macro functions.

Section 4 Using the Protocol Macro Function describes various precautions in using the protocol
macro function.

Section 5 Object Creation describes how to create objects, such as projects, protocols, sequences,
steps, messages, and matrices.

Section 6 Project and Protocol Editing describes details of the editing of projects and protocols.
Section 7 Sequence Setting and Editing describes details of the setting and editing of sequences.
Section 8 Step Setting and Editing describes details of the setting and editing of steps.

Section 9 Setting and Editing Messages and Matrix Lists describes details of the setting and edit-
ing of messages and matrix lists.

Section 10 Communications PLC Setup and Online Connections describes details of the commu-
nications settings and online connections.

Section 11 Protocol Data Transferring and Printing describes details of the transferring, converting,
and printing of protocol data.

Section 12 Tracing and Monitoring describes details of PLC memory area monitoring and the trans-
mission line tracing.

Section 13 Error and Error Log Display describes details of the displaying of errors and the error
log.

Section 14 Troubleshooting lists the error messages and describes their causes and remedies.
Section 15 Help describes the online help services.

Appendix A Creating the Protocol Applications shows some examples of data transmission
between personal computers using the protocol macro function.

Appendix B PLC Setup and PMSU Settings provides the settings for the PLC Setup and PMSU.
Appendix C Wiring RS-232C Cable Connectors describes how to wire RS-232C connectors.

The CS Series and CJ Series are subdivided as shown in the following table.

Unit

CS Series

CJ Series

CPU Units

CS1-H CPU Units: CS1H-CPULIH
CS1G-CPULIH

CJ1-H CPU Units: CJ1H-CPULIH
CJ1G-CPULILH

CS1 CPU Units: CS1H-CPULIL-EV1

CS1G-CPULIL-EV1

CJ1 CPU Units:  CJ1G-CPULIL-EV1

Basic 1/0O Units

CS-series Basic /O Units

CJ-series Basic I/O Units

Special I/O Units

CS-series Special I1/0 Units

CJ-series Special /0 Units

CPU Bus Units

CS-series CPU Bus Units

CJ-series CPU Bus Units

Power Supply Units

CS-series Power Supply Units

CJ-series Power Supply Units

Xii
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PRECAUTIONS

This section provides general precautions for using the CX-Protocol and related devices.

Theinformation contained in this section isimportant for the safe and reliable application of the CX-Protocol. You
must read this section and under stand the information contained before attempting to set up or operate the CX-

Protocol.
1 Intended AUudienCe . ... .. oo Xiv
2 General PreCaltions ... ... oottt Xiv
3 Safety Precautions. . . .. ..ot Xiv
4 Operating Environment Precautions. . .. ..., Xiv
5 Application Precautions . ...t XV
6 Software Operating Procedures. . . ... XVi

Xiii
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I ntended Audience 1

1 Intended Audience

This manual is intended for the following personnel, who must also have
knowledge of electrical systems (an electrical engineer or the equivalent).

* Personnel in charge of installing FA systems.
 Personnel in charge of designing FA systems.
 Personnel in charge of managing FA systems and facilities.

2 General Precautions

The user must operate the product according to the performance specifica-
tions described in the operation manuals.

Before using the product under conditions which are not described in the
manual or applying the product to nuclear control systems, railroad systems,
aviation systems, vehicles, combustion systems, medical equipment, amuse-
ment machines, safety equipment, and other systems, machines, and equip-
ment that may have a serious influence on lives and property if used
improperly, consult your OMRON representative.

Make sure that the ratings and performance characteristics of the product are
sufficient for the systems, machines, and equipment, and be sure to provide
the systems, machines, and equipment with double safety mechanisms.

This manual provides information for programming and operating OMRON
PLCs. Be sure to read this manual before attempting to use the software and
keep this manual close at hand for reference during operation.

&WARNING It is extremely important that a PLC and all PLC Units be used for the speci-
fied purpose and under the specified conditions, especially in applications that
can directly or indirectly affect human life. You must consult with your OMRON
representative before applying a PLC System to the abovementioned applica-
tions.

3 Safety Precautions

AWARNING Never attempt to disassemble any Units while power is being supplied. Doing
so may result in serious electrical shock or electrocution.

&WARNING Never touch any of the terminals while power is being supplied. Doing so may
result in serious electrical shock or electrocution.

4 Operating Environment Precautions

Do not operate the control system in the following places.
» Where the PLC is exposed to direct sunlight.
* Where the ambient temperature is below 0°C or over 55°C.

« Where the PLC may be affected by condensation due to radical tempera-
ture changes.

» Where the ambient humidity is below 10% or over 90%.

* Where there is any corrosive or inflammable gas.

« Where there is excessive dust, saline air, or metal powder.
* Where the PLC is affected by vibration or shock.

« Where water, oil, or chemical may splash onto the PLC.

AUDIN - élg/venue de la malle - 51370 Saint Brice Courcelles - Tel : 03.26.04.20.21 - Fax : 03.26.04.28.20 - Web : http: www.audin.fr - Email : info@audin.fr



Application Precautions 5

&Caution The operating environment of the PLC system can have a large effect on the
longevity and reliability of the system. Improper operating environments can
lead to malfunction, failure, and other unforeseeable problems with the PLC
system. Be sure that the operating environment is within the specified condi-
tions at installation and remains within the specified conditions during the life
of the system.

5 Application Precautions

Observe the following precautions when using the PLC.

AWARNING Failure to abide by the following precautions could lead to serious or possibly
fatal injury. Always heed these precautions.

 Always ground the system to 100 Q or less when installing the system to
protect against electrical shock.

 Always turn OFF the power supply to the PLC before attempting any of
the following. Performing any of the following with the power supply turned
ON may lead to electrical shock:

¢ Mounting or removing any Units (e.g., I/O Units, CPU Unit, etc.) or
memory cassettes.

* Assembling any devices or racks.
« Connecting or disconnecting any cables or wiring.

&Caution Failure to abide by the following precautions could lead to faulty operation of
the PLC or system or could damage the PLC or PLC Units. Always heed
these precautions.

» Use the Units only with the power supplies and voltages specified in the
operation manuals. Other power supplies and voltages may damage the
Units.

» Take measures to stabilize the power supply to conform to the rated sup-
ply if it is not stable.

 Provide circuit breakers and other safety measures to provide protection
against shorts in external wiring.

* Do not apply voltages exceeding the rated input voltage to Input Units.
The Input Units may be destroyed.

» Do not apply voltages exceeding the maximum switching capacity to Out-
put Units. The Output Units may be destroyed.

¢ Always disconnect the LG terminal when performing withstand voltage
tests.

« Install all Units according to instructions in the operation manuals.
Improper installation may cause faulty operation.

 Provide proper shielding when installing in the following locations:
« Locations subject to static electricity or other sources of noise.
« Locations subject to strong electromagnetic fields.
 Locations subject to possible exposure to radiation.
 Locations near to power supply lines.

 Be sure to tighten Backplane screws, terminal screws, and cable connec-
tor screws securely.

XV
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Softwar e Operati ng Procedures 6

» Do not attempt to take any Units apart, to repair any Units, or to modify
any Units in any way.

&Caution The following precautions are necessary to ensure the general safety of the
system. Always heed these precautions.

* Provide double safety mechanisms to handle incorrect signals that can be
generated by broken signal lines or momentary power interruptions.

* Provide external interlock circuits, limit circuits, and other safety circuits in
addition to any provided within the PLC to ensure safety.

6 Software Operating Procedures

Observe the following precautions when using the CX-Protocol.

&WARNING Confirm safety before transferring the I/O memory area state to the CIO area
of the PLC using the PLC memory window function of the CX-Protocol. Not
doing so may cause malfunction in devices connected to the I/O Units regard-
less of the operating mode of the CPU Unit.

&Caution Confirm safety at the destination node before transferring a protocol to
another node or editing the 1/O area. Doing either of these without confirming
safety may result in injury.

&Caution Confirm that no adverse effect will occur in the system before changing the
present value of any word in memory. Not doing so may result in an unex-
pected operation.

&Caution Confirm that no adverse effect will occur in the system before changing the
operating mode of the CPU Unit. Not doing so may result in an unexpected
operation.

&Caution Confirm that no adverse effect will occur in the system before force-setting/
force-resetting any bit in memory. Not doing so may result in an unexpected
operation.

&Caution Confirm that no adverse effect will occur in the system before transferring the
communications port A/B settings to the Protocol Macro Support Unit
(PMSU). Not doing so may result in an unexpected operation.

&Caution Check the user protocol for proper execution before actually running it on the
Unit. Not checking the protocol may result in an unexpected operation.

&Caution Online connection of the CX-Protocol cannot be made to a PLC which is con-
nected online to SYSMAC-CPT or SYSMAC-PST. Therefore, when SYSMAC-
CPT or SYSMAC-PST is running and connected online to a PLC, it must be
offline before making online connection to the CX-Protocol. Similarly, when
the CX-Protocol is connected online to a PLC, it must be switched to offline
before making online connection to SYSMAC-CPT or SYSMAC-PST.
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Overview of the CX-Protocol Section 1-1

1-1 Overview of the CX-Protocol

The CX-Protocol is the software for creating a procedure (or protocol) for
sending or receiving data to or from general-purpose external devices con-
nected to a Protocol Macro Support Unit (PMSU) through RS-232C or RS-
485A/422.

A protocol consists of a set of communications sequences. CX-Protocol trans-
fers a protocol to the PMSU, specifies the sequence number of the protocol
using the PMCR instruction on the CPU Unit, and executes the communica-
tions sequence.

The communications sequence consists of several steps and allows the user
to iterate, branch, or end these steps according to the result of the process.

Note In the following section, the Communications Board for the C200HX/HG/HE,
Serial Communications Board for the CS and CQM1H, and Serial Communi-
cations Units for the CS/CJ are referred to as the “PMSU.”

+ CX-Protocol

Protocol creation/transmission

CPU unit PMSU
Specifies
sequence Protocol
number Sequence No. 060-099 Command execution (Send, Receive, or Send&Receive)
ification
sequence Sequence

No.

RS-232C or
™ RS-422A/485

General-purpose
external device

PLC area Program-
1/0 memor ming
( ory) Deviee Shared memory
servicing
-

1-2 Features

1-2-1 Features of the Protocol Macro Function

Support for a wide range of communications protocols
Supports communications with almost all external general-purpose devices
that have RS-232C or RS-422A/485 ports and support half-duplex or full-
duplex mode (full-duplex is for CS/CJ only) and start-stop synchronization
mode (refer to 4-1 Applicable Range of the Protocol Macro Function for
restrictions).

AUDIN - g avenue de la malle - 51370 Saint Brice Courcelles - Tel : 03.26.04.20.21 - Fax : 03.26.04.28.20 - Web : http: www.audin.fr - Email : info@audin.fr



Features Section 1-2

Creation of send frames and receive (expected) frames according to the desired communications
frame specifications

Enables creation of almost all send frames (frames composed of commands,
data, and so on) and receive (expected) frames (frames composed of
responses and so on) according to the communications frame (message)
specifications of external devices.

Support for operation functions relating to communications
Supports error check code calculation, frame length calculation during trans-
mission process, and numeral data conversion between ASCII and hexadeci-
mal.

Support for the send and receive time monitoring function
Supports the receive wait monitoring, receive finish monitoring, and send fin-
ish monitoring functions. This function lets you designate whether to finish
send/receive process or to start retry process when those monitoring times
are exceeded.

Support for retry process Lets you designate, only by designating the number of retries, whether to
automatically execute send/receive retries when an error occurs.

Integration of variables for read/write process with PLC into send frames and receive (expected)
frames

Enables integration of variables for read process from PLC’s I/O memory into
send frames (messages) themselves. Data in the PLC that has been read
during transmission process can be used for addresses (destinations) or data.
This function also enables integration of variables for write process to PLC’s I/
O memory into receive frames (messages) themselves. Addresses (destina-
tions) or data can be written into the PLC during the receive process.

Easy realization of rich functions including 1:N communications and switching data write destinations,
using repetition variables

Lets you designate repeat variables for send/receive process (repeat counter)
in variables. With this function, a wide variety of process can be easily real-
ized: for example, sending the same data to multiple addresses (destinations)
by switching them during 1:N communications; switching write destination
addresses in PLC’s I/O memory during data receive process.

Execute interrupt program on the PLC while receiving data
Enables interrupt program execution on the PLC (CPU Unit) while receiving
data. The interrupt function is supported only by the Communications Board
for the C200HX/HG/HE and Serial Communications Board for the CS. It can-
not be used with the Serial Communications Unit for the CS/CJ.

Switch the next process depending on the received data
The next process can be switched according to the data comparison with the
data registered to the maximum of 15 types.

The following functions have been added to the protocol macro for the CS/CJ.

Error check code (only for the CS/CJ protocol macro)
LRC2 (2's complement of LRC) and SUM1 (1's complement of SUM) have
been added to the error check codes.

Wait command to keep the next process on standby until a synchronous signal is input from the PLC
(only for the CS/CJ protocol macro)

During the send/receive sequence step, the next process can be kept on
standby until a synchronous signal is input from the PLC (CPU Unit). This
enables computation processing such as data processing on the CPU Unit
during the send/receive sequence.
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Supports half-duplex and full-duplex transmission mode (only for the CS/CJ protocol macro)
The conventional protocol macro provides only the half-duplex macro. With
the half-duplex macro, the receive buffer is cleared right after the send opera-
tion, thus the received data cannot be used. With the full-duplex mode, all the
data received within the sequence can be used and data can be sent and
received at the same time.

Note The full-duplex mode can be used with the RS-232C or four-wire setting. It
cannot be used with the 1:N or two-wire setting. (Only for models with the RS-
422A/485.)

Clear data using Flush command within the receive buffer at any time (only for the CS/CJ protocol
macro)

With the full-duplex mode, the receive buffer is cleared only right before exe-
cuting the send/receive sequence. If any reception error occurs, the received
data can be cleared at any time using the Flush command (receive buffer
clear).

Turn the DTR control signal ON and OFF using the Open/Close command (only for the CS/CJ protocol
macro)

When connected to a modem device, DTR signal is used to indicate that the
Serial Communications Board or Unit (DTE) is ready to send or receive data.
Previously, the DTR signal could be turned ON only during the send/receive
sequence.

Now the DTR signal can be turned ON or OFF at any time within the send/
receive sequence. This allows connection or disconnection with a modem
using the protocol macro.

The DTR signal can be set to ON even after the send/receive sequence has
completed. The DTR signal can be retained even after changing to another
protocol mode (for example, host link).

With this function, remote programming or monitoring can be performed
through a remote Programming Device by changing to the host link mode
using the STUP instruction after connecting to a modem.

1-2-2 Features of the CX-Protocol

Simultaneous display of tree (hierarchical) view and list (table) view
The CX-Protocol displays data in the form of a tree in the left pane, which
gives you easier understanding of the hierarchical structure of data you are
setting/monitoring.

Object-oriented operation Double-clicking target data, instead of choosing from menus, opens its corre-
sponding popup dialog, which enables you to create protocols quickly without
a thorough understanding of operation menus.

Supplied standard system protocols

Data exchange protocols for OMRON’s components (Temperature Control-
lers, Panel Meters, Bar Code Readers, Modems, and so on) are included as
standard system protocols.

Notice that those standard system protocols are included also in the PMSU.

Possible to trace send/receive message
By executing the trace function from the CX-Protocol, the PMSU can trace
and save chronological data of send/receive messages up to 670 bytes for the
C200HX/HG/HE and up to 1,700 bytes for the CS/CJ. Each data item can be
displayed and printed for reading and saved as a trace file.
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1-3 Checking the Contents of the Package

After purchase, first check the contents of your CX-Protocol package.

CX-Protocol Model

Product Name Model Setup disk Version
CX-Protocol WS02-PSTC1-E CD-ROM Ver. 1.2
CX-Protocol Components Check that all the following components of the CX-Protocol are included in

your package.
WS02-PSTC1-E

Item Quantity
Setup disk (CD-ROM) 1
Operation manual (this book)
User registration card for outside Japan
User registration card for within Japan
Seal
Notice sheet

A I

1-4 Supported PLC Models and Personal Computers
1-4-1 Supported PLC Models

The CX-Protocol supports the following PLCs (Programmable Controllers).

Series CPU Unit

CS CS1H-CPU67/66/65/64/63
CS1G-CPU45/44/43/42
CS1H-CPU67H/66H/65H/64H/63H
CS1G-CPU45H/44H/43H/42H

(O8] CJ1G-CPU45/44
CJ1G-CPU45H/44H/43H/42H
CJ1H-CPU6B6H/65H

C200HX/HG/HE C200HX-CPU34-E/44-E/54-E/64-E/34-ZE/44-ZE/54-ZE/64-ZE/65-ZE/85-ZE
C200HG-CPU33-E/43-E/53-E/63-E/33-ZE/43-ZE/53-ZE/63-ZE
C200HE-CPU-32-E/42-E/32-ZE/42-ZE

Note CX-Protocol Version 1.0 does not support the C200HX/HG/HE.

1-4-2 Supported PMSUs
CS-series PCs

Product name Installation Model Serial communications ports
Serial Communications . . CS1W-SCB21 |RS-232C port x 1 + RS-232C port x 1
Boards (Inner Board) Installed in the CPU Unit

CS1W-SCB41 | RS-232C port x 1 + RS-422A/485 port x 1
Serial Communications Installed on the CPU Rack |CS1W-SCU21 |RS-232C portx 1+ RS-232C portx 1
Unit (CPU Bus Unit) or CS Expansion Rack
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Section 1-4

Mounting the Serial Communications
Board on the CPU Unit

Mounting the Serial Communications
Unit on the CPU Rack

CPU Rack CPU Unit
g - >
— /‘ == . l Power Supply Unit
7] MI l
Serial Com- CS1 Expansion Rack
j munications
__|F / Units Power Supply Unit
CJ-series PCs
Product name Classification Installation Model Serial communications ports
Serial Communi- | CJ-series CPU | CPU Rack or CJIW-SCU41 |RS-232C port x 1 + RS-422A/485 port x 1
cations Unit Bus Unit CJ Expansion Rack

Connecting the Serial Communications Unit

Power Supply Unit CPU Unit

PORTL
(Rs422
1a85)

u
AC100.240v
INPUT
L
=)

=]
oo !

&)
ourpth i
T

ACZ40v
BC2av

r

(00o00))

0000/ ©
=]

/
I

Serial Communications Unit

C200HX/HG/HE PCs

Product | Installation Model Enhanced Specifications
name functions (see
note)
C200HW-COMO04-E CPU bus interface + RS-232C port x 1
. C200HW-COMO4-EV1 0 With the protocol macro function
Installed in =5 30 HWw-comos-E RS-232C port x 2
PMSU the CPU ith th | f .
Unit C200HW-COMO5-EV1 0 With the protocol macro function
C200HW-COMO06-E RS-232C port x 1 + RS-422A/485 port x 1
C200HW-COMO6-EV1 0 With the protocol macro function

Note 1. The enhanced functions are as follows:

* SUM2 (2's complement of SUM) and CRC-16 are added as error
check codes.

» Repeat counter N current value, Sequence End Finish Flag, and Se-
guence Abort Finish Flag are added to the auxiliary area.

¢ A check code can be located behind a terminator in messages.
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» Swap between high byte and low byte can be designated for error
check codes.

2. Mounting the Communications Board on the CPU Unit

Communications Board

CQM1H

Product name Installation Model Serial communications ports
Serial Communications . ) CQM1H-SCB41 |RS-232C port x 1 + RS-422A/485 port x 1
Boards Installed in the CPU Unit

CQM1H CPU Unit

4
———— CQM1H Serial Communications Board

Note The following restrictions exist when using the CX-Protocol to create and edit
protocol macros, transferring data between the Board and personal computer,
or performing other functions for the CQM1H.

+ Always turn ON pin 8 on the DIP switch on the front on the CQM1H CPU
Unit. (When pin 8 is ON, you will not be able to connect the peripheral
port, built-in RS-232C port, or serial communications ports on Boards
mounted in the CPU Unit to the CX-Programmer or other Support Soft-
ware running on a personal computer.)

+ Set the PC type to “C200HG” and the model to “CPU43.”

» Other than these restrictions, functionality will be the same as for the
C200HX/HG/HE PCs.
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1-4-3 Supported Personal Computers

Item Minimum requirements | Recommended requirements
Personal computers | IBM PC/AT or compatible personal computers
CPU Pentium 90 MHz or higher (See note 1.) | Pentium 166 MHz or higher
Operating system Microsoft Windows 95/98/Me/2000/NT4.0
Memory 16 Mbytes 24 Mbytes or more
Hard disk drive 24 Mbytes or more of available area 50 Mbytes or more of available area
Monitor S-VGA (800 x 600 pixels) or higher
Floppy disk drive 1 or more drives (1.44-Mbyte drive)
CD-ROM drive 1 or more drives

Note 1. When using Windows Me, a Pentium 150-MHz processor or higher must
be used.

2. Does not run on Microsoft Windows 3.1.

1-5 System Configuration

1-5-1 Connecting the CX-Protocol and the PLC
For the CS/CJ Connect the peripheral port on the CPU Unit to the built-in RS-232C port.
Note Can be connected to the PMSU port if the port is set to the host link mode.

Connection to a IBM PC/AT or
compatible computer

Peripheral port connection RS-232C port connection

9-pin 9-pin

Peripheral port RS-232C port on the
/- on the CPU Unit CPU Unit or PMSU port
/ (host link mode)

Fa!
Fds -

/

9-pin

CS1W-CN226 (2.0 m) / P

CS1W-CN626 (6.0 m) XW2Z-200S-V (2.0 m)
XW2Z-500S-V (5.0 m)

Note When using the RS-232C Cable to connect to a CPU Unit peripheral port, as
shown below, use the CS1W-CN118.

XW2Z-[1s-0
RS-232C Cable

CS1W-CN118
/__

- Peripheral port
o—L ]

When combining the CS1W-CN118 with the RS-232C Cable, connections
cannot be made using the Toolbus. Make connections using Host Link
(SYSWAY).
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For the C200HX/HG/HE Connect the peripheral port on the CPU Unit to the built-in RS-232C port.

Note Can be connected to the PMSU port if the port is set to the host link mode.

Connection to a IBM PC/AT or
compatible computer

Peripheral port connection RS-232C port connection

9-pin

Peripheral port

RS-232C port on the
/_ on the CPU Unit

CPU Unit or PMSU port
/ (host link mode)

/ 9-pin
XW22Z-200S (2.0 m)
XW22-500S (5.0 m)

(see note)

CQM-CIF02
Connecting Cable

Note For IBM PC/AT or compatible computers, a conversion connector from D-sub
25P (female) to 9P (female) is required for the personal computer side con-
nector.

1-5-2 Connecting the PLC to External Devices

For the CS/CJ The following figure shows the system configuration of the PMSU in the PLC
and external devices. The RS-232C port provides 1:1 connection and the RS-

422A/485 port 1:N connection.

CS1W-SCU21 Serial Communications Unit—\ /—- CS1W-SCB41 Serial Communications Board

CPU Unit

Port 1 D Port 1 RS-232C
Port2 | _D RS-422A/485
Port 2
RS-232C RS-232C General-purpose
external device
| General-purpose
external device
General-purpose  General-purpose General-purpose
external device external device external device
Types of PMSUs
Communications Communications function
Model Name Model . . i
port Protocol Host link NT link Cyclical
macro test
RS-232C (port 1) d O g ad
Serial CSIW-SCB2L - TRs o3 (port 2) 0 0 0 0
Communications RS-232C (port 1) 0 0 0 0
Boards CSIW-SCB41  [RS-422A/485 0 0 0 0
(port 2) (see note)
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Communications Communications function
Model Name Model i
port Protocol | postiink | NTIHink | Cvelica
macro test
Serial RS-232C (port 1) ad O O
Communications CS1W-SCU21
Units RS-232C (port 2) a O O
General- Host com-
Devices to be connected purpose puter pro- PT None
external gramming
devices devices

Note Cannot be used with two-wire models.

For the C200HX/HG/HE The following figure shows the system configuration of the PMSU and exter-
nal devices. The RS-232C port provides 1:1 connection and the RS-422A/485

port provides 1:N connection.

CPU Unit/——— C200HW-COMO06-EV1 Communications Board

Port B RS-232C
RS-422A/485

Port A

General-purpose
external device

General-purpose
external device

General-purpose
external device

General-purpose
external device

Types of PMSUs (Only Models Having the Protocol Macro Function)

c o Communications Function
Model ommunications =5 1ol . No- : NT link
port macro Host link procedural 1:1 link 11, 1:N CPU bus
C200HW-COMO4- CPU bus interface --- --- - - - O
E/EV1 RS-232C (port A) O O O a O
C200HW-COMO5- | RS-232C (port A) g g O g O ---
E/EV1 RS-232C (port B) O d d ad O
RS-422A/485 (port O ad ad
C200HW-COMO06- |A) O (see note | (see note | (see note ad
E/EV1 2) 2) 2)
RS-232C (port B) O O O ad O
General- | Host com- | General- Interface
Devices to be connected purpose puter pro- purpose PLC PT with (;om-
external gramming external munica-
devices devices devices tions Units

Note 1. C200HW-COMUU-EV1: Enhanced function model

2. Not available for two-wire models.
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1-6 Protocol Macro

1-6-1 Protocol Macro Outline
Protocol macro is a function that creates macros for communications proto-
cols that conform to specifications for communications between general-pur-
pose external devices that have a serial communications port.
Generally the protocol macro performs two kinds of function:
+ Creation of communications frames (messages).
+ Creation of procedures for sending and receiving communications frames
(messages).
Creation of Communications Frames (Messages)

1,2,3... 1. Communications frames, referred to here as “messages” and which can be
understood by general-purpose external devices, can be created accord-
ing to the communications specifications.

I It |

Header Address Data Check Terminator
code

Note In general, the data area of a send message contains a command code and
data. The data area of a receive message contains a response code.
2. Variables for reading data from (or writing data to, if receiving) the 1/O
memory (data memory, for example) of the CPU Unit, can be integrated
into the messages.

I/O memory

[ ]

Read

LI JE 1 JL JE ] ——send

Variable R ()
Variable W ()
| | | | | | | | | | | |Receive<-—

! Write
I/O memory
This function has the following advantages:

e Ladder program processing will not be necessary at the CPU Unit
when, for example, sending messages after arranging them all in data
memory.

CPU Unit

Header

Not necessary Address e Send

11
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» The components of the previously created messages are stored in
memory at the PMSU, not the CPU Unit. When sending or receiving
data, the CPU Unit only has to execute the PMCR instruction.

CPU Unit PMSU

Message
N ) B N
Receive
~— 1 | [ [

* When handling one part of the /O memory data, if the variable re-
quired for reading that data has been integrated into a send message,
the PMSU will automatically read the required data from the /O mem-
ory of the CPU Unit when the PMSU sends the message. Similarly,
when writing data from one part of a received message into I/O mem-
ory, if the variable required to read the data has been integrated into
the reception settings message, the PMSU will automatically write the
data at the designated position in the message into I/O memory when
the PMSU receives the message.

CPU Unit PMSU

PMCR instruction

Send message
— | | | [ |—

I/O memory E
CPU Unit PMSU
| Receive message
~—[ [ 1 [T J=—
—

I/O memory E

podecenpococnvnans

Writes to 1/O memory
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Creating Procedures for Sending and Receiving Communications Frames (Messages)

1,2,3... 1. This function enables all the processing needed to send or receive a mes-
sage to be handled as one step, and possesses all the commands (step
commands), such as Send, Receive, Send&Receive and Wait, that are
needed for each step.

CPU Unit PMSU

T T

General-purpose
external device

Step O

Step 1

2. This step can be set so that the next process (step/end) depends on the
processing result of the previous step. In particular, it is possible to set the
sequence so that the next process depends on the contents of one or sev-
eral set receive messages.

CPU Unit PMSU

General-purpose

external device
— | 1 L 1 P
Step 0
,\:\:Cigjr P
d d
ocononteote—>__1_ 1 1 1 }—

ceived data,

~ Step n (depending on con-
M tents of received data)

Note 1. A send message created with a protocol macro will perform settings for
messages that are actually sent.

2. Areceive message created with protocol macro will set an expected mes-
sage for comparison with messages that are actually received.

Send | | | | | l|——> (Send)

-

hd
Sets message being sent
Message received

Receive | | | | | |<-— (Receive)

\ J
Y

Sets expected message for comparison
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1-6-2 Standard System Protocol

Data exchange protocols (called standard system protocols) for OMRON
Units (Temperature Controllers, Panel Meters, Bar Code Readers, Modems,
etc.) have been installed into the PMSU. By setting the prescribed receive/
send data and executing the PMCR instruction, therefore, data exchange can
be easily performed with OMRON Units.

1-7 Protocol Macro Structure

The protocol consists of a communications sequence (“sequence” in short),
which is an independent process for the general-purpose external device (for
example, reading a process variable from a Temperature Controller). One
sequence consists composed of some steps, each of which is composed of a
Send, Receive, or Send&Receive command, send/receive message, branch
or end according to the result of the process.

For example, the sequence to read a process value from the temperature con-
troller sends to the controller a send message (a string containing the read
command with a header, address, check code, and terminator), and then
receives a receive message (a string containing a response to the read com-
mand with a header, address, check code, and terminator).

Protocol Macro Support Unit

Command
CPU unit -
Send Send message (Example: Measured value read command)
d
(send) @] oo Rxoo-- | Fcs (]
Header Address Send Data Check Code Terminator
D = RS-232C or
Receive Receive message (Example: Response) RS-422A/485

~ treceve) | '@J oo mxo1- [ Fes | - o]

\/\ Header Address Receive Data Check Code Terminator
«-—

General-purpose
external device
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The sequence determines, according to the result of process, whether to send
the same send message again (called retry) or execute the next process
(reading process value from the Temperature Controller linked to another
address, etc.), for example.

Structure of one step i
Protocol f . (For Wait, Flush, Open,
——— (max 60 sequences per protocol) (for Send. Receive, Send&Receive commands) Close commands)

Sequence No. 2
Sequence No. 1 [ _// Command _ ——
Sequence No. 0 Ste (Note 1) ommand (Note 1)
] Message
Note 2
Transmis- Step 0 Step 1 ¢ ) v Next process
sion control Step 1
parameter e
Link word retried?
Monitoring
timer N (Not retried)
Response N
Type
Step 15 (Max.) —\
Step 15 (Max.) N (Not repeated)
Next process Error process
- To the next step
"""""""""""""""""" - To the specified step
Message lists (see note 2) - Ending the sequence
Send message list - Aborting the sequence
e | | | ]

| 1 1 1 1
IHeaderIAddressI Data ICheck I Terminator lJ

Receive message list

LI T T T 1

| 1 1 1 1
IHeaderI Addressl Data ICheck I Terminator IJ

Matrix (see note 2)
Case No. 15

1 1 |

/
s Case No. 00
I Receive message I—-I Next processl

Note 1. The command is Send, Receive, Send&Receive, Wait, Flush, Open, or
Close.

« A step can be retried with the Send&Receive command.

e A step can wait to transmit a send message upon the Send or
Send&Receive commands.

A step can select the next process according to the content of the re-
ceived message by using a matrix.

2. There are three types of messages: send messages, receive (expected)

messages, and matrices that switch processes according to multiple re-

ceive (expected) messages. Those messages are managed by lists and
separated from sequences.
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1-7-1 Step Structure

Each step has the fixed processing framework as follows. Users create proto-
cols by setting parameters for each framework.

One step contains one command (Send, Receive, Send&Receive, Wait,
Flush, Open, or Close) and one or two messages (send, receive, or send/
receive). The step changes from one to another by the Next Process within

the step.
Structure of one step (For Wait, Flush, Open,
(for Send. Receive, Send&Receive commands) Close commands)
Sequence
Step 00 Command
Message ¢
Step 01 v Next process
25 :
=) H
f=e1 H To be
DO : Normal end? rg
2?7) s N retried?
F=ge]
c=
S Y N
S Step n
SE j
T E ’
=Xe) H
$ H Next procgss
Next process Error process
Step 15

Note The Wait, Flush, Open, and Close commands are for the CS/CJ protocol mac-
ros. (They are not supported by the C200HX/HG/HE protocol macros.)

Setup Parameters that Commonly Affect Steps (in Each Sequence)

Parameter Description
Transmission control parameter Sets the control mode for control signals including flow control.
Link word Sets area in which data is shared between the PLC and the PMSU.
Monitoring time Sets monitoring time for send and receive process.
Response type Sets timing of writing receive data into PLC’s I/O memory.

Setup Parameters for Each Step

Parameter Setup content
Command Send, Receive, Send&Receive, Wait, Flush, Open, or Close
Send message Sets message to be sent for the Send command.

Receive message | Sets message expected to be received for the Receive command.
Send message and | Sets messages to be sent and expected to be received for the Send&Receive

Message receive message command.
Selects the next process according to the content of the received message when the
Matrix command is Receive or Send&Receive and up to 15 messages can be expected to
be received.

The number of times iterating the step (0 to 255). Using this parameter N allows to
change the content of send and receive messages.

(Used only for Send&Receive command)
Retries the command when a retry cause such as an error occurs (0 to 9 times).

(Used only for Send or Send&Receive command)
Set the waiting time before starting to send data.

With/Without Response Writing Specifies whether to write received data.
Next process Sets the next step to which the step transits or the sequence exits if it ends normally.

Sets the next step to which the step transits or the sequence exits if it ends
abnormally.

Repeat counter

Retry count

Send wait time

Error process
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1-8 Data Created by the CX-Protocol

The CX-Protocol creates/manages data by file unit, called “project.
Project files consist of the following data:

1 project file Protocol list Protocol -~
) | Up to 20 protocols (see note 1)
Protocol list Protocol - (Up to 1,000 sequences/PLC)
Protocol list Protocol J
Trace list
PLC
Note 1: Protocol ———— Sequence B
(1 protocol) Up to 60 sequences (see note 2)
—— Sequence (The first sequence number and

the last sequence number are
designated for each protocol.)
— Sequence

Message O

—— Send message list
Message

— Receive message list Message
—E Message

— Matrix list Matrix

[ Matrix

Note 2: Sequence# ] Step 00 W
—E Step01 Up to 16 steps

Step 15

Project files are stored with a file extension .PSW.

Note To transfer standard system protocols to the PMSU or create a new protocol
by partially modifying one of the standard system protocols, first copy the
required standard system protocol to another project file and then use the
project file. The standard system protocols themselves cannot be edited or
transferred.

The standard system protocols have been installed into the PMSU at our fac-
tory.
Files that can be Read or Written by CX-Protocol
Type of file Content File Read Write
extension
CX-Protocol/SYSMAC-PST CX-Protocol project files consist of the * PSW Yes Yes
project files (see note) following:
Protocol data
PLC (communications conditions between
PLC and personal computer, communications
port (A/B) setting of the PSB or the port (1/2)
setting of the Serial Communications Board/
Unit)
Trace data
PSS system setting file File that contains communications port (A/B) | *.pts Yes No
setting data of the PSS Protocol Macro
Support Unit

PSS protocol file File that contains only PSS protocol data *ptl Yes No
Trace data file File that contains only trace data *.ptr Yes No

Up to 300 messages

} Up to 100 matrices
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Note CX-Protocol project files cannot be read by the PSS (DOS version of Protocol
Support Software) or the SYSMAC-PST.

Refer to 11-3 Importing Protocol Data from PST/PSS Files for loading PST
project files or PSS files.

1-9 Main Screens of the CX-Protocol

The CX-Protocol displays the tree view of the hierarchical data structure in the
left pane. For the highlighted data in the left pane, the list view of its contents
is displayed in the right pane.

Contents of a Project A project consists of protocol list, trace list, and PLC.

i 1}

Protocol List Protocols

Protocol List Protocols
New Protocal List 1

'| Trace List Traces
Bt Trace List 4]

*| PG Name Model GPU
iy PLC MewPC1 CE1G CRLM2

" $Projects [Bevetem | @ el |

Display of Sequences in a Protocol
A protocol consists of sequences.

Llll * | F | o] ication Seq | Link Word | Gontrol Responze Timer Tr | Timer Tfr | Timer Tfs
B ExAMPLE. 2 37 000 Procoes value read -—= Set Scan 3 zec dsec dzeo
-3 Ex Protocol List 3" 001 Lampset point read -—= Set Sean 3 sec 3 zec 3 zec
: @ TEMP COMM 3 002 Manipulsted variable read - Set Scan dzec 3 zec 3 zec
=) Ex1 Protocol List 3 003 Set point read - Set Scan 3 zec dsec dzeo

=80 Controller (E5_K read) 3 004 Alarmvalue read - Set Scan 3 sec 3 zec 3 zec
& Trace List 3 005  Propo bandlntes/Deri tirne read - Set Scan dzec 3 zec 3 zec
8 MewPLot [Offline] [031G — of [:3Y 0068 Coaling coefficient read - Set Scan Jcec 3zec 3zec
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Main Screens of the CX-Protocol Section 1-9

Display of Each Step in a Sequence
A sequence consists of steps and their setup parameters for each sequence
(transmission control parameter and so on).

Zl=
=10] x|
5] BXAMPLE 2 =| I[*[5tep] Repeat G d |Retry|Send Wait|Send M Recv M

E g: E){ F' t I LIS‘t . Ep EpeEa omman eiry en al en eSS age eCcy BEES3

= T;ﬂ;cgor\;m @,00 RSET/001  Send &Receive 3 — AR EIREK

2 Bt Protoso| List ‘@ 01 RSET/001  Send &Receive 3 - D203 1 FWi200 1

; 3 00 RSET/001 Send & Recei 3 sl SD21) 1 RE21Y 1

E-@ Contraller (E5_K read) 9, B EENE = z

9
&

Procces walue read
Lamp set point read
tanipulated warishle 1
Set point read

Alarm walue read

Display of Messages in a Message List
Messages are managed separately from sequences. Messages can be
referred to by their names from each step in a sequence.

=13 EXAMPLE.2
53 B¢ Protocol List Gheck code <c> Length <I>| Address <a>
k@ 3OO0 [240D] LRC (H parity)iod (2Byte ASGI} FROILZY Chiy+dar+
law SDisE) 1 ‘@ [za00] LRG (H pari 00 (2Byte ASCID FROL2Y Chredo+
ke SD043 1 ‘@ [2a0D] LRC (H parity)i0) (2Byte ASCID FROTLZY Chirtdar+
% Brocoes value read tae SO 201 ‘@ [240D] LRG (H parity)i0 (2Byte ASGI} FROIL2Y Chiredar+
Lamp set. point. read k@ 300111 ‘@ [240D] LRC (H parity)io (2Byte ASGI} FROILZY Chirtdar+
Manipulated variable r ta 300211 @ [2A00] LRG (H parity)ioy (2Byte ASGI} BROTLZY Chrrd s
Set paint. read k@ SDI031 @ [2a0D] LRG (H parityli0) (2Byte ASCID FIROTA2D Chr+{ax+
3 Alarm value resd lae SDiT00 1 ‘@ [2a0D] LRG {H parity}0} (2Byte ASCI $RAL2Y Chbedade
¥ Propo band)ntesDeri ke SDI20Y 1 ‘@ [za0D] LRG (H parity0? (2Byte ASGH) FROLZY <hirdar
Cooling caéﬁ’icient e k@ 302101 @ [2a00] LRG (H parity)ioy (2Byte ASGI} FROILZY Chy+dart
% Doad hand read ke 5022001 rat [2a00] LRG (H parity)il) (2Byte ASCID FR(T2Y Chrtdar+
Manual resst value re ke SDO0911 ‘@ [2a0D] LRC (H parity)i0) (2Byte ASCID FROTLZY Chirtdar+
2 Gontroller hysterasis k@ SD(2301 ‘@ [240D] LRG (H parity)i0 (2Byte ASGI} FROIL2Y Chiredar+
2 Control period read t@e D061 @ [240D] LRC (H parity)iod (2Byte ASGI} FROILZY Chiy+dar+
5P lamp time unit/ se ke 5004301 at [2a00] LRG (H parity)il) (2Byte ASCID FR(T2Y Chrtdar+
LBA dataction time ks SDI0T71 @ [2a0D] LRG (H parityli0) (2Byte ASCID FIROTA2D Chr+{ax+
3 Stap/error manip vari ke SD08 1 ‘@ [220D] LRC (H parity)io (2Byte ASCID} FROTLZY Chired ar
Manip variable limit re ke SDE4 11 ‘@ [240D] LRG (H parity)id (2Byte ASGI} FROILZY Chrtdar
Input digital filter rear k@ 30511 @ [2A00] LRG (H parity)ioy (2Byte ASGI} BROTLZY Chrrd s
o Alarm hysteresis roat Lo D621 ‘@ [2a0D] LRG (H parity)(0) (2Byte ASCID $RALZY Chyedade
M ' Lo DM “a@ [2400] LRG (H parity )0} (2Byte ASCID FRO2Y T Ry
3+ Temperature input sk T s e i e J, e o P _l;l
2 Level 0 parameter re; < | s
Level 1 parameter re:
Level 1 parameter re:
¥ Level 2 parameter res
Level 2 parameter re:
General-purpose rear
L E |
- Receive Message Lis

Display of Cases in a Matrix
Matrices are managed separately from sequences. Matrices can be referred
to by their names from each step in a sequence.

vt o g s o
¥ Level 1 parameter re:
' Level 1 parameter re: Gase Mumber Receive Message Mext Process
¥ Level 2 parameter re: @15 Other End
' Level 2 parameter re:
$ General-purpose reat
3: Send Message List
Receive Message Lis
Matrix List

S Matrix
R Trama ot
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Main Screens of the CX-Protocol Section 1-9

Display of Trace Data

Displays the send and receive messages in chronological order up to the

maximum of 1,700 bytes (characters) for the CS/CJ and 670 bytes (charac-
ters) for the C200HX/HG/HE.

"' Dust_ul
Trace MNumber 2 2 2 2 2 2 2 2 2 2 2 2 2 2
Send Message @ 0 0 R I 4 7 * .
(HEX) 40 a0 30 5z a5 34 a7 248 0D
Receive Message ? . _ i .
HE: aF 0 26 2F 0D
Sequence Mumber | 338 338 338 338 338 338 338 338 338 338 338 338 338 338
Step Mumber 0 0 0 0 0 0 0 0 0 0 0 0 0 0
RTS [
CTS [
OTR
DOSR
Cormm. Error <] | I
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Overview of Project Creation Section 1-10

1-10 Overview of Project Creation

Menu Operation/lcon Operation Refer to
‘ Project creation from scratch } """"""" Select New from the File menu SECTION 5-1
4{ PLC lnodel change } """""""""" Display after creating new project. SECTION 10-1/10-2
rrrrrrr - menu. Designate farget PLC model, bersonal Com- SECTION 10-4/10-2

puter «» PLC Communication Settings.
Double-click the PMSU icon. Designate setup  Note: Ports in parentheses

items for each of ports 1(A) and 2(B). are for the C200HX/HG/HE.
Protocol creation (addition to Iist)} ''''''''''''''''''''''''''''''''''' Right-click Create/Protocol. SECTION 5-1
| Protocol sequence number range setting | SECTION 5-1

Designate the following: Protocol name,
sequence start number, sequence end
number, target.

‘ Sequence creation [~ Right-click Create/Sequence. SECTION 5-2
SECTION 7

Designate the following: link word,
transmission control parameter,
response type, and monitoring time
(Tr, Tfr, Tfs).

Step Creation|----------rr-sororss oo Right-click Create/Step. SECTION 5-2
SECTION 8
Designate the following: repeat counter,
command, retry count, send wait time,
send message (note), receive message
(note), with/without response writing, next
process, and error process.

— \ﬂ Message creation |-« Right-click the Send Message or ~ SECTION 5-3
Receive Message field in the step  SECTION 9
Header, terminator, check code, length, list, and select New Message
address, message edit (including data) from the pop-up menu.
Matrix creation O Right-click Create/Matrix and SECTION 11-1

Create/Matrix Case.

\ Protocol transfer (from personal computer to PMSU) \

Note 1. A send message in a step can be designated by choosing its message
name in the send message list.

2. A receive message in a step can be designated by choosing its message
name in the receive message list or matrix name in the matrix list.

3. Therefore, you can create a message part during step creation more easily
by choosing a message name of the desired send message, receive mes-
sage, or matrix that you have created in advance.
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I ncorporated Standard System Protocol

Section 1-11

1-11 Incorporated Standard System Protocol

The CX-Protocol together with the PMSU provides the following 13 types of
incorporated standard system protocols. (There are 12 types for the Commu-
nications Board of the C200HX/HG/HE because it does not support Compo-
Way/F.)

The protocols can be displayed by selecting the System tab of the project
workspace.

To transfer standard system protocols to the PMSU or create a new protocol
by partially modifying one of the standard system protocols, first copy the
required standard system protocol to another project file and then use the
project file. The standard system protocols themselves cannot be edited or
transferred.

The standard system protocols have been installed into the PMSU at our fac-
tory.

Note

Protocol name

Function

CompoWay/F Protocol for sending a CompoWay/F command and receiving responses from the devices incorpo-
rating the CompoWay/F protocol (Slave function). This protocol operates only with the CS/CJ.

Controller Protocol for controlling an E5[ K Digital Controller via the PMSU. Procedures for reading the MV

(E5_K read) and operating parameter setting.

Controller Protocol for controlling an E5[ K Digital Controller via the PMSU. Procedures for writing set points

(E5_K write) and operating parameters.

Temp Controller
(E5ZE read)

Protocol for controlling an E5ZE Temperature Controller via the PMSU. Procedures for reading
measured temperature and operating parameter setting.

Temp Controller

Protocol for controlling an E5ZE Temperature Controller via the PMSU. Procedures for writing

(E5ZE write) control temperatures and operating parameters.
Temp Controller Protocol for controlling a E5SL1J Temperature Controller via the PMSU. Procedures for writing set
(E5_J) points, reading output amounts, and reading/writing operating parameters.

Controller (ES100_)

Protocol for controlling a ES100L] Temperature Controller via the PMSU. Procedures for writing
adjustment parameters, reading operation amounts, and writing/reading operating parameters.

Intelligent Signal Pro-
cessor (K3T.)

Protocol for controlling a Digital Panel Meter via the PMSU. Procedures for writing comparison val-
ues and reading display values are set.

Bar Code Reader
(V500/V520)

Protocol for controlling a Bar Code Reader via the PMSU. Procedures for controlling the Bar Code
Reader in remote mode, reading the data that has been read by the Bar Code Reader, and
reading/writing operating parameters.

Laser Micro Meter
(3z4L)

Protocol for controlling a Laser Micrometer via the PMSU. Procedures for controlling the Laser
Micrometer in remote mode, reading measured data, and writing/reading operating parameters.

Visual Inspection
System (F200/300/
350)

Protocol for controlling a Visual Inspection System via the PMSU. Procedures for controlling the
Visual Inspection System in remote mode, reading measured values, and writing/reading
operating parameters.

ID Controller (V600/
620)

Protocol for controlling an ID Controller via the PMSU. Procedures for performing Read/Write
operations of the ID Controller and writing/reading operating parameters.

Hayes modem AT
commands

Protocol for controlling a Hayes modem (AT commands) via the PMSU. Procedures for
initialization of the modem, dialing, data transmission, switching to escape mode, and
disconnecting the line.

For more information on each protocol, refer to the Communications Board
Operation Manual (W304) and Serial Communications Board/Unit Operation
Manual (W336).

Example: Protocol for the Controller (E5_K read)

Sequence No. Communications sequence
000 Read process value
001 Read set point during SP ramp
002 Read MV
003 Read set point
004 Read alarm value
005 Read proportional band, integral time, and derivative time
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Basic Procedure of the Protocol Macro Usage Section 1-12

1-12 Basic Procedure of the Protocol Macro Usage

1-12-1 For the CS/CJ

Procedure 1 PMSU Setup

Setting the Serial Communications Board Setting the Serial Communications Unit
(Only for Serial Communications Boards with Front rotary switch setting
RS-422A/485)

———- Unit No. setting switch

|_— Terminating resistance ON/OFF switch
| 2-wire/4-wire Selection switch

[aFF v 75
WIRE. o
o (@)
. 88
39| || raerz
ol || A2
298 | sz o
o) R5485)
E.22 4
| A

Set the unit No. in a range from 0 to F (O to 15).

Procedure 2 PMSU Mounting

Mounting the Serial Communications Board Mounting the Serial Communications Unit
et gl -
=
[———
=
___|F <]~
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Basic Procedure of the Protocol Macro Usage Section 1-12

Procedure 3 Connection with External Devices

CS1W-SCU21 Serial Communications Unit —\

CS1W-SCB41 Serial Communications Board
CPU Unit /—

N

Port 1 D Port 1 RS-232C

Port 2 __D Port 2
RS-422A/485

RS-232C RS-232C General-purpose
external device

General-purpose
external device

General-purpose General-purpose General-purpose
external device external device external device

Note For connector pin arrangements and connection methods, refer to the Serial
Communications Boards/Unit Operation Manual (W336) and other relevant
manuals for general-purpose external devices.

Procedure 4 Initial Setting

1,2,3... 1. For Connecting Cables between the PLC and the CX-Protocol, refer to

2-2 Connecting to a PLC.

2. PLC Setup of the CPU Unit and the PMSU.
PLC Setup for Connecting the PLC to the CX-Protocol.
Perform the following setups (a) and (b). The communications conditions
designated in (a) and (b) must be coherent.
a) Using the CX-Protocol, designate a target PLC model and perform the

communications setup between the personal computer and the PLC.

b) Using a Programming Device for PLC's CPU Unit, perform the PLC
setup according to a connected port.

PLC Setup of the Serial Communications Board PLC Setup of the Serial Communications Unit

Allocated DM area: D32000 to D32767 Allocated DM area: D30000x100 Unit No.

D32000 to D32009 PLC setup of port 1 Unit No. DM area

D32010 to D32019 PLC setup of port 2 0 D30000 to D30099 m to m+9: PLC setup of port 1

D32020 to D32767 Reserved by the system D30100 to D30199 m+10 to m+19: PLC setup of port 2
D30200 to D30299 m+20 to m+99: Not used

D30300 to D30399
D30400 to D30499
D30500 to D30599
D30600 to D30699
D30700 to D30799
D30800 to D30899
D30900 to D30999
D31000 to D31099
D31100 to D31199
D31200 to D31299
D31300 to D31399
D31400 to D31499
D31500 to D31599

Timjojojwm{>jo|o]N]o|uls]|w N -

Example: Setting the Default Communications Conditions (m=D30000+100xUnit No.)

Board Unit Bits Settings
Port 1 Port 2 Port 1 Port 2
D32000 |D32010 m m+10 15 0: Start bit=1 bit, Data length=7 bits, Parity=Even, Stop bit=2 bits
11 to 08 | 6: Protocol macro
D32001 |D32011 m+1 m+11 03 to 00 |0O: Baud rate: 9600 bits/s
D32008 |D32018 m+8 m+18 15 0: Half-duplex
D32009 |D32019 m+9 m+19 15 to 00 | 00C8 Hex: Protocol send/receive data bytes: 200 bytes max.

AUDIN - g,4avenue de la malle - 51370 Saint Brice Courcelles - Tel : 03.26.04.20.21 - Fax : 03.26.04.28.20 - Web : http: www.audin.fr - Email : info@audin.fr



Basic Procedure of the Protocol Macro Usage Section 1-12

Using the CX-Protocol, make the settings for communications ports 1 and 2 of
the PMSU and transfer the settings to the PLC.
For more information, refer to 10-7 Transfer of Communications Port Setting
Data to PLC.
3. External Device Settings
Perform required processes including DIP switch settings on external de-
vices.

Procedure 5 Protocol Design
Refer to the SECTION 4 and SECTION 5.

1,2,3... 1. Creates the status transition chart of the communications sequence.
2. Disassembles the status transition chart into sequences and steps, and
set them up.

3. Creates the send and the receive messages.

Procedure 6 Project (Protocol Data) Creation and Transfer by CX-Protocol
Refer to 1-10 Overview of Project Creation.

1,2,3... 1. Creates a new project.
Refer to 5-1 Creating Projects and Protocols.

2. Creates a new communications sequence.
Refer to 5-2 Creating Sequences and Steps and7-1 Setting Sequences.

3. Creates each step.
Refer to 5-2 Creating Sequences and Steps and 8-1 Step Setting.

4. Creates each message. (See note.)
Refer to 9-1 Message Setting.

5. Transfers the created projects to the PMSU.

Refer to 11-1 Transferring and Reading Protocol Data between the Com-
puter and PMSU.

Note Each step can be created after each message creation by designat-
ing the message name.

Procedure 7 The Ladder Program Creation

1,2,3... 1. Allocates a function code for the PMCR instruction.
Example: For the Serial Communications Board
Protocol Macro Communications Port . .
Execution Flag Enabled Flag Use communications port No. 7 and
Input condition 191915 A20207 serial port No. 2.
i | 1 i | PMCR (260) Destination unit number address E1:
e B Inner (serial communications) Board

#0064 | Sequence No. 100
D00000 | Send data first word
D00100 [ Receive data storage first word

When the input condition is set to “ON” and the Protocol Macro Execution
Flag (191915: port 2) is set to “OFF” the communications sequence num-
ber 100 registered on the PMSU is called to send and receive data via port
2 of the PMSU if the Communications Port Enabled Flag (A20207: internal
logic port of the communications port No. 7 is used) is ON.

The send data is sent out from the next DO0001 according to the number
of effective words (number of words including DO0000) designated by

DO00000.
D00000 | Number of effective words How many words including
D000O are effective?
D00001 Designated number at DO0O000
; of send data are read beginning
Send data Effective from D000O1.
25
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The receive data is stored in the successive words beginning from D00101
for the number of effective words actually stored in D0O0100 (number of
words including D00100).

How many words including
D00100 are effective?
Receive data is stored in

D00100 | Number of effective words —

D00101

Effective successive words beginning
Receive data words from D00101 and the number of
effective words is stored in
D00100.

Note Receive data set before the PMCR is executed will not change if re-
ceive processing fails.

2. Execute the PMCR instruction.
Procedure 8 Confirmation of Operations
Refer to SECTION 12 Tracing and Monitoring.

1,2,3... 1. Traces the transmission lines.

Trace the data in the send and receive messages and the control signals
that are flowing on the transmission line (RS-232C or RS-422A/485).

2. Monitors the I/O memory.
Monitor the send and the receive data and the status of flags.

1-12-2 For the C200HX/HG/HE

Procedure 1 PMSU Setup DIP Switch Setup for the PMSU (For C200HW-COMO06-E/EV1 only.)
SW1: Switch between two-wire and four-wire methods
SW2: ON/OFF of terminating resistance (ON during using RS-422A/485

ports)
o DIP Switch SW2
g; DIP Switch SW1
o
10
o)
o)
@) D o
]
0
10
Procedure 2 PMSU Mounting
1,2,3... 1. Open the memory cassette cover.

4
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Section 1-12

2. Remove the PMSU cover.

1

—

3. Insert the PMSU and slide it into the slit completely.

]

i

4. Close the memory cassette cover.

|

Procedure 3 Connection with External Devices

Connect through RS-232C or RS-422A/485.

CPU unit Protocol Macro Support Unit

Port B

RS-232C

Port A

RS-422A/485

ex

ternal devic

General-purpose

e

Ge

neral-purpo

external device

S

' General-purpose
' external device

General-purpose
external device
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Basic Procedure of the Protocol Macro Usage Section 1-12

Note For connector pin arrangements and connection methods, refer to the Com-
munications Board Operation Manual (W304) and other relevant manuals for
general-purpose external devices.

Procedure 4 Initial Setting

1,2,3... 1. For Connecting Cables between the PLC and the CX-Protocol, refer to
2-2 Connecting to a PLC.
2. PLC setup of the CPU Unit and the PMSU.
PLC Setup for Connecting the PLC to the CX-Protocol.
Perform the following setups (a) and (b). The communications conditions
designated in (a) and (b) must be coherent.
a) Using the CX-Protocol, designate a target PLC model and perform
communications setup between the personal computer and the PLC.
b) Using a Programming Device for PLC's CPU Unit, perform PLC setup
according to a connected port.
« When connected to the peripheral port:
Communications setup of the peripheral port:
DM 6650 to DM 6654 in the PLC setup area
* When connected to the CPU Unit’s built-in RS-232C port:
Communications setup of the RS-232C port:
DM 6645 to DM 6649 in the PLC setup area
For both the peripheral port and the CPU Unit’s built-in RS-232C port,
make the default settings (start bit: 1 bit, data length: 7 bits, parity: even,
stop bit: 2 bits, baud rate: 9600 bps) to correspond to 0000 in DM 6650 for
the peripheral port and DM 6645 for the CPU Unit’s built-in RS-232C port
respectively.
PLC Setup for the PMSU
Use one of the following methods to perform PLC setup of the PMSU port
A/B.
c) Using a Programming Device for the PLC’s CPU Unit, perform the fol-
lowing PLC setup.
PMSU PLC setup
Port A: DM 6555 to DM 6559 in the PLC setup area
Port B: DM 6550 to DM 6554 in the PLC setup area

Example: Setting the Default Communications Conditions
5 ' ' 0
DM6555| 6 . 0 . 0 . 0

Communications conditions of Port A

0 indicates:

Start bit:1 bit, data length: 7 bits, parity:
even, stop bit: 2 bits, baud rate: 9,600 bps

Communications mode for port A
6: Protocol macro

d) Using the CX-Protocol, perform setup of communications port A/B
through the PMSU icon and transfer the setting to the PLC.
For more information, refer to 10-7 Transfer of Communications Port
Setting Data to PLC.
3. Setup of external devices.
Perform required processes including DIP switch settings on external de-
vices.

AUDIN - g,8avenue de la malle - 51370 Saint Brice Courcelles - Tel : 03.26.04.20.21 - Fax : 03.26.04.28.20 - Web : http: www.audin.fr - Email : info@audin.fr



Basic Procedure of the Protocol Macro Usage

Section 1-12

Procedure 5 Protocol Design

1,2,3...

Refer to SECTION 4 Using the Protocol Macro Function and SECTION 5
Object Creation.

1. Creates the status transition chart of communications sequence.

2. Disassembles the status transition chart into the sequences and steps and
sets them up.
3. Creates the send and the receive messages.

Procedure 6 Project (Protocol Data) Creation and Transfer by CX-Protocol
Refer to 1-10 Overview of Project Creation.

1,2,3...

1. Creates a new project.
Refer to 5-1 Creating Projects and Protocols.
2. Creates a new communications sequence.
Refer to 5-2 Creating Sequences and Steps and 7-1 Setting Sequences.
3. Creates each step.
Refer to 5-2 Creating Sequences and Steps and 8-1 Step Setting.
4. Creates each message. (See note.)
Refer to 9-1 Message Setting.
5. Transfers the created projects to the PMSU.
Refer to 11-1 Transferring and Reading Protocol Data between the Com-
puter and PMSU.

Note Each step can be created after each message creation (by designat-
ing the message name).

Procedure 7 The Ladder Program Creation

1,2,3...

1. Allocates function code for the PMCR instruction.
1) Sets SW4 of the CPU Unit to ON (enables the application commands

setup).

2) Allocates function code for the PMCR instruction through a Program-
ming Device for the CPU Unit.

Note If your PLC is the C200H[]-CPULILI-ZE, function code 260 will be as-
signed to the PMCR instruction by default.

2. Describes the PMCR instruction.

Example:
Protocol Macro
Input condition gggggt'on Flag
' | | +F PMCR (260)
#1100
DMO0000
DMO0010
ER Flag
25503
: IL FAL(06)001

Sequence No. 100 is executed using the Port A.
Send data first word

Receive data storage first word

When the input condition is set to “ON” and the Protocol Macro Execution
Flag (28908: port A) is set to “OFF” the communications sequence No. 100
registered on the PMSU will be called to send and receive data via port A
of the PMSU.

29
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The send data will be sent out from the next DM 00001 according to the
number of effective words (number of words including DM 0000) designat-
ed by DM 0000.

How many words including
DM 0000 are effective?
. Designated number at DM 0000
Effective  of send data are read beginning
words from DM 0001.

DM0000 Number of effective words —
DM0001

Send data

/

The receive data is stored in the successive words beginning from DM
0011 for the number of effective words actually stored in DM 0010 (number
of words including DM 0010).

How many words including
DM 0010 are effective?
Receive data is stored in

DMO0010 Number of effective words

DMO0011 i
. \,E\,g?ggve successive words beginning
Receive data from DM 0011 and the number
of effective words is stored in
DM 0010.

3. Execute the PMCR instruction.

Procedure 8 Confirmation of Operations
Refer to SECTION 12 Tracing and Monitoring.

1,2,3... 1. Traces the transmission lines.

Trace the data in the send and the receive messages and the control sig-
nals flowing on the transmission line (RS-232C or RS-422A/485).

2. Monitors the I/O memory.
Monitor the send and the receive data and the status of flags.

1-13 Specifications

1-13-1 Protocol Macro Specifications

Item Description

Number of protocols 20 max. Can be created and registered by the CX-Protocol.
Number of sequences 1000 max.
Per Sequence 60 max.
protocol count

Message 300 max.

count

Matrix count | 100 max.
Number of steps per 16 max.
sequence
Sequence execution Designated by the PMCR instruction on the PLC’s CPU Unit (by giving a sequence number).
condition
Transmission mode Half-duplex or full-duplex can be designated. (Full-duplex is only for the CS/CJ protocol

macro.)

Synchronization method Start-stop synchronization (non-synchronization method)

AUDIN - g’,oavenue de la malle - 51370 Saint Brice Courcelles - Tel : 03.26.04.20.21 - Fax : 03.26.04.28.20 - Web : http: www.audin.fr - Email : info@audin.fr



Specifications Section 1-13
Item Description
Sequence | Transmis- One of X-on/X-off flow or RTS/CTS flow, delimiter control, contention control, or modem
content sion control | control can be designated.
(common parameters
parameter pesponse | Mode for writing received data to the 1/0 memory area designated by the third operand
to all steps) | yype (for C200HX/HG/HE) or fourth operand (for CS/CJ) of the PMCR instruction.
Either the scan mode or interrupt mode can be designated.

Monitoring Receive wait, receive finish, or send finish can be monitored.

time for Setup range: 0.01t00.99s,0.1t09.9 s, 1t0 99 s, or 1 to 99 minutes

sending/

receiving

Link word Data are exchanged between the PLC’s CPU Unit and the PMSU when the CPU Unit is

doing a Peripheral service. Two areas for sending data, and two areas for receiving data.

Step Command Send, Receive, or Send&Receive, Wait, Flush, DTR-ON (Open), or DTR-OFF (Close) (Wait,
content Flush, DTR-ON, and DTR-OFF are only for the CS/CJ protocol macro.)

Repeat 1 to 255 times

counter

Retry count |0 to 9 (Can be designated only for Send&Receive command.)

Send wait 0.01t00.995s,0.1t09.95s,1t099 s, or 1 to 99 minutes

time (Can be designated only for Send or Send&Receive command.)

With/Without | Specifies whether to store the receive message after data receiving is completed (when

response storing received data to the area designated by the third operand (for C200HX/HG/HE) or

writing fourth operand (for CS/CJ) of the PMCR instruction.)

(operand

addressing)

Next process

Specifies the next process as follows when the step ends normally: End (end the sequence),
Next (go to the next step number), Goto (go to a designated step number), or Abort (abort
the step to end the sequence).

Error Specifies the next process as follows when the step ends abnormally: End (end the
process sequence), Next (go to the next step number), Goto (go to a designated step number), or
Abort (abort the step to end the sequence).
Send Settings for the data to | Consists of a header (Note 1), address (Note 2), length, data
message be sent when the (Note 2), error check code (Note 3), and terminator (Note 1).
command is Send or
Send&Receive.
Receive Settings for the data to
message be received when the
command is Receive or
Send&Receive.
Matrix When the command is | Designate a receive message and next process for each of case
Receive or numbers 00 to 15.
Send&Receive, the At least one of 16 cases must be designated to Other for its
matrix sets up the receive message type (other than the designated receive
message expected to be | message).
received (up to 15 sets)
to switch next process
by comparing the data.
Data Constant ASCI| data, hexadecimal data, or control code.
attribute of
header and
terminator
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Item Description
Step Address Constant | ASCII data, hexadecimal data, or control code (For address, the control code
content attributes cannot be used.)
anddata  [variable | No conversion, hexadecimal to ASCII conversion, or ASCII to hexadecimal
22;'3%?5 In conversion (Direction of read / write can be designated.)
receive Specifica- | (X,Y) o
message tion X: Effective address (source or destination address)
method Y: Data size (1 to 1,000 for CS/CJ and 1 to 255 for C200HX/HG/
HE) (Data size is equal to the number of bites on transmission
path.)
X Word Word read | Designated by | Designated start
designation (o the second address + n
memory operand (for (The linear
— send C200HX/HG/ expression
data) HE) or the third | aN+b, which
operand (for CS/ | includes the
CJ) of the repeat counter
PMCR N, can be
instruction designated for
Designated by | ")
the link word.
Designated
directly.
Word write | Designated by
(receive the third
data — 1/0O | operand (for
memory) C200HX/HG/
HE) or the fourth
operand (for CS/
CJ) of the
PMCR
instruction.
Designated by
the link word.
Designated
directly.
Wildcard X Receive any data/address (only for
receive message)
Linear expres- |aN+b a: 0 to 255 (for C200HX/HG/HE)

sion or constant
including the
repeat counter

or 0 to 1,000 (for CS/CJ)
b: 1 to 255 (for C200HX/HG/HE)
or 1 to 1,000 (for CS/CJ)
N: Repeat counter value
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Item Description
Step Address Variable Linear expres- |aN+b a: 0 to 255 (for C200HX/HG/HE)
content attributes sion or constant or 0 to 1,000 (for CS/CJ)
and data including the b: 1 to 255 (for C200HX/HG/HE)
attributes in repeat counter or 1 to 1,000 (for CS/CJ)
send or N: Repeat counter value
receive Wildcard X Receive any length of data.
message - -
Word Word read | Designated by | Designated start
designation (/O mem- |the second address +
ory —send | operand (for n (The linear
data) C200HX/HG/ expression aN +

HE) or the third
operand (for CS/
CJ) of the
PMCR
instruction

Designated by
the link word.

Designated
directly.

b, which
includes the
repeat counter
N, can be
designated for

n.)

Error check
code

Supports calculation of LRC, LRC2, CRC-CCITT, CRC-16, SUM, SUM1, and SUM2.
(LRC2 and SUML1 are only for the CS/CJ protocol macro.)

The
maximum
length of the
send or the
receive
message

CS/CJ: 1,000 bytes (possible to set to a range between 200 and 1000 bytes)
Also possible to set to this range at a control of RTS/CTS flow, X-on/X-off flow, or delimiter.

C200HX/HG/HE: 256 bytes (Within 200 bytes of one-step receiving message at a control of

RTS/CTS flow, X-on/X-off flow, or delimiter.)

Trace function

Possible to trace chronological data of send/receive messages.

CS/CJ: Data length that can be traced is 1,700 bytes (characters).
C200HX/HG/HE: Data length that can be traced is 670 bytes (characters).

Possible to trace changes in the control signals such as step number, RTS, or CTS.

AUDIN - 8, avenue de la malle - 51370 Saint Brice Courcelles - Tel : 03.26.04.20.21 - Fax : 03.26.04.28.20 - Web : http: www.audin.fr - Email : info@audin.fr

33



AUDIN -

Differences between Protocol Macros

Section 1-14

1-13-2 Specifications of the CX-Protocol

Item

Description

Basic functions

Creation of protocols, transfer of protocols to and from the PMSU, and file saving

File creation unit

Project unit

Components of project | Protocaol list Up to 20 protocols (components of
protocol: sequence, send/receive
message, matrix)

Devices Target PLC, network setup, com-
munications port setup
Trace list

Other functions

- Tracing of transmission lines

- Monitoring of PLC’s I/O memory

- Print of protocols

- Standard system protocols are built-in.
- Error display

Supported OS

Microsoft Windows 95/98/Me/2000/NT4.0

Supported network

Host link (SYSMAC WAY), Tool Bus, Controller Link, SYSMAC LINK, and Ethernet.

Connection with PLCs

Peripheral port on the CPU Unit, built-in RS-232C or RS-232C port on the PMSU (only in the
host link mode) or a Network Support Board with the above networks.

Personal computers

IBM PC/AT or compatible computer

CPU

Pentium 90 MHz or higher (With Windows Me, Pentium 150 MHz or higher)

Memory 16 Mbytes or more

Hard disk 20 Mbytes or more of available area
Monitor S-VGA or higher

Floppy disk drive 1 or more 1.44-Mbyte drives
CD-ROM drive One or more

1-14 Differences between Protocol Macros

The protocol macro for the CS/CJ is different from the one for the C200HX/
HG/HE as shown in the following table.

Item C200HX/HG/HE Cs/CJ

Transmission mode Half-duplex Half-duplex or full-duplex

Commands Send, Receive, and Send&Receive Send, Receive, Send&Receive, Wait,
Flush, DTR-ON (Open), and DTR-OFF
(Close)
Notes
Wait: Keeps the step on standby and
controls the next process.
Flush: Clears all data in the receive
buffer.
Open (DTR-ON): Holds the DTR signal
even after the sequences has ended
(only under modem control).
Close (DTR-OFF): Turns OFF the DTR
signal under the modem control.

Receive 256 bytes 2.5 Kbytes

buffer

(per port)
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Item C200HX/HG/HE CSs/CJ
Receive | Starting point (send stop 200 bytes 2 Kbytes
buffer request to the destination
flow device: RTS signal OFF)
control
(RTS/
CTS,
Xon/
Xoff) on
PMSU
side
Ending point (send When shifting steps 0.5 Kbytes
resumption request to the
destination device: RTS
sighal ON)
Maxi- Number of bytes that can be | 256 bytes max. 1,000 bytes max.
mum sent for one Send processing Default: 200 bytes
send/ Possible to set between 200 and 1,000
receive bytes.
mes- Note
sage When receiving data, data within the
length receive buffer will be retrieved for each
Number |RTS/CTS flow, 200 bytes max. maximum length.
of bytes | Xon/Xoff flow,
that can | delimiter control
be
received
forone | Others 256 bytes max.
Receive
process-
ing
Maxi- RTS/CTS flow, Xon/Xoff flow, | 200 bytes max. As shown above.
mum delimiter control Possible to set between 200 and 1,000
receive bytes.
mes- Default: 200 bytes
sage
length
whena | Others 256 bytes max.
wildcard
(*)is
used for
data
length
Designa- | When Maximum send 127 words max. (Not including the 250 words max. (Including the send
tion of operand |data send data word area) data word area)
send/ is desig- [ \aximum receive | 127 words max. (Not including the 250 words max. (Including the receive
(rjz(;:“’e nated data receive data word area) data word area)
storage
location
Data When Area 1 IN Total of 128 words max. Total of 500 words max.
capacity |link word ouT
is desig-
nated Area 2 IN
ouT
Direct Maximum send or | 128 words max. (No conversion) 500 words max. (No conversion)
designa- |receive data
tion (by
each
parame-
ter)
35
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Iltem C200HX/HG/HE CS/CJ
Receive buffer Half-duplex 1) Right before sequence is executed. |1) Right before sequence is executed.
clearing timing 2) Right before Receive processing is |2) Right before Send processing is
executed. executed.
3) When Flush command is executed.
Full-duplex Not available. 1) Right before sequence is executed.

2) When Flush command is executed.

Receive processing | Half-duplex Only while Receive processing is Any time other than when Send
to the receive buffer being executed. processing is being executed.
Full-duplex Not available. Every time the sequence is executed.
(No receive processing if sequence is
not executed.)
Character trace Half-duplex Every time the sequence is executed. |Every time the sequence is executed.
receive record (Also recorded while Send processing | (Also recorded while Send processing
is being executed.) is being executed.)
Full-duplex Not available. Execution sequence number
communications error.
Transmission con- | RTS signal When RTS/CTS flow control is desig- | When RTS/CTS flow control is
trol signal operation nated: RTS signal turns ON when the |designated: RTS signal turns ON when
receive buffer on the PMSU side the receive buffer on the PMSU side
reaches 200 bytes. reaches approx. 2 Kbytes.
When modem control is designated: When modem control is designated:
Turns ON when data is sent and turns | Turns ON when data is sent and turns
OFF when transmission is completed. | OFF when transmission is completed.
CTS signal When RTS/CTS flow control is desig- | When RTS/CTS flow control is
nated: transmission is kept standby designated: transmission is kept on
when CTS signal is ON and transmis- | standby when CTS signal is ON and
sion becomes possible when CTS sig- | transmission becomes possible when
nal is OFF. CTS signal is OFF.
DTR signal When modem control is designated: When modem control is designated:

Turns ON when sequence execution is
started and turns OFF when sequence
execution is completed.

Note
Does not turn ON in modes other than
the modem control.

Turns ON when sequence execution is
started and turns OFF when sequence
execution is completed.

Under the modem control, ON/OFF
can be controlled at any desired timing
by executing the Open (DTR-ON state
is retained even after sequence is
completed) or Close (DTR-OFF)
command.

DTR signal can be controlled over
more than one sequence.

Note

When both the RTS/CTS flow control and modem control are designated:
The DTR signal will follow the modem control and RTS/CTS signal will turn ON
the RTS signal when sending data and will follow the RTS/CTS flow control

when receiving data.

Synchronization with the CPU Unit after
sequence is executed.

Not available.

Keeps transition between steps on
standby using the Wait command and
starts control when the Wait is cleared
from the CPU Unit.

Example: Processing can proceed to
the next step after the CPU Unit com-
pletes internal computation in a
particular step.

Send/receive
messages

Receiving data
length

No check.

Data is retrieved as a message for the
length indicated in the expected
receive message.

Error check code

LRC2 and SUM1: Not available.

LRC2 and SUM1: Available

Interrupt natification function

Not available.

Serial Communications Board:
Available.

Serial Communications Unit: Not
available.
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SECTION 2
Environment/I nstalling/Uninstalling/Star ting/Ending

This section outlines the functions of the CX-Protocol and describes the operating environment, installation procedure, and
the setting of the usage environment.

2-1  Environment ReqQUIremMents. . . .. ..o vt 40
2-2 ConnectingtoaPLC. ... .. i 41
2-3 INstalling . ..o 43
2-4  UNINStalling. . ... 45
2-5  SAt-UP . oo 46
2-6  Shut-down. .. ... ... 46
2-7 Outlineof User Interface. .. ... 47
2-7-1 WINAOW. . . oot 49
2-7-2  Control MenU . ..o oot e 52
2-7-3 Menuand Short-cut Keys. ... 53
2-7-4  POPUPMENUS . ..ot 54
2-7-5 To0l Bar [CONS. . ..o vt e 56
2-7-6  StausBar . ... 57
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2-1 Environment Requirements

The CX-Protocol requires the following minimum computer configuration
requirements for effective operation.

* A CPU at least as fast as the 90-MHz Pentium

* At least 16 Mbytes of RAM

 Hard disk storage with at least 24 Mbytes of free space

* A display system at least as advanced as the S-VGA

* Microsoft Windows 95/98

* Mouse

Cs/Cd The CX-Protocol operates with the following CS/CJ-series PLCs.

* CS1H-CPU6B7-E/CPU6B6B-E/CPUB5-E/CPU6G4-E/CPUB3-E
* CS1G-CPU45-E/CPU44-E/CPU43-E/CPU42-E
* CS1H-CPU67H/66H/65H/64H/63H
* CS1G-CPU45H/44H/43H/42H
* CJ1G-CPU45/44
* CJ1G-CPU45H/44H/43H/42H
+ CJ1H-CPU66H/65H
The CX-Protocol supports the following Serial Communications Boards and
Units.
» Serial Communications Board CS1W-SCB21
(Communications port: RS-232C (Port 1), RS-232C (Port2))
» Serial Communications Board CS1W-SCB41
(Communications port: RS-232C (Port 1), RS-422A/485 (Port2))
» Serial Communications Unit CS1W-SCU21
(Communications port: RS-232C (Port 1), RS-232C (Port2))
» Serial Communications Unit CJ1W-SCU41
(Communications port: RS-422A/485 (Port 1), RS-232C (Port 2))

C200HX/HG/HE The CX-Protocol operates with the following PLCs which support PMSUSs.
Note CX-Protocol Version 1.0 does not support the C200HX/HG/HE.

+ C200HX-CPU85-(Z)E/CPUB5-(Z)E/CPUB4-(Z)E/CPU54-(Z)E/CPU44-
(2)E/
CPU34-(2)E
+ C200HG-CPUB3-(Z)E/CPU53-(Z)E/CPU43-(Z)E/CPU33-(Z)E
+ C200HE-CPU42-(Z)E/CPU32-(Z)E
The CX-Protocol supports the following PMSUSs.
+ C200HW-COMO04-E/-EV1
(Communications port: Communications Unit connection port,
RS-232C (Port A)
+ C200HW-COMO05-E/-EV1
(Communications port: RS-232C (Port A), RS-232C (Port B))
+ C200HW-COMO06-E/-EV1
(Communications port: RS-232C (Port B), RS-422A/485 (Port A))
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Section 2-2

2-2 Connecting to aPLC

When transferring protocol data created by the CX-Protocol to Communica-
tions Boards or Units, use the following Cables to connect the computer and
PLC. Connection to the CPU Unit can be made to either the peripheral port or

RS-232C port of the CPU Unit.
A personal computer can be connected to the PMSU port if the port is set to

Note

the host link mode. With the C200HX/HG/HE, if one of the PMSU ports is set
to the NT link mode, this connection will not be possible.

Cs/CJ
Communications Cable used Cable length Connector on the Connector on the
procedure computer PLC

Peripheral bus CS1W-CN118 (see note) |0.1 m RS-232C Peripheral port
CS1W-CN226 2m
CS1W-CN626 6m
XW2Z-200S-V 2m CPU Unit built-in
XW2Z-500S-V 5m RS-232C port

Note The CS1W-CN118 is used when connecting an RS-232C cable to the periph-

eral port.

Connecting the CPU Unit to the peripheral port

CS1W-CN118/226/626

1

RS-232C

Connecting the CPU Unit to the RS-232C port

]

—

Peripheral port

L

XW2Z-200S-V/500S-V

; CPU Unit

i
[ |

| Peripheral port

M—

RS-232C

ol

—

RS-232C port

;CPU Unit

|
L.r/

— RS-232C port

C200HX/HG/HE
Communications Cable used Cable length Connector on the Connector on the
procedure computer PLC
Peripheral bus CQM1-CIF02 3.3m RS-232C Peripheral port
RS-232C XW2Z-200S-V 20m RS-232C
XW2Z-500S-V 5.0m
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Connecting the CPU Unit to the peripheral port

; CPU Unit

L— Peripheral port

A
~J "

—_—

Peripheral port

CPU Unit
XW2Z-200S-V/500S-V i—‘

RS-232C cable

_
L1l ' | RS-232C port
L

—_—

RS-232C RS-232C port

When creating a specific RS-232C cable, join the connectors listed in the fol-

lowing table.
Connectors and Cables
Component name Model Manufacturer

D-sub connector (9-pin, | XM2A-0901 (connector) OMRON

PLC side, male) XM2S-0911 (connector hood)

D-sub connector (9-pin, | XM2D-0901 (connector) OMRON

PC side, female) XM2S-0911 (connector hood)

Recommended Cable UL2464 AWG285P IFS RVV SB Fujikura Ltd.
(UL item)
AWG28P O 5P IFVV-SB (non-UL item)
UL2464-SB 5P 0 AWG28 (UL item) Hitachi Cable,
CO-MA-VV-SB 5P 0 AWG28 Ltd.
(non-UL item)

Wire path length Upto15m

Connection Signals on the Personal Computer Side
Pin number Symbol Circuit name

1 FG Protective Ground

2 RD Receive Data

3 SD Send Data

7 RTS Request To Send

8 CTS Clear To Send

5 SG Signal Ground
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_
Wiring Cables The following diagram shows the wiring of cables connecting a PLC and com-
puter.
D-sub 9-pin plug (Male) D-sub 9-pin plug (Female)
PLC Computer
Connector hood FG| " Shield . Connector hood FG
1 - b T e 1 FG
SD 2 2 RD
RD 3 3 SD
RTS 4 7 RTS
cts 15— s crs
SG 9 5 SG

2-3 Installing

Precautions when Installing onto the Same Personal Computer as SYSMAC-PST

+ Before installing the CX-Protocol onto a personal computer that already

has SYSMAC-PST installed, be sure to perform the following procedures.

* Before installing SYSMAC-PST onto a personal computer that already

has the CX-Protocol installed, be sure to uninstall the CX-Protocol first,
and perform the operations given below. Then, reinstall the CX-Protocol.

If the following operations are not performed, the SYSMAC-PST or the CX-
Protocol may not function properly.

3 Start i

Procedure 1 Checking if SYSMAC-PST has been installed onto the personal computer.
1,2,3... 1. Left-click the Start button on the taskbar and move to Settings.

2. Left-click the Control Panel.

3. Double-click (left mouse button) the Add/Remove Programs icon.

4. The Add/Remove Programs Properties dialog box will displayed.
Select the Install/Uninstall tab.

5. The Install/Uninstall list will be displayed.

Check if SYSMAC-PST appears on the list.
Procedure 2 Moving the DLL file.
1,2,3... 1. Using the Explorer or another file management tool, transfer or copy the
file shown below (CDMAPI32.DLL) from the Windows folder to the
SYSMAC-PST Programs folder.
File name File size Latest update
CDMAPI32.DLL 143,872 bytes July 21, 1997
Note 1. If Show all files (set in View/Options/View tab/Hidden files) in the set-
tings for the Explorer is not checked, this file will not be displayed, even if
the SYSMAC-PST is installed.

2. When moving the above file, ensure that other files in the Windows folder
are not also moved. If other files are also moved, Windows, along with oth-
er application software, may cease to function properly.

CX-Protocol Installation Use the following procedure to install the CX-Protocol on a computer running

Microsoft Windows 95/98.

Note Do not stop the installation of the CX-Protocol halfway. Otherwise, files copied
before stopping may remain in the installation directory.
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1,2,3... 1. Turn ON the computer to start the Windows 95/98.
2. Left-click the Start button on the taskbar and move to Settings.

3. Left-click the Control Panel.
]
— 4. Double-click the Add/Remove Programs icon.

Lz 5. The Add/Remove Programs Properties dialog box will be displayed.
Left-click the Install... button.

6. Insert the CX-Protocol CD-ROM into the computer’s drive. Left-click the
Next> button. Ensure that the Command Line for Installation Program
field reads “d:\setup.exe,” where “d:\" (drive name may differ depending on
the computer; capitalization is not important) is the location of the CD-
ROM drive, and left-click the Finish button. If required, left-click the
Browse... button to find the setup.exe file.

7. The Choose Setup Language dialog box will be displayed. Select English
from the drop-down list and left-click the OK button.

8. Itwill take a little while to initialize the setup program. Initialization progress
will be displayed on the progress indicator. Once the progress indicator
reaches “100% complete,” installation will begin. The Welcome dialog box
will be displayed. Read the information on the Welcome dialog and left-
click the Next> button.

9. The Choose Destination Location dialog will be displayed. The CX-Pro-
tocol will be installed in the “C:\Program File\Omron\CX-Protocol” folder by
default. Click the Browse... button to locate a different destination folder for
the CX-Protocol. If a destination folder does not currently exist, it will be
created by the installation process following confirmation by the user. Left-
click the Next> button to continue.

10. At the end of the program, the Setup Complete dialog box will be dis-
played as shown below.

InstallBhield Yizard Complete

Setup complete

[ ¥iew Readme/Feicasetioles file

¥ Install CH-Server

< Back [ Finish | | Gamcel |

Confirm that a checkmark is placed in the check box for Install CX-Server
and left-click the Finish button, and installation of the CX-Server will start.
If any SYSMAC Windows Support Software (for example, CX-Program-
mer) other than the CX-Protocol has already been installed, the CX-Server
will have been already installed. In that case, click the checkmark box to
remove the checkmark for Install CX-Server and left-click the Finish but-
ton. This completes the installation.
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Install the CX-Server according to the following procedure.

11. The Choose Setup Language dialog box will be displayed. Select English
from the drop-down list and left-click the OK button.

12. The Welcome dialog box will be displayed. Read the information and left-
click the Next> button.

13. The Choose Destination Location dialog box will be displayed. Select
the folder where the CX-Server is to be installed and left-click the Next>
button.

14. The Select Components dialog box will be displayed. When executing
communications with a PLC using the SYSMAC LINK Board or Controller
Link Board, select Fins Gateway Omron NSB Drivers and select an in-
stallation driver (subcomponent) on the Select Sub-components dialog
box. Click the Continue button to close the Select Sub-components dia-
log box. Left-click the Next> button.

15. This completes the installation of the CX-Server.

16. If the Fins Gateway Omron NSB Drivers has been selected subsequent
to the CX-Server installation, the setup program of the Fins Gateway Om-
ron NSB Drivers will start.

Left-click the Cancel button to cancel the setup operation. Left-clicking the
Cancel button will display the Exit Setup dialog box. Left-click the Exit
Setup button to cancel the setup and the Resume button to continue the
setup.

Note The CX-Protocol requires installation of not only the CX-Protocol software but
also the CX-Server software used as a system program for communications.
If any SYSMAC Windows Support Software (for example, CX-Programmer)
other than the CX-Protocol has already been installed, the CX-Server will
have been already installed. In such a case, it is not necessary to install the
CX-Server after installing the CX-Protocol.

2-4  Uninstalling

Use the following procedure to uninstall the CX-Protocol from the computer.
click the left mouse button with the cursor located at the OK button

) Start 1,2,3... 1. Left-click the Start button on the taskbar and move the cursor to Settings.
2. Left-click the Control Panel.
il 3. Double-click the Add/Remove Programs icon.
S 4. The Add/Remove Programs Properties dialog box will displayed.

laga
444

Select the CX-Protocol entry from the list and click the Add/Remove...
button.

5. Left-click the OK button on the confirmation screen. The CX-Protocol will
be removed from the personal computer.

Note If SYSMAC Windows CX-series Support Software (for example, CX-Program-
mer) other than the CX-Protocol has been installed, do not remove the CX-
Server and CX-Server PLC Tools. Otherwise, it will not be possible to use
another Support Software.
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2-5 Start-up
Use the following procedure to start the CX-Protocol.
m 1,2,3... 1. Left-click the Start button on the taskbar and select Programs.
Grren 2. Select the Omron folder.
C%-Protocol 3. Select the CX-Protocol folder.
4. Left-click the CX-Protocol program to start the CX-Protocol. When the
% OX—Protocol CX-Protocol is started, the standard system protocol will be displayed.

Eile View Help

eal =22 A I el M L2 B =
=l [

=& System Protocals

& Projects @ System [@Heln |

For Help, press F1

2-6  Shut-down

Use one of the following methods to shut-down the CX-Protocol.

. Select the Control Menu on the title bar and left-click the Close button.
Select the File menu and left-click the Exit in the menu.
Left-click the Close button on the title bar.
EI Press the Alt+F4 Keys.

A confirmation dialog box will be displayed if any data currently opened in the
CX-Protocol has not been saved.

Left-click the Yes button to save the changes. Left-click the No button to dis-
card the changes. The CX-Protocol will close. Left-click the Cancel button to
abort the operation and return to the CX-Protocol.
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2-7 Outline of User Interface

The following is the basic screen configuration of the CX-Protocol. The stan-
dard system protocol screen that is displayed upon startup is always dis-
played in the Project Window.

Standard system protocol project window

Title bar
Menu bar — Eile': Edit ¥iew! Prasoanl [PIG Tonls  Windew  Heln
i
Tool bar — EiEiidll TR o RiNE] e e ouleels] o Bl
LE Svstem Protocols ’ nglﬁ |
g 2] Pew ER ]
=% hew Protocel List =%
Project name. | % @ Comratr €3 resd o
+ Temp Controller (ESZE read) @ 2. :
¥ Hayes rodem 5T sommands .2 G52 Passmord warify - Set Scan -
% Trace List @ ;:E:: nhi Lata sendfrecene - Set Soan L sec
+ g hawPLCT [Offline] [CS1H - GPUST] @ |5 554 Escaps mode - -— Scan 10 sec
) @ ::§-- 65 On~hook command - - Scan 10 zec
Project workspace — @ |3 560 Modeminitisize (MDZ4FBIOY) - Set Scan 10 sec
@ .3 561 Did MDZ4FEIOV) - Set Scan 0 sec
@ § B2 Initidize = dd (MD24FE10W) -— Set Soan 0 zec |
@ .37 570 Modeminitidize (MD144FESW)  ——— Set Scan 10 sec
@ .3 571 Did (MD144FES V) - Set Scan o sec
5 | | g @ ;:§-- E72 Initidize — dd (MO 44FES W) -— Set Soan 0 sec
- : : @ -3~ 580 Modeminitidize (ME1 414E2) -—= Sat Soan 10 zec
P Prajects |Bisvstem S tiap 4] [ 3 521 Dia GvE1419ED) - Set Scan 0 sec
|3 5ag Initidize — dd (WME1414E2) - Set Scan o sec
:
Output window Project window

-
| | | I\Compilerf | 4 v
Status bar— Fer Help. pre=s .

\
Project tab System tab
Project Window:  The contents of the data highlighted in the project workspace is displayed.

By double-clicking the icon on the left edge of the screen, the contents of the data are
displayed as a hierarchy from the highest level to the lowest level scrolled.

Project Workspace: The hierarchy is displayed with the Pr ojectas the highest level. The contents of the
highlighted data will be displayed in the project window.

Output Window:  Errors or warnings that occur while compiling data that have been sent to the PMSUs
connected online are displayed.

System Tab: Left-click the tab to make active the project window of the standard system protocol.
Project Tab: Left-click the tab to make active the project window of the project created by users.

The screen consists of three panes.

» The data hierarchy is displayed in the left pane in a tree format. The left
pane is called the Project Workspace.

* The contents of designated data (i.e., highlighted data) in the project
workspace will be displayed in a table format in the right screen portion.
The right pane is called the Project Window.

The menu and tool bars are used for basic Windows functions such as file and
edit functions as well as protocol and trace operating functions.

When the CX-Protocol is started, the standard system protocol will be dis-
played on the screen. When a new protocol is created or when an existing
project file is opened, the project window will be displayed on top of the
screen. This becomes the active window.

I# System I To switch between the standard system protocol project workspace and the
_——— user’s project workspace, either left-click the system tab or project tab or

& Cx—Protocol directly click the project window.
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The following are the basic operations required to create, edit, and download
protocols.

* Double-click the icon on the project workspace or project window to shift
from the highest level to the lowest level. Press the Esc Key to shift from
the lowest to the highest level.

 To create a new object such as a protocol, sequence, step, or message,
right-click to display the popup menu and select Create. A new object will
be displayed in the project window.

* To input data into the list in the project window, left-click the cell (input
field) or click the Down-arrow icon to display the settings dialog box and
input set values into the dialog box.

* The popup menu is used for setting the communications port of the
PMSU, uploading protocols, tracing data, or downloading trace data.
Right-click or press the Shift+F10 Keys to display the popup menu.

Note The popup menu that is displayed when the right mouse button is clicked is a
useful feature of the CX-Protocol. Different popup menus will be displayed
depending on where the right button is clicked. These popup menus are effi-
cient because they include almost all the main functions such as: creating
new protocols, sequences, messages, matrices, and matrix cases, setting the
communications port of the PMSU, uploading protocols, and tracing data.

Click the right button and select a desired menu.

Ot |+
Doy Chr|+C
Easte,  ErlHh

Right click
@ Delete D=l
ove 4
e Seguence..
Frinter * batris..

Send Message..
Beceive Messagse.
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2-7-1 Window

Project Workspace

@ Project

Data will be displayed in the following hierarchy.

T - - ) @ Project
--' =3 Protocol List _
: : Tea Protocol List
: .'_': - - i@ Protocol Name Displays
' . © __ @3 Sequence more
. . i g:' Na?ne @ than one.
X ' ' Protocol
. X . Sequences under the
' ' ' above protocol name N o
: : - -- %1 Sequence 3 ggnbrgggécatlons
' ! ' > Name q
: : P :E Send Message Lists under the Send Message
. X . List above protocol List
! ! ! . name
X ' .- Receive Message Receive Message
. : . List List
' ' ' o ] Sl Displays
: : v Matrix List o) Matrix List > orl1l)? y
: : X LT - @ Trace List one.
) , - - - - a@a Matrix
' -1 - ]
) - -, /= Devices (PLC)
: “t - - i@ Protocol Name
: - :_ . Board
: "+ .- - @ Protocol Name
X - | Unit (16 from 0 to F)
Coo @ Trace List
' ;Z' The data indicated to the right
a - -' displays those in lower levels.
T EIII PLC “+' The data indicated to the right
) - -' does not display those in low
P8 Pvsu er levels.
sooo " unito
So-- % unitF
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Project Window The following items will be displayed depending on selected data items (i.e.,
the highlighted data) in the project workspace.
Selected data in Item in the project window
the project
workspace
Project * | Name Protocol Number | Trace Number |PLC Name |Series |Model |------
@ List Name | of Proto- | List of
cols Traces
«aw | Protocol * | Protocol Sequence | Se- Type Target -—- -—- - - -
5% | List Name Start quence
Number End
Number
@ Protocol x| # Communi- | Link Trans- Respon | Timer Timer Timer --- ---
Name (Se- cations Word mission |se Type |Tr Tfr Tfs
quence Sequence Control
Number)
»- | Sequence |=*|Step Repeat Com- Retry Send Send Receive | Re- Next |Error
# |Name Counter mand Count | Wait Mes- Mes- sponse
Time sage sage
< Send * | Message |Header Termi- |Check |Length |Address |Data --- --- ---
<o+ | Message Name <h> nator Code <|> <a>
List <t> <c>
<aH Receive * | Message |Header Termi- |Check |Length |Address |Data
<1 | Message Name <h> nator Code <I> <a>
List <t> <c>
== | Matrix List | * | Matrix Number of | --- --- - - - - - -
e Name Cases
ama | Matrix * | Case Receive | Next --- - - - - - -
33 Number |Message |Process
Trace List |=|Descrip- |Uploaded |Size - --- --- --- --- --- ---
% tion
PLC * | Inner Type Serial Type --- --- --- --- --- ---
ETD
Board Commu-
nica-
tions
Unit
i Board * | PMSU Status Commu- | Type
Trace nica-
tions
Port
Unit * | PMSU Status Commu- | Type
1 Trace nica-
tions
Port

The highlighting cursor is available in both the project workspace and the
project window.

The focused portion (i.e., the portion actually selected in operation) is sur-
rounded by a dotted line. If a line in the project window is selected, the
focused portion will be in the project window.
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To switch over the focus between these two windows, press the Tab Key or
select Swap Focus from the View menu or left-click either of the screens.

Focused

File Edit Yiew Protocol PLC Tools Window Help

Bes|w] &ley a2l SI=]=]2 ] 2all] sl ===

-
EIE Swstermn Profocols

EEE Systeny Protocols

w-@ Cofitroller (E5_K read @ .00 '

@) ontroller (EE_K writel 2 | # | Communication Sequence |Link Word| Gontrol Rl

---@ Termp Controller {ESZE read (5 [100]Set temperature read T Set :

@ Temp Controller (ESZE write) .;o:' 1071 Messured ternperature read —== Set

@ Temp Contraller (€5 ) o3 102 Output wvariable resd -== Set

H-@ Controller (ES100) 3 103 5et/ress ternp, output var read;,  --- Set

@ Intell Signal Processor (K3T ) 3 104 Propo bandIntesDeri tire read -—- Set

5@ Bar Code Reader (/600/\/E20) i£ 105 Gontrol period read - Set

®-@ Lazer Micro Meter (3741 (3° 106 Output mode read T Set

#-@ Visual Inspe Sys(F200/ 300/ 350) cZ 107 Alarm mode read o Set
Selecting Elements in Use the mouse, Up, Down, Left, or Right Key, or Function Key to select the
Projects elements in projects.

The following operations are available without the mouse.
» Use the Up or Down Key while the focus is in either of the screens.
To scroll up or down on the tree in the project workspace.
To scroll up or down the rows of the tables in the project window.
* Press the Esc Key or the Backspace Key to shift to the next higher level.

* Press the Page Up or Page Down Key to scroll up or down by a whole
screen in the project window.

* Press the Ctrl+F6 Keys or select Next from the Control menu to move to
the next active window of the CX-Protocol.

* The size ratio of the project workspace to the project window will automat-
ically be adjusted when displayed.

* The width of each item in the project window will automatically be
adjusted when displayed.

* Click the '+ 'or ' = portion to select the hierarchy in the project workspace.
After the '+ portlon is clicked, the '—! portion will be displayed at the final
h|erarchy Ievel in which case onIy the display of the project workspace
will change while the display of the project window will not change.

=-[# P
@ PSW E| EEE MNew Protocol List
gt New Protocal List - E-@ MNew Protocol
Trace List 4 Trace List
0 MewPLZT [Dffline] [C51G - CPL42] -0 MewPLC1 [Offline] [551G - GPU42]
Click this. Displays the lower level data.
Scrolling the Hierarchy Double-click or press the Right Key while the focus is in the project work-

space to scroll down the hierarchy. The selected and highlighted data in the
project workspace will shift down.
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Press the Esc Key or select Parent in the View menu to move up in the hier-
archy.

Popup Menu Click the right mouse button to display the popup menu.

*| # [Gommunication Sequence|Link Wo

C20 000 Mew Sequence -—=

34 -— Anew step is created after clicking the right mouse
Cut Ctr |+ button or pressing the Shift+F10 Keys to select the
corresponding item in the popup menu. In this
+
goDy gr: S example, Create/Step is selected.
Faste it
Delete Del List

Data Input Left-click each item in the table within the project window, or left-click and then
E either left-click the Enter button or press the Enter Key to input data of each
item displayed in the dialog box.

* | 5tep| Repeat Gommand Retry|Send Wait| 5end Messaege | Re:

(@, 00 RSET/001 Send * -—- = : Either click the Enter
button or press the
Transmission Wait Time Enter Key.

velue  Time Unit

Bl ¥ |10 milisecond =]
Cancel |

2-7-2 Control Menu
o CPowco-Pswi IR B

Control Menu . el 2 L I_

e NEYRET| Close

g EJE' ﬁl Maximize
M = Minimize
Mimimize —
BTz

Close  Alt+F4 : Closes the CX-Protocol.

B PSwi1

Hestane

Project tove
Window ;

Control El_ZE_! :
Menu Minimize

I auimnize

Cloze  Ctl+F4 : Closes the Project.

M et Chil+F&
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2-7-3 Menu and Short-cut Keys
Main Submenu Description Short-cut | Icon on tool bar
menu key
File New Creates a new project. Ctrl+N Yes
Open... Opens the existing project selected. Ctrl+O Yes
Close Closes the project worked on. ---
Save Overwrites and saves the project file worked on. Ctrl+S Yes
Save As... Saves the project file worked on as a new file.
Print... Prints the protocols or trace selected. Ctrl+P Yes
Print Preview Displays the image of print output. ---
Print Setup... Sets the printer model, paper size, and printing
direction.
Recent File (1,2,3,4) Displays a maximum of four files recently used. ---
Exit Exits CX-Protocol.
Edit Cut Cuts and transfers the range designated to the Ctrl+X Yes
clipboard.
Copy Copies and transfers the range designated to the | Ctrl+C Yes
clipboard.
Paste Pastes the contents of the clipboard to the position | Ctrl+V Yes
designated.
Delete Deletes the range designated. Del Yes
Move Scrolls the steps or matrix case upwards or down- | --- Yes
wards to the top or bottom.
View Toolbar Shows or hides the project tool bar.
Status Bar Shows or hides the status bar.
Project Workspace Moves the cursor to the project workspace. ---
Output Moves the cursor to the output window.
Parent Scrolls the displayed hierarchy portion in the Esc
project window to the one upper.
Swap Focus Switches over the focus among the project work- | Tab
space, project window, and output window.
Proto- |Create Selected when newly creating a protocol list, proto- | ---
col col, sequence, step, message matrix, matrix case.
Upload Protocol List | Displays the protocol list of Boards or Units.
Upload Protocols Transfers the protocol of the Board or Unit to the | --- Yes
project.
Download Protocols... | Transfers the protocol created in the project to the |--- Yes
Board or Unit.
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Main Submenu Description Short-cut | Icon on tool bar
menu key
PLC Connect to PLC Connects the PLC to online. ---
Operating Mode Switches among the PLC operation modes.
Edit PC-PLC Comms | Sets the PLC model and communications
Settings... specifications between the PLC and computer.
Edit Communications | Sets the communications specifications of the
Port Settings... communications port of the Board or Unit.
Upload Communica- |Uploads the communications port settings of the | --- Yes
tions Port Settings Board or Unit.
Download Communi- | Downloads the communications port settings of Yes
cations Port Settings |the Board or Unit to the PLC.
Start Trace Selected when executing the continuous tracing or | --- Yes
one-shot tracing.
Stop Trace Selected when stopping the continuous tracing or | --- Yes
one-shot tracing.
Upload Trace Uploads the results of continuous tracing or one- | --- Yes
shot tracing to the project.
IO Table Sets or edits the I/O table. --- ---
Memory Monitors or edits the contents of I/O memory area |---
of the PLC.
Error Log Displays the error contents and history of the PLC | ---
(CPU Unit).
Tools CX-Net Used for specifying the settings required for net- --- ---
work communications such as the routing table or
data link.
Customize... Customizes the tool bars or commands. ---
Window | New Window Creates an identical new window.
Cascade Shows windows in cascade status.
Tile Shows windows laid vertically. - -
Arrange Icons Aligns icons to with one another. ---
Currently Open Makes the selected window active. --- ---
Windows (1,2,3, ...)
Help Help Topics Shows the search topic in CX-Protocol’s Help. --- ---
About CX-Protocol... |Shows the version of CX-Protocol. Yes

2-7-4 Popup Menus

, avenue de la malle - 51370 Saint Brice Courcelles - Tel : 03.26.04.20.21 - Fax :

When one of the following objects is selected, right-click or press the
Shift+F10 Keys, and a popup menu will be displayed according to the hierar-

chy.
Popup Edit Menus

Selected object

Popup menu or submenu

Project

Create (Protocol List)

Close

Save

Save as

Properties

Protocol List Cut

Copy

Paste

Delete

Create (Protocol)

Print
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Selected object Popup menu or submenu
Protocol Cut
Copy
Paste
Delete

Create (Sequence, Matrix, Send message,
Receive message)

Print (Print, Print preview, Printer settings)
Communication Sequence Cut

Copy

Paste

Delete

Create (Step)

Step Cut

Copy

Paste

Delete

Move (Top, Bottom, One up, One down)
Send Message List Copy

Paste

Create (Send Message)

Receive Message List Copy

Paste

Create (Receive Message)
Matrix List Cut

Paste

Create (Matrix)
Matrix Cut

Copy

Paste

Delete

Create (Matrix case)
Case Cut

Copy

Paste

Delete

Move (Top, One up, One down)
Trace Delete
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Popup Operation Menus (in Online Operation)

Selected object Popup Edit menu
PMSU icon Upload Communications Port Settings
Download Communications Port Settings
Upload Protocol List
Upload Protocols
Trace 1(A)/2(B) Start Trace (Continuous Trace, One-shot Trace)
Stop Trace
Upload Trace
Communications Port 1(A)/2(B) Edit Communications Port Settings
Upload Communications Port Settings
Download Communications Port Settings

2-7-5 Tool Bar Icons

e Standard Tool Bar e Trace Tool Bar

These icons are for the operation of These icons are for the operation of trace-related functions.
project-related functions.

2zl ozlel szl SEl=1s]

e Protocol Tool Bar e PLC Status Bar
These icons are for the operation The PLC modes, such as offline, program, and monitor modes,
of protocol-related functions. and corresponding PLC models are displayed.
_ e e = ExibPLE1 psve | MewPLCA |Z51G - CPLME Program
%l Bl EEEE] |
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List of Tool Bar Icons

Tool bar Icon Corresponding Tool bar Icon Corresponding
menu menu
Standard tool New Protocol tool bar Download Proto-
[#1 %
bar cols
s Open Download Com-
=~ |$ﬁ munications Port
Settings
Save Upload Commu-
ad . .
hﬁl mi nications Port
Settings
,}i', Cut .9 Upload Protocols
: Copy = Delete
=3
Paste g U
= P
Print cac Down
=
? About = Top
Help = Bottom
& 2]
Trace tool bar B Start one-shot PLC status bar _ Off-line/PLC
= trace Mode
B Start Continuous PLC Model
=+ trace
Stop trace
B
& Upload trace

2-7-6 Status Bar

The status bar displays the explanation of the menu or icon of the position
where the cursor is located.

Download communications port settings

Note Select the Tool Bar icon by referring to the corresponding explanation of the
icon displayed on the status bar.
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SECTION 3
Protocol Macro

This section describes details of the protocol macro functions.

3-1 Protocol MacroOutline. .. ... 60
3-1-1  Sequence/StEp StrUCtUre. . .. oottt e e 60
3-1-2  Communications Sequences and the PMCR Instruction . ........ 63
3-1-3 Condtruction of Send/Receive ..., 68
3-1-4 Transition StageBetween Steps. . ... ... 79
3-1-5 Setting TransmissionMode . ...t 79
3-2  Sequence Attributes (Commonto All Steps) . ...t 82
32-1  SEiNG. . oot 82
3-2-2 CX-Protocol SetupScreen ... 83
3-2-3  Transmission Control Parameter .............. ... ..., 83
3-2-4  Link Word Addressing .. .....oooviii i 85
3-2-5 RESPONSE TYPE . v o vttt e 86
32-6 Monitoring Time. . ...ttt e 90
33 StEP AHIDULES. . . oo 91
3-3-1 CX-Protocol Setup Screen .. ..o v 91
332 SEING. . 92
3-3-3 Repeat CoUNEr . . ..ot e e e e 94
334 COMMEANAS . ..ottt e 96
335 Retry Count. ... ..ot 98
336 SendWat Time. .. ..o vit e 99
3-3-7 SendMessage/ReceiveMessage . ........co i 99
3-3-8  With/Without Response Writing. . . ..., 100
3-3-9  Next Process/Error Process. . . . ..o v v i 100
3-4 Communication Message Attributes. . ........... ... ... ... o 102
3-4-1 CX-Protocol Setup SCreen ..o 103
342 Header..... ..o e 103
3-4-3  AdAresS. . ..o 103
34-4  Length. ... 103
345 DA .t 104
34-6 ErrorCheck Code. . ... .cooiii 105
3-4-T  TEMINAON. . ..ottt e 105
3-4-8 Messageltem DataAttributes .............. ... i 105
3-4-9 Supplemental NotesonMessageSetup ... ..o it 117
35 Creating MatriCes . . ... oo 119
3-6 Examplesof Standard System Protocols .............. ... ... . ... ... 123
3-6-1 Example: “Process Value Read” Sequence of the “Controller (E5_K Read%"
Protocol. . . ..o 12
3-6-2 Example: “Modem Initialize (MD24FB10V)” Sequence of “Hayes Modem
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Protocol Macro Outline Section 3-1

3-1 Protocol Macro Outline

The Protocol Support Tool allows users to freely create and edit protocols,
which are procedures for sending data to and receiving data from general-
purpose devices connected to the PMSU (see note) through RS-232C or RS-
422A/485. The protocol macro is a function to implement the sending and the
receiving messages by the execution of a starting instruction for the protocol
macro (PMCR instruction) of the CPU Unit's user program.

CPU unit PMSU Note: The send/receive message can be
stored on and after the send or
receive data address + 1.
H_PMCR I—> Sequence No. 001
#1001 1
Sequence number Step 0
S:cr;d data specification .
address
Receive datal Step 1
address '
General-purpose
‘/\/ external device
1//O memory Shared memory
Peripheral
servicing

Note In this section, the Communications Board for the C200HX/HG/HE, the Serial
Communications Board for the CS, and the Serial Communications Units for
the CS/CJ are all referred to as the “PMSU” (Protocol Macro Support Unit).

3-1-1 Sequence/Step Structure

One sequence consists of up to 16 steps. One step includes one command
(Send, Receive, Send&Receive, Open, Close, Flush, or Wait (for CS/CJ only))
and one or two messages (Send, Receive, or Send&Receive). Step transition
is designated by the “next process/error process” within the step.

Step mechanism outline for Send, Step mechanism outline for
Receive, or Send&Receive Wait, Flush, or Open & Close
Sequence /
Message ¢
Step 01 v Next process
3 g Tob
é % : Normal end? N reotrieed?
% : Y N
&9 :
25 g
SE
$ 9 : Next process Error process
Step 15
1,2,3... 1. Sequence-specific data (common to all steps)
Setup Item Description
Transmission X-on/X-off flow control, RTS/CTS flow control, modem control,
control parameter delimiter control, or contention control
Link word Shared memory area between the PLC and the PMSU.
Monitoring time Time for monitoring send and receive process.
Response type Timing for writing received data.
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2. Step-specific data

Setup Item Description Command type
Send | Receive | Send& Wait Flush Open Close
Receive (see (see (see (see
note) note) note) note)
Command Send, Receive, --- --- --- --- --- --- ---

Send&Receive, Wait",
Flush*, Open® or Close*

Repeat counter | The number of times to (0] (0] (0] - - --- ---
iterate the step (1 to 255)

Send message | The contents set here are @) --- (0] --- --- --- ---
sent as a message.

Receive The message that was 0] (0]

message actually received is com-
pared with the data set here.

Matrix Selects the next process (0] (0]

according to message
expected to be received (up
to 15 types).

Retry count The number of times for (0]
retrying the command when
some retry factor such as an
error arises.

Send wait time | Wait time for starting data o] 0
sending for a Send
command.

With/Without Designates whether to write | --- ) o

Response Writ- | received data.
ing (operand
addressing)
Next process Designates the next stepto | O @) (0] (0] (0] (0] (0]
which control will go to when
the system ends normally.

Error process Designates the next stepto | O (0] (0]
which control will go to when
the system ends abnormally.

Note For CS/CJ protocol macro only.

3. Message structure and content
Messages to be sent and received are generally structured as follows:
1) Messages containing header and terminator

IHeaderlAddressl Data |Error Check| Terminatorl

l— End of the message
Error check code
Content of the message

(Sending: Data to be sent,or Receiving
: Data expected to be received,according to the command)

L Destination of the message

L— Beginning of the message
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The check code and the terminator can be replaced with each other.

Note With the C200HX/HG/HE, possible only when the C200HW-
COMLUIL-EV1 Communications Board is used.

| Header | Address | Data | Terminator | Check code |

2) Messages containing header and data length

IHeaderIAddressl Lengthl Data |Error checkl

Error check code

Content of the message
(Sending: Data to be sent, Receiving: Data expected to be received)

Length of the message (To be calculated automatically)

- Destination of the message

— Beginning of the message

Setup Item Meaning Data attributes
Constant Variable
Header Beginning of mes- |O
sage
Address Message destina- |O (0]
tion
Length Message length (0]
Data Message body @) (0]
Check code Error check code -—- (0]
Terminator End of message (0] ---

* Input the constant in the header and terminator.

« Either the constant or variable can be input in the address and data. By
including variables in the address and data, the address or data can be
retrieved from the designated area of the I/O memory and the transmitted or
received data can be written in the designated area of the I/O memory.
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3-1-2 Communications Sequences and the PMCR Instruction

The PMCR instruction will designate a communication port number and
sequence number. In addition, the user can designate the source I/O memory
address and the destination /0O memory address of the message.

CSs/CJ
PMCR Instruction

— PMCR
C1 C1: Control data
C2 C2: Control data
S S: Send data first word number
D D: Receive data storage first word number

Control Data

C1

/N / \

l——Destination Unit Address
CPU Bus Unit: Unit No.+10 hexadecimal
Inner Board: E1 hexadecimal

Serial Port No. (physical port)
1 to 2 hexadecimal

Communications Port No. (internal logic port)
0 to 7 hexadecimal

Cc2

Send/Receive Sequence No.
0000 to 03E7 hexadecimal (0 to 999)

CPU Unit Serial Communications Board/Unit
Port

nw

S
end/Receive l
equence No.

=

D General-
purpose
external

device
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Ladder Program

Ladder Program

C1: System executes the sequence to the Serial Commu-

c ications P nications Board port No. 1 using the communications port
s S AT Enabied Error Flag. No. 7 (logic port).
———— {—{_PVvCR
#71E1 /l C2: Execute sequence No. 101.
Board port 1:190915 #0065
Board port 2:191915 . )
) P ) D0000 S: Designate the first word number of the I/O memory area
Unit port 1: word n+9, bit 15 D0100 |=— | that stores the data to be sent.

Unit port 2: word n+19, bit 15

ER
(n=1500+25 Unit No.) i FAL(06)001 5:D0000 | 0004Hex Set the number of words of the

) - D0001 send data on the first word.
Instruction Execution

Error Flag D0002 This example shows that the
D0003 _sysltedr_n seéwds 4 words of data
including S.

D: Designate (1) the initial data for the receive

buffer before execution of the send/receive 4 words
sequence, or (2) the first word of the I/O memory Stores the actual send data
area to store the received data. on and after the second word
(S+1).
D:D0100| 0004Hex} =— 'Srtréergg?;]évgrd automatically Note: With the protocol macro for the CS/CJ, the execution of a

D0101 umber of words . . .

of data received. send/receive sequence to a Board or Unit following a PMCR
D0102 instruction, is performed by sending a FINS command. There-
D0103 4 words fore, it will be necessary to make the following settings for

. ) sending FINS commands with the operands for the PMCR
The actual received datais | | instruction.

stored on and after the

second word (D+1). Communications port (logic port) No. 0 to 7

Note: Functions for the receive data storage area Unit address

(the data inside the words starting from D) differ Serial Communications Board: E1 hexadecimal
before and after execution of the PMCR instruc- CPU Bus Unit: Unit No. + 10 hexadecimal

tion. It will also be necessary, as a PMCR instruction execution
(1) Before execution: The receive data storage condition, to set the Communications Port Enable Possible
area functions as initial value data for the receive Bit in order to check the availability of the communications
buffer before execution of the send/receive port number to be used.

sequence.

(2) After execution: Data received as a result of
Receive operations is stored in the receive data
storage area (if With Response Writing is enabled).
For details refer to

Function of PMCR The send/receive sequence designated in C2 will be executed from the serial

Instruction port (physical port) designated in bits 8 to 11 of C1 at the unit address (Rack)
designated in bits 0 to 7 of C1, using one of the communications ports (logic
ports) O to 7, as designated in bits 12 to 15 of C1.

If the variable in the send message is operand-designated, the number of
words in S from word S+1 will be used as data for the send area.

If the variable in the receive message is operand-designated, it will be
received in words D+1 onwards, and the number of words of received data will
automatically be stored in D.

If receive process is not successfully carried out, the data from words D+1
onwards (the words contained in D) that was set before the execution of the
PMCR instruction will be read from the receive buffer and will again be stored
in words D+1. (Due to this function, even if reception is not successful, the
present value data will not be cleared to 0 and the most recent receive data
will be saved.)
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SEND, RECV, and CMND also use the logic ports 0 to 7 to execute communi-
cations sequences through a PMSU (internally using FINS commands).
PMCR cannot be executed for a logic port that is already being used by
SEND, RECV, CMND or PMCR. To prevent more than one communications
sequence from being executed for the same logic port, the corresponding
Communications Port Enable Flag (A20200 to A20207) should be used as a
N.O. input in the execution condition for PMCR.

CPU Unit

PMCR(260)
PMCR(260)

Juududity

The Error Flag will turn ON in the following cases.

* The corresponding Communications Port Enable Flag is OFF for the speci-
fied logic port (0 to 7) when PMCR(260) is executed.

» C1 is not within the specified ranges.
If the data for C2 is outside the range, the Error Flag will not turn ON. A com-

pletion code will be stored in the Communications Port Response Code
(words A203 to 210) in the auxiliary area.

Note The same communications port numbers (internal logic ports) are used for
PMCR instructions and network communications instructions (SEND/RECV/
CMND). Therefore, port numbers for which these instructions coincide cannot
be set.
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Note 1. With the CS/CJ, the Protocol Macro Execution Flag is not set to ON with
the PMCR instruction, but is set to ON when the PMSU starts the se-
guence. It is set to OFF when the sequence ends and received data is
safely stored in the designated I/O memory area. The Communications
Port Enabled Flag is set to OFF with the PMCR instruction and is set to ON
after the PMSU has started the sequence. Therefore, when executing the
next PMCR instruction, the ladder program first checks that the Protocol
Macro Execution Flag is set to OFF and the Communications Port Enabled
Flag is set to ON.

Sequence executed Sequence completed
v

;
:
. t
Write |
-
¥
»

I

Sequence executed

Receive data stored
in /O memory

Protocol Macro
Execution Flag

Communications
Port Enabled Flag

v
¢
'
s
i
'
'
'
'
'
'
'
'

Other protocol macro in - Other protocol macro in
structions not possible  structions possible

2. The FAL instruction is used to check whether PMCR instruction parame-
ters, etc., are correctly set.
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C200HX/HG/HE

PMCR Instruction

Control Data

— PMCR
¢ 15 ~ 1211 00
: | | |
; —
C: Control data gggﬁgﬁ;gg)
S: Send data beginning word number PortN
D: Receive data store beginning word number 1:°P°n°A
2: PortB
Ladder Program
Process  Protocol Macro
Start Execution Flag C: Means that the system executes sequence No. 101
PMCR / using port A on the Communications Board.
Port A: 28908 #1101
Port B: 28912 S . -
° Dogos S: Specify here the beginning word number of the area
D0100  f+— that stored the data to be sent.
2 D0000 | #0004 Set the number of words of the
D001 seng data on the beginning
Instruction Execution D0002 WO'I’ )
Error Flag This example means that the
D0003 system sends 4 words of the

data including the beginning

D: Specify here

area storing the data that was received.

D0100

D0101

D0102

<
)

D0103 A=

word number.
the top word number of the

Store the actual send data on
and after the second word.

~— The top word automatically
stores the number of
words of the data that was
received.

The actual received data
is stored on and after the
second word number.

Note 1. The Protocol Macro Execution Flag is set to “ON” at the start of the PMCR
instruction and set to “OFF” when the sequence ends and the received
data is safely stored in the designated data area. Therefore, to execute the
next PMCR instruction, the ladder program first checks that the flag is set

to “OFF”
Sequence Sequence
started ended
v v

Sequence executed '—‘J L——

Receive data stored
in /0O memory

Protocol Macro -—I |—

Execution Flag

s
2

2. The FAL instruction is used to check whether PMCR instruction parame-
ters, etc., are correctly set.

67

AUDIN - 8, avenue de la malle - 51370 Saint Brice Courcelles - Tel : 03.26.04.20.21 - Fax : 03.26.04.28.20 - Web : http: www.audin.fr - Email : info@audin.fr



Protocol Macro Outline Section 3-1

3-1-3 Construction of Send/Receive

Outline of Construction The construction of send and receive messages with the protocol macro func-
tion is shown below.

CPU Unit PMSU
Sequence No. A
—_PMCR Pt | seng Send buffer
’_( pro- e message |pf ™ ———F To transmission line
cess
A Sends when the send process is executed.

Receive Comparison with | Receive buffer
process 1Y ‘jpﬁg;f‘;rrgfef:ge From transmission line
switching . .
Half-duplex: Receives when not performing send process.

Full-duplex: Receives throughout execution of the sequence.

Process for
writing to I/O
memory
CPU Unit PMSU
Internal process Buffer
Following Send Following send process (Send command, The send message moves to the
PMCR Send&Receive command), data from /O transmission line via the send buffer.
instruction, memory is converted under the designated
designates conversion formula and the send message is
execution assembled and is transferred to the send
sequence buffer.
number for the  I'Receive |Following receive process (Receive Half-duplex: Data that is received from the
PMSU. command, Send&Receive command): transmission line when send process is not
1. The data in the receive buffer is input, being performed will be saved in the receive
comparison with the expected message is buffer.
executed, and switching of the next process | Full-duplex: All data received from the
takes place. transmission line during sequence execution
2. If there is a Response Write, the data will | will be saved in the receive buffer.
be written to 1/O memory after being
converted with the designated conversion for-
mula.
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Send Process If the Send command (or the Send&Receive command) is executed with a
(Send Command, certain step, the send message set by that step will be assembled and sent
gg?ﬁm&aﬁg)‘:e've from the send buffer as shown below. If a variable (reading variable) has been

integrated into the send message, the appropriate data will be read from I/O

memory and converted to the designated form according to the variable, and
the send message will be assembled.

Note When a send completion monitoring time has been set for send process and
the time is exceeded without sending a message, the step will end abnormally
and the system will move to the error process. Otherwise, the step will end
normally and move to the next process.

PMSU
Step Maximum send buffer Send message
Send proces 1,000 bytes max. (CS1) > I Head I Add | Length I Dat. |Error check] Terminat I
execution 256 bytes max. (C200HX/HG/HE) gl el e L e ae code erminatorf ————-
A Sent after the Send Waiting Time for a step
Data | g~ 1. Read process:
From the (Address) Data/(Address)/(Repeat counter) designated by
CPU Unit (Repeat ; .
counter) variable is read from memory address

ﬂ

r~ 2.Variable process:
Conversion to the format designated by the vari-
able
* No conversion
* Hexadecimal—>ASCII conversion
(ASCll—Hexadecimal conversion)

!l

3. Assembly process:
Send message is assembled

Error
Length l Data check le- minator
code l l

I Header lAddress
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Receive Process If, with a certain step, the Receive command (or the Send&Receive Com-
(Receive Command, mand) is executed, the data will be taken out of the receive buffer and a com-
gg?ﬁm&aﬁg)‘:e"’e parison with the expected message will be made. If the data does not

correspond, the step will end abnormally and the system will move to the error

process. If the data does correspond and a variable (write variable) has been
integrated into the expected message, it will be converted to the format desig-
nated by the variable, and write process to I/O memory in the CPU Unit will be
performed. All processing for the step will be completed and the system will
move to the next process.

PMSU

Maximum
Step receive buffer Receive message
Receive
process 1,000 bytes ’ Header | Address l Length I Data Eérdoer check Termmatorl<—
execution max.

Half-duplex: Receives when not executing send process.
Y Full-duplex: Receives all data during sequence execution.

1. Comparison process
Actually received message

Error

Header | Address Length Data check frerminator
code

Comparison (Goes to error
process if unmatched.)

Set expected message

Error
Header | Address Length Data check  [Terminator
code

Note: Possible to have several (15 max.) expected mes-
sages (matrix).

~ 2. Variable process:

Conversion to the format designated by the variable

* No conversion

¢ ASCll—Hexadecimal conversion
(Hexadecimal—ASCII conversion)

— 3. Write process:
Data written to /O memory designated variable.

Note: The Write Timing will depend on the setting for

. the response type (scan mode, interrupt mode) in
To CPU Unit - I Data ; sequence attributes only if With/Without Response Writ-
ing is set to Yes in the step attributes when the oper-

ands are set.

[~ 4. Notification to the CPU Unit:
Completion of the sequence and Write notified by the Pro-
tocol Macro Execution Flag.

Note: When the operands are set and the response type
is set to interrupt mode in sequence attributes, designation|
will be possible with the interrupt process.
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Send & Receive Process The receive (Receive) process will start approximately 60 us after the send
(Send & Receive process is completed.
Command)

In general, when communications commands are sent as send messages and
responses are received as receive messages, Send&Receive will be exe-
cuted.

Note With the CS/CJ, there is a time-lag after send operations for the half-duplex
(refer to page 79).

PMSU

Step

Send&Receive
process com-
mand

Y Send buffer Send message

[Send process‘—»l '——P'

Approx. 60 us later
A Receive buffer Receive message

| Receive process |<—| I<——i l<_

Note: Retry can be designated with Send&Receive.

Clear Process (Flush By executing the Flush command, all the data in the receive buffer is cleared.
Command) for Receive For example, this is used in the full-duplex mode before executing the receive
Buffer (CS/CJ only) process, to clear data left in the receive buffer because of noise.
PMSU
Receive buffer
Clear

Flush command -
execution

This command can also be used, for example, in full-duplex mode when a
communications error occurs. Without aborting, switch the step in Goto, exe-
cute the Flush command in the step, clear the receive buffer, and retry.

Retry

— Step

Send&Receive

Error

Normal completio

Goto

Step
Ir Flush
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Integration of Variables One of the characteristics of sending and receiving data with the protocol
macro function is the way that instructions (variables) for reading from and
writing to 1/O memory in the CPU Unit can be integrated in the send and
receive messages themselves.

Sending
Example: CS/CJ
CPU Unit PMSU
éequer!ce Sequence No. 001 Send message
el PMCR g > Step 0 J—_gendl Heade' Addres{ Data ggggkl Terminatorl—b
0 ©
g |z
N =
© o
/0 memory g w
0
l ASCIl
'l ASCII
Variables inside the send message
determine which area of the I/O
memory is used.
Receiving
Example: CS/CJ
CPU Unit PMSU
slequenlce Sequence No. 001 Receive message
}— PMCR e > Step 0 J_ Receive Header] Addressl Data I ggfgk Terminator l‘—
o
o 3
f\/ s S
o o
® 2
1/0 memory g— §
— s ¢
F ASCII
IASCII L
_ I

Variables inside the receive
message determine which area
of the I/O memory is written to

To designate which area of I/O memory is used for creating send messages
and which area of I/O memory is used for storing receive messages, the fol-
lowing three methods can be used.

1,2,3... 1. Operand Designation: Use the designated memory address with the oper-
ands for the PMCR instruction.

2. Direct Designation: Directly designate the /0O memory address.

3. Link Word Designation: Use the shared data area (link word) between the
CPU Unit and the PMSU.
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Designation Methods for Send/Receive Data Area
Designation Function Symbol in message to be Application
method designated

Operand The 1/0 memory area is designated using the Word read: R(z With a PMCR instruction
designation (set | third (first word of send data storage area) and ' 'l) in a ladder program, the
within send/ fourth (first word of receive data storage area) ) ) data area that is jointly
receive operands (second and third operands for 3rd operand in PMCR in | ysed for the sequence
message) C200HX/HG/HE) in the PMCR instruction of a |Struction (2nd operand for | can pe set

ladder program within the send/receive 820.0 HX/HG/HE) automatically. Using the

. . - ) esignate word+ z word ~ |. .

message. Sending and receiving will be carried interrupt function,

out using the designated I/O memory area. Itis |\nord write: W 2) high-response

possible to set the system to either write or not ('[ processing can be

write the receive data in the buffer area (having achieved.

been converted under the designated 4th operand in PMCR

conversion method) after each step using the |instruction (3rd operand

With/Without Response Writing setting for step |for C200HX/HG/HE)

attributes. When the receive process is Designate word+ z word

executed following a step command which has

been set to With Response Write, the receive

data in the receive buffer will generally be

written to the CPU Unit’s I/O memory in one of

the two ways shown below. (Set with the

response type for sequence attributes. For

details refer to page 86.)

1.Scan notification mode: With each CPU Unit

scan, receive data is written to I/O memory.

Since the CPU Unit refreshes with each scan,

writing to the I/O memory area will not take

place simultaneously with receive process and

there will be a time-lag.

2. Interrupt notification mode: When data is

received, an interrupt is executed at the CPU

Unit and the receive data is immediately written

to the designated I/O memory area. (Either the

fixed number or the receive case number are

possible for the interrupt program number)

Note: After the sequence has been completed,

the data in the receive buffer will be read to I/O

memory by the scan notification method.
Direct The I/O memory address is set directly, in the | CIOLILIL] Set when allocating a
designation (set | send/receive message. Since the CPU Unit WRLICIOIC (note 1) fixed data area and used
within send/ refreshes with each scan, writing to the I/O LROICICICT (note 2) separately within the
receive memory area will not take place simultaneously | HRLCICICIC] step. When changing, it
message) with receive process and there will be a ARLICICIC] will be necessary to

time-lag. DM correct the step and

EMUCICIOIN resend.
[J: Word number
Link word A holding data shared area is designated for 11 (IN for link word 1) Set when allocating a
designation (set |the CPU Unit and the PMSU. It is possible to O1 (OUT for link word 1) | fixed data area and used
with sequence |set two link words, 1 and 2. 12 (IN for link word 2) separately within the
attributes) Link word 1: IN (receive data storage) 02 (OUT for link word 2) step. When changing, it
OUT (send data storage) will be necessary to
Link word 2: IN (receive data storage) correct the step and
OUT (send data storage) resend.

Designations are made under the 11, 12, 13, and

I4. Since the CPU Unit refreshes with each

scan, writing to the I/O memory area will not

take place simultaneously with receive process

and there will be a time-lag.
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Note 1. CS/CJonly.

2. C200HX/HG/HE only.
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Using Operand-designated 1/O Memory Area in a PMCR Instruction
(Operand Designation)

Creation of send messages and storage of receive messages is performed
with the memory address designated by operands 3 and 4 (2 and 3 for the
C200HX/HG/HE) in the PMCR instruction.

CPU Unit PMSU
'—1 +—{ PMCR
3rd operand *1: During PMCR execution.
4th operalnd *2: If the With/Without Response Type setting that is set
for each step is Yes and the receive process is executed,
the time required for the data to be reflected in I/O
/0 memor memory will depend on the response type setting (i.e.,
* whether it is the Scan Notification Method, Interrupt Notifi-
3 > Send data cation Method [fixed number], or Interrupt Notification
Method [receive case number]).
] - 2
Example: | PMCR Reading variables
C1 Communications Port No. Example: (R (2), 4): The 4 bytes (2 words) from address D00102
c2 Sequence No. (D00100+2) will be read.
S |DMO00100] First word number of send data======———"1
D |DMO00200]First word number of receive data storage

Send message
s D:D00100 d-u; .

[——
+2

D00102 } T For reading
D00103

Writing variables
Example: (W (2), 4): The 4 bytes (2 words) from
address D00202 (D00200+2) will be written

Receive message

— D:D0020 -\_ﬂ,___.;l-
+2
D00202 } P | For writing
D00203[ - N
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Direct Designation of I/O Memory Area Address

Creation of send messages and storage of receive messages is performed
with the I/O memory address designated directly.

CPU Unit PMSU

Direct designation to
this address

V I/O memory
*
l l 1 > Send data *1: During message sending

*2: During message receiving

*
2 The timing with which the data

is reflected in /O memory de
pends on the scan for the
CPU Unit.

A

Reading Variables

Example: (R (D00102), 4): The 4 bytes (2 words) starting from D00102 will be
read.

Writing Variables

Example: (W (D00202), 4): The 4 bytes (2 words) starting from D00202 will be
written.

Using a Shared Data (Link Word) Area for the CPU Unit and the PMSU
(Link Word Designation)

CPU Unit PMSU
Items to set:
Link word 1
. . IN: first word address (area classification
Link word 1 N Link word 1 and address), number of words (0 to 500) *
. n woa) | € Refresh n OUT: first word address (area classification
(Receive data) (Receive data) and address), number of words (0 to 500) *
01 OUL o1 Link word 2
(Send data) (Send data) IN: first word address (area classification
and address), number of words (0 to 500) *
Link word 2 Link word 2 OUT: first word address (area classification
12 P IN 12 and address), number of words (0 to 500) *
(Receive data) | = (Receive data) *Settings of up to 500 words (CS1) or 128
ouT words (C200HX/HG/HE) can be made for
02 > 02 IN and OUT for both link words 1 and 2.
(Send data) (Send data)

Creation of send messages and storage of receive messages is performed
using the link word area.

Reading Variables
Example: (R (01), 2): 2 bytes will be read from link word output area O1.

Writing Variables
Example: (W (11), 2): 2 bytes will be written from link word input area 11.
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Related Settings

variables are in the receive
message)

Variable setting for number of
iterations setting with the repeat
counter

Designation Send/receive message Step Sequence (shared for steps)
method
Operand Integrate variables into address | With/Without Response Writing | Response type (when
designation or data (when operand-designated operand-designated variables

are in the receive message)

Direct designa-
tion

Integrate variables into address
or data

Variable setting for number of
iterations setting with the repeat
counter

Link word desig-
nation

Integrate variables into address
or data

Variable setting for number of
iterations setting with the repeat

Link word

counter

Note Receive Process with Operand-designated Variables
When operand-designated variables are in the receive message, the receive
process will be performed as shown below.
When the receive process is executed, data in the receive buffer will be read,
and using that data as the receive message, the following process will be per-

formed.
Process Response Response type for sequence attributes
Write for step
attributes
With- | With Scan notification Interrupt notification Interrupt notification
out (fixed number) (receive case number)
1. Comparison with Yes Yes -—- --- ---
expected message
2. Conversion under the |Yes Yes -—- --- ---
formula designated by
variables
3. Write to /O memory | No Yes Writes at scan time. Writes immediately after conversion.
Notification to CPU Unit | Yes Yes Turns the PMCR Execution Flag OFF after writing and after sequence is
completed.
Designates fixed inter- | Designates calculated
ruption task (program) | interruption task
number and executes (program) number and
the interrupt process executes the interrupt
process
Wait Process (Wait When only using the Send/Receive/Send&Receive commands after
Command) sequence execution has started, the progression of steps will be determined
by the results of each successive step (normal end/abnormal end). The pro-
gression cannot be stopped.
To stop the progression of steps during sequence processing, use the Wait
command (only possible with CS/CJ).
If the Wait command is issued during a step:
1,2,3... 1. When the wait-cancel soft-switch is turned OFF, the progress of the steps

will stop and the sequence will go into standby status.

If the wait-cancel soft-switch is turned ON in the ladder program, the stand-
by status will end and the sequence will go to the next process. During the
standby status, the Wait Flag will turn ON.
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2. When the wait-cancel soft-switch is turned ON, the sequence will proceed
to the next process without going to standby.

Simultaneously, the wait-cancel soft-switch will be turned OFF.

Wait-cancel switch

9

Wait-cancel switch g
OFF—ON

Wait-cancel Switch OFF

Step (wait) } Step
( By ladder program )

(I By Wait command )

Step

ON
Wait-cancel switch OFF

}
1
+
T
h
1
1
1
.
1
1
1
)
]
]
'
]
T
1

( By Wait command )

ON
Wait Flag OFF

t
'
i
1
v
v
i
'
e
1

i Standby status

Ladder program
Ladder process

Wait-cancel Switch ON )
l_- Step (wait)

( By Wait c.ommand )

ON 7
Wait-cancel switch OFF 4

(see note)

ON

]
+
¥
b
1
]
[}
I
'
]

Wait Flag OFF No standby status

; No ladder process
.[ p

Ladder program 1

Note: If the Wait command is executed while the
wait-cancel switch is ON, the sequence will not
wait but the Wait-cancel Flag will be turned ON.

Note 1. The wait-cancel switch is turned from OFF to ON using the SET instruction
in the ladder program. When setting (temporary manual setting) with the
Programming Console, the protocol macro standby may not be able to turn
the wait-cancel switch from ON to OFF because ON will be held for a mo-
ment while the key is depressed.

2. If the receive buffer may become full during wait standby (e.g. with full-du-
plex), use in combination with flow control.
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3. Wait command can be used to set the system to proceed to the next step
after allowing the CPU Unit to complete processing, such as internal com-

putation.
Example Command
______ Step 1 (Receive)
Standby
P processing Step 2 (Wait)
L y/ | | ytrtomeReete
- .
'm| t Computation Step 3 (Send)
t processing
v | )
I_.....l _______ 1
'
General- :
purpose |
device )

If used in combination with a matrix, it is possible to set up the system so that
when certain data is received, the send/receive sequence will be put on
standby and computational processing (e.g. data processing) will be per-
formed at the CPU Unit before proceeding to the next communications pro-

cess.
Step No. 00
Send data
|Receive AI lReceive BI Error
| I
Step No. 01 Abort
Step No. 2 Computational proces-

sing (e.g. data proces-
sing) performed at the
CPU Unit

Standby (Wait)

To step No. 3

Wait-cancel switch
OFF—ON
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3-1-4 Trans

ition Stage Between Steps

Following execution of a command within a step, the next process will switch
in the following way depending on the result of the send or receive process.

Process Conditions for error process Conditions for next process
Send Send not completed within send monitoring Any condition not listed under “conditions for
time. error process.”
Receive |Receive |The actual received message and the set Any condition not listed under “conditions for
message | expected message do not correspond. error process.”
Other errors with data communications. (For
details, refer to 3-3-9 Next Process/Error Pro-
cess.)

Matrix Error with data communications Compares the actual received message with a
maximum of 15 kinds of expected message,
and depending on the contents, switches the
next process as required.

Contents of error pro-
cess or next process

Goto **: Goes to a designated step.
Next: Goes to the next step.
End: Ends the sequence.

Abort: Aborts the step and ends the sequence.

Goto **: Goes to a designated step.

Next: Goes to the next step.

End: Ends the sequence.

Abort: Aborts the step and ends the sequence.

Step No.

00

' Send A I

Normal end

1

N (error process)

Y (next process)
To step No. n l I To step No.m l
| l
Step No. n Step No. m
i i
[ Send B | l Send D ,

Receive C

N (error process)

1 Y (next process)

Receive E

N (error process)

l Y (next step)

End I I Abort I I

End l [ Abort

3-1-5
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Setting Transmission Mode

With the protocol macro function, half-duplex mode or full-duplex mode can
be selected so as to match the transmission mode for the destination device.

Note 1.

Half-duplex Mode: For communications between two devices, data can

only be sent one-way at a given time.

or
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Full-duplex Mode: For communications between two devices, data can be
sent both ways simultaneously.

In half-duplex mode, the receive buffer is cleared just before sequence ex-
ecution and just after completion of send operations (Send, Send&Receive
commands). Any data received before or during a send operation cannot
be received as data for the next receive operation.

Transmission | Clear timing | Receive data Character Timing chart (example)
mode for receive trace
buffer
Half-duplex Just be_zfore Betweer) Eve_rything Communica- | |
execution of completion of | during trace tions sequence ; '1 i ; ; i :
communica- send operation | execution . ! 'Receive | | Send 1 iReceive
tions sequence | and Recelve buffer | 1 Vo A :
) cleared ' ' [ Vo '
Just after completlon of ! ! I Vo '
execution of receive : : bl b E
operation, or '
send bgtween Receive data l::l : [::I
command h ' ) " - ]
completion of J ! . I !
H L 1 L} L} L} L} L}
send_ operation Character I ; s — ;
and just before trace ; HE in :
. — '
execution of ' ' (See note 3.) '
send operation ’
Full-duplex Onlyju_st before Eve_rything Eve_rything Communica-  } : — — |
(see note 1) execution of during during trace tions sequence . | i | i
communica- sequence execution : \Receive! 1 Send + iReceive
. . i ) ) 1 1 ) 1 )
tions sequence | execution Receive buffer, | ; P P ;
(see note 2) ' : Vo I '
: : Vo I :
: : I . !
Receive data | E E E E E |
L} t 1} 1 » ] &
L 1 ] ) 5 1 3
L} 1 t L} 1 1 ®
L} 1 ¢ 1 ] 1 ¥
Character | 2 i R H
trace L Ll (R .
i L} Ll ¥ 1 ) 1)

Note 1. The full-duplex can be used with the RS-232C or the RS-422A/485 (1:1
and 4-wire type). It cannot be used with the RS-422A/485 (1:N or 2-wire
type).

2. Clearing of receive buffer is performed with the Flush command, and will
clear the buffer with the desired timing.

3. Although data received up until the completion of send operation will be
lost, it will still be reflected in the character trace.
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Note When performing send operation in half-duplex mode with the CS/CJ, there
will be a time-lag (refer to the table below) between completion of processing
for sending data and completion of the send operation. Therefore, if the
response of the destination device is fast and data is sent back in half-duplex
mode from the time of sending the data (communications commands, etc.) to
completing the send operation, the data received during that interval cannot
be received. If such a situation seems possible, use full-duplex mode.

Send operation

Data transmission processing

it | te=150ps

Fast response o : :
Timing (see the table below) Data cannot be

] received during
this time

Data reception

A

Reception buffer cleared

Time-lag
Baud rate (bps) Time-lag (us)

1,200 1,116

2,400 578

4,800 288

9,600 144

19,200 73

38,400 36
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Note The time-lag is provided to ensure that when using in half-duplex/2-wire
mode, the receive operation will be performed after the last stop bit of the
send data has entered the circuit.

Half-duplex

CPU Unit

PMSU

message.

Comparison with
expected message,
switching for next
process.

+

Writes to CPU Unit,

Receive buffer

Depending on
receive process,
used as receive

Data

Receive possible during
execution of receive
process.

Data received during sending will not be
used as receive data. Data received when

not sending will be sent to the receive

buffer. This data can be extracted using

Full-duplex

CPU Unit PMSU

Data

Receive buffer

All data received during

Depending on sequence execution

receive process,
used as receive
message.

Comparison with
expected message,
switching for next
process.

+

Writes to CPU Unit,

All data received during sequence execution (includ-
ing data received when not executing the receive
process) will be used as the receive message.

During the send process, which includes the Send

the receive process. command, Send&Receive and other commands, the
receive process will continue and data will be sent to
the receive buffer. Therefore, after the send process
and other commands have been completed, this
data can, using the receive process, be used as the
receive message.
Transmission modes for the Protocol Macro are set in the following way.
m=D30000 + 100 x Unit No.
PLC Device Setting area Address Bits Contents
Port 1 Port 2
Cs/CJ Serial Communications Allocated DM D32008 D32018 15 0: Half-duplex (default)
Series Board area 1: Full-duplex
Serial Communications Allocated DM m+8 m+18 15 0: Half-duplex (default)
Unit area 1: Full-duplex

3-2 Sequence Attributes (Common to All Steps)

Set the sequence attributes as described in the following.

3-2-1
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Setting

Setup Item Description
Transmission control X-on/X-off flow control, RTS/CTS flow control, modem
parameter control, delimiter control, or contention control
Link word Shared memory area between the PLC and the Board/

Unit.

Response type

Timing for writing received data.

Monitoring time

Time for monitoring send and receive process.
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3-2-2 CX-Protocol Setup Screen

,7 Sequence name

Link word addressing
Transmission control mode
Response type

Receive wait monitoring time, Tr
Receive finish monitoring time, Tfr

Send finish monitoring time, Tfs

‘l F | Gommunication Sequence |Link Word| Gontrol Respnnse|T|mer Tr|T|mer Tfr|T|mer Tfs_~

3- F'rocces value read

37007 Lamp set point read -
37002 Manipulated variable read -
39.003:5et point read -
30004 Alarm value read -
27005 Propo bandInte/Deri time read! -
;3006 Gooling coefficient read -
3%:007:Dead band read -

3008 Warnal rezat ralie raard i St

Set Sean 3 zec 3 zec
- Set Scan 3 zec 3 zec
- Set Soan 3 zec 3 zec
- Set Soan 3 zec 3 zec
- Set Sean 3 zec 3 zec
- Set Soan 3 zec 3 zec
- Set Soan 3 zec 3 zec
- Set Sean 3 zec 3 zec

Sran S oer T

3 zec
3 zec
3 zec
3 zec
3 zec
3 zec
3 zec
3 zec

BT

For the details of setup method, refer to SECTION 7 Sequence Setting and
Editing.

3-2-3 Transmission

Control Parameter

Set the transmission control parameters such as the flow control, RTS, CTS,
DTR, DSR, etc. The following five types of transmission control are sup-
ported. Set the same transmission control modes as for the external device to
be communicated with. Note that the modem control parameter can be desig-
nated together with other parameters.

Transmission control
parameter

Function

Usage

RTS/CTS flow
control

Executes flow control by hardware
using the RTS and CTS signals.

Set when the external device supports
the RTS/CTS flow control.

Xon/Xoff flow control

Executes flow control by software
using Xon (11 hexadecimal) and Xoff
(13 hexadecimal) codes.

Set when the external device supports
the Xon/Xoff flow control.

Modem control

Holds the DTR “ON" during execution
of a PMCR instruction, and turns ON
the RTS when data is sent.

Possible to turn the DTR signal ON or
OFF at any timing using the Open or
Close command for each step.

Once the DTR signal is turned ON
using the Open command, it will
remain ON until it is turned OFF using
the Close command.

Furthermore, once the DTR signal is
turned ON using the Open command,
it will remain ON even after a
sequence is completed and another
sequence is started. Therefore, the
DTR signal can be used for controlling
more than one sequence.

Set when the external device checks
the DSR status. Must be used if the
internal RS-422 port is to be used.
Must be used also if an external
RS-422/RS-485 converter is
connected to RS-232C port.

Contention control

Transmission control mode for getting
the correct send in point-to-point
contention communication.

Set when the external device supports
contention control.

Delimiter control

For sending or receiving a large
quantity of data, this procedure
separates data into several frames
with delimiters.

Set when the external device supports
delimiter control.
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Note Unless modem control is set, the DTR on the port of the PMSU cannot be
turned ON. When both modem control and RTS/CTS control are set, the DTR
complies with modem control, and the RTS and CTS comply with RTS/CTS
flow control.

Transmission control parameter Settings on the SYSMAC-PST

RTS/CTS flow control None: No RTS/CTS flow control

Send: RTS/CTS flow control only during
sending

Receive: RTS/CTS flow control only
during receiving

Send&Receive: RTS/CTS flow control
during both sending and receiving

Xon/Xoff flow control None: No Xon/Xoff flow control

Send: Xon/Xoff flow control only during
sending

Receive: Xon/Xoff flow control only during
receiving

Send&Receive: Xon/Xoff flow control
during both sending and receiving

Modem control Yes/No

Contention control No
Yes: Send request code; either control
code or ASCII, hexadecimal

Delimiter control No

Yes: Send request code; either control
code or ASCII, hexadecimal

Receive request code; either control code
or ASCII, hexadecimal

CX-Protocol Window

Transmiss

RTS/CTS - Qi
XON/XOFF — [none = Cancel
[ Modem

[~ Contention
— Contention Send Reguest Code

[Code -] | Edt. |

I~ Delimiters
—Delimiter Send Code

Joode = | Eciit... |

—Delimiter Receive Code

[code -] | Edt. |

Control

i

Note 1. Note that the RTS/CTS flow control cannot be set at the same time as the
Xon/Xoff control.

2. With the CS/CJ protocol macro, each port is provided with a receive buffer
(2.5 Kbytes max.). When receiving large amounts of data or when the
communications sequence is set to the wait state, a large-capacity receive
buffer may be required. However, when the protocol macro function is
used, received data exceeding the receive buffer capacity will be overwrit-
ten on the 2.5-Kbyte data already received. Therefore, be sure to set the
flow control if such a large data transmission is expected.
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3-2-4 Link Word Addressing

Use the following procedure to use the link word addressing for designating
transmission data storage locations.

Addressing Function Identification code in Use
messages
Link word Designates an area on which data is shared 11 (IN of link word 1) This mode is used to assign
addressing | between the PLC and the PMSU. Two sets of |O1 (OUT of link word 1) a fixed data area com-
link words (link word 1 and link word 2) can be |12 (IN of link word 2) monly used by all stepsin a
set as such areas. 02 (OUT of link word 2) sequence.
Link Word 1: Changing link words
IN (for storing receive data) requires modification and
OUT (for storing send data) retransmission of the
Link Word 2: sequence.

IN (for storing receive data)

OUT (for storing send data)
Set these areas using the reserved words 11,
12, O1, or O2. Writing operation to the 1/10
memory will not be synchronized with data
reception because these words are refreshed
at each PLC scan, thus inducing some time-
lag. Directly addresses an I1/0O memory within a
send or receive message.

Link Word Designation

CPU Unit PMSU
oLink L | coLlink ko |
IN ‘ ; .
Starting address |
: Refresh
Size Area type
ouT '
Starting address | !
Size Areé type
Link 2o Link 2
IN

Starting address | !

Size Ared type

ouT

Starting address |

Size Ared type
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Area Type and Size

PLC

Cs/CJ

C200HX/HG/HE

Area type and address subject to link

word addressing

ClO: 0000 to 6143
WR: 000 to 511

HR: 000 to 511

AR: 000 to 511

DM: 00000 to 32767
EM: 00000 to 32767
Note: EM banks (1 to
C) cannot be
designated for link
words.

CIO (see note): 000 to
511

WR: 00 to 63

HR: 00 to 99

AR: 00 to 27

DM: 0000 to 6655

EM: 0000 to 6143
Note: CIO indicates I/O
area, IR area, and SR
area.

0 to 500 words

0 to 128 words

0 to 500 words

0 to 128 words

0 to 500 words

0 to 128 words

Number of link 11
words (setting o1
range
ge) m
02

0 to 500 words

0 to 128 words

Sum of [1+12+01+02
must be equal to or less
than 500 words.

Sum of [1+12+01+02
must be equal to or less
than 128 words.

Example: Read and write part of data assigned in the above in a message.

CPU Unit

ouT

Clink T :

Cl00100

20
‘words

PMSU

Designation in a message

ouT

Refresh

1CI00119

' DM0100

130
‘words

Refresh

 DM0129

cLlink Lo .

IS words

Send message

| |(R(01+5), 2)

.

e IS words

send message.

» ClO 105 is read and built in the data in a

Receive message

\ (W (11+3), 4) |

%7

Settings (Allocation) with the CX-Protocol

Link Channel Infarmation

Link 1
I Area

Adr

Len

fiov- I o

OUT Area Addr

Mone  x

0

Len

[

Link 2
IIGArea Al Len
INDne - IO IO_
OUT Area Addr Len
INDne - |o IO—

Data in receive message is written in
DM 0103 to DM 0104.

Cancel |

3-2-5 Response Type

The response type will be valid only when there is an operand-designated
parameter in a receive message. The response type designates when to write
the receive data to the I/O memory designated by the fourth operand (for CS/
CJ) or third operand (for the C200HX/HG/HE) of the PMCR instruction and
how to notify this write process to the CPU Unit. One of the following three
methods can be used.
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1,2,3...

When response writing is
set to “Yes” under step
attribute setting

When response writing is
set to “No” under step
attribute setting

When sequence has
terminated

1. Scan Notification Method

Writes the data in the receive buffer into the 1/O memory when the data is
scanned (see note) for the CPU Unit after conversion. Turns OFF the PMCR
Instruction Execution Flag after writing all the received data into the 1/O mem-
ory and after the sequence has terminated.

Received data remains in the receive buffer without performing any process-
ing for the CPU Unit. Turns OFF the PMCR Instruction Execution Flag after
the sequence has terminated.

Writes the data in the receive buffer into the 1/O memory when the data is
scanned (see note) for the CPU Unit after conversion.

CPU Unit PMSU

Receive
buffer Receive data

A

— ——__PMCR

Half-duplex: Other than send process.
Full-duplex: During sequence execution.

Receive
process

Ej Conversion

™ 1/0 memor ) ) .
Y Data is written during
scanning (see note)/
. i
- < ;
Turns OFF when writing is fin-
ished and sequence has termi-
nated.
Protocol Macro <
Execution Flag N I

Note With the scan notification method, write timing will vary as shown below

When response writing is
set to “Yes” under step
attribute setting

When response writing is
set to “No” under step
attribute setting

depending on the PMSU model.

Model PLC Write timing
Serial Communications | CS/CJ Cyclic | Written when 1/O is refreshed
Unit for the CPU Bus Unit.

Serial Communications Written when I/O is refreshed
Board for the CPU Inner Board.

Communications Board | C200HX/HG/HE | Cyclic | Written when servicing is
performed for the Communi-
cations Board.

2. Interrupt Notification Method: Fixed Number

Writes the data in the receive buffer into the I/O memory immediately after it is
converted according to the designated method. When all the data has been
written into the I/O memory, an interrupt task number (external interrupt task)
(for the CS/CJ) or a subroutine number (for the C200HX/HG/HE) will be desig-
nated and the interrupt task will be performed for the CPU Unit. Also, when all
the data has been written into the 1/O memory and when the sequence has
terminated, the Protocol Macro Execution Flag will be turned OFF.

Interrupt process for the CPU Unit will take place when the notification is
received. The received data will remain in the receive buffer without perform-
ing any write process for the CPU Unit. The Protocol Macro Execution Flag
will be turned OFF after the sequence has terminated.
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Sequence Attributes (Common to All Steps) Section 3-2

Note With the CS, this method is applicable to the Serial Communications Board
and with the C200HX/HG/HE, it is applicable only to the Communications
Board. It cannot be used for the Serial Communications Unit for the CS/CJ.

. Serial Communications Board
CPU Unit or Communications Board

Fixed interrupt task
Interrupt (program) No.
process

i)

H —{ PMCR {

T~

Receive
buffer

) Half-duplex: Other than send process.
After Receive y Duri ;
writing process Full-duplex: During sequence execution.
| | Conversion
“
1/0 memory
Data is written immediately
after conversion. J

L]

-> D Turns OFF when writing is fin-
ished and sequence has termi-
nated.

Protocol Macro
Execution Flag

Note With the CS-series (Serial Communications Board), received data cannot be
stored in the EM area using the interrupt notification. If this is attempted, a
protocol macro syntax error (A42410) will occur.

3. Interrupt Notification Method: Receive Case Number

When response writing is Writes the data in the receive buffer into the I/O memory immediately after it is
set to “Yes” under step converted according to the designated method. When all the data has been
attribute setting written into the 1/O memory, the external interrupt task number (for the CS/CJ)
or the subroutine number (for the C200HX/HG/HE) will be calculated based
on the step number executed according to the following procedure and the
case number, and the interrupt task will then be performed for the CPU Unit.
Also, when all the data has been written into the 1/O memory and when the
sequence has terminated, the Protocol Macro Execution Flag will be turned

OFF
When response writing is Interrupt process for the CPU Unit will take place when the notification is
set to “No” under step received. Received data will remain in the receive buffer without performing

attribute setting any write process for the CPU Unit. The Protocol Macro Execution Flag will be

turned OFF after the sequence has terminated.
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Sequence Attributes (Common to All Steps) Section 3-2

Note With the CS, this method is applicable to the Serial Communications Board
and with the C200HX/HG/HE, it is applicable only to the Communications
Board. For the CS/CJ, it cannot be used for the Serial Communications Unit.

i Serial Communications Board
CPU Unit or Communications Board

Interrupt i
Receive
/ process ixed i
~ —1_PMCR : < yy Qgﬁ%r&zﬂg‘nﬁg buffer Received data
\ o.

Half-duplex: Other than Send process.

After Receive Full-duplex: During sequence execution.
writing process
Conversion

1/0 memory

Data is written immediately
after conversion.

J

I
Turns OFF when writing is fin-
ished and sequence has termi-
nated.

Protocol Macro
Execution Flag

Interrupt task number = [ ][] XX (hexadecimal)

(for CS/CJ) or L When using a matrix: Case num-
Subroutine number ber of the matrix

(for C200HX/HG/HE) Otherwise: 0

Step number of the sequence that
was executed

Note With the CS-series (Serial Communications Board), received data cannot be
stored in the EM area using the interrupt notification. If this is attempted, a
protocol macro syntax error (A42410) will occur.

Example: When the step No. = 2 and the matrix case No.
= 11 (hexadecimal):

Interrupt task (subroutine) No. = 2B (hexadecimal) = 43 (decimal)

Note With the CS/CJ, the interrupt task (external interrupt task) with the task num-
ber assigned according to calculation will be performed. With the C200HX/
HG/HE, the interrupt task (external interrupt task) with the subroutine number
(SBN to RET) assigned according to calculation will be performed.

Setting with the CX-Protocol

Responze Type | 7]

Matification Type (]
+ Sear

" |nterrupt Fixed #

" |nterupt Receive Caze
The interrupt Mo, to the PLC will be zet
to automatic for the comm board status.,

Cancel

Note When an interrupt notification is used with the CS-series (Serial Communica-
tions Board), the protocol macro status area (within the interrupt data area)
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Sequence Attributes (Common to All Steps) Section 3-2

will not be updated completely when the interrupt notification is received.
Therefore, read the receive data only after the external interrupt task condi-
tions have been satisfied in order to ensure concurrent data processing.

The PMCR instruction cannot be executed within the external interrupt task
that has been started using the interrupt notification. An execution error will
occur.

3-2-6  Monitoring Time

Users designate the time for monitoring the send or receive process. The fol-
lowing types of monitor time can be designated. However, Ts (send wait time)
is omitted here because the value is set step by step.

Set the monitoring time by sequence only as described below in the shaded

area.
Monitoring time Description Command type
Send | Receive | Send &
Receive
Receive wait Monitors the time from when the receive command of the step in the |--- (@) (0]
monitoring time: sequence is recognized (receive command execution) until the first
Tr byte (header) is received.
When receiving no data in the designated Tr (Note 1), the system
executes the error process set in the step.
Receive finish Monitors the time from reception of the first byte to reception of the |--- (@) (0]
monitoring time: last byte of the data in the step in the sequence. When reception
Tfr does not complete in the designated Tfr (or the terminator does not
come) (Note 1), the system executes the error process set in the
step (Note 2).
Send finish Monitors the time from transmission of the header to transmission of | O -—- (0]
monitoring time: the last byte of the data. If the transmission does not end within this
Tfs designated monitoring time (Note 1), the system will execute the
error process set in the step.
Send wait time: Ts | Sets the time from when the send command of the step is recog- (0] (0]
nized until the first byte is sent. For example, when sending the data
over an extension line through the modem, dialing may not be suc-
cessful unless there is a pause to input the telephone number after
dialing O.

O: Available, ---: Not available

Note 1. When aretry count of Send&Receive is set for the step, the system repeats
the step up to the number of times of the retry count. If all retries fail or a
time-out occurs, the system executes the appropriate error process.

Sendonly:i™— T8 |~ e —

Receive only: —Tr—|— Tfr -

Send&
Receive: — Tr —|— Tir —
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Step Attributes Section 3-3

2. Be sure to set both the receive wait monitor time Tr and receive finish mon-
itor time Tfr. With the CX-Protocaol, it will not be possible to set just one of

these.
Setting with the CX-Protocol
Timer Tr KH
Walue Tirne it 0K
IE * I'I zecond j
Cancel
Timer Tk KH
Walue Tirne it oK
IE * I'I zecond j
Cancel
Timer Tkz EH
Waluz Tirne it 0K
IE = I'I secand j
Cancel
3-3 Step Attributes
Set the sequence attributes as described below.
3-3-1 CX-Protocol Setup Screen
With/Without
Repeat counter Sond wait n‘]seend message response writing EITOr process
Command
Retry count Receive message
Next process
* | Step| Repeat | Command |Retry| Send Wait| Send Message| Recw Message|Response| Mext | Error |
@00  RSET/001 Send & Receive 3 -—- SD0040 1 R/ (D) 1 YES  Mext :Mext
'@ 01 RSET/001 Send & Receive 3 -—- SOi420 1 R4 2) 1 YES End Abort

For the details of setup method, refer to 8-1 Step Setting.
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Step Attributes Section 3-3
3-3-2 Setting
Parameter Description Remark Command
Send | Receive | Send & | Wait | Flush | Open | Close
Receive | (see | (see | (see | (see
note) | note) | note) | note)
Repeat Sets the number of Incorporating a linear |O (0] (0]
counter times that the step is | expression including
repeated. The the repeat counter N
system increases the |into the send or
value of the repeat receive message
counter N at every allows users to freely
step. change the destina-
tion of the message or
the 1/0O memory to
which the message is
stored.
Command | Sets one of the follow- | When sending and --- --- --- --- - --- ---
ing seven kinds of receiving the data by
command: consecutive turns,
Send: Sends data. using the
Receive: Receives Send&Receive com-
data. mand allows users to
Send&Receive: set the steps effi-
Sends and receives | ciently.
data. Since the retry count
Wait (see note): for an error can be
Keeps the step on set, the error process
standby. (Until the is described simply.
Wait Clear switch is Use the Wait com-
turned ON from the mand when shifting to
CPU Unit. Once the |the next step after the
switch is turned ON, | CPU Units completes
the step shifts to the | computation between
next process.) steps (see note).
Flush (see note): Use the Flush
Clears all the data command when clear-
within the receive ing data within the
buffer. receive buffer under
Open (see note): the full-duplex mode
Turns ON the DTR | (See note).
signal at the desired | Use the Open or
timing. The DTR sig- | Close command
nal is held ON after when turning ON or
the sequence has ter- | OFF the DTR signal
minated and after the |to match the control
port is re-enabled protocols of the
using the STUP external device under
instruction. the modem control
Close (see note): (see note).
Turns OFF the DTR | Note: Only for the CS-
signal at the desired | series protocol macro.
timing.
Note: Only for the CS-
series protocol macro.
Retry count | Valid only for During retrying, the --- --- (0] --- -—- --- ---
Send&Receive com- |send wait time is
mand. The system ignored. Therefore,
executes the current | the send wait time
step up to the desig- | has to be provided by
nated times (0-9) an error process dur-
when some retry fac- |ing retrying. Likewise,
tor such as an error | aretry process has to
occurs. If the retry be provided by an
factor still remains, error process for
control will go to the | Send or Receive
error process. command.
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Step Attributes Section 3-3

Parameter Description Remark Command
Send | Receive | Send & | Wait | Flush | Open | Close
Receive | (see | (see | (see | (see
note) | note) | note) | note)
Send wait | Sets the wait time Set a send wait time | O (0]
time (Ts) as waiting time | when the communica-
for data sending to tions partner cannot
start. receive data immedi-
ately.
Send Sets the send With the CX-Protocol, |O (0]
message message when the a send message
command is Send or | name created in the
Send&Receive. send message list is
referred to or a send
message is created
directly in this step.
Receive Sets the expected With the CX-Protocol, | --- (@] (@]
message receive message a receive message
(including |when the commandis | name created in the
matrix) Receive or receive message list
Send&Receive. is referred to or a
For details refer to 3-4 | receive message is
Communication Mes- | created directly in this
sage Attributes. step. Or, a matrix
When setting a matrix | name created in the
to switch the next matrix list is referred
process according to | to. (The matrix
several expected cannot be created
receive messages, directly from the step.)
specify the matrix
name from here.
For details refer to 3-5
Creating Matrices.
With/With- | Sets whetherreceived | Setting this parameter | --- (0] (0]
out data is to be written. | to “available” always
Response | Valid only when the needs to designate
Writing receive data are the response type
(operand stored using the oper-
address- and addressing
ing) mode.
Next Sets the next transit | End: Executes the (0] (0] (0] (0] @) (0] (0]
process step when the step step and ends the
ends normally. sequence.
Next: Executes the
next step.
Goto**: Executes the
step designated by
sk3k
Abort: Aborts the step
and ends the
sequence.
Error Sets the next transit | Same as above. (0] (0] (0]
process step when the step
ends abnormally.

O: Available, ---: Not available

Note The Open and Close commands turn the DTR signal ON or OFF under a con-
trol mode other than the modem control. The ON or OFF state will be retained
not only after the sequence has terminated but also when the protocol has
been changed through the STUP or port starting.
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Step Attributes Section 3-3

3-3-3 Repeat Counter

1,2,3... 1. Initial value designation

One of the following parameters can be set as the initial value in the corre-
sponding step of the repeat counter variable N.

Reset After the repeat counter variable N is reset to 0 when the step is started, the
step will be repeatedly executed by a designated number of times.

Hold When the step is started, the current value of the repeat counter variable will
be held as it is, and the step will be repeatedly executed by a designated num-
ber of times.

2. Number of iterations set

The number of iteration times to repeatedly execute the step can be desig-
nated by one of the followings:

 Setting constant 1 to 255.
* Usingawordread R ()
Example) R (1) The content (binary) of the low-order byte at the word of the third operand

(second operand for the C200HX/HG/HE) +1 of a PMCR instruction is desig-
nated as the number of iterations.

Example) R (DM000O0) The content (binary) of the low-order byte in DM 0000 is designated as the
number of iterations.

Note How to designate word read

R(C )
L Start word + constant
How to designate Syml_:)ol to be Example
aword designated When constant=0 | When constant=2
Operand None Cannot be set. R(2)
designation
Link word 01,1, 02,12 R(0O1) R(0O1 +2)
designation
Direct designation | CIOLICI], LRI R(DMO0000) R(DMO0000 + 2)
(*1), WRLICIIO
(*2), HROI],
AR[CIC], DMUIOICIC,
EMCICICICT:
Word#

Note (*1): C200HX/HG/HE only
(*2): CS/CJ only

The content of the low-order byte at the start word + constant word is read as
binary data to indirectly designate the number of bytes.

Note When 0 is read by the repeat counter during the word read, the step will be
skipped (ignoring the next step setting) and control will shift to the next step
(+1).
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Step Attributes Section 3-3

Setting with the CX-Protocol

Repeat Counter Information

Counter Cancel |
@& Constant |1

© Channel  [R(D Edt. |

* While a step is executed for the number of times set in the repeat counter,
control is not shifted to the destination designated for the next process. After
the step is executed the designated number of times, the control shifts to the
designated destination for the next process.

» Use the repeat counter variable N for designating a send/receive message
address or data enables the following:

Example: If the same send message is to be sent to multiple N-connected external
Units,
include the repeat counter variable N in the send message address.

PMSU

Send message

Y

T M

Header Address Data

$(N,1) Address 0 Address 1 -----

Example: If different addresses for different steps are to be designated to store receive
messages, include the repeat counter variable N in the data in the receive
message.

CPU Unit PMSU

Receive message

[ PMCR ] —~—| | ] Qe

T

Header Address Data

| o &(W(N+1,2))

+1 < !
+2 €+—--F--—--" /
& (W(N+1),2) Two-byte receive data is converted from ASCII to hexadecimal and stored at

the address of the fourth operand (third operand for the C200HX/HG/HE) des-
ignated address + (repeat counter variable N + 1) word of a PMCR instruction.

Note The repeat counter variable N will be as follows depending on the initial value

setting.

(1) Reset (5times), N=0to 4

(2) Hold (5 times), N=4to 8
For Hold, the repeat counter value updated in the previous process will be
used.
The set value and process value of the repeat counter in the above examples
are 0501 to 0505 for example (1) and 0501 to 0505 for example (2).
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3-3-4 Commands

Set the Send, Receive, Send & Receive, Wait, Flush, Open, or Close com-

mand.
Send Sends a send message set in a step.
Receive Handles a receive message in a step or receive message in a matrix as an

expected message, and receives data (note 1).

Send&Receive After sending a send message set in a step, handles the receive message set
in a step or receive message in a matrix as an expected message, and
receives data (note 1).

Wait Keeps the step on standby until the Wait Clear switch changes from OFF to
ON. (See note 2.)

Flush Clears the data within the receive buffer. (See note 2.)

Open Turns ON the DTR signal. (See note 2.)

Close Turns OFF the DTR signal. (See note 2.)

Note 1. Compares an actually received message and set receive (expected) mes-
sage, and if they match, goes to the next process. If they do not match,
control is shifted to the error process for the receive message, and for the
matrix, to the next process designated with “Other” (other than the set re-
ceive message group.)

2. Only for the CS/CJ protocol macro.

3. Generally, when a command is sent and a response is received, set
Send&Receive.

4. Send&Receive allows retry to be designated. At retry, transmission wait
cannot be applied. If a transmission wait at retry is to be applied, divide the
retry into the Send step and Receive step.

5. Hold process ON (Open command) and process OFF (Close command) of
the DTR signal (only for the CS/CJ protocol macro).

The DTR signal will turn ON when a sequence execution is started. Exe-
cute the Close command to turn OFF the DTR signal at the desired timing.
Execute the Open command to turn ON the DTR signal again at the de-
sired timing. When the Open command is executed, the DTR signal will be
setto ON until the Close command is executed. This ON state will continue
even after one sequence is terminated and another sequence is started.

Sequence Another sequence

} Il i
T T 1

Execution of
Open/Close > I l
command

A4 Pl

Open Close
command command

1
¥
+
]
]
]
.
]

DTR signal

A4 A4 Yal

1]
1]
H
+ Close Open Close

+ command command command

When the transmission control parameter is set to modem control for the
conventional protocol macro for the C200HX/HG/HE, the DTR signal will
turn ON when a sequence is started and will turn OFF when sequence ex-
ecution is completed. This setting has the following problems.

* When hanging up the phone in the middle of a sequence execution via a
modem, it will be necessary to send an escape code (for example: +++) and
an AT command (to cut the line) to the modem. However, hanging up the
phone can be performed more easily and reliably using electrical signals
(without requiring a modem monitor timer).
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With the CS/CJ protocol macro, the phone can now be hung up at the
desired timing by turning OFF the DTR signal.

* With the conventional protocol macro for the C200HX/HG/HE, the phone
line cannot be set to be active for more than one sequence.
With the CS/CJ protocol macro, the DTR signal can be retained even after a
sequence has terminated, and can be applied in the following way.

1,2,3... 1. Make a call using the protocol macro from the PLC to a host computer
(Programming Device: CX-Programmer).

2. When the line is connected, change the serial communications mode from
protocol macro to host link using the STUP instruction. (DTR signal is re-
tained.)

3. Execute remote programming/monitoring from the Programming Device
side.

Personal computer

3) Remote programming/monitoring

1) Dial-up.

= 2 Modem Modem

RS-232C

PC

2) Change the mode to host link
using the STUP instruction.

Setup with the CX-Protocol

Cormmand Type

Feceive

Send & Receive —

Note When set to modem control mode, the DTR signal will turn ON when the
sequence is started and will turn OFF when the sequence ends. If the DTR
signal is turned ON using the Open command under the modem control
mode, the DTR signal will remain ON even after the sequence has ended.
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3-3-5 Retry Count

When the retry count of the Send&Receive command is set, if a retry factor
among the above error factors occurs, (refer to the table of error factors on the
following page) the system will execute the Send&Receive command repeat-
edly. If this error factor still remains after the designated number of retry repe-
titions, the system will go to the error process.

When retrying, the system will send data regardless of the send wait time Ts.

xecuted to
the number of

times of the
retry count2

Send&Receive

Error
occurred?

(Normal end) (Abnormal end)

l

Error process

Next process

Setting with the CX-Protocol

| ¢ ]

Note To execute the retry process as an error process, it is necessary to set the
steps as follows. As seen in the following, the description of the error process
is more complicated than using Send&Receive commands and designating
the retry count.

Example: Retrying the same process 3 times.

Next process Error process
Step 00 Retry count 0 End Goto 01 (or Next)
Step 01 Same content as step 00 End Goto 02 (or Next)
Step 02 Same content as step 00 End Abort
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Note When both the repeat counter N and the retry count is set, the counter N will
not be updated until the system executes the steps for the number of times of
the retry count. The counter N will be updated when the retry factor disap-
pears or the system has executed the steps for the number of times of the
retry count.

Executed
to the number of
times of the retry
count?

Send&Receive

Error
occurred?

Executed
to the number of
times of the retry
count?

lv

(Normal end) (Abnormal end)

Next process Error process

3-3-6 Send Wait Time

For the Send or Send&Receive command, set the wait time taken from the
corresponding step up to data transmission.

Screen with the CX-Protocol

Transmission Wait Time

Walue Time Unit

] ¥ |10 milisecond 7]
Cancel |

3-3-7 Send Message/Receive Message

Send Messages A send message name created in the send message list is referred to or a
send message is created directly in this step. For details about the contents of
send messages, refer to 3-4 Communication Message Attributes.

Receive Messages A receive message name created in the receive message list is referred to or
(Including Matrix) a receive message is created directly in this step. For details about the con-
tents of send messages, refer to 3-4 Communication Message Attributes.
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A matrix name (indicated with brackets) created in the matrix list. is referred
to. For details about the contents of send messages, refer to the following 3-5
Creating Matrices.

nd Wait| Send Message | Recv Messag
SO0 1 - | R0 1
hessage
S00000 1
SD(E6) 1
SD04) 1
SDid 201

SD0131

3-3-8  With/Without Response Writing

Sets whether or not received data is written.

This setting is valid when the data in a receive message is designated with a
variable and the first word address is operand-designated.

If it is set to Yes, the data in the receive buffer will be written into the I/O mem-
ory according to the response type designated in the sequence attribute (scan
notification, interrupt notification: fixed number, or interrupt notification:
receive case number) and a natification of data reception will be issued to the

CPU Unit.
Response
YES vI

Rezponse

3-3-9 Next Process/Error Process

When a step is normally or abnormally terminated, set which step control it
will be shifted to.

When a matrix is designated as a receive message, the above setting is
invalid, and the next process designated with the matrix is valid.

Goto** After execution of the step, shift to the designated step ** (0 to 15).

Next After execution of the step, shift to the next (+1) step.

End After execution of the step, terminate the entire sequence including the step.
Abort If an error factor occurs during execution of the step, interrupt the execution of

the step and terminate the entire sequence including the step.

Setting with the CX-Protocol

o

) Wext \_KI
i Goto IOO Cancel |

QK I
Cancel |
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When one of the following error factors occurs, the step ends abnormally, and
then the system goes to the appropriate error process.

Command

Message

Normal end?

Error factor

To be
repeated?

Next process ' IError process

Errors Command type When retry is
Send | Receive | Send & | designated.
Receive

The Message that was received is not the same as the expected receive | --- (0] (0] Step is retried.
message.
Monitoring time expired | The data (or header) are not received within | --- (0] (0]

“receive wait monitoring time.”

Data receiving is not finished within “receive |--- (0] (0]

finish monitoring time.”

Data sending is not finished within “send (0] --- (0]

finish monitoring time.”
A transmission error occurs during data receiving. (0] (0]

For the CS/CJ, an overrun/framing/parity error occurs for the transmis-
sion error occurrence status. (Words +8/+19) (bits 02 to 04 are set to
“ON")

For the C200HX/HG/HE, the Communication Error Flag 28304 or 28312
is set to “ON.”

An error is detected in error check code. (6] (6]

Received data size exceeds the area for the designated area during the | --- (0] (0] Step is not
writing of data to or reading of data from the CPU Unit. retried.
For the CS/CJ, data read/write area error (error code 3) is stored in the
error code (bits 00 to 03) indicating the port operating status

(words +9/+19) of the protocol.

For the C200HX/HG/HE, data read/write are error (error code 3) is
stored in the error code. (Word 256, bits 8 to 11 (port A) and bits 12 to
15 (port B))

Note In case of the Wait, Flush, Open, or Close command, the error will not occur
during execution.
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3-4 Communication Message Attributes

The communication message contains six items: header, address, length,

data, error check code, and terminator.

| Header | Address | Length | Data | Check code Terminator |
Parameter Description Data attributes
Header Sets the data that indicates the beginning of the communications message | Constant only

frame. At reception, data from the header is received as the message.

Address Sets the unit number or other information to be used as the message’s Constant (Reserved
destination. characters are not available.)
« The system identifies whether the receiving data is addressed to itself. | Variable
* When “Word writes” or “Wildcard” is set as a data attribute, the system
receives all the messages addressed to itself without identifying whether
it is addressed to itself (broadcast addressing).
« The message sending address can automatically be updated by using
the repeat counter.
Length « Indicates the length (number of bytes) of a message. Based on the calcu- | Automatic variable
lation method set at transmission (length size/data format), calculates
message length and appends the value before sending.
* When the message is received, the amount of data
corresponding to this value for the length is taken from the actual
received data and processed as the receive message. (Checking of this
value is not supported by C200HX/HG/HE.)
Data » For sending messages Constant
Set the data to be sent. Variable

For receiving messages

Set the data expected to be received. When the data of the actually
received message frame is different from the designated data, the sys-
tem executes the error process.

The received data can be written to the I/O area of the CPU Unit.

Error check
code

At the send process, the check code of the send message frame is auto-
matically calculated according to the setup, and appended to the mes-
sage frame to be sent.

At receive process, error checking that compares the check code
received with the check code locally calculated from the received data is
executed.

When both check codes are different, the control will go to the error pro-
cess.

Automatic variable (LRC,
LRC2*1, SUM, SUM1*L,
SUM2, CRC-CCITT, CRC-16,
or No-Check)

*1: Only for CS/CJ protocol
macro

Terminator

Marks the end of a message frame.

* When sending a message, the system will finish a frame of the message
sending after it sends the terminator. If the terminator is not set, the sys-
tem will finish the sending when it sends the data set at the end of the
send message.

When receiving a message, the system will finish receiving when it
receives the terminator. If the terminator is not set, the system will finish
the receiving when it receives the data set at the end of the receive mes-
sage.

If the number of bytes of data set at the end of the receive message is
“Wildcard,” the system will finish receiving when the buffer becomes full
(CSICJ: 2,500 bytes, C200HX/HG/HE: 256 bytes). However, if flow con-
trol (X-on/X-off, RTS/CTS) is set, the system will send the X-off code
when the buffer is filled to 75% (CS/CJ: 2,000 bytes, C200HX/HG/HE:
200 bytes) and finishes receiving.

Constant only
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Sending: The header, the address, the length, the error check code, and the

terminator can be eliminated.

Receiving: If the terminator exists, the header, the address, the length, and
the error check code can be eliminated. If the data length is fixed, the termina-

tor can be eliminated as well.
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3-4-1 CX-Protocol Setup Screen

—  Message name (Note)

Header Terminator

Check code

{ Length (Address { Data

* |5end Messaege| Header <h>| Terminator <t> Gheck code <c> Leneth <I>|Address <a>
S0i000 1 @ [2an0] LRC H parity D} (2Byvte ASCID FRO2) Chrdar+1"
S0iBAEY 1 @ [2an0] LRC H parity D} (2Byvte ASCID FRO2) Chrdar+ 1"
SO0 1 @ [2anD] LRC H parity )0} (2Byvte ASCID FROD2) Chrrdar+ 1"
S0id23 1 @ [2anD] LRC H parity )0} (2Byvte ASCID FROD2) Chrrdar+ 1"

For the details of setup method, refer to the SECTION 9 Setting and Editing
Messages and Matrix Lists.

Note After the creation of communication message, users can create steps by des-
ignating the message name.

3-4-2 Header

Indicates the beginning of a message. Only a constant can be designated.
Selects the message type (ASCII, hexadecimal, control code), and enters
data.

Example: Type: ASCII, data: @ (screen display: “@")

3-4-3 Address

Designate the address when a message is subjected to 1:N communications.
A constant or variable can be designated. Using the repeat counter variable N
for the variable can change the address for each sending and receiving.

Select the address type (constant, variable), and enter data.

Example: Type: variable, conversion: none, data: (R(1),2) (screen display: (R(1),2))

3-4-4 Length

Sending (Common to C200HX/HG/HE and CS/CJ)
Upon sending, calculations are automatically performed for the message item
corresponding to the length itself, and adds the item. Unit: Number of bytes. It
is possible to set the range for the item to be calculated.

Receiving Protocol Macro for C200HX/HG/HE

This length data is not checked upon reception.

Designate the length size (one byte, two bytes), data type (ASCII, binary)
according to the communications designation of the device at the communica-
tions partner.

Example: 1 byte, binary, initial value: 0 (screen display: (0) (1 Byte BIN))
Note The length calculation range is set in the Message Editor dialog.
Protocol Macro for CS/CJ

This length data is checked upon reception.

If there is no terminator designation, an amount of message items corre-
sponding to the length (number of bytes) set in the expected message will be
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extracted from the receive buffer and processed as the receive message.

If there is a terminator designation, data up to the terminator will be received
as the receive message and a comparison will be made to check that the
length of this message matches the value for the length in the expected mes-
sage.

Note Even if there is no designation for the header, it is possible to take the mes-
sage item out of the receive buffer if the length or the terminator is designated,
and process it as the receive message.

Length designation for the CS/CJ operates in the following way.

Example: If the received message is <h>+<I>+(W(1),*), the data size of (W(1),*) will be
determined by the value of <I> in the expected message following <h>, and
the data will be received as the receive message.

Note A comparison error may occur as the result of an ASCII conversion error for
<>,

Example: If the received message is <h>+<I>+(W(1),*)+<t> and the range between <h>
and <t> has been recognized as the receive message, a comparison will be
made between the value of <I> in the expected message and the data size of
the actually received (W(1),*).

Note A comparison error or a data size comparison error may occur as the result of
an ASCII conversion error for <I>.

Expected message Receive buffer Message

Length | Data IError check

Address Terminator

l Header code

Reception

Example: If the data part is 100 bytes, the following
will be received as the receive message.

100 bytes

I Header | Addressl Length Data EO"&O;CheCkI Terminator

3-4-5 Data
At sending, designate data to be sent. At reception, designate expected data.

A constant or variable can be designated. A constant and a variable can be
combined as a string.

Designating a variable allows the I/O memory word data to be used as part of
data (at sending: read, at reception: write). Furthermore, using the repeat
counter variable N for the variable allows data to be changed for each send
and receive.

Select the data type (constant, variable), and enter data.

Example: Type: Constant (ASCII), data: RX0
Type: Variable (hexadecimal), data: &(N,R (1))
Type: Constant (ASCII), data: 00

'
(Screen display: “RX0” + &(N,R(1)) + “00")
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3-4-6  Error Check Code

Designate the error check code when data is sent.

LRC, LRC2, CRC-CCITT, CRC-16, SUM (1-byte/2-byte), SUM1 (1-byte/ 2-
byte), and SUM2 (1-byte/2-byte) can be designated. As the data type, BIN or
ASCII can be selected. The data size, default, and swap between high byte
and low byte can be designated.

Example: Type: LRC, data type: ASCII, data size; 2 bytes, initial value: O (screen dis-
play): LRC (H parity) (0) (2 Byte ASCII)
Note 1. The error check code range is set in the Message Editor dialog.
2. SUM2, CRC-16, and swap between high byte and low byte are possible for
the C200HX/HG/HE only when the Communications Board is the

C200HW-COMLILI-EV1. For the CS/CJ, they are possible with any PMSU,
and SUM1 (1 byte, 2 bytes) and LRC2 are also possible.

3-4-7 Terminator

With reception of this code, data reception is completed. (When data is
received without this code, data reception will be completed when the data
that corresponds to the length of the message set in the reception message
inside the step is received.)

With sending of this code, data sending is completed. (When data is sent
without this code, data sending is completed at the time when the last data is
sent.)

Only a constant can be designated.

Select the terminator type (ASCII, hexadecimal, control code) according to
the communications specification of the device of the communication partner,
and enter the data.

Example: Type: hexadecimal, data: 2A0D (screen display [2A0D])

Note Even if there is no designation for the header, it is possible to take the mes-
sage item out of the receive buffer if the length or the terminator is designated,
and process it as the receive message.

3-4-8 Message Item Data Attributes

Users can set the following constants or variables as message items.

Constant Can be set for the header, address, data, or terminator.
Constant Designating method Examples

ASCII data Designate between double quotation marks, |“12345”
asin “12345”

Hexadecimal data | Designate between square brackets as in [5A2B]
[5A2B].

Control code Designate by selecting the special code from |[OD] for CR
the list, such as CR, LF, or STX.

Variable Can be set for the address or data.
Variables read from and write to the I/O memory of PLC, and utilize repeat
counter variables.
1. Format
Designate in the form of (X, Y).
X: Effective address

Designates where to read from or write to in the I/O memory, the lin-
ear expression including N, or the wildcard. One of the following can
be used to designate items.
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a) Both the read/write options and the first word + (the linear expression

including N)

b) Linear expression including N.

c) Wildcard (*)

Note Wildcard can be designated only in the receive message.
Y: Data size (CS/CJ: 1 to 1000, C200HX/HG/HE: 1 to 255)
Designates the number of bytes to read or to write, when the data are
not converted. (Designates 1 when reading the value of N.)
Designates the number of bytes on the transmission, when the data
are converted. The number of bytes on I/O memory are as follows.

Option Data size on the I/O memory
$ &
(Hexadecimal—>ASCIl) | (ASCll->Hexadecimal)
R (Read from the PLC—»Send) | Y/2 bytes Y x 2 bytes
W (Receive—Write to the PLC) | Y x 2 bytes Y/2 bytes

One of the following can be used for designate items.

1,2,3... 1. Linear expression including N.
2. Wildcard (*)
Note Wildcard can be designated only in the receive message.
3. Both the read option and first word + (the linear expression including N)
Note Reads bits 0 to 11 of the word as 3-digit BCD.

There are three types of variables as shown below. For each variable, users
can set the attribute which designates the direction (forward or reverse direc-
tion) to read or to write the data to be converted.

Note 1. ASCII Data Conversion, Hexadecimal Data Conversion:
When ASCII data conversion is performed, the designated data is read as
Hex (hexadecimal) data and each digit is converted to its ASCIl code num-
ber. Consequently, the size of the data will be double that before conver-
sion.
When Hex data conversion is performed, the designated data is read as
ASCII data and each byte of the data is converted to a hexadecimal value.
Consequently, the size of the data will be half that before conversion.
The specifications for the conversion vary with the designated data, read/
write designations, and direction designations. For conversion examples,
refer to page 112.

2. Forward direction: Bit: High-order — low-order, word: high-order — low-or-
der
Reverse direction: Bit: High-order — low-order, word: low-order — high-or-
der

Read/write direction
Forward
X, Y)

Variable Function
Read | Write

Y bytes of data from the address designated by X
are processed without conversion.

Reverse
~(X,Y)

Unconverted variable
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Variable Read/write direction Function
Forward Reverse Read Write
Variable converted to | $(X, Y) $~ (X, Y) |Y/2 bytes of hexadeci- |Y bytes of hexadecimal
ASCII mal data from the data is converted into
address designated by | ASCII data equivalent to
X are convertedto Y Y=2 bytes before stor-
bytes of ASCII data. age with the address
designated by X as the
beginning.
Variable converted to | & (X, Y) &~ (X, Y) |Y=*2 bytes of ASCIl data | Y bytes of ASCII data is

hexadecimal

from the address desig-
nated by X are con-
verted to Y bytes of
hexadecimal data.

converted into hexadeci-
mal data equivalent to
Y/2 bytes before storage
with the address desig-
nated by X as the begin-
ning.

Variable Format
Y

X
T
$~(R(DM0000), 2)

3

Data size on the transmission path:
The linear expression including N or the wildcard (*) or indirect designa-
tion by the Read option R( ): Reads from PLC.
(Reads bits 0 to 11 of word as 3-digit BCD.)

Effective address:
The first word + (The linear expression including N)

or the linear expression

including N or the wildcard (*)

Read/ Write option
R: Read from the PLC
W:

Write to the PLC
Conversion direction
Blank: Forward direction
~: Reverse direction

Conversion attribute

Blank:  Unconverted
$: ASCII conversion
&: Hexadecimal conversion
Note 1. How to designate a word.
How to designate Syml_:)ol to be Example
aword designated When linear When linear
expression expression
including N=0 including N=2N+1
Operand None Cannot be set. R(2N+1)
designation
Link word 01,11, 02, 12 R(0O1) R(O1+2N+1)
designation
Direct designation | CIOLICIL], R(DMO0000) R(DMO0000+2N+1)
WRLIIOIC
(note 2), LRLIC]
(note 3), HRLIL],
AR,
DML,
EMLICIC]
[1: Word #

2. For CS/CJ.
3. For C200HX/HG/HE.

Note For converted variables:
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When the frame format of instructions (commands) that the partner Unit can
translate is configured by ASCII code, the numeric hexadecimal data in the I/
O memory has to be converted to hexadecimal data by $(, ) before it is sent,
and the numeric ASCII data has to be converted to hexadecimal data by &(, )
before it is received.

When converting data (hexadecimal data) in the I/O memory into ASCII
code before sending

Example: Convert a 6-digit numeric value (3 bytes in the I/O memory) for DM 0000 into
ASCII in the reverse direction

15 0
DM0000, 5 =6 =7 =8

$~(,) —— | 35 |3 |37 |38 |31 | 32|

— ‘
1 —» 2 On the g "g" ngu ng nqn nou
‘ : transmission path

How to designate:$ ~ (R (DM0000) 6)

Number of bytes in the transmission path
(after ASCII conversion)

Read from DMO00O

Reverse direction

Hexadecimal —— ASCII conversion

When converting the numeric data (ASCIl data) from the external device
into the hexadecimal data and receiving and writing it

Example: Converting a 5-digit numeric data (5 bytes in ASCII data) into hexadecimal,
and writing it from DM 0000 in the reverse direction.

15 0
31323333 | —+&(,) - D™moooo 1 -2 -3 =4
wQnompmowguo o wge o oege On the 57 —~0 )

transmission path

How to designate: & (W (DM0000), 5)

Number of bytes in the transmission path

Read from DM0O00O

Reverse direction

ASCIl— Hexadecimal conversion

Users can set the following contents on the X and Y of variable (X,Y).
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2. Contents of Xand Y

How to set X and Y Specification Example Items available
Send Receive
Address | Data | Address | Data
How | Reading/ | Word Operand | R (2) (R(1),1) 0] 0] (0] 0]
to writing reading |address- ‘ ] | The system reads
set |[the I/O ing First word + (Lin- | one byte from the
X memory €ar expres- | third operand (for

isrllon’\ll?clud- CS/CJ) or second
9 operand (for
C200HX/HG/HE) of
Read option |the PMCR
instruction + 1
location to send it

Read from the with no conversion.

Link first word + $(R(O1+5),2) O o o O
word (yN + x) word | The system reads 2

address- bytes from the 5th

ing word in the link

word’s output area
1to send it with
conversion to ASCII

form.
Direct $(R(DM0000).3) ] ] O 0]
address- The system reads 3
ing bytes from DM 0000

to send it with con-
version to ASCII
form.

Reading/ | Word Operand | W (z) (W(1).1) --- @) --- @)
writing writing | address- \ The system writes

the I/O ing First word + one byte of receive
memory (Linear ex data to the (fourth
pression In operand of the
cluding N) PMCR instruction +
1)th word (for CS/CJ)
or the (third operand
— Write option of the PMCR

Read from the instruction +1)th

first word + word (for C200HX/
(YN + x) word HG/HE) with no
conversion.

Link &(W(11+5),2) 0] @)
word The system writes 2
address- bytes of receive data
ing to the input area 1 of
the link word’s 5th
word with
hexadecimal
conversion.

Direct &(W(LR0O060),3)

address- The system writes 3
ing bytes of receive data
to LRO060 with
conversion to
hexadecimal form.

O
O
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How to set X and Y Specification Example Items available
Send Receive
Address | Data | Address | Data
How | Wildcard Can be set only in With (x, 2) - o --- o
to the address part or | designated in the
set data part of the address part, 2 bytes
X receive message. can be received from
« Setting the wildcard | any address.
in the address part: With (x, 5)
The system designated in the
receives all the address part, 5 bytes
messages without | ¢an be received from
checking the any address.
address data.
 Setting the wildcard
in the data part:
The system
receives all data
without checking
the received data.
N (repeat counter) N (N, 1) repeat ] ] o] @]
counter value
How | Linear expression including N 3ﬂ+7xL $(R(1),2) (@) (@) (0] @)
to (repeat counter) The system
set gg{‘ssttﬁgt' repeatedly reads 2
Y number of bytes starting at
bytes word No. (third
(1-255). operand of the
PMCR instruction +
Repeat counter | 1) (for CS/CJ) or
value word No. (second
Coefficient operand of the
(0-255). PMCR instruction +
1) (for C200HX/HG/
HE) to send as
ASCII.
Wildcard Can be set only in &(W(1),*) 0 0
the data part of the | The system receives
receive message. data from the fourth
Setting the wildcard | operand (for CS/CJ)
in the data part The | or the third operand
system receives all | (for C200HX/HG/HE)
the messages of the PMCR instruc-
without checking the |tion + 1 to store it
received data. with conversion to
However, if x is a hexadecimal form
linear expression regardless of the
including N, this length.
setting is not
possible.
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How to set X and Y

Specification

Example

Iltems available

Send

Receive

Address | Data | Address

Data

How
to
set

1/0 Word
read

Chan-
nel read

Operand
designa-
tion

Link
word

Direct

R @

First word
+ (linear
expression
including
N)

Read option

The content of the
low-order byte of
the first word + (yN
+ x) word is read as
a binary value and
handled as a byte.

(*,R(1)): Setin
receive data.

Any receive data is
received by the
number of bytes of
the contents word +
1 word designated
using the fourth
operand (for CS/CJ)
or the third operand
(for C200HX/HG/
HE).

@) @] (0]

o

(R(1) , R(O1): Setin
send data. Data is
sent by the number
of bytes of the
contents of the first
word at the link word
output area 1 from
word + 1 word
designated with the
third operand (for
CS/CJ) or the sec-
ond operand (for
C200HX/HG/HE) of
a PMCR instruction.

(R (DM0000),

R (DM0100)): Setin
send data. Data
starting from
DMO0000 and
corresponding to the
number of bytes set
in DM0100 is sent.
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Examples of the Variable Reading from CPU Unit to PMSU.

No conversion

(R(D00OO), a)E — [s6 [78 [ 12 |
YT
Byte count
Reverse direction no
conversion 558
DO000 | 56 a78

= (D000, 3) e[ B — [ T5s [15]

PP E—

Byte count

ASCII conversion
D0000 | 56 in 78

$ (R(oooooyeﬁ D000t |15 =54 —[35 [36 [37 [38 [31 [32 |
S e s e e

Byte count
Reverse direction ASCII
conversion
Doooo
5 RE000D) 6) pocor R
Byte count
HEX conversion DMO000O %
& (R(DM0000), 3) DMooo1 | 851536 | —p[ 34 | 56 | 78 |

—[__Byle count DMoo02 m

Reverse-direction

HEX conversion pmoooo | 37 P38 |
&(R(DM0000), 3) DM0001 E’E —»[ 75 [ 56 | 32 |
“T__Byte count pMmooo2 | 33P a4 |

Writing from PMSU to CPU Unit

No conversion
(W(D0000), 5) [31 [32 [33 [34 [ 35| -
— e g ge agr v
—— Note
Reverse direction
no conversion
(a1 [s2 [33 [ a4 35 ] -
~ (W(D000O0), 5) v g g
Byte count Note
ASCII conversion omoooe  [EEEET
$(W(DM0000). 3) —> omooor [ 33 fea |
Byte count DM0002 -31 %ﬂ
Reverse direction ASCII conversion
oMoooo | 317 P32 |
$7(W (DM0000), 3) —> DMooo1 | 33 1>34 |
Byte count DM0002 m’
HEX conversion
[at T2 [33 [3a [35 ] —_ Doooo| 12
& (W(D0000), 5) g g g e D0001 | 50" = 00|
]
Byte count Note
Reverse direction
HEX conversion (31 Ts2 [35 [ o4 [35 ]
—
& (W(D0000), 5) v g g -
Byte count °

Note “0”is stored in an empty bit in a word whose write data is less than 16 when
writing to the CPU Unit.
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When the receive data has variable length, use the wildcard (*).

No conversion
(W(DM0000), *)

—

[31 [32 [33 [34 35 [36]37]
o g g e e

The system stores all the data that were received on DM0000

and after.

+—— Note

HEX conversion
& (W(DM0000), *)

(o1 [s2 |33 [oa [ [36 [o7] —. DMoooo| 4567 |
- o 3 g m g DMo0001| 0123

~ | Note

No conversion

¢, 5)

The system reads 5 bytes of data to discard them. Use when data
need not to be stored in the relay area and no error ispermissdle for

anydata contents.

When converting to hexadecimal, convert data other than numerical data in the following way:
* The negative sign (-) is recognized as a minus value and the highest digit is
stored as F hexadecimal.

* The decimal point is ignored when the data is stored.
* Symbols and characters other than 0 to F are stored as 0 hexadecimal.

Receive data string

(Example)
HEX: 2D 3132333435
ASCI: — 1 2 3 45

ASCIl: 1 2 3

HEX: 3132332E3435
4 5

HEX: 31 2F 33343536
ASCI: 1/ 3 4 G 6

Variable (ASCII to After conversion
hexadecimal conversion)

& (W(DM000.6) DMO0000 | 23 ' 45

DM00OO1 [ FO ' 01

DM0000 | 23 ~ 45

DMO0001 | 00 ' 01

DMO0000 [ 34 ° 06

DMO001 [ 00 ' 10

When converting from hexadecimal, convert data other than numerical data in the following way:
* The negative sign (-) is treated as a symbol and stored as 0 hexadecimal.

* The decimal point is ignored when the data is stored.

Symbols and characters other than 0 to F are stored as 0 hexadecimal.

Receive data string

(Example)
HEX: 2D 3132333435
ASCI: — 1 2 3 45

ASCIl: 1 2 3

HEX: 3132332E3435
4 5

HEX: 31 2F 33343536
ASCIl: 1/ 3 4 G 6

Variable (ASCII to After conversion
hexadecimal conversion)

& (W(DM000,6) DMO00O [ 01 ' 23

DMO001 [_45 " 00

DM0000 | 12 ° 34

DMO0001 | 50 ' 00

DMO000 | 10 ' 34

DMO001 | 06 ' 00

Note Error Check Code

For protocol macros, the following 8 types of check code can be set:

Calculation Data type Reverse Initial value
method direction
(see note 1)
LRC (see note |BIN 1 byte Unavailable 0-255
2) ASCII 2 byte Available
(see note 2)
113
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Calculation Data type Reverse Initial value
method direction
(see note 1)
Sum BIN 1 byte Unavailable 0-255
(1 byte) ASCII 2 byte Available
Sum BIN 2 byte Available 0-65535
(2 bytes) ASCII 4 byte Available
Sum2 BIN 1 byte Unavailable 0-255
(1 byte) ASCII 2 byte Available
Sum?2 BIN 2 byte Available 0-65535
(2 bytes) ASCII 4 byte Available
CRC-CCITT BIN 2 byte Available
ASCII 4 byte Available
CRC-16 BIN 2 byte Available 0-65535
ASCII 4 byte Available
LRC2 (see BIN 1 byte Unavailable 0-255
note 3) ASCII 2 byte Available
SUML1 (see BIN 1 byte Unavailable 0-255
note 3) -
(1 byte) ASCII 2 byte Available
SUML1 (see BIN 2 byte Available 0-65535
note 3) -
(2 bytes) ASCII 4 byte Available

Note 1. Swap between high byte and low byte of the error check code is possible
for CS/CJ, and is also possible for C200HX/HG/HE when the Communica-
tions Board is the C200HW-COMLILI-EV1.

2. The host link (SYSMAC WAY) uses an error check code: LRC ASCII 2-byte
(sequential direction).

3. With CS/CJ protocol macro.

Calculation Examples

The following message items are used to calculate the check code when the
initial value is 0.

00 52 44 38 39

Calculation items

1,2,3... 1. LRC (Longitudinal Redundancy Check)

This mode calculates the exclusive OR (XOR) of the characters of a set of
data to create a check code.
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00 hexadecimal
XOR
52 hexadecimal

XOR
44 hexadecimal

XOR
3) 38 hexadecimal

XOR
(4) 39 hexadecimal
I:l 17 hexadecimal

Calculation result \ ,

1 byte E : Check Code
LRC 2byte ASCII 005244 38 3931 370D
LRC 2byte ASCII 005244 383937 310D
LRC 1lbyte ASCII 005244383917 0D

Note LCR2 is the 2's complement of the LCR calculation result.
2. SUM
This mode adds arithmetically the characters of a set of data to create a

check code. Users can designate either of the directions for storing the
SUM, as with variables.

Initial value 00 Hex
o 52 Hex
@ 44 Hex
® 38 Hex
Discarded “ ® 39 Hex
Calculation : ] SUM 107 Hex
result H I '
N
1 byte
2 bytes

E : Check Code

SUM (1 byte) ASCII 2byte 00 52 44 38 39 30 37 OD

SUM (2 byte) ASCII 4byte 00 52 44 38 39 30 31 30 37 OD
SUM (1 byte) BIN 1lbyte 00 52 44 38 39 07 0D

SUM (2 byte) BIN 2byte 00 52 44 38 39 01 07 OD
“SUM (1 byte) ASCII 2byte 00 52 44 38 39 37 30 OD
“SUM (2 byte) ASCII 4byte 00 52 44 38 39 31 30 37 30 0D
“SUM (2 byte) BIN 2byte 00 52 44 38 39 07 01 OD

Note SUML1 is the 1's complement (bit reversal) of SUM.
SUM2 is the 2’s complement of SUM.

3. CRC (Cyclic Redundancy Check Code)

This mode regards the whole data as a bit string (message polynomial),
divides this string by the fixed constant (generative polynomial), and de-
fines the remainder as the check code.
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CRC detects errors better than the vertical parity or horizontal parity, and
is used widely in LANS, etc. (For example, the SYSMAC LINK uses CRC-
CCITT.)

Various kinds of CRC can be used. The calculation mode defined accord-
ing to the CCITT recommendation is called CRC-CCITT, where

X16+x12+X5+1 is used as the generative polynomial. (Incidentally, CRC-16
(X16+X12+X2+1) is also often used as a generating polynomial.)

E : Check Code

CRT-CCITT 4byte ASCII 02 52 44 38 39 33 36 46 42 0D
CRT-CCITT 2byte BIN 02 52 44 38 39 36 FB 0D
CRT-16 4byte ASCII 02 52 44 38 39 42 46 46 41 0D
CRT-16 2byte BIN 02 52 44 38 39 BF FA 0D

Note Reverse direction is available. Default value can be set for the
CRC-16

The generating function in the calculation mode of the CRC is uniquely de-
termined as CRC-CCITT or CRC-16. Data for each character of CRC-
CCITT is treated differently from that for CRC-16 as shown below.

If a message with “n” characters, which is subject to check code calcula-
tion, is expressed as shown in the following table, the MSB (most signifi-
cant bit) and LSB (least significant bit) in every character for CRC-16 will
be reversed as shown in the following tables.

Co Cy Cha
DO(7) to DO(0) D1(7) to D1(0) Dn-1(7) to Dn-1(0)
Note D: O or 1
CRC-CCITT
Co Cy - Ch1
DO(7) DO(6) to DO(0) | D1(7) D1(6) to D1(0) |— Dn-1(7) Dn-1(6) to
Dn-1(0)
CRC-16
Co Cy Cn1
DO(0) DO(1) to DO(7) | D1(0) D1(1) to D1(7) |— Dn-1(0) Dn-1(1) to
Dn-1(7)

Therefore, algorithm for each one becomes as shown below.
* CRC-CCITT algorithm

Gg:' o e D]] shift register
LIHH" HHHH—A)—D_—LD‘@

\ /]
/ Data input

The last value is determined
as the check code.
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* CRC-16 algorithm

X16 xlz XZ
MSB LSB
—[ I ]——[IIIIIITIIT]—®—[[]—
T \— The last value is determined
. as the check code.
Data input

3-4-9 Supplemental Notes on Message Setup

1,2,3... 1. Designating more than one constant or variable
To designate more than one constant or variable, use “+” as follows:

Example: Sending a command (“RX0” + word number + “00” (code number)) to deter-
mine the PV (process value) of the Temperature Controller.

“RX0” + $(N,1) + “00”

2

A message “RXONOO” (N is the value of the repeat counter, 0-255) is sent.
N = 0: “RX0000”

N = 1: “RX0100”

N = 2: “RX0200"

2. Word writing for receive messages
For receive messages, the system needs to compare the “address part” of
the message frame that was received, confirm whether this part has the
self unit number or not, receive the data part if so, and store this “data part”
to the appropriate area on the PLC by “word writing.”

« Designate the data needed for comparison such as an address using
a constant, variable with constant X, variable (word reading), wildcard,
etc.

« Designate the data necessary to be stored to the area on the PLC us-
ing a “variable (word writing).”

Example: Comparing the address part (2 bytes long) and receiving the data part suc-
ceeding the address part to store in the /O memory on the PLC.

Address Designation:

: $(R(1),2) When the received message is for the receiver (the received ad-

dress is the same as the address (1 byte long) set in the third operand (CS/

CJ) or second operand (C200HX/HG/HE) of the PMCR instruction + 1, and

converted to ASCII, the data part succeeding this address part will be re-

ceived.

Note The message to be compared (expected message) is word read (R
option).

: (*,2) Whichever unit address the destination of the receive message has,

the data part succeeding the address part is received.

Note For the address part, the wildcard (*) can be used only on X.

Data Addressing:

: &(W(1), *) The data that was received is written to the fourth operand

(CS/CJ) or the third operand (C200HX/HG/HE) of the PMCR + 1 in hexa-

decimal regardless of the length.

Note To store the data that was received into the area on the PLC, use
word writing (W option) to designate.
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Example: Comparing some part of the receive data and storing the other part of the
data to the PLC area.
The system checks the command string “TX==" in the data that were received,
and then stores the succeeding data to the area in the PLC.

Data Designation:

“TX"+(*,2)+&(W(1), *) When receiving the command TX, the system does
not compare the next 2 bytes of data, and stores the subsequent data in
hexadecimal regardless of the length.

« If the wildcard (*) is set at the data size part of “variable (word write),” the
actual data size will be determined at one of the following times:

For the CS/CJ, when the message length reaches the maximum number
of bytes under PLC Setup (allocated DM area m+9, m+19).

For the C200HX/HG/HE, when the message length reaches 256 bytes with
no flow control, or when the message length reaches 200 bytes with flow
control.

When delimiting factors in the following data (terminator, constants) allow
data-size recognition.

Note Constants will be recognized as delimiters only up to 4 bytes.

« If the wildcards are set at the data sizes of consecutively designated “vari-
ables (words write)” (separated by “+”), only the first “variable (word write)”
is effective.

For example, (W(1), *)+(W(10), *) is equal to (W(1), *).

If the wildcards are set at the data sizes of consecutively designated “vari-
ables (words write)” or “variables (words read)” (separated by “+”), only the
first “variable (word write)” is effective.

For example, (W(1), *)+(R(2), 8) is equal to (W(1), *).

If “+”s separated by a constant or a check code of less than 5 bytes are des-
ignated between “variables (words write)” the data sizes of which are set as
wildcards, the constant or the check code is deemed a delimiter.

For example, if “12345ABC5678” is received while (W(1),
*)+"ABC"+(W(10), *) is set, “12345" corresponds to (W(1), *) and “5678"
corresponds to (W(10), *).

If “+”s separated by a constant or an error check code of more than 4 bytes
are designated between “variables (words write)” or “variables (words
read),” the data sizes of which are set as wildcards, only the first “variables
(words write)” is effective.

For example, if “12345ABCDE56789” is received while (W(5),
*)+*ABCDE"+(R(2), 8) is set, “12345ABCDE56789” will correspond to
(W(5), *). The (R(2), 8) setting will be ignored.

When there is an error check code <c> after a “variables (words write)” set
with a wildcard, the error check code will be calculated if the position of the
error check code itself can be be located within the receive message. Such
a condition is satisfied at the following times.

When the position of the error check code itself relative to the start can be
calculated.
For example: <h>+(W(2), 10)+<c>

When the position relative to the delimiter (terminator, constant) following
the error check code can be calculated.
For example: <h>+(W(5), *)+<c>+<t>
<h>+(W(5), *)+<c>+"ABC"+<t>
<h>+(W(5), *)+<c>+"ABC"+(W(5), *)+<t>
Note Only constants of less than 4 bytes will be recognized as delimiters.
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As in the following examples, if the position of the error check code itself
within the receive message cannot be located, it will not be calculated.

For example:

tion device.

<h>+(W(5), *)+<c>

<h>+(W(5), *)+<c>+(W(5), *)

<h>+(W(5), *)+<c>+“ABCDE"+(W(5), *)

3. Setting the header, error check code, and terminator

* For the header or terminator, various special codes such as @, CR, LF,

STX, or ETX are used according to the communications destination device.
Always set on the message the same header or terminator as the destina-

* There are several different kinds of error check code such as SUM, LRC,
CRC-CCITT, that may be used by the communications partner. Make sure
that the error check code set in the message corresponds to that used by
the communications partner.

* Most external devices can send or receive only ASCII codes. In this case,
convert the hexadecimal code into ASCIl before sending and convert
received data from ASCII to hexadecimal conversion before storage. Con-
sider the data format and reading/writing direction which allows sending/
receiving of the destination device, and convert it into a data format which
can be handled with the data conversion-available variable before sending

and receiving.

3-5 Creating Matrices

Matrices are set when more than one receive messages are expected to be
received or when users want to change next process for each receive mes-

Receive

—

sage.

Up to 15 types of message can be set in a matrix (case No0.00 tol14). In a
matrix, next processes such as End, Next, Goto**, or Abort are set for each
one of the up to 15 types of receive (expected) message.

“Other” must also be set to enable processing when some message other
than the receive messages designated in the matrix is received.

Note

The attribute by which the system compares the expected value with the actu-

ally received value in the matrix is not of data, but of messages.
If only “other” is set, a protocol data syntax error (error code: 4) will occur.

Matrix

Received message

<h> | <a> | Data|<c> | <t>

<h>: Header

<a>: Address

<c>: Error check code
<t>: Terminator

! [Receive (expected) message]

<h> |<a> |Data|<c> | <t>
<h> |<a> |Data|<c> | <t>
<h> |<a> |Data|<c> | <t>

Other (must be set.)

—

[ Next process |I

Goto, Next,
End, Abort

Goto, Next,
End, Abort

Goto, Next,
End, Abort

Goto, Next,
End, Abort

Note: Maximum of 16 cases are possible including "Other."
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Note Set the format for the messages in the matrix to be the same for all cases.
The matrix opens up messages under the frame configuration designated in
case number 00, and performs a comparison with all the cases in order from
case number 00 to case number 15.

Actually received message
Receive | l
—

Case No. 00 Opens up message with case number 00 as standard

|<h> I <a> | Data l <c> | <t> l

Case No. 00
l <h> I <a> l Datal <c> l <t>]*—r’] <h> I <a> I Data l <c> ] <t>

Comp:’;\rison
! Case No.01

I N

"’I <h> l<a>l Datal <c>l <t> l > 15 max.

Case No. 14
"l <h> l <a> ' Data | <c> l <t> ]J

Therefore, if there are differences in message formats between cases
because messages are opened up using the frame configuration of case
number 00, comparison results for frames with a different message format
from case number 00 will register a non-match, irrespective of the actually
received message.

However, with the CS/CJ, the following operation that combines length desig-
nation and matrix, will be possible. (Not possible with C200HX/HG/HE.) With
case number 00, the message is opened up using the length designation, and
is compared with case numbers 00 to n. Even if the message lengths for the
cases 00 to n are different, the comparison will be performed correctly.

Example of Matrix

As an example, the following matrix is used:

Case No. 0: <h>+<I>+“W"+(W(1), *)

Case No. 1: <h>+<I>+"R"+(W(1), *)

Case No. 2: <h>+<I>+“C"+(W(1), *)

(<h>=@)

If “@5W01234" is received, it will match with case number 0. (W(1),
*)="01234"

If “@8R01234567” is received, it will match with case number 1. (W(1),
*)="01234567""

If “@3C012" is received, it will match with case number 2. (W(1), *)="012"

Note Error check code or terminator can be appended.

Example: Via the host link (SYSMAC WAY), change over the process according to the
response (PROGRAM/MONITOR/RUN mode) for the status read command.
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— PMSU
Host link MS command LResponse PLC
{
* Issue an MS command. o o arrom
Transmission message: | @"+"00"+"MS"+LRC+{2A0D] |
(expected)
* Receive a response. Receive message Next process
Matrix: Case No.00 ||| @"+"00"+"MS“+"00"+rIOOI|+(*,*)+LRC+[2AOD]| Go 1o 01
Program mode code
Header End code
Address Host
link command

Case No.01 |'@"+"00"+"MS"+"00"+02}+(*,*)+LRC~+[2A0D]| Go to 02

Monitor mode

Case No.02 |"@"+"00"+"MS"+"00"+08'+(*,")+LRC+2A0D]| Go to 03

RUN mode
Case No.03 Others

By using the matrix, identify the difference in the status in the response data

(section in the above), and change over the process according to the mode of
the PLC.

Matrix Example Change over the process according to the ACK, NAK reception.

In the following example, the entire message structure is omitted and only
data is indicated with “”.
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Step No. 00

Send&Receive

Receive
"ACK"

Next

Step No. 01

Send&Receive

IReceive ”Other”l l Receive "AC K"i lReceive "NAK‘I

1

Step No. 02| Goto

Yes ¢
r End | | Abort
Step structure
Step No.| Repeat Command Retry Send Send Receive Response Next Error
counter wait message | message type process process
00 R/001 | Send&Receive "ENQ" "ACK" Next Goto 00
01 R/001 | Send&Receive 1ls Message Matrix Goto 00
02 R/001 | Send&Receive "EOT" End Abort
Matrix
Case No. Receive Next
message process Set next processes (End, Next, Goto**, or Abort)
— for each one of the up to 15 types of receive
00 "ACK" Goto02 message.
01 "NAK" Goto01 —— For "Other" case, set the next process to be
executed when the message that was received is
- --- not equal to any of the expected messages.
15 Other Abort

Note Set same header and same terminator for all the receive messages set by the
matrix. If headers or terminators are different by case number, the system
shall make a comparison for the received message based on the header and
the terminator (or the data length, if the terminator is unavailable) of a
received message set as case number 00. For example, therefore, if the
header of case number 00 is “@” and the header of case number 01 is
[02](STX), the system identifies that the comparison results in the unmatched
even if the header of actually received message is [02], because it is different
from the header “@” of case number 00
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3-6 Examples of Standard System Protocols

3-6-1 Example: “Process Value Read” Sequence of the “Controller
(E5_K Read)” Protocol
Level Item Contents of setting

Sequence Link word
Transmission control parameter Modem control
Response Type Scan
Receive wait monitoring time Tr 3s
Receive finish monitoring time Tfr | 3s
Send finish monitoring time Tfs 3s

Step Step No. 00
Repeat counter RSET/001
Command Send&Receive
Retry counter 3
Send wait time ---
Send message SD(00)_1
Receive message RV(00)_1
With/Without response writing Yes
Next process End
Error process Abort

Send message Header <h> Q"

SD(00)_1 Terminator <t> [2A0D]

Error check code <c>

LRC (H parity) (0) (2-byte ASCII)

Length <I>

Address <a>

$(R(1),2)

Message editing

<h>+<a>+"1"+"00"+"0000"+<c>+<t>
.

Data

sage

Reception mes-

RV(00) 1

Header <h>

n@n

Terminator <t>

[2A0D]

Error check code <c>

LRC(H parity)(0) (2-byte ASCII)

Length<I>

Address<a>

$(R(1).2)

Message editing

<h>+<a>+"1"+"00"+"00"+&(W(1),4)+<c>+<t>
[

Data

AUDIN - 8, avenue de la malle - 51370 Saint Brice Courcelles - Tel : 03.26.04.20.21 - Fax : 03.26.04.28.20 - Web : http: www.audin.fr - Email : info@audin.fr

123



Examples of Standard System Protocols

Section 3-6

3-6-2 Example: “Modem Initialize (MD24FB10V)” Sequence of “Hayes
Modem AT Commands” Protocol

Level Iltem Contents of setting
Sequence Link word -—-
Transmission control param- | RTS/CTS flow (receive), modem control
eter
Response type Scan
Receive wait monitoring time | 10s
Tr
Receive finish monitoring -—-
time Tfr
Send finish monitoring time | ---
Tfs
Step Step No. 00 01 02
Repeat counter RSET/001 RSET/001 RSET/001
Command Send&Receive Send&Receive | Send&Receive
Retry counter 0 0 0
Send wait time --- 1s 1s
Send message MD24FB10V MD24FB10V MD24FB10V
Receive message <Initial-R1> <Initial-R2> <Initial-R3>
With/Without response writ- | None None None
ing
Next process Matrix Matrix Matrix
Error process Goto 1 Goto 2 Abort
Send Header <h>
message Terminator <t> CR
MD24FB10V
Error check code <c> -
Length <I> ---
Address <a>
Message editing "ATEOVOX4W2\N3%CO*CO\X1&MO"+'S26=10"+<t>
\ |
Data
Matrix Case No. 00
<In!t!aI-R1> Receive message RxD.0
<Initial-R2>
<Initial-R3> | Next process End
Receive Header <h> -
message Terminator <t> CR
RXD.0
Error check code <c>
Length <I> -
Address <a> -
Message editing "0+ <t>
(|
Data
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3-7 Example of Communications Sequence

Shown below is an example of sequence to read process values from a 8CH
type temperature controller (E5ZE):

3-7-1 Sequence Setup Content

Sequence No. 101

Link word

Transmission
control mode

Response type Monitor time Tr Monitor time Tfr Monitor time Tfs

Modem control

Scan mode 3s 3s 3s

3-7-2 Step Setup Content

Normal

Abnormal

Create a process flow as follows:
Step No. 00

Retry possible

Send the read command up to 3 times.

for process value

Send & Receive

Receive the
response

Error occurrence

Normal

Current value of Repeat
Counter
N=8

End Abort

The system sends the read command for a process value and waits the
response from the Temperature Controller. It converts the process value data
to hexadecimal codes and store them in 1/O memory. It uses the repeat
counter to switch the PLC area, sends the read command for the next process
value until eight words of process values are read and stored in the PLC
areas.

According to a set retry count (three times), the same step is repeatedly exe-
cuted up to three times automatically when any of the following errors occurs:

* The send finish monitoring time Tfs, the receive wait monitoring time Tr,
or the receive finish monitoring time Tfr has expired.

* A receiving communication error occurred (For CS/CJ, port 1: n+8 bit 15,
port 2: n+18 bit 15 is “ON”, n=1,900 (board), 1,500+25xUnit No. (unit).
For C200HX/HG/HE, port A: CI028304 or port B: 28312 is “ON”).

* Wrong receive message.
* An error in the error check code.
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Example of Communications Sequence Section 3-7
Step No. 00
Repeat Command | Retry count | Send wait | Send mes- | Receive With/Without | Next pro- Error pro-
counter time sage message | response writ- | cess cess
ing
RSET/008 |Send& 3 Refer to Refer to Yes End Abort
Receive page 126, |page 127,

Send Mes- | Receive

sage Cre- |Message

ation Creation

* 1 Step i Repeat

1 Cammand

i Retr: i Send Wait 1 Send hWessage ; Recw hWes=age i Rezponse i et i Errar

E Aar
@ 00

£)

RSETA008 Send & Receive 3

SOOR

R R 1

es

End Abaort

3-7-3 Send and Receive Messages Creation

The system can read the PV (process variable) of the designated word on the
temperature controller (E5ZE) by sending the “RXONOOQ” (N is the word num-
ber of the controller) command. Only one word of data can be read in one
time of data sending or receiving. When reading 8 words of data, it is neces-

sary to execute the Send&Receive command 8 times repeatedly.

Send message

Example: A frame of read command for the process variable

I I I
Umt R X (0] Word O (0] FCS .
| |
Header Address Data Check code Terminator

x | Send Messagel Header (h)| Terminator (t)|

Gheck code {c2

|Leneth <1>|Address <a>|

ke SO0 1

[2A00]

LRG (H parityid) (2Bvte ASGID

Receive message
Example: A frame of the response to the read command for the process variable

BRI 02D

I I I I I I I
Unlt R X | End code Process variable FCS * | L
| | | | | |
Header Address Data Check code Terminator

<h>+<a>+—|

x |Receive Messagel Header <h>| Terminator <t>|

Check code <{c>

|Leneth <1>| Address <a>|

far [F 0071 |

Send Message Creation
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PMCR

[

DM0000

DMO0000
+1CH

[2a0D]

LRGC {H parityd(D) (2Byte ASCID

FROL2D

<h>+<=—|

* Designating the unit number as 2 characters (1 byte) beginning from the
third operand (second operand for C200HX/HG/HE) of the PMCR instruc-

tion + 1
1b 1 byte 1 byte
/ \ HEX to ASCII
- -- (ASCi ode
Unit number
\ / 12 is specified

3rd (2nd for C200HX/HG/HE) operand

— Specify $(R(1),2)

2 bytes
3rd (2nd for C200HX/HG/HE) operand-designated word+1 word of the PMCR instruction

Means the number of bytes
after ASCII conversion.

Conversion to ASCII data

as the address.
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Example of Communications Sequence Section 3-7

* Designating the word number of the measured temperature as 1 digit of
the repeat counter N

1 byte
N=0-7 HEX to ASCII
__conversion (ASCII code)
15 00 v -
15, specity $ (1) When N = 1, word number

1 is specified.
1 bytes
Repeat counter's value
Conversion to ASCII data

As a result, create the send message as follows.

T T
@| Unit [R|{X |0 MWorq 0| O FCS | ~
1

T =

Header Address . Data Check code

Terminator

Al
“@" + & R(1),2) + "RXO"+$( N, 1)+"00"+LRC(HParity)(0)(2byte ASC) + [2A0D]

Receive Message Creation

* When reading the data of the measured temperature from the word desig-
nated by the fourth operand (third operand for C200HX/HG/HE) of the
PMCR instruction + (2N + 1) without fixing the length.

Note N means the value of the repeat counter.

PMCR DM0100
N=0 +1 [T ]
<« - 4 bytes
‘ +2 } L 1]

DMO100) N=1 +3 } ]

" «— : l 4 bytes

4th operand

P
(3rd for C200HX/HG/HE) /\/

—>  Specify & (W(2N+1)F).

Data length (byte)

Word set by 4th (3rd for C200HX/HG/HE)
operand of PMCR instruction+2N+1

Conversion to HEX data

Create the receive message as follows.

T T T T T

. Measured *
@ U?It R Xjo0f0 | temperature FICS
\T\ 7 Ll 7\ < 7
Header  Address Data Check code Terminator

@ "+ $(R(1),2)+"RX00" +& (W (2N + 1), )  +LRC (HParity) (0) (2 byte ASC) + [2A0D]

Means that the system reads the data between RX00
and the check code, converts the data from ASCII to
Hex, and writes the converted data to the address of
the fourth (third for C200HX/HG/HE) operand of the
PMCR instruction + (2N+1)
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Executing a Created Communications Sequence (CS/CJ) Section 3-8

3-7-4 Contents of Sequence

“Measuring temperature read” in sequence No. 101 of “Temp Controller
(E5ZE read) protocol.”

» Sequence attribute setting

Iltem Contents
Link word No setting
Transmission control parameter Modem control available
Response type Scan
Receive wait monitoring time (Tr) 3s
Receive finish monitoring time (Tfr) 3s
Send finish monitoring time (Tfs) 3s

« Step attribute setting
Step 00 (only)

Iltem Contents

Repeat counter Repeat type: Reset
Counter: 8 (constant)

Command Send & Receive
No. of retries 3
Send wait time None
Send message Message name: SD (RX)_1
Receive message Message name: RV (RX)_1
With/Without Response Writing Yes
Next process End
Error process Abort

* Presence of send/receive message
Send message name <SD(RX)_1>

"@"+$(R(1),2)+"RX0"+$(N,1)+"00"+LRC(H parity)(0)(2 Byte ASCII)+[2A0D]

1 !

Header Address Data Check code Terminator

Receive message name <RV(RX)_1>

"@"+$(R(1),2)+"RX00"+&(W(2N+1),9)+LRC(H parity)(0)(2 Byte ASCII)+[2A0D]

I l ! |

Header Address Data Check code Terminator

3-8 Executing a Created Communications Sequence (CS/CJ)

This section describes how to execute the communications sequence
described so far using a CS/CJ PLC. It is necessary to transfer the protocol
that was created to the Serial Communications Board/Unit in advance. How-
ever, the previously mentioned communications sequence is registered in
sequence number 101 of the incorporated standard system protocol, so the
following describes the procedure for executing sequence number 101.

Note It is assumed that the standard protocol is under the initial status. When the
sequence is changed, for example, by the CX-Protocol, return to the original
sequence before execution.
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Executi nga Created Communications Sequence (CS/CJ) Section 3-8

3-8-1 Device Connection

For example, a CS PLC, CS1W-SC41 Serial Communications Board, and
E5ZE Temperature Controller are connected as follows.

[ |—

CS1+CS1W-SCB41 -—

Temperature
input

8 channels

i —
pill

ESZE

Port 2 of Serial Com-
munications Board

Eight points of measured temperature are stored in DM 00101 to DM 00116.

Measured temperature

DMo101 Word 0 lower part
DMo0102 Word 0 upper part
DMo103 ‘Word 1 lower part
DMo104 Word 1 upper par]

DM0115 | Word 7 lower part
DMo116 Word 7 upper pal

3-8-2 Initial Setup

1,2,3... 1. Set the DIP switch on the Serial Communications Board.

OFFC:D ON Terminator switch OFF: Without terminator ON: With terminator

2 @ 4 Wire switch 2: 2-wire type 4: 4-wire type
2. Setthe allocated DM area for the CS/CJ as follows:
Address Set value Contents
(see note)
D32010 0600 Treats the protocol macro as the communications mode
and takes the standard communications conditions.
D32011 0000 Standard baud rate.
D32018 0000 Half-duplex
D32019 00Cs8 Maximum number of bytes for protocol macro send/
receive message: 200 bytes.

Note Setting address for port 2 of the Board.
Standard settings:

Start bit 1 bit

Data length 7 bits
Parity Even parity
Stop bit 2 bits

Baud rate 9,600 bps

Note For more information of the PLC setup area related to the protocol
macro function, refer to Appendix B PLC Setup and PMSU Settings.
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Executing_j a Created Communications Sequence (CS/CJ) Section 3-8

3. Set the ESZE Temperature Controller.
Set the unit number to “0” and baud rate to “9,600 bps.”

57 07" Switch Unit:
o S |l Used for setting
m %@c‘i TS the Unit number.
== &58 2 b’é‘g 12 Setto "0."
| iu‘ UNIT  INPUT
(n Switch Function:
e Duggghﬁg“ — Used for setting
|0 caessorwe the switch function.
|l FUNCTION
Switch Function
rwmvmomw OFF
L

Hardware mode

Not used (Must be OFF)

Temperature unit (°C or °F)

Operation mode when the power is ON
Connection of E5ZD-SDL Setting Indicator
Memory bank designation method

1: ON, 2: OFF (Set to 9600 bps)

Note After changing the DIP switch’s setting, turn OFF and ON the power
supply once.

3-8-3 Creating Ladder Programs

The protocol is executed by the PMCR instruction of the PLC. For details
about the related auxiliary area and allocated data areas, refer to page 141.

PMCR Instruction Specifications:

PMCR

C1
Cc2
S

D

* Function: Calls the send/receive sequence number registered in the
Serial Communications Board, and by executing the send/receive
sequence of that number, sends data to or receives data from a general-
purpose external device via port 1 or 2 of the Serial Communications
Board.

* Meaning of operands:

C: Control data

15 12 11 87 43 0 15 0
c1 : | c2
|~ Destination Unit address L Send/receive sequence
Serial Communications Unit: Unit No.+10 hexadecimal No. 000 to 03E7
Serial Communications Board: E1 hexadecimal hexadecimal (0 to 999)

Serial port number (Physical port)
1 Hexadecimal: port 1
2 Hexadecimal: port 2

Communications port number (internal logic port)
0 to 7 hexadecimal

S: First word number of send data
Set the first word of the word area where data required for sending is
stored.
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Executi nga Created Communications Sequence (CS/CJ) Section 3-8

Note When there is no send data, be sure to set to #0000.
In S, the number of words, starting from S, that contain valid send data is
stored.
In S+1 onwards, the actual send data is stored.

~N

S \',\Ivgi,g; send data ~—— How many words are valid (including S)
S+ 1 | Send data Number of valid words

D: First word number of storage area for receive data.
Set the first word of the word area in which the receive data is to be stored.

Note When there is no receive data, be sure to set to #0000.

In D, the number of valid word numbers from D+1 is stored.

In D+1 onwards, the initial data that was in the receive buffer before execution
of the send/receive sequence, and the received data is stored.

D No. of valid words <—— How many words are valid (including D)

D +1 | Receive data Number of valid words

Note The function of the receive data storage area (the data stored in the area
starting with D and continuing for the number of words indicated in D) before
the PMCR instruction is executed, differs to the function of the area after-
wards.

Before execution of PMCR instruction

The receive data storage area functions as initial value data in the receive
buffer before execution of a send/receive sequence.

After execution of PMCR instruction

The received data storage area will be used to store data received with a
Receive operation (when With/Without Response Write is set to Yes).

* Flags
Flag Label ON OFF
Error ER Turns ON upon instruction execution, if the Com- | Remains OFF in any situation not indicated under
Flag munications Port Enabled Flag for the designated | “ON."

communications port (internal logic port) is OFF.
Turns ON if the designated serial port (physical
port) is not in protocol macro mode.

Turns ON if the data in C1 or C2 is outside the

range.

Access |AER Turns ON if an area in the send data and read Remains OFF in any situation not indicated under
Error data has been set to not allow read or write. “ON.

Flag Turns ON if an area in the receive data has been

set to prohibit writing.
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Executing a Created Communications Sequence (CS/CJ) Section 3-8

» Data Contents

Area C1 | Cc2 | S | D
CIO Area (I/0, etc.) 0000 to 6143
Work Area WO000 to 511
Holding Area HO00 to 511
Auxiliary Area AO000 to 959 A448 to 959
Timer TOO00O0 to 4095
Counter C0000 to 4095
DM Area D00000 to 32767
EM Area E00000 to 32767 See note.
EM Area (including En_00000 to 32767 (n=0 to C) See note.
bank designation)
Indirect DM/EM @DO00000 to 32767 See note.
(binary) @EO00000 to 32767
@En_00000 to 32767 (n=0to C)
Indirect DM/EM (BCD) | *D00000 to 32767 See note.
*E00000 to 32767
*En_00000 to 32767 (n=0 to C)

Constants Refer to previous 0000 to 03E7 hexa- #0000 to FFFF
description. decimal (0 to 999) (binary data)
Data registers DRO to 15
Index Registers
(Direct)
Index Registers ,IRO to 15 See note.
(Indirect) —2048 to +2047,IR0 to 15

DRO to 15 ,IR0,IRO to 15
IR0 to 15+(++)
—(--)IROto 15

Note The EM area cannot be designated for the receive data with the interrupt noti-
fication function for the Serial Communications Board. If such a designation is
attempted, the Protocol Macro Syntax Error (A42410) will turn ON.

Contents of send/receive data word allocation to read the process value in
sequence No0.101 of the standard system protocol “Temp Controller (E5ZE
read)” are as follows.

Read the process value and store the result in the designated address.
» Send data word assignment (third operand of PMCR instruction)

Send data +0 | No. of send data words
starting address

+1 |(Indeterminate)|  Unit No.

Offset Contents (Data format) Data
+0 No. of send data words 0002 (fixed)
(hexadecimal 2-digit)
+1 Unit No. (hexadecimal 2- |00 to OF
digit)
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Executi nga Created Communications Sequence (CS/CJ) Section 3-8

* Receive data word assignment (fourth operand of PMCR instruction)

Receive data +0 No. of send data words
storage address

+1 Measuring temperature (rightmost 4-digit) Channel 0

+2 Measuring temperature (leftmost 1-digit)

+3 Measuring temperature (rightmost 4-digit)

- — Channel 1
+4 Measuring temperature (leftmost 1-digit)

+15 | Measuring temperature (rightmost 4-digit)
. . Channel 7
+16 | Measuring temperature (leftmost 1-digit)

Offset Contents (Data format) Data
+0 No. of receive data words 0017
(hexadecimal 2-digit)
+1 CHO Measuring temperature Differs depending on the
(rightmost 4-digit) (BCD 4-digit) |temperature measuring model.

+2 CHO Measuring temperature Refer to the E5ZE Operation
(leftmost 1-digit) (BCD 1-digit) | Manual
F denotes “~" (minus).

to to to

+15 CH7 Measuring temperature Differs depending on the
(rightmost 4-digit) (BCD 4-digit) |temperature measuring model.

+16 CH7 Measuring temperature Refer to the ESZE Operation

- Iy Manual.
leftmost 1-digit) (BCD 1-digit
(leftmost 1-digit) ( 9N | F denotes “— (minus).

Settings of the PMCR Instruction

Use communications port number 0 and serial
port number 2, with a destination unit address
El:Inner (Serial Communications) Board.

Execution
start
I +F i PMCR Set 0065 in hexadecimal because the
7 sequence number of the measured value
191915 A20200 #02E1 /— reading is 101.
Protocol Commu-
Macro nications / #0065 |
Execution Port / D000
Flag Enabled Set the address for storing the data to be
Flag / D00100 transmitted to the PMSU.

\- Set the address for storing the data to be

returned from the PMSU.

This example sets D00100 so that the mea-
surement data will be stored on and after
Set, with the 2nd digit from the left, the port D00101.

on which the protocol will be executed.
1: Port 1 (Upper port)

2: Port 2 (Lower port)

[Send Data setting]

L]
]
)
E "17" means that the 16
L}
[Receive Data Storage Location] !

1}
1]
¥
1]
1]
1]
(17-1) words, D00101 to !
&
1]
4
L]
1

' D00116, will be used as the
"2" means that the 1 (2-1) word, DO0001, will ' ) receive area.

be used as the send area. ' D00100| #0011 H
'
£l

D00101 | fygimost ' --------------------- '

D00000 | #0002

1]
—_
L}
D00001 | #0000 \j
1

t

H

:

¥

1]

t

1]

“~ Data of temperature input

Leftmost
D00102 | 1digit 1 channel 0 (measured

1]
.
.
' temperature) 2

+
.
For this sequence, set the unit numbers. ) B
The protocol communicates with ESZE with unit ! L SO iy PSP
:
L}

number 00 because the rightmost 2 digits are "00."

D00115 | fghtmost g
Leftmost ¢ Data of temperature input

""""""""""""""""""""""""""" 4 D00116} 1-digit

Note Observe the following precautions when using the PMCR instruction.
* In the following cases, set the third operand of the PMCR instruction to
the constant (#0000):
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Executing a Created Communications Sequence (CS/CJ) Section 3-8

« If an operand-designated reading variable is not used in the sequence
to be performed.

« If there is no send data word allocation when using the standard sys-
tem protocol.

Transmitting no data to the PSB

@PMCR
#02E1
#0065

Set the constant (#0000)

when transmitting no data.

* In the following cases, set the fourth operand of the PMCR instruction to
the constant (#0000) or to a dummy word.

« If an operand-designated writing variable is not used in the sequence
to be performed.

« If there is no receive data word allocation when using the standard sys-
tem protocol.

Storing no data to the data area on the PLC

@PMCR
#02E1
#0065
D0000

Set the constant (#0000)
when there is no receive

data.

3-8-4 Operation

The following describes the system’s operation when executing the ladder
program shown in 3-8-3 Creating Ladder Programs.

1,2,3... 1. When executing a PMCR instruction, the system transmits the information
set in the operand of the PMCR instruction such as the starting sequence
number and communications data storage area, and turns ON the Protocol
Macro Execution Flag (191915).

2. The PMSU reads the communication sequence with the appropriate se-
guence number set in the PMCR instruction.

3. The system sends “RX0 Channel No. 00” as the command measuring the
temperature of the Temperature Controller’s designated channel to the unit
number (00) of the E5ZE Temperature Controller stored in DM00O1.

4. The system receives “RX00” as the response from the Temperature Con-
troller (00 means the end code) from the E5ZE with unit number 00 to store
the next measured temperature into D00101 and D00102 through the PLC
scan.

5. The system increments the value of the repeat counter by 8 times repeat-
edly. Each time the repeat counter is incremented, the following contents
will be changed.

» The word number of the Temperature Controller designated by $(N,1)
in the send message changes in a range from 0 to 7.
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Execulti nga Created Communications Sequence (C200H X/HG/HE) Section 3-9

« The DM area storing the measured temperature designated by
&(W(2N+1),*) in the receive message changes as follows:

D00101 —» D00103 — DO00105 — D00107 — D00109 — DO00111 —
D00113 — D00115

6. When the system ends the execution of the sequence, the Protocol Macro
Execution Flag (191915) will turn OFF.

3-8-5 Confirming the Operation

When the process variable is not stored successfully, confirm the following
points.

* INNER continuation error.
» Confirm that the System Setup is set correctly.
* Bit 191914 (Step Error Processing Flag) is ON.

» Confirm that the System Setup is correct. (In particular, check that port
1 and port 2 are not designated conversely.)

» Confirm that the wiring is correct (refer to the CS/CJ-series Serial
Communications Boards and Serial Communications Unit (W336) for
the wiring method).

 Confirm the communication rate, frame, and unit number of the E5ZE.

* No error, but data is not stored.

 Confirm that the RUN indicator of the E5ZE is lit. (For details, refer to

the E5ZE Operation Manual (H076).)

Note When trace operation is executed from the CX-Protocol, from that point, the
Serial Communications Board performs a trace on chronological data in the
send/receive message (up to 1,700 bytes). Using this, it is possible to confirm
what kind of messages are sent and received at each step. (For details about
traces, refer to SECTION 12 Tracing and Monitoring.)

3-9 Executing a Created Communications Sequence (C200HX/
HG/HE)

This section describes how to execute the communication sequence
described so far, using a C200HX/HG/HE PLC. It is necessary to transfer the
protocol that was created to the PMSU in advance. However, the previously
mentioned communication sequence is registered in sequence number 101 of
the incorporated standard system protocol, so the following describes the pro-
cedure for executing sequence number 101.

Note It is assumed that the standard protocol is under the initial status. When the
sequence is changed, for example, by the CX-Protocol, return to the original
sequence before execution.
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Execulti nga Created Communications Sequence (C200HX/HG/HE) Section 3-9

3-9-1 Device Connection

It is assumed as an example that a C200HX PLC, C200HW-COMO06-EV1
Communications Board, and E5ZE Temperature Controller are connected as

follows.
Ui—
C200HX PLC + C200HW-COMO6-EV1 -~
Temperature input
8 channels
00
Al

RS-485 E5ZE

Port A of the Com
munications Board

Eight points of measured temperature are assumed to be stored to DM101 to
DM 116.

Measured temperature

DMo101 Word 0 lower part
DMo0102 Word 0 upper part
DMo103 ‘Word 1 lower part
DMo104 Word 1 upper par]

DM0115 | Word 7 lower part
DMo116 Word 7 upper pal

3-9-2 Initial Setup

1,2,3... 1. Setthe DIP switch on the PMSU.

2 SW1 2: 2 wire system, 4: 4 wire system
|::_' SW2 ON: Terminator available, OFF: Terminator not avaitable

4
sw2 swi

2. Setthe PLC Setup of C200HX as follows:

Note Communications mode as the protocol macro function to set the
communications requirements as follows:

DM6555: #6000

The communication requirement of port A
0: Standard setup

The mode used by port A.
Standard setup contents

Start bit 1 bit

Data length 7 bits
Parity Even parity
Stop bit 2 bits

Baud rate 9,600 bps

Note For more information of the PLC Setup area related to the protocol
macro function refer to Appendix B PLC Setup and PMSU Settings.
3. Setthe E5ZE Temperature Controller.
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Execulti nga Created Communications Sequence (C200H X/HG/HE) Section 3-9

Set the unit number to “0” and baud rate to “9,600 bps.”

<07 o Switch Unit:
pop— Sao| | ST Used for setting

- %’:@é‘; TS the Unit number.
= 1 68l 68l Set to "0."
| iL UNIT  INPUT

(n Switch Function:
| ‘E D%thgg — Used for setting

] B —aovoor® the switch function.

il FUNCTION

Switch Function
ON

E

\-NCOQ'LOCOI\CO OFF

L Hardware mode

Not used (Must be OFF)

Temperature unit (°C or °F)

Operation mode when the power is ON
Connection of E5ZD-SDL Setting Indicator
Memory bank designation method

1: ON, 2: OFF (Set to 9,600 bps)

|
-—

Note After changing the DIP switch settings, turn OFF and ON the power supply
once.

3-9-3 Creating Ladder Programs
The protocol is executed by the PMCR instruction of the PLC. For details
about related auxiliary area and data areas, refer to page 141.
* PMCR instruction specification

» Function: Calls the send/receive sequence number registered in the
PMSU, and executing the send/receive sequence of the corresponding
sending/reception sequence and sends/receives data to/from the gen-
eral-purpose external device through port A or B of the PMSU.

» Meaning of Operand:
C: Control data

— PMCR

15 12 11 8 7 0

—— Send/receive sequence
No. 000 to 999(BCD)

Port designation
1: Port A
2:PortB

S: Send data first word number
Set the first word at the data area where data required for setting is stored.
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Executing a Created Communications Sequence (C200HX/HG/HE) Section 3-9

Note When no send data is found, be sure to set to #0000. Setting to another con-
stant or word generates an error (ER Flag 25503 is ON), and the PMCR
instruction is not executed.

Send data of the number of words that are valid at S and the following are
stored in S.

Actual send data is stored in S+1 and the following.

s No. of send data

words = No. of words that are valid (including S)

S +1 | Send data

D: Receive data storage starting address number
Set the starting address at the data area where receive data is stored.

Note When no receive data is found, be sure to set a dummy word. Setting a con-
stant (#0000 to FFFF) generates an error (ER Flag 25503 is ON), and the
PMCR instruction is not executed.

Data is not written to the dummy word. It can be used for the others.
Receive data is not stored in D and the following.
The number of effective addresses is stored in D1—, D+ 1 and the following.

D No. of effective words -— No. of words that are valid (including D)

D + 1 | Receive data

* Flag
Value ON OFF
ER(25503) |+« When *DM (Indirect) is designated, the DM | Other than the

contents are not 6656 or higher or BCD. cases mentioned to
« For D, the DM contents are not 6144 or higher | the left.
or BCD.
* When the instruction is executed or already in
execution.
e When neither 1 nor 2 is designated for the
port.

» Data Contents

Model C200HX/HG/HE

Operand C S D

Internal relay area 1| 000-255 000-255 000-252
Internal relay area 2 | 256-511 256-511 256-511
Hold relay HRO00-99 HRO00-99 HRO00-99
Auxiliary relay ARO00-27 ARO00-27 ARO00-27
Link relay LR0O0-63 LR0O0-63 LR0O0-63
Timer/counter T/C000-511 T/C000-511 T/C000-511
Temporary relay --- -—- ---

Data memory D0000-6655 D0000-6655 D0000-6143
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Indirect data *D0000-6655 *D0000-6655 *D0000-6655

memory
Constant

See the above. #0000-FFFF -

Contents of send/receive data word assignment to read the process value in
sequence No.101of the standard system protocol, “Temp Controller (E5ZE
read)” are as follows:

Read the process value and store the result in the designated address.
» Send data word assignment (Second operand of PMCR instruction)

Send data No. of send data words
starting address
+1 |(Indeterminate)| Unit No.
Offset Contents (Data format) Data
+0 No. of send data words 0002 (fixed)
(BCD 4-digit)
+1 Unit No. (hexadecimal 00 to OF
2-digit)

* Receive data word assignment (Third operand of PMCR instruction)

Receive data +0 | No. of send data words
storage address - - — -
+1 Measuring temperature (rightmost 4-digit) Channel 0
+2 Measuring temperature (leftmost 1-digit) N
+ Measuring temperature (rightmost 4-digit
3 . . P (rig ) g ) Channel 1
+4 Measuring temperature (leftmost 1-digit) ]
+15 | Measuring temperature (rightmost 4-digit)
. . Channel 7
+16 | Measuring temperature (leftmost 1-digit) ]
Offset Contents (Data format) Data
+0 No. of receive data words (BCD 0017
4-digit)
+1 CHO Measuring temperature Differs depending on the tempera-
(rightmost 4-digit) (BCD 4-digit) ture measuring model. Refer to
+2 CHO Measuring temperature the ESZE Operation Manual.
(leftmost 1-digit) (BCD 1-digit) F denotes “~" (minus).
to to to
+15 CH7 Measuring temperature Differs depending on the tempera-
(rightmost 4-digit) (BCD 4-digit) ture measuring model. Refer to
+16 CH7 Measuring temperature the ESZE Operation Manual.
(Ieftmost 1-digit) (BCD 1-digit) F denotes “~" (minus).
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Execulti nga Created Communications Sequence (C200HX/HG/HE) Section 3-9

Settings of the PMCR Instruction

! 'Set 101 on the rightmost 3 digits of this
Execution start /word because the sequence number of the
PMCR__ measured value reading is 101.
28908 #1101
Instruction Doooo* Set here the address for storing the data to
Execution DO0100 be transmitted to the PMSU.
Flag .
Set here the address for storing the data to
be returned from the PMSU.
Instruction execution this example sets DM0100 so that the data
error flag that were measured are stored on and after
DMO0101.
Set on the leftmost digit the port
on which the protocol is executed.
1: Port A (Lower port),
2: Port B (Upper port)
. "2" means that two words of DM000O to [Receive Data Storage Location] , '
[Send Data setting] 1 5\1001 are used as the transmission area. 1 "17" means that 17 words of
, DM0100 to DM116 are used as ,
Doooo DM0100 , the receiving area. \
pooot [#0000] For this sequence, set the unit numbers here. P #godn‘ L '
The protocol communicates with E5ZE with unit |~ DM0101 | Rightmost 4-digi J 77777777777777777
i " " Leftmost 1-digit ) 1
number 00 because the rightmost 2 digits are "00. ; DMO0102 T Data of temperature input chan- |

nel 0 (measured temperature)

DM0115 [ Fighmos s | PLLLITIIILLIIT ,
DMO0116 J</' Data of temperature input chan-,
' nel 7 (measured temperature) |

Note Observe the following precautions when using the PMCR instruction.

* If transmitting no data to the PMSU.

| @PMCR
I I #1101
#0000
D0100 \
Set the constant (#0000)

when transmitting no data.

« If storing no data to the data area on the PLC.

| @PMCR
|| #1101
D0000

D0100

~~—— Constants can not be set here.
Set a word even if it is not necessary.

3-9-4 Operation

The following describes the system’s operation when executing the ladder
program shown in 3-9-3 Creating Ladder Programs.

1,2,3... 1. When starting to execute a PMCR instruction, the system transmits the in-
formation set in the operand of the PMCR instruction such as the starting
sequence number and communications data storage area, and turns ON
the Port A Instruction Execution Flag (28908).

2. The PMSU reads the communication sequence with the appropriate se-
guence number set in the PMCR instruction.

3. The system sends “RX0 Channel No. 00" as the command measuring the
temperature of the Temperature Controller’s designated channel to the unit
number (00) of the E5ZE Temperature Controller stored in DM00O1.

4. The system receives “RX00” as the response from the Temperature Con-
troller (00 means the end code) from the E5ZE with unit number 00 to store
the next measured temperature into DM0101 and DM0102 through the
PLC scan.
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5. The system increments the value of the repeat counter by 8 times repeat-
edly. Every time the repeat counter is incremented, the following contents
are changed.

« The word number of the Temperature Controller designated by $(N,1)
in the send message changes between 0 and 7.

e The DM area storing the measured temperature designated by
&(W(2N+1),*) in the receive message changes as follows:

bmMm0101 - DM0103 —» DM0105 - DM0107 —» DM0109 —» DM0111 —
DM0113 —» DMO0115

6. When the system ends the execution of the sequence, the Port A Instruc-
tion Execution Flag (28908) will turn OFF.

3-9-5 Confirming the Operation

If the process variable is not stored successfully, confirm the following points.
» System error FAL9C.
» Confirm that the PLC’s Setup is set correctly.
* Bit 28909 (Port A Step Error Processing Flag) is ON.
» Confirm that the PLC’s Setup is correct. (Especially confirm whether
port A and port B are not designated conversely.)
 Confirm that the line distribution (Refer to the Communications Boards
Operation Manual (W304) to connect the line is correct).
 Confirm the communication rate, frame, and unit number of the E5ZE.
* No error, but data are not stored.

» Confirm that the RUN indicator of E5ZE is lit. (For details, refer to the
E5ZE Operation Manual (HO76).)

Note When trace operation is executed from the CX-Protocol, from that point, the
Serial Communications Board performs a trace on chronological data in the
send/receive message (up to 670 bytes). Using this, it is possible to confirm
what kind of messages is sent and received at each step. (For details about
traces, refer to SECTION 12 Tracing and Monitoring.)

3-10 Auxiliary Area and Allocated Data Areas

PMSU status (sequence and step execution status) are allocated to the fol-
lowing auxiliary area and data areas on the CPU Unit, and can be used from
the ladder program.

3-10-1 Special Auxiliary and Allocated Areas

The following table provides a list of the protocol macro related bits for the CS/
CJ Serial Communications Board/Unit and the C200HX/HG/HE Communica-
tions Board.
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n = 1500 + 25 x Unit No. (For the Serial Communications Unit only.)

Type Name CS Serial CS/CJ Serial C200HX/HG/HE Contents
Communications Board | Communications Unit | Communications Board
Word Bit Word Bit Word Bit
System PMSU A424 00 A417 (CPU |00to 15 ClO 268 00 1: Error
error Watchdog Bus Unit (For Unit Communi- 0: Normal
Timer Error Error No. No. 0to 15) | cations
Flag) See note. Board error
Inner Bus 01 None details area | 01 1: Error
Error (Port System 0: Normal
recognition error
error) FALOC
Protocol A424 09 None error 02 1: Error
Data Error 0: Normal
(Protocol
data
checksum | Cl0 1901 |00 n+1 00 1: Error
error due to 0: Normal
memory ’
damage)
Protocol A424 10 None 11 1: Error
Macrol 0: Normal
Execution
Error (At
port 2 or B)
Protocol 12 1: Error
Macrol 0: Normal
Execution
Error (At
port 1 or A)
System A424 08 None 13to 15 1: Error
Setting 15: System |0: Normal
Error setting error
Cl0 1906 |01 n+6in+16 |01 1 Eorat
or CIO P
1916 13: Error at
port B
Note A40207 (CPU Bus Unit Error Flag) is the representative bit.
Type Name CS Serial CS/CJ Serial | Com- | C200HX/HG/HE Communica- Contents
Communica- | Communica- | mon tions Board
tions Board tions Unit
Allocation Area Special Auxiliary Area
Portl | Port2 | Portl | Port2 Bit Port Bit Port Bit
word | word | word | word A B
word word
Port Port Operating | CIO CIO n+6 n+16 |00 None None 1: Port operating
Operation 1906 |1916 2: Port stopped
Restart Flag |A636 |A636 |A620 |A620 ClO 00 ClO 01 0to 1: Restart
(each port) Bit 01 |Bit 02 |+ Unit |+ Unit 289 289
No. No.
Bit 01 |Bit 02
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Type Name CS Serial CS/CJ Serial | Com- | C200HX/HG/HE Communica- Contents
Communica- | Communica- | mon tions Board
tions Board tions Unit
Allocation Area Special Auxiliary Area
Port1 | Port2 | Portl | Port2 Bit Port Bit Port Bit
word | word | word | word A B
word word
Protocol Protocol ClO ClO n+9 n+19 |15 ClO 08 ClO 12 1: Protocol
Macro Macro Execu- [1909 |1919 289 289 macro (sequence)
tion Flag executing
(each port) 0: Protocol
macro (sequence)
abnormal
execution
Protocol CIO CIO n+9 n+l19 (00to |CIO 08to |CIO 12to |0: No error
Macro Error 1909 (1919 03 286 11 286 15 1: No protocol
Code (each function
port) (C200HX/HG/HE
only)
2: Sequence No.
error
3: Data read/Data
write area
exceeded error
4: Protocol
data syntax error
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Type Name CS Serial CS/CJ Serial | Com- | C200HX/HG/HE Communica- Contents
Communica- | Communica- | mon tions Board
tions Board tions Unit
Allocation Area Special Auxiliary Area
Portl | Port2 | Portl | Port2 | Bit Port Bit Port Bit
word | word | word | word A B
word word
Sequence | Communica- |CIO ClO n+10 [n+20 |00to |None None 000 to 03E7
Monitor tion Sequence | 1910 |1920 11 hexadecimal
No. (each (000 to 999)
port)
Execution ClO ClO n+ll [n+21 |08to |CIO 04to |CIO 04to |OtoF
Completion 1911 |1921 11 287 07 288 07 hexadecimal
Step No. (O to 15)
(code) (each
port)
Execution CIO CIO n+13 |n+23 |[00to |None None 0 to 15 bits:
Completion 1913 |1923 15 Corresponds to
Step No. Stor- step No. 0 to 15
age Flag
(each port)
Execution ClO ClO n+ll [n+21 |00to |CIO 00to |CIO 00to |OtoF
Completion 1911 |1921 03 287 03 288 03 hexadecimal
Step Matrix (0 to 15)
Case No.
(code) (each
port)
Execution Cio Cio n+12 |n+22 |[00to |None None 0 to 15 bits:
Completion 1912 | 1922 15 Corresponds to
Matrix Case case No. 0 to 15
No. Storage
Flag
Execution None |None |None |None |[None |CIO 15 Cio 15 0: Nothing stored
Completion 287 287 1: Stored
Storage Flag
(each port)
Repeat CIO CIO n+l4 |n+24 |00to |CIO 00to |CIO 00to |0OltoFF
Counter 1914 |1924 07 284 07 285 07 hexadecimal
Present Value
(each port)
Repeat CIO CIO n+14 |n+24 |08to |None None 01to FF
Counter Set 1914 |1924 15 hexadecimal
Value (each
port)
SequenceEnd |CIO |CIO n+9 n+19 |11 CIO 10 CIO 14 1: Sequence end
Completion 1909 |1919 289 289 completed
Flag (each 0: Sequence end
port) not completed
Sequence CIO CIO n+9 n+19 |10 CIO 07 CIO 15 1: Sequence abort
Abort Comple- | 1909 |1919 283 283 completed
tion Flag 0: Sequence abort
(each port) not completed
Step Error | Step Error ClO ClO n+9 n+19 |14 ClO 09 ClO 13 1: Step error
Processing 1909 |1919 289 289 processing com-
Execution pleted
Flag (each 0: Step error
port) processing not
completed
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Type Name CS Serial CS/CJ Serial | Com- | C200HX/HG/HE Communica- Contents
Communica- | Communica- | mon tions Board
tions Board tions Unit
Allocation Area Special Auxiliary Area
Portl | Port2 | Portl | Port2 | Bit Port Bit Port Bit
word | word | word | word A B
word word
Trace Trace Execu- |CIO CIO n+9 n+19 |12 CIO 00 CIO 01 1: Executing
tion Flag 1909 |1919 286 286 0: Stop
(each port)
Continuous ClO ClO n n CIO 02 CIO 03 Oto 1: Start
Trace Start/ 1900 (1900 |pito1 |bit 09 289 289 1 to 0: Stop (Only
Stop Switch Bit 01 |Bit 09 used with CX-Pro-
(each port) tocol)
Short Trace CIO CIO n n CIO 04 ClO 05 O to 1: Start
Start/Stop 1900 11900 | it 02 |bit 10 289 289 1 to 0: Stop (Only
Switch (each | Bit 02 |Bit 10 used with CX-Pro-
port) tocol)
Abort Forced Abort | CIO ClO n n Port1: | CIO 11 ClO 15 Set from 0 to 1 for
Switch (each 1900 |[1900 03 289 289 forced abort
port) Port2 (Depending on the
11 timing, the opera-
tion may not abort
and the sequence
will complete.)
Forced Abort | CIO CIO n+9 n+19 |13 None None 1: Forced abort
Generated 1909 |1919 executed
Flag 0: All other times
Wait Sequence ClO ClO n+9 n+19 |09 None None 1: Sequence wait-
Waiting Flag 1909 (1919 ing
(each port) 2: Sequence not
waiting
Wait Release | CIO CIO n n Port1: | None None 0 to 1: Wait
Switch (each 1900 (1900 0 release
port) Port2:
8
Transfer RTS Signal CIO CIO n+7 n+17 |03 None None 1: ON
control sig- | Status 1907 |1917 0: OFF
nal monitor -
CTS Signal ClO ClO n+7 n+l7 |04 None None 1: ON
Status 1907 |1917 0: OFF
DSR Signal CIO CIO n+7 n+17 |06 None None 1: ON
Status 1907 |1917 0: OFF
DTR Signal CIO CIO n+7 n+17 |07 None None 1: ON
Status 1907 |1917 0: OFF
Local Node Cio Cio n+7 n+17 |08 None None 1: Local node
Reception 1907 |1917 reception busy
BusyNVgltlng 0: Local node
to Receive waiting to receive
Remote Node |CIO CIO n+7 n+17 |10 None None 1: Remote node
Reception 1907 |1917 reception busy
BusyNVanmg 0: Remote node
to Receive waiting to receive
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Type Name CS Serial CS/CJ Serial | Com- | C200HX/HG/HE Communica- Contents
Communica- | Communica- | mon tions Board
tions Board tions Unit
Allocation Area Special Auxiliary Area
Port1l | Port2 | Portl | Port2 | Bit Port Bit Port Bit
word | word | word | word A B
word word
Transfer No Error Clo ClO n+8 n+18 [(00to |CIO 00to |CIO 08to |AllO
Error Gen- 1908 (1918 15 283 03 283 11
erated Sta- 0: No 0: No
tus (Port _ error error
Communi- - -
cations Parity Error ClO ClO n+8 n+18 |02 ClO 00to |CIO 08to |1: Parity error
Error) 1908 (1918 283 03 283 11 0: Normal
1 1o |Does not turn ON
Parity Parity |in C200HE/HX/
error error HG protocol
macro mode
Framing Error | CIO CIO n+8 n+18 |03 CIO 00to |CIO 08 to |1: Framing error
1908 (1918 283 03: 283 11 0: Normal
2: 2: Does not turn ON
Fram- Fram- | in C200HE/HX/
Ing Ing HG protocol
error error | macro mode
Overrun Error | CIO ClO n+8 n+18 |04 ClO 00to |CIO 08to |1: Overrun error
1908 (1918 283 03 283 11 0: Normal
3: 3: Does not turn ON
Over- Over- |in C200HE/HX/
rn rn HG protocol
error error | macro mode
Timeout Error |CIO ClO n+8 n+18 |05 ClO 00to |CIO 08to |1: Timeout error
1908 (1918 283 03 283 11 (Tls, Tfr, or Tr)
5: 5: 0: Normal
Time- Time- | poes not turn ON
out out 1in C200HE/HX/
error error | 4G protocol
macro mode
Command ClO ClO n+8 n+18 |06 ClO 00to |CIO 08to |1:Command error
Error 1908 |1918 283 03 283 11 (reception data
7: 7: constant compari-
Com- Com- |son does not
mand mand |2adree)
error error | 0: No command
error (Does not
turn ON in
C200HE/HX/HG
protocol macro
mode)
FCS Check ClO ClO n+8 n+18 |07 ClO 00to |CIO 08to |1:FCS check
Error 1908 |1918 283 03 283 11 error (check codes
4 4: do not agree)
FCS FCS |0: Normal (Does
Check Check | not turn ON in
error error | C200HE/HX/HG
protocol macro
mode)
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Type Name CS Serial CS/CJ Serial | Com- | C200HX/HG/HE Communica- Contents
Communica- | Communica- | mon tions Board
tions Board tions Unit
Allocation Area Special Auxiliary Area
Portl | Port2 | Portl | Port2 | Bit Port Bit Port Bit
word | word | word | word A B
word word
Transfer Checksum None None CIO 00to |CIO 08to |---
Error Gen- | Error 283 03 283 11
erated Sta- 6: 6:
tus (Port Chec- Chec-
Communi- sum sum
cations error error
Error)
Transmis- | Tr (Receive CIO CIO n+8 n+18 |12 None None 1: Exceeded
sion Error | wait monitor- | 1908 |1918 0: Normal
Gener- ing time)
ated Sta- | Exceeded
tus (each port)
Tfr (Receive |CIO |CIO n+8 n+18 |13 None None 1: Exceeded
finish monitor- | 1908 |1918 0: Normal
ing time)
Exceeded
(each port)
Tfs (Send fin- |CIO |CIO n+8 n+18 |14 None None 1: Exceeded
ish monitoring {1908 |1918 0: Normal
time)
Exceeded
(each port)
Max. No. of ClO |[CIO n+8 n+18 |08to |None None No. of retries
Retries (each 1908 |1918 11 0to 9: 0 to 9 hexa-
port) decimal
Communica- [CIO |[CIO n+8 n+18 |15 ClIO |04 Clo 12 1: Communica-
tions error 1908 |1918 283 283 tions error
(Communica- 2: Normal
tions port
error)
3-10-2 Description of Each Area
Type Name Address Details Timing
Initial- Set Reset
ization
System PMSU Watchdog | CS/CJ: CS/CJ and C200HX/HG/HE: Setto | At When When
error Time Error Board: A424, 1 when the PMSU is damaged. power | error power is
bit 00 Firmly re-secure the PMSU. Ifthe | ON occurs turned ON
Unit: A417, error does not cancel, even after (See again.
bits 00 to 15 installing the PMSU on another CPU | note
C200HX/HG/HE: Unit, replace the PMSU. 1)
ClO 268, bit 00
Inner Bus Error | CS: A424 bit 01 | CS Board only: Set to 1 when an When When
(Board only) Inner Bus error occurs. Firmly re- error power is
secure the PMSU. If the error does occurs turned ON
not cancel, even after installing the again.
PMSU on another CPU Unit, replace
the PMSU.
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Type Name Address Details Timing
Initial- Set Reset
ization
System Port Recognition | C200HX/HG/HE: | C200HX/HG/HE only: Setto 1 (ON) | At When When
error Error CIO 268 bit 01 when a communications port error | power | error power is
has occurred. Replace the PMSU. ON occurs turned ON
(See again.
Protocol Data CSICJ: CSICJ: Set to 1 (ON) when an error | "0 [\When Normal
Error Board CIO 1901, |is detected in the Protocol data 1) error is when
Unit n+1 words, |checksum. At the same time, for a occurs protocol
bit 00 Serial Communications Board, the data is
Board only: A424 | ERR/ALM indicator on the CPU Unit resent.
bit 09 will flash and the RDY indicator will

| flash at intervals of 1 s. Auxiliary
CZOOHX/E'.G/HE' Word A424, bit 09 will turn ON. For
CIO 268 bit 02 the Serial Communications Unit, the
RDY or ERC indicators will light.

C200HX/HG/HE: Set to 1 (ON)
when an error is detected in the Pro-
tocol data checksum. At the same
time the ERR indicator on the CPU
Unit or the RDY indicator will flash.
CIlO 268 bit 2 will turn ON.

Error is generated when the commu-
nications connector comes lose dur-
ing protocol data transmission or
when the power to the PLC is OFF.
Using CX-Protocol, resend the pro-

tocol data.
Protocol Macro CS: Board only |CS: Setto 1 (ON) when data read/ When When
Execution Error | A424 bit 10 (No | write area exceeded (error code 3) error sequence
Unit) or protocol macro syntax error (error occurs starts

C200HX/HG/HE: | code 4).

ClO 268 bit 11 C200HX/HG/HE: Set to 1 (ON) for
(port B), bit 12 any of the following: No protocol
(port A) macro function (error code 1),
sequence number error (error code
2), data write area exceeded (error
code 3), or protocol macro syntax
error (error code 4).

System Setting CS/CJ: ClIO 1906 | CS/CJ and C200HX/HG/HE: Set to When At power
Error CIO 1916, n+6, |1 (ON) when a PLC Setup error error ON (See
n+16 bit 01, occurs in the DM Area. Change the occurs note 1.)

Board only, A424 | system settings, and turn ON the
bit 08 (No Unit) | power again, restart or auto-restart,
C200HX/HG/HE: | or execute the STUP instruction
ClO 268, bit 15 | (CS/CJ only). Those settings for
which there is an error will return to
the default settings.

Port Port operating CS/CJ: CIO CS/CJ only: The communications When After pro-
operation 1906, CIO 1916, |port’s serial communications mode error tocol data
words n+6, is set to Protocol Macro. Set to O occurs is sent
N+16, bit 00 (OFF) when a protocol data error
C200HX/HG/HE: | occurs. Setto 1 (ON) in all other
None cases.
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Type Name Address Details Timing
Initial- Set Reset
ization
Port Port 1/2 Serial CS/CJ: Board CS/CJ and C200HX/HG/HE: The At User Setting
operation | Communications |A636, bit 01/02, |communications port is restarted power |operation |changes
Port Setting Unit A620 + Unit | when this flag goes from 0 to 1. ON or STUP |com-
Changes Flag No., bits 01/02 (See instruc- pleted or
(Port Restart C200HX/HG/HE: note tion exe- | port
Flag) CIO 289, bits 1) cuted restart
00/01 completed
Protocol Protocol Macro CS/CJ: CIO CS/CJ and C200HX/HG/HE: Set to Instruc- Instruc-
macro Execution Flag 1909, CIO 1919, |1 (ON) when the PMCR instruction tion exe- |tion com-
n+9, n+19, bit 15 | (sequence) is executed. Returns to cuted pleted
C200HX/HG/HE: | 0 (OFF) if execution fails.
CIO 289, hits Set to 0 (OFF) after sequence is
08/12 completed and all reception data
has been written to 1/0 memory. Set
to 0 (OFF) when sequence is com-
pleted (whether sequence is com-
pleted normally or using Abort). (See
note 2.)
Protocol Macro CS/CJ: CIO CS/CJ and C200HX/HG/HE: Error When When
Error Code 1909, CIO 1919, |code contents and information are error sequence
n+9, n+19, bits listed on page 154, Protocol Macro occurs starts
00to 03 Error Codes.
C200HX/HG/HE:
CIO 286, bits 08
to 11 or 12 to 15
Sequence | Communication |CS/CJ: ClO 1910 | CS/CJ only: The processing com- When None
monitor Sequence No. CIO 1920, n+10, | munication sequence number will be sequence
n+20, bits set when the sequence execution starts
00to 11 starts.
C200HX/HG/HE: |ltis also set when a Sequence Num-
None ber Error occurs (error code 2).
It is cleared when STUP is executed
or the PMSU is restarted.
Execution CS/CJ: ClI0 1911 | CS/CJ and C200HX/HG/HE: Sets When When
Completion Step |CIO 1921, n+11, |step numbers 0 to 15 (0 to F hexa- step is sequence
No. (code) n+21, bits decimal) when execution is com- executed |starts
081to 11 pleted.
C200HX/HG/HE: | Cleared when either the sequence
CIO 287 CIO starts executing, STUP is executed,
288, bits 04 to 07 | or the PMSU is restarted.
Execution CS/CJ: CIO 1913 | CS/CJ only: Each bit corresponding When When
Completion Step |CIO 1923, n+13, |to step numbers 0 to 15 (bits 00 to step is sequence
No. Storage Flag |n+23, bits 15) for which execution is complete, executed |starts
00to 15 will be set to 1 (ON). Once a bit has
C200HX/HG/HE: |been set it will remain set (ON) dur-
None ing the sequence (and after comple-
tion), so bits corresponding to steps
which have been executed will be
set to 1 (ON) in order of execution.
Cleared when either the sequence
starts executing, STUP is executed,
or the PMSU is restarted.
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Type Name Address Details Timing
Initial- Set Reset
ization
Sequence | Execution CS/CJ: ClI0 1911 | CS/CJ and C200HX/HG/HE: Recep- | At Matrix When
monitor Completion CIO 1921, n+11, |tion matrix case numbers 0 to 15 (0 | power sequence
Matrix Case No. [n+21, bits 00to |to F hexadecimal) for which recep- |ON starts
(code) 03 tion is completed will be set. (See

C200HX/HG/HE: | Cleared when either the sequence | Note
CIO 287 CIO starts executing, STUP is executed, 1)
288, bits 00 to 03 | or the PMSU is restarted.

The Execution Completion Matrix
Case Number is only stored when
the matrix has been designated by
the Receive/Send&Receive com-
mand. It will be cleared to 0O if there
is no matrix or another command is

executed.
Execution Com- | CS/CJ: CIO 1912 | CS/CJ only: Each bit corresponding Matrix When
pletion Matrix CIO 1922, n+12, |to matrix case No. 0 to 15 (bits 00 to sequence
Case No. Storage | n+22, bits 00 to | 15) for which reception is complete, starts
Flag 15 will be setto 1 (ON).
C200HX/HG/HE: | Cleared when either the sequence
None starts executing, STUP is executed,
the PMSU is restarted, or step is
executed.

After the matrix Receive command,
either the WAIT command can be
executed or the sequence com-
pleted and the matrix case number
confirmed from the ladder program.

The corresponding bits for the
stored case number will only be set
to 1 (ON), for the Execution Comple-
tion Receive Number Storage Flag
when the matrix has been desig-
nated by the Receive/
Send&Receive command. It will be
cleared to O if there is no matrix or
another command is executed.

Current Repeat | CS/CJ: CIO 1914 | CS/CJ and C200HX/HG/HE: Stores When the | When
Count ClIO 1924, n+14, |the repeat count value N. repeat sequence
n+24, bits 0010 | Cleared when either the sequence countis | starts
07 starts executing, STUP is executed, refreshed

C200HX/HG/HE: |the PMSU is restarted, or step is
ClO 284 CIO executed.

285, bits 00 10 07 | The current value N will differ
according to the method for desig-
nating initial values.

Reset: After starting that step and
setting N to 0, execute the set num-
ber of retries.

Hold: After starting that step set the
number of retries while holding the
value of N. (See note 3.)
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Type Name Address Details Timing
Initial- Set Reset
ization
Sequence | Set Repeat Count | CS/CJ: CIO 1914 | CS/CJ only: Stores the attempts At When When
monitor CIO 1924, n+14, |(Set number of retries) that are power | step starts | sequence
n+24, bits 08 to | made to execute that step. ON starts
15 Cleared when either the sequence | (S€€
C200HX/HG/HE: |starts executing, STUP is executed, |Note
None the PMSU is restarted, or step is 1)
executed.
Sequence End CS/CJ: CIO 1909 | CS/CJ and C200HX/HG/HE: Set to When When
Completion Flag |CIO 1919, n+9, |1 (ON) when sequence processing sequence |sequence
n+19, bit 11 is completed or the sequence ends ends starts
C200HX/HG/HE: | due to an error. (See note 4.)
ClO 289, bits 10/
14
Sequence Abort | CS/CJ: CIO 1909 | CS/CJ and C200HX/HG/HE: Set to When When
Completion Flag |CIO 1919, n+9, |1 (ON) when sequence processing sequence |sequence
n+19, bit 10 is completed or is aborted due to an is aborted | starts
C200HX/HG/HE: | €rror.
CIO 283 CIO 1: Sequence abort completed
283, bits 07/15 | 0: sequence abort not completed
Step error | Step Error CS/CJ: CS/CJ and C200HX/HG/HE: Set to Whena |When
Processing Exe- | CIO 1909, 1 (ON) when step ends in an error. reception |sequence
cution Flag ClO 1919, n+9, |When processing ends normally compari- |starts
n+19, bit 14 after retries, it remains at 0. son error
C200HX/HG/HE: | 1: Step ended in error oceurs
%O 289, bits 09/ | 0: step ended normally
Trace Trace Execution |CS/CJ: CIO CS/CJ and C200HX/HG/HE: Set to When When
Flag 1909, CIO 1919, |1 (ON) when send or receive mes- trace trace is
n+9, n+19, bit 12 | sage time series data is being traced starts completed
C200HX/HG/HE: | using CX-Protocol.
CIO 286, bits 00/
01
Continuous Trace | CS/CJ: CIO CS/CJ and C200HX/HG/HE: Turns Using CX- | Using CX-
Start/Stop Flag 1900/CIO n, from 0 to 1 when a continuous trace Protocol | Protocol
bits 01/09 is started using CX-Protocol. Turns
C200HX/HG/HE: | from 1 to 0 when the trace stops.
ClO 289, bits 02/
03
Shot Trace Start/ | CS/CJ: CS/CJ and C200HX/HG/HE: CX- Using CX- | When
Stop Flag CIO 1900/CIO n, | Protocol shot trace starts when it Protocol | shot trace
bits 02/10 turns from 0 to 1. When the trace is com-
C200HX/HG/HE: | buffer is full, the PMSU is cleared. pleted
CIO 289, bits 04/ | (See note 5.)
05
Abort Forced Abort Cs/CJ: CS/CJ and C200HX/HG/HE: Turns User set | User set
Flag CIO 1900/CIO n, |from 0 to 1 when Protocol Macro
bits 03/11 processing stops. Depending on the
C200HX/HG/HE: |timing, processing may be com-
CIO 289, bits 11/ | Pleted.
15
Forced Abort CS/CJ: CS/CJ only: Set to 1 (ON) when the When When
Generated Flag | CIO 1909, Forced Abort Flag is used from the Forced sequence
CIO 1919, n+9, |user program. When the Forced Abort is starts
n+19, bit 13 Abort Flag is set to ON when the generated
C200HX/HG/HE: | sequence is in the final stages, the
None sequence will either end or be
aborted.
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Type Name Address Details Timing
Initial- Set Reset
ization
Wait Sequence Wait- | CS/CJ: CS/CJ only: Setto 1 (ON) when the | At When the | Wait
ing Flag CIO 1909, sequence is waiting due to the WAIT | power | WAIT Release
ClO 1919, n+9, command being issued. ON command | Flag is
n+19, bit 09 Wait status can be set from OFF to |(S€e |isissued |ON or
C200HX/HG/HE: | ON and move to the next step, by | Note When
None using the Wait Release Flag in the | 1) sequence
ladder program. (See note 6.) starts
Wait Release Cs/CJ: CS/CJ only: Set from 0 to 1 when User set |WAIT
Flag CIO 1900/CIO n, |the sequence WAIT command is com-
bits 00/08 released. mand
C200HX/HG/HE: completed
None
Transfer Transfer Control | CS/CJ: CS/CJ only: Reads the status of the Reads Reads
control sig- | Signal Monitor CIO 1907, transfer control signals (DTR, DSR, status status
nal monitor CIO 1917, n+7, |CTS, RTS) for each port.
n+17, bits 03/04/ | 4. High, 0: Low
06/07
C200HX/HG/HE:
None
Remote Node CSs/CJ: CSI/CJ only: Indicates the reception Reads When
Busy/Waitingto | CIO 1907, status of the remote note when the status busy is
Receive ClO 1917, n+7, Xon/Xoff flow control and RTS/CTS released
n+17, bit 10 flow control are set for the transmis-
C200HX/HG/HE: | sion control parameters. Xon/Xoff
None flow control clears the reception
buffer when the sequence starts, so
the remote node reception status is
0.
1: Remote node busy (reception
buffer is full, therefore reception no
possible)
0: Remote node waiting (reception
possible)
Local Node Busy/ | CS/CJ: CIO CS/CJ only: Indicates the reception Reads When
Waiting to 1907, CIO 1917, |status of the local node (at the status busy is
Receive n+7, n+17, bit 08 | PMSU) when Receive is executed, released
C200HX/HG/HE: | when the Xon/Xoff flow control is set
None for the transmission control parame-
ters.
1: Local node busy (reception not
possible as reception buffer is 4/5 =
2 kbytes min.)
0: Local node waiting (reception
possible as reception buffer is 1/5 =
0.5 kbytes max.)
This area is cleared when the power
is turned ON. It can also be cleared
using the STUP instruction or Port 1/
Port 2 System Setting Changes Flag
(Auxiliary Bit). The area is also
cleared when the next sequence is
executed.

AUDIN - E}Sagenue de la malle - 51370 Saint Brice Courcelles - Tel : 03.26.04.20.21 - Fax : 03.26.04.28.20 - Web : http: www.audin.fr - Email : info@audin.fr




Auxiliary Area and Allocated Data Areas Section 3-10

Type Name Address Details Timing
Initial- Set Reset
ization
Transmission Error CS/CJ: CIO CS/CJ: When a transmission error | At When an | When
Generated Status 1908, CIO 1918, |occurs the corresponding flag is set | power |error sequence
n+8, n+18, bits to 1 (ON). Bits 00 to 14 are repre- ON occurs starts
00to 15 sented by bit 15. The cause of the | (See

C200HX/HG/HE: | €rror or the cause of Send&Receive | note
CIO 283, bits 00 | command retries will be represented | 1.)
to 03, 08 to 11 in bits 00 to 15. (See note 7.)

When communications retries are
executed by the Protocol Macro, an
error will be recorded in bits 00 to
14, but Transmission Error Gener-
ated bit 15 will remain at 0 (OFF).
Even if another error occurs during
retries, the cause of the error will be
held.

Bits 00 to 15 are cleared when either
the sequence starts executing,
STUP is executed, or the power is
turned ON.

C200HX/HG/HE: When a transmis-
sion error occurs in a Protocol
Macro, error codes 1, 2, 3 will be
stored in bits 00 to 03 or bits 08 to
11. Bit 07 is representative of bits 00
to 03 and bit 15 is representative of
bits 08 to 11. The cause of the error
or the cause of Send&Receive com-
mand retries will be represented in
bits 00 to 15.

When communications are restored
by the Protocol Macro retries, error
codes in bits 00 to 03 and bits 08 to
11 will be cleared. Even if another
error occurs during retries, the
cause of the error will be held. Bits
00 to 15 are cleared when either the
sequence starts executing, the
power is turned ON, or the PMSU is
restarted.

Note 1. In the above table, only “at power ON” is shown, but the CPU Unit is
cleared in any of the following circumstances. At power ON, When the op-
erating mode is changed (From PROGRAM to RUN or MONITOR), when
the STUP instruction is executed, when the PMSU is reset, or when the
communications port is restarted. Each area can also be cleared after set-
ting, by using the timing methods shown in the reset column.

2. When the response type is set to “scan,” the Protocol Macro Execution
Flag will be set to 0 (OFF) when confirmation is received that the contents
of all reception data (with responses) has been written to I/O memory.

3. When the repeat count set value is set using word read R (), if O is read,
0 will be stored and that step will be skipped (the next processing setting
ignored) and forcefully moved to the next step (+1).
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4. This flag can be used to distinguish whether or not the sequence was com-
pleted normally, by leaving the setting at End (or for an error Abort), after
the sequence has been completed.

1: Sequence End Completion
0: Sequence End not Completed

5. When the trace function is executed from CX-Protocol, the CPU Unit uses
the Shot Trace Start/Stop Flag and the Continuous Trace Start/Stop Flag
for the Serial Communications Board and Unit. Do not create ladder pro-
grams which set these flags to ON.

6. Setthe Wait Release Flag in the ladder program to turn from OFF to ON.
When the Force Set Key on the Programming Console is used, the flag will
be only ON while the key is being pressed, so it will not be possible to set
the protocol macro function from ON to OFF (clear) from the Programming
Console.

7. When an error in bits 00 to 14 cause an error in the Protocol Macro, the
Transmission Error Generated Flag (bit 15) will turn ON (1).

Protocol Macro Error Codes

Code Error contents Protocol macro
execution
No error Executed
1 No protocol macro function Not executed
(C200HX/HG/HE only)
2 Sequence number error: Not executed

The sequence number designated in the
PMCR instruction does not exist in the
PMSU.

3 Data write/read area exceeded error: Execute aborted after error
When data was written to or read from occurs.

the CPU Unit, data exceeded the range
of the designated data area.

4 Protocol data syntax error:

During Protocol Macro execution, a code
which could not be executed was found.
(E.g.: There was a header after the
terminator.)

CS/CJ

For the Serial Communications Board, when an error code 3 or 4 is recorded,
A42411 (Protocol Macro Syntax Error) will turn ON (1), the CPU Unit ERR/
ALM indicator will flash and a continuous error will be generated. For the
Serial Communications Unit, the ERC indicator will flash. All other error codes
are not used.

When an error occurs, the error code will be stored until the next sequence
starts. The error will be cleared when either the STUP instruction is executed,
the PMSU is restarted, or the next sequence is executed.)

Note To reset the cause of a continuous error when an error code 3 or 4 is gener-
ated for the Serial Communications Board, the error display will be cleared
after one of the following operations is performed.

» The next sequence is executed.

» The STUP instruction is executed.

* Restart.

» The CPU Unit is set to PROGRAM mode.

AUDIN - &%enue de la malle - 51370 Saint Brice Courcelles - Tel : 03.26.04.20.21 - Fax : 03.26.04.28.20 - Web : http: www.audin.fr - Email : info@audin.fr



Auxiliary Area and Allocated Data Areas Section 3-10

C200HX/HG/HE

When error codes 1,2,3, or 4 are recorded, CIO 268 bits 11/12 will turn ON (1)
(PMCR execution error), the CPU Unit ERR indicator will flash and a continu-
ous error will be generated. When an error occurs, the error code will be
stored until the next sequence starts.

The error will be cleared when either the STUP instruction is executed, the
PMSU is restarted, or the next sequence is executed. After removing the
cause of the error, it will also be necessary to perform an error resetting oper-
ation from a device such as a Programming Console.

Additional Notes and Precautions

Time Delay

When a half-duplex send operation is performed (CS/CJ only), there is a time
delay (see t1: Timing List below) between when the actual data transmission
processing is completed and the send operation is completed. If the response
from the remote device is early, that is, if the response is received in between
the time that the data is transmitted (using a communications command) and
when the send operation is completed, with the half-duplex system the data
received in this interval (the response) cannot be received. In this case, set to
the full-duplex system. If the wiring to the device uses a 2-wire RS-422A/485
system, both transmission data and reception data will be sent along the
same wires, so in order to separate the transmission paths to send and
receive, a timing of t2 = 150 us will be necessary. Accordingly, if a 2-wire sys-
tem connection is used and a high-speed response device is connected so
that data is returned within t1 + t2, take measures to slow down the data
response from the remote device.

Send operation

Data transmission processing

it =150 us

Fast response - ’ y
Timing (see the table below) Data cannot be

—— received during
this time

Data reception

A

Reception buffer cleared

Timing List: t1
Baud rate (bps) Timing (unit: ps)
1,200 1,116
2,400 578
4,800 288
9,600 144
19,200 73
38,400 36
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Error Flags when Overrun Errors, Framing Errors, and Parity Errors are
Detected (CS/CJ and C200HX/HG/HE)

When any of the above errors are detected in the protocol macro function, the
information on the status of the reception data error will be stored in the
reception buffer. Whether or not the appropriate error flag will turn ON
depends on the following conditions.

* When error information data is included in the data which matches the
reception expected message.

When the receive operation is performed, the reception buffer is searched
for a reception expected message, and if the data matches this, it will be
treated as reception data. If this reception data contains error information,
all the error flags will turn ON. In the following example,100 bytes of data
matching the reception expected message were received.

100 bytes { . Error Flag ON

®

P: Parity Error

When error information data is included in the data which does not match
the reception expected message.

If this data does not match the reception expected message and contains
error information, the data will be corrupted and the error flag status will not
change.

For trace information, all error information obtained from the reception buff-
er will be stored within the trace data capacity range (CS/CJ only). In the
following example, data which did not match the reception expected mes-
sage contained a parity error.

Corrupt
®
<h>

. Error flags do not change
<t>

Reception Buffer (CS/CJ Only)

With the protocol macro function each port has a reception buffer of up to
2.5 kbytes. To receive a large volume of data at one time or when the trans-
mission sequence is waiting, use a reception buffer with a large capacity. If the
reception buffer is already full and data is received, data will exceed the 2.5
kbytes of capacity and will overwrite existing data in the buffer. For this rea-
son, always be sure to use the flow control setting.

With the full-duplex system, the reception buffer will be cleared immediately
before the sequence is executed. The reception buffer receives data while
both Send and Receive commands are being executed and the data is treated
as macro data.
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Relationship between the Flow Control and the Maximum No. of Words of
Reception/Transmission Data (CS/CJ Only)

One Serial Communications Board or Unit has a reception buffer of 2.5 bytes.
Flow control will be set to start at the point when the reception buffer contains
approximately 2 bytes of data, and flow control will be released when approxi-
mately 0.5 bytes of reception data have been processed.

Set the reception buffer so that it can receive a maximum of 2 kbytes of recep-
tion data at a given time, and by setting the Receive command to receive a
maximum of 1,000 bytes (03E8 hexadecimal) of transmission data at any
given time, it is possible to store data in units of 1,000 bytes (500 words) max-
imum.
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SECTION 4
Using the Protocol M acro Function

This section describes various precautions in using the protocol macro function.
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4-1 Applicable Range of the Protocol Macro Function
4-1-1 CS/CJ

Using the Protocol Support Tool allows users to create several communica-
tions sequence (or protocol) compatible with communications control modes
discussed in this section. However, they are not compatible with communica-
tions control modes such as the synchronous communication, frame synchro-
nous mode (HDLC: High-level Data Link Communications), etc.

Transmission mode Half-duplex or full-duplex
Synchronizing mode Start-step synchronization mode

Transmission control mode | Contention mode (Point-to-point connection)
Polling selecting mode (Point-to-multi-point connection)
Modem control mode

Flow control mode Software flow: Xon/Xoff flow control
Hardware flow: RTS/CTS flow control

Delimiter control
Transmission error control |LRC, LRC2, CRC-CCITT, CRC-16, SUM, SUM1, SUM2

mode

Message format Header + Address + Length + Data + Check Code +
Terminator
or
Header + Address + Length + Data + Terminator + Error
Check Code

« The maximum message length can be set to a desired value in a range
from 200 to 1,000 bytes based on the allocated DM area of the PMSU.
The default is 200 bytes. A message exceeding 1,000 bytes cannot be
sent or received.

When using a wildcard (*) for the data length, the maximum receive mes-
sage length will be the same as this length setting (200 to 1000 bytes).

Data calculation functions are available only for the calculation of seven
kinds of error check codes, calculation of frame length for sending data,
and conversion between ASCII and hexadecimal data only. Other calcula-
tions or conversions will be handled by the ladder program, if necessary.

* The DTR signals can be turned ON or OFF under modem control.

Data can be retrieved from the receive buffer as a receive message in the
length set in the expected receive message.

When the transmission mode is half-duplex, data in the receive buffer will
be cleared right before a sequence is executed or send command is exe-
cuted.

When the transmission mode is full-duplex, data in the receive buffer will
be cleared only right before a sequence is executed.

e« Maximum number of processes that can be branched according to
received data (sent command, etc.) is 15. If more branches are neces-
sary, use the ladder program.
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4-1-2 C200HX/HG/HE

Using the Protocol Support Tool allows users to create several communica-
tions sequence (or protocol) compatible with communications control modes
discussed in this chapter. However, they are not compatible with communica-
tions control modes such as the full-duplex, the synchronous communication,
frame synchronous mode (HDLC: High-level Data Link Communications), etc.

Transmission mode Half-duplex
Synchronizing mode Start-step synchronization mode

Transmission control mode | Contention mode (Point-to-point connection)
Polling selecting mode (Point-to-multi-point connection)
Modem control mode

Flow control mode Software flow: Xon/Xoff flow control
Hardware flow: RTS/CTS flow control

Delimiter control
Transmission error control | LRC, CRC-CCITT, CRC-16 (see note), SUM, SUM2

mode (see note)

Message format Header + Address + Length + Data + Error Check
Code + Terminator
or

Header + Address + Length + Data + Terminator +
Error Check Code (see note)

Note It is valid only when the Communications Board is the C200HW-COMLIL-
EV1.

« The message length must be 256 bytes or less. For a message whose
length is 257 bytes or more, the data exceeding 256 bytes cannot be sent
or received.

« Data calculation functions are available only for the calculation of five
kinds of error check codes, the frame length to be sent, and the numeral
data conversion between ASCII and hexadecimal data only. Other opera-
tions or conversions will be handled by the ladder program, if necessary.

» The signal line cannot be controlled optionally by any mode other than the
modem control and the RTS/CTS flow control.

« A process that determines the number of receiving bytes by using the
beginning data of a received frame is infeasible.

e The data in the buffer is cleared before the sequence execution and after
the receive command execution. Therefore, a process that reads bytes
one by one from the content of receive buffer cannot be used.

« Maximum number of processes that can be branched according to

received data (sent command etc.) is 15. If more branches are necessary,
use the ladder program.
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Section 4-2

4-2 Protocol Creation Process

4-2-1

* Retry, if not B.
* End, if B.

* Retry after one
minute, if not D.

« End,ifE

Creating Communications Sequence Flowcharts

* Create the status transition chart of communications sequence.

Before creating a protocol by using the Protocol Support Tool, users are
recommended to first draw such a status transition charts to illustrate the
communications sequences with the communicating machine as shown
below as an example. Then, users can convert them to “sequences” and
“steps” editable by the Protocol Support Tool.

v

Example:
PLC External device PLC Temperature
controller
Send the read
Send A > command for
* Retry, if not process value.
response
format.
* End, if
response
format.
Send the write
command for a
Send C

set value.

 Retry, if not
response
format.

* End, if
response

format.

4-2-2 Disassembling into Sequences and Steps

« Disassembling the protocol into “sequences” and “steps” to be editable by
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the Protocol Support Tool.

« Disassemble into sequences
Take out a block from the above process as a “sequence” which is to
be started (or switched) by the ladder program.
For example, either “Read the process value of temperature controller”
or “Write the set value of temperature controller” becomes a “se-
guence.”
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Section 4-2

Send

« Disassemble into steps
Disassemble sequences into squares (steps) as shown below:

Send&Receive Receive

Normal
end

Error

Receive Error

B

Receive Error

B

v

Next Error
process process
v v
Next Error Next Error
process process process process
Send&Receive (Matrix)
‘ Send A ‘
( Matrix

—— —— ]

‘ Receive B Receive C Receive D

v v

‘Next process ‘ ‘Next process ‘

i,,‘,,,,‘,,,,,j

‘ ‘Receive others ‘ ‘ Error ‘

v

‘ Error Process ‘

‘Next process ‘ ‘Next process ‘

Receive (Matrix)

Matrix

"

‘ Receive B ‘ Receive C Receive D

e —

‘ ‘ Receive Other ‘ ‘

1
Error ‘

v

‘ Error Process ‘

‘ Next process ‘ ‘ Next process ‘ ‘ Next process ‘ ‘ Next process ‘
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Example 1:
Step No. 00
Send message
Send
&
Receive
Send data Error
Receive
the
expected
message Abort
Next
Step No. 01
end escape three
code ‘ times
Send Retry
& count
Receive
Receive a Other
result code than 0,
10 or Error
Abort
Step No. 02 Next
A
Send disconnect ‘47 m‘?gg
command times
Send
& Retry
. count
Receive
Receive a
result code
v
End ‘ ‘ Abort
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Example 2:
Step No.00

Send dial
command Retry three times
etry i
Send& Retry count
Receive
< (Matrix)
Result code”
‘ Receive 7,9 ‘ ‘ Receive 1 234‘ ‘ Receive 4,6,8, or others ‘ ‘ Error

i v v
END

Send dial
command .
Retry three times
Send& Retry count

Receive
(Matrix)
esult code” -
\\\\\:,,,777777 —
Recelve 1,234 Receive 4,6, 7 8,9,0r others ‘ ‘ Error ‘

When configuring the steps, the enough consideration is necessary not only
for the normal course (the process is completed in normal) but for the error
course (the process is terminated by error). The error courses are often set to
be aborted (intermittent process stop) all together. However, if the abort is set
as the simple “other than normal course,” the process stops there.

Add the description to switch from the error course to the normal course by
setting Next and Goto as much as possible if the error cause is predicted and
the process can be continued by the other steps even if the errors occur.
Besides, if the error causes are identified, the debug will be easy even when
the recovery is impossible by describing the steps. For example, for a device
such as a modem which returns the specific result codes, the result codes can
be set in the matrix in order to confirm the sent result codes and to ease the
error cause identification.

4-3 Transmission Control Mode Setup

The Protocol Macro function supports such transmission control modes as the
flow control (Xon/Xoff flow control by software and RTS/CTS flow control by
hardware), delimiter control, contention control, and modem control. Note that
the system cannot freely control the signal line through another mode.
Examples of their general use are as follows:
» The external device is compatible with the RTS/CTS flow control.
Select the RTS/CTS flow control.
» The external device is compatible with the Xon/Xoff flow control.
Select the Xon/Xoff flow control.
» The connection in one-to-n configuration is used for the external de-
vice.Select the modem control.
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* The external device is a modem.
Select the modem control.

» The external device is a modem compatible with the RTS/CTS flow
control (or the Xon/Xoff flow control).
Select both the modem control and the RTS/CTS flow control (or the
Xon/Xoff flow control).

» The external device compatible with the RTS/CTS flow control (or the
Xon/Xoff flow control) is connected in 1:N configuration.
Select both the modem control and the RTS/CTS flow control (or the
Xon/Xoff flow control).

Note

The RTS/CTS flow control sets the CTS signal from the receiving terminal to
“OFF" to stop the data sending temporally when the receiving speed exceeds
the processing in a no-procedural communication. When the receiving pro-
cess finished, it sets the CTS signal to “ON” again to resume the sending.
This control is a kind of hardware flow control. The signal line of RS-232C
cable is used.

The Xon/Xoff flow control sends the Xoff (13H) signal from receiving termi-
nal to temporarily stop data sending when the receiving speed exceeds the
processing capacity in no-procedural communications. When the receiving
process becomes available, it sends the Xon (11H) signal to start the data
sending again. This is a kind of software flow controls. (However, the Xon and
the Xoff signals are control codes, therefore they might be included in the
sending data if it is binary. On the contrary, the Xon and the Xoff signals may
be mixed in the data. Thus, this control is not used for a binary data communi-
cations).

The modem control is a specific function to the Protocol Macro function.

It sets DTR signal to “ON” from the start of Protocol Macro execution through
the end.

It sets RTS signal to “ON” during the data sending.

The contention control is a data transmission mode which establishes a
data link from the data sending terminal before the communication. Since
mutually communicating terminals have equal priority, either terminal can
establish the link to send data anytime.

The delimiter control sends a delimiter, which has been set by the send
code, at the end of the send data if no terminator is defined for the send mes-
sage. At the next step, it does not send until it receives a delimiter, which has
been set by the receive code, from the communicating terminal.

If a terminal received a delimiter set by the receive code, it sends a delimiter
set by the send code and continues the data receiving.

When the received data exceeds 200 bytes (for the C200HX/HG/HE) or
exceeds the maximum receive bytes (for the CS/CJ) in the RTS/CTS flow
control, the Xon/Xoff flow control, or the delimiter control mode.

For the C200HX/HG/HE

The received data is 200 bytes maximum a step in the RTS/CTS flow control,
the Xon/Xoff flow control, or the delimiter control. If more than 200 bytes of
data are expected to be received, it will necessary to design the sequence to
receive them using multiple steps.

Example: When receiving 300 bytes.

Step No. Command Send Receive Next process
message message
00 Send&Rec | A command 200 bytes Next
eive
01 Receive 100 bytes End
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For the CS/CJ

With the CS/CJ protocol, the maximum number of receive bytes per step is
1,000 bytes in the RTS/CTS flow control, Xon/Xoff flow control, or delimiter
control as in the case where these control modes are not specified. (The max-
imum number of bytes for the send/receive message handled by the protocol
macro can be set in a range from 200 to 1,000 bytes by setting the allocated
DM area for the PMSU.)

Note on the selection of the contention control mode

When the contention control mode is set, the send request code is automati-
cally sent at the beginning of the sequence, the successive process has to be
set in the sequence.

« When the communicating partner does not have a priority. (Execute the
communications process after the receipt of partner’s receive permission

code)
Step No. Command Send message |Receive message Next process Error process
00 Receive --- Receive Next Goto00
permission code
01 Send&Receive Data send Data receive End Abort

* When the communicating partner has a priority.
(Send the receive permission code if the received data is not the partner’s
receive permission code)

Step No. Command Send message |Receive message| Next process Error process
00 Receive --- Receive permis- | Next Goto02
sion code
01 Send&Receive Data send Data receive End Abort
02 Send&Receive Receive permis- Data receive Next Abort
sion code
03 Send Data send --- End Abort
167

AUDIN - 8, avenue de la malle - 51370 Saint Brice Courcelles - Tel : 03.26.04.20.21 - Fax : 03.26.04.28.20 - Web : http: www.audin.fr - Email : info@audin.fr



Ladder Programming Method Section 4-4

4-4 Ladder Programming Method
4-4-1 CS/CJ

 To avoid executing a PMCR instruction while another PMCR instruction is
being executed, the Communications Port Enabled Flag should be
switched from the normally open input condition to the normally closed
input condition.

« Perform the sequence execution result read process and the sequence
error termination process under the condition that the Protocol Macro
Execution Flag is cleared.

Note Before executing a PMCR instruction with the CS/CJ Series, ensure that the
serial communications mode for the communications port to be used is set to
protocol macro. If a PMCR instruction is executed with the port set to Host
Link (SYSWAY), messages that cannot be understood by the application will
be output from the serial communications port.

Example:
Communications
Protocol Macro Execution Port Enabled Flag
Flag (for port 2 of Serial ~ (Communications
Communications Board) port 0)
Input condition 191915 A20200
Il L 11
1T P4l 1 PMCR
191915
i | = DIFD (14) A I
A
{1
Sequence execution result reading process
Sequence error termination process

Example: The execution of the protocol Temperature Controller (E5LIK Read
System) Sequence No. 000 (read process value)

CS1W-SCB41 Serial Communications Board

|:| Port 2
D The Temperature Controller unit number is spe-
cified, the send data of the process value read

command is sent, and the process value in the
response is received in the specified word.

RS-422A/485
Send data
—/ —/ —/
Receive data —/ —/ —/
E5[IK Temperature E5[IK Temperature E5[CIK Temperature
Controller Controller Controller
Unit No. 00 Unit No. 01 Unit No. 31

Maximum 32 Units
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« The Send/Receive Word Allocation Contents of the Sequence No.
000 (read process value)

*0 Number of send data words

(Undefined)

Unit No.

Contents (data format) Data

Number of send data words (4 digits

0002 (fixed)

Unit No. (2 digits BCD)

00to 31

Number of receive data words

Process value

Contents (data format)

Data

First word of
send data
Offset
+0
hexadecimal)
+1
+0
Receive data
storage words
Offset
+0
(2 digits hexadecimal)
+1

Number of receive data words

0002

Process value (4 digits BCD)

Scaling (lower limit to upper
limit)

* PMCR Instruction Operand Setting Contents
In this case, the Unit No. 03 E5LIK process value is read, received and,

stored in DM 0201:

C: Control data

* /
L—E1 Hexadecimal: Inner board
(Serial Communications Board)

0 Hexadecimal: Communications port (Internal logic port No. 0)

PMCR 15 1211 87 43 0
° #02E1 ci[ 0 2 ] z |
Cc2 #0000 \ v \

DMO00100
DM00200
2 Hexadecimal: Port 2
15 0
c2|

\

L——— 0000 Hexadecimal: Sequence No. 000

S: The first word number of the send data

S: D00100 15 0

S:D00100 | _00 02

Number of send data words = 2

S+1:D00101|_00 | 03

Unit No. = 03

D: The first word number of the receive data storage

D: D00200

15 0

D: D00200 | _0002

D+1: D00201 |Process value

Number of send data words = 2

Process value is stored (BCD 4-digit)
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Input condition  Port Enabled Flag

000000
1L

* Example of the Ladder Program Creation
The following example shows that the protocol “Controller (E5_K read)”
Sequence No. 000 (“Process value read”) is executed by the PMCR
instruction and the read process value is transferred to another word at
the normal completion of the sequence.

Communications

A20200
P4

Protocol Macro
Execution Flag

191915
Y4

4 4

PMCR

#02E1

#0000

D00100

D00200

When the input condition 000000 is ON, the Commu-
nications Port Enabled Flag A20200 is turned OFF,
and the Protocol Macro Execution Flag 191915 is
turned OFF, the sequence No. 000 is executed at port
2 of Serial Communications Board, and the process
value is stored in D00201.

When the Protocol Macro Execution Flag 191915 is
cleared from ON to OFF, 000100 changes from OFF
to ON (remains unchanged to be ON during 1 cycle).

DIFD (14) 000100

Step Error Processing

Execution Flag The process value received in D00201 is transferred

000100 191915 191914 to DO0300 when 000100 is ON, Protocol Macro Exe-
11 X )4 MOV (21) cution Flag 191915 is turned OFF, and the Step Er-
H Al Al ror Processing Execution Flag 191914 is turned

D00201| OFF.
Step Error Processing D00300
Exefgg'gqfag If the Step Error Processing Execution Flag 191914 is
' ON when 00100 is ON (sequence termination), the
1T FAL (06) 00| FAL instruction (Failure Alarm instruction) will be exe-
cuted as the sequence error termination.

A21900

i | FAL (06) o1] If the Communications Port Execution Error Flag
A21900 is ON, the FAL instruction will be executed.
Protocol Macro 1
Execution Flag
191915 0 —
Sequence Sequence Sequence
execution termination restart
1 [ :
00100 :
0 . .
"1 cycle '
. The process value in D00201 is
1 ' transferred to D0O0300.
Sequence normal termination: ) )
Step Error Processing Execu- s '
tion Flag 191914 0 ; Z
. FAL instruction is executed.
o ; v )
Sequence error termination:
Step Error Processing Execution
Flag 191914 0

Application of the Receive Data Storage Area before PMCR Execution

The receive buffer is cleared to 0 right before a communications sequence is
executed at the time of PMCR execution. Therefore, if a ladder program that
constantly reads the process data as shown in the following example is cre-
ated, the process value data will be momentarily cleared to 0 if data cannot be
read due to a reception error.

There is a function that reads and sets data from the 1/O memory area of the
CPU Unit for a number of words of the first “m” in the receive area right before
the communications sequence is executed. This is done in order to hold the
received data when a reception error occurs. With this function, the process
value data will not be cleared to 0 and the data that existed just before recep-
tion failure can be retained.
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Specify the number of words of data to be retained in “m.” If set to 0 or 1, the
data received will not be retained and cleared to O.

Example The following protocol sends or receives data once and constantly or periodi-
cally executes the PMCR instruction for reading the received data according
to the ladder program.

Always ON Communications Protocol Macro

Flag Port Enabled Flag Execution Flag Set Receive
I 11 w
i H Al PMCR buffer
Cl
c2 Stores the value at
S the time of reception
failure
D|—-D m
m words

When the receive area is not retained

Communications

|
|
sequence , ’_—i
Clear

Receive buffer 4 Reception !
! failure :
: i Cleared value is stored.

D+1on
When the receive area is retained

Communications

I
sequence !
Set I l

. ) . t
Receive buffer & A Reception !
Clear failure !

Receive area __i ]

D+1 on $ooTTrmmTTTTTTTTET T Set value is stored.

Functions of the Receive Data Storage Area
Use the receive data storage area according to the following procedure.

1,2,3... 1. The 250 words of the PMSU receive buffer of the PMSU is cleared to 0
right after the PMCR instruction is executed.

2. Before the communications sequence is executed, data (starting from
D+1) for the number of words (D value—1) in the I/O memory is overwritten
on the receive buffer (except at the beginning). The receive buffer consid-
ers this as the initial value and waits for the results of Receive processing.
The contents of the receive buffer that exceed the number of words for D
remain as the initial value of 0000 hexadecimal. (If the number of words is
specified to be 00, the whole area remains as the initial value of 0000 hexa-
decimal.

3. Asthe result of Receive processing, received data starting from the desig-
nated first (offset) word is stored in this receive buffer (except the begin-
ning). The stored data is compared with the expected message. If the
response is not written, the received data is kept in the receive buffer and
is not stored in the CPU Unit.

4. |Ifthe response is written, the received data (except at the beginning) in the
receive buffer will be stored in the 1/O memory area (starting from D+1).
The number of words (including D itself) to the maximum position of the
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stored data is stored in D. (The number of words within D is updated every
time data exceeding the maximum position is stored.)

5. The previous steps 3 and 4 are repeated until the protocol macro com-
pletes its operation.

Value changes.

Number of words of this value

PMCR 1/0 memory 1/0 memory ]
This number of
C1 i
04 words is stored to
Co D 00 | 00 | @ ‘_' update the value.
D+1 1234 @ — 1234
S D+2 ABCD Set 5678
D D+3 55AA FFFF
D+ == ' Overwftes the initial value AAAA J
CPU Unit ‘ A
PMSU Response writing is designated.
Receive buffer Receive buffer ¢
00 | 00 00 00 F{ece(ijve data is
1 3
0000 Right after PMCR 1234 store
is executed @
0000 Qo ——— ABCD
Internal processing to|
0000 clear the buffer 9 55AA
0000 0000
: Storing starts from the
T Receive desigrgated word.
® Overwrites the received data.

Offset A
Received data +2 5678 FFFF AAAA

Sequence Error Termination Process

If the End is set for the normal sequence termination and the Abort is set for
the error termination as follows, either the normal sequence termination or the
error termination can be identified by the Sequence End Termination Flag and
the Sequence Abort Termination Flag.
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Example 1 Example 2
Sequence Sequence
Step No. 00 Step No. 00
Error Error
Sequence error
termination
Step No. 01 Step No. 01 Step No. 02
Error Error
Sequence error Sequence error
termination termination
Abort Abort
Sequence normal Sequence normal
termination termination
End End End

Example: Port 1 of the Serial Communications Board

Sequence Normal Termination

Protocol Macro 1
Execution Flag

190915

Sequence End
Termination Flag
190911

1

Step Error Proces- 1
sing Execution
Flag 190914 0

0_

Sequence Normal Termination

Protocol Macro
Execution Flag

Sequence Sequence
execution termination

0 41—,5 | IL

190915

Sequence
restart

Sequence End
Termination Flag
190911

Step Error Proces-
sing Execution

Sequence Error Termination

Protocol Macro 1

Execution Flag
190915

Sequence Abort
Termination Flag 0
190910

Step Error Proces- 1
sing Execution
Flag 190914

o —

Flag 190914

1
(O —

Sequence Sequence

Sequence

execution termination restart

I e

Error process at
the step No. 00

]

0

Sequence Error Termination

Protocol Macro
Execution Flag

Sequence Sequence
execution termination

NS B

AU N

Note

190915

Sequence
restart

Sequence Abort
Termination Flag
190910

Step Error Proces-
sing Execution
Flag 190914

[

Error process at
the step No. 00

1 .
Sequence Sequence  Sequence
execution termjnation restart

0

b
0

1. The Step Error Processing Execution Flag is not a flag for the whole se-

quence, but a flag to determine whether the error process is executed at a
step in the sequence. Therefore, as in the above example 2, if the consec-
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utive step terminates normally after error process execution during the se-
guence (step No. 00), the Flag will remain unchanged at 1 (ON). Thus it
should be kept in mind that this Flag is not always useful as an error termi-
nation flag for the whole system.

2. Use the Forced Abort Flag while keeping the following points in mind:

A sequence under execution can be forced to stop by using the forced
abort switch. When the switch is changed from OFF to ON using the ladder
program or Programming Console, the protocol macro function changes
the Forced Abort Flag from OFF to ON and then changes the Protocol
Macro Execution Flag and the forced abort switch from ON to OFF.
Therefore, do not turn the forced abort switch from ON to OFF using the
ladder program or Programming Console.

4-4-2 C200HX/HG/HE

The Instruction Execution Flag should be set to the normally closed input
condition in order to avoid another PMCR instruction execution during
PMCR instruction execution.

Perform the sequence execution result read process and the sequence
error termination process under the condition that the Instruction Execu-
tion Flag has been cleared.

Example:

Instruction Execution Flag

Input condition 28908

i | 1 PMCR

28908

Sequence execution result reading process
Sequence error termination process

Example: Execution of the protocol name “Controller (E5_K read)” Sequence
No. 000 (“Process value read”)

/

| —~ Communications Board

1 ]

The Temperature Controller unit number is spe-
cified, the send data of the process value read

command is sent, and the process value in the
response is received in the specified word.

RS-422A/485
Send data
—/ —/ —/
Receive data —/ —/ —/

E5CIK Temperature E5CIK Temperature E5CIK Temperature

Controller Controller Controller

Unit No. 00 Unit No. 01 Unit No. 31

N J

Y

Maximum 32 Units
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« The Send/Receive Word Allocation Contents of the Sequence No.
000 (“Process value read”)

+
First word of 0 Number of send data words
send data (Undefined) | Unit No.
Offset Contents (data format) Data
+0 Number of send data 0002 (fixed)
words (4 digits BCD)
+1 Unit No. (2 digits BCD) 00 to 31
+0
Receive data Number of send data words

storage words
+1 | Process value

Offset Contents (data format) Data
+0 Number of receive data 0002
words (4 digits BCD)
+1 Process value (4 digits Scaling (lower limit to
BCD) upper limit)

* PMCR Instruction Operand Setting Contents
In this case, the Unit No. 03 E5[LIK process value is read, received and
stored in the DM 0201:

C: Control data

15 1211 87 43 0
#1000 T T

DM0100 c 1 0 : 0 : 0

DMO0200 \—|—:
1: Port A

S: The first word number of the send data
S: DM0100

S: DM0100 | 00 02 Number of send data words = 2
S+1:DM0101 00 103 | ypit No. = 03

D: The first word number of the receive data storage
D: DM0200

PMCR

000: Sequence No.

D: DM0200 Number of send data words =2
D+1: DM0201 Process value is stored (BCD 4-digit)

Process value
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* Example of the Ladder Program Creation
The following example shows that the protocol name “Controller (E5_K
read)” Sequence No. 000 (“Process value read”) is executed by the
PMCR instruction and the read process value is transferred to another
word at the normal completion of the sequence.

Input condition Instruction flag
00000 28908
11 )4
1T P4l PMCR When the input condition 00000 is ON and the

#1000 | Instruction Execution Flag 28908 is OFF, the
sequence No. 000 is executed and the process
DMO0100 | value is stored in DM 0201.

Instruction flag DM0200
28.9.08 The Instruction Execution Flag 28908 is cleared from
H @l ON to OFF, 00100 changes from OFF to ON
Step error process execution flag (remains unchanged to be ON during 1 cycle).
00100 28908 28909
il H v (B MOV (21) If the Instruction Execution Flag is OFF and the Step
OVIOZ01 Error Process Execution Flag 28909 is OFF when

00100 is ON, the current received process value in
pmo300 | DM 0201 will be transferred to DM 0300.

Step error process execution flag

28,9,09 If the Step Error Process Execution Flag 28909 is
1T FAL (06) 00 | ON when 00100 is ON (sequence termination), the
FAL instruction (Failure Alarm instruction) will be
executed as the sequence error termination.
Instruction 1
Execution Flag
28908 0 —
Sequence Sequence Sequence
execution termipation restlart
1 [ :
00100 :
0 . .
11 cycle '
. The process value in DM0201
1 ' istransferred to DMO0300.
Sequence normal termination: ) )
Step Error Process Execution W/ '
Flag 28909 0 ’ X
: FAL instructior:1 is executed.
Sequence error termination: 1
Step Error Process Execu-
tion Flag 28909 0

Sequence Error Termination Process

If the End is set for the normal sequence termination and the Abort is set for
the error termination as follows, either the normal sequence termination or the
error termination can be identified by the Sequence End Termination Flag and
the Sequence Abort Termination Flag.
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_ _
Example 1 Example 2
Sequence Sequence
Step No. 00 Step No. 00
Error Error
Sequence error
termination
Step No. 01 Step No. 01 Step No. 02
Error Error
Sequence error Sequence error
termination termination
Abort Abort
Sequence normal Sequence normal
termination termination
End End End

Sequence Normal Termination

Instruction 1 —
Execution Flag
28908 00—
Sequence Sequence  Sequence
execution termination restart

Sequence End !

1 .
Termination Flag 0 .

28910

Step Error Process 1
Execution Flag
28909

Sequence Error Termination

Instruction 1 —
Execution Flag 0
28908
Sequence Sequence  Sequence
termination restart

execution

Sequence Abort 1 :

Termination Flag 0
28910

Step Error Process 1

Execution Flag 0 J L

28909

Sequence Normal Termination

Instruction 1 —
Execution Flag
28908 0 —
Sequence Sequence  Sequence
execution termination restart
Sequence End 1 X | '
Termination Flag '
28910 0 '
Error process at X
the step No. 00 !
Step Error Process — ,
Execution Flag
28909 0 J \—

Sequence Error Termination

Instruction
Execution Flag
28908

Sequence Sequence  Sequence
execution termjnation restart
h

|

Sequence Abort
Termination Flag 0

28910 Error process at :

the step No. 00

Step Error Process 1
Execution Flag
28909
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Note 1. The Step Error Process Flag is not a flag for the whole sequence, but a flag
to determine whether the error process is executed at a step in the se-
guence. Therefore, as in the previous example 2, if the consecutive step
terminates normally after the error process execution during the sequence
(Step No. 00), the Flag will remain unchanged at 1 (ON). Thus, it should
be kept in mine that this Flag is not always useful as the Error Termination
Flag for the whole system.

2. Use the Forced Abort Flag while keeping the following points in mind:
The Instruction Execution Flag will change from ON to OFF when the user
program changes the Forced Abort Flag from OFF to ON. Therefore, the
abort process will not be executed if the Forced Abort Flag in turned OFF
when the Instruction Execution Flag turns OFF. Set the Forced Abort Flag
to OFF after the minimum period [CPU Unit cycle time + 15 ms] of the ON
held. When the Instruction Execution Flag B-bit is the PMCR instruction
execution condition, the PMCR instruction will be executed during the
forced abort process and cause the FAL9C error. Therefore, execute the
PMCR instruction after the minimum period [CPU Unit cycle time + 15 ms]
after the Forced Abort Flag is changed from OFF to ON.

Example The Forced Abort Flag is turned ON, the 30 ms period is elapses, the Forced
Abort Flag is turned OFF, and simultaneously the PMCR instruction interlock
is released.

Instruction  Forced Abort
Input condition Execution Flag Flag

00000 28908 28911
11 LK LK
1T Pql Pql PMCR
The condition
to allow the abort TO0O A

1 s O

TIMH

000

#0003

T000 28911
)4 Forced
Al O Abort Flag

The condition to
allow the abort

5

—
30 ms 1 cycle

|

I

TOOO

Forced Abort Flag
28911

Instruction
execution flag

1L
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Calculation Method of Monitoring Time Section 4-5

4-5 Calculation Method of Monitoring Time

The calculation method of monitoring time for the operand addressing (with-
out response writing) is shown here. Referring to this calculation method, cal-
culate the monitor times for the operand addressing (with response writing),
link word addressing, and direct addressing. When actually setting the moni-
tor times as sequence data, be sure to provide sufficient allowance.

Protocol Support
CPU Unit Board External device
PMCR #01E1
#0001
D00000 | — > D0000
D01000 | ]
. PMCR Send data
instruction conversion
process process
«——————————————— PP +——>
External
1 2 3 device
rocess
- D1000 P
Received Redcgti;ecj
data writ- conversion
ing process
<4t P4 P4+— >
7 6 5 4
Number Function Time Required Description

1 PMCR instruction’s process time | Depends on the Unit/Board being | Internal process time from the
used. start of PMCR instruction to the

end of the send data transfer

2 Send data conversion process Depends on number of conversion | Time from the end of the send

time bytes data conversion based on the
specified conversion method to
the start of the send data to the
external device.

3 Send data transmission time Number of data characters x num- | Time required to the send data
ber bits in one character/ trans- transmission to the external
mission rate device. When designing, use

double the calculated time
because idle time exists between
the send characters.

4 External device process time Depends on the external devices’ | Time required by the external
process device to process according to the

command from the PLC until the
start of the send response data.

5 Received data transmission time | Number of data characters x one | Time required to transmit the
character bit/ transmission rate received data from the external

device. When designing, use two
to five times the calculated time
because idle time exists between
the receive characters.
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Calculation Method of Monitoring Time Section 4-5

Number Function Time Required Description
6 Received data conversion process | Depends on number of conversion | Time required for the conversion
time bytes of the received data from the

external device based on the
specified conversion method

7 Received data writing time One cycle time maximum Time required to finish the
received data transfer to the 1/0
memory.

Note Although the data conversion process times of 2 and 6 vary according to the
PLC operation status, for the CS/CJ, the maximum values can be estimated
with the following calculation formula:

2: The send data conversion process time = 10 ms + one-byte conversion
time x number of conversion bytes

Reverse conversion: 5 us, ASCIl reverse conversion: 4 us, hexadecimal
reverse conversion: 7 us

(One-byte conversion time — No conversion: 1 us, reverse conversion: 5 pus,
ASCII conversion: 10 us, ASCII reverse conversion: 4 us, hexadecimal con-
version: 7 us, hexadecimal reverse conversion: 7 us)

6: The receive data conversion process time = 2 ms + one-byte conversion
time x number of conversion bytes

(One-byte conversion time — No conversion: 1 us, reverse conversion: 4 us
ASCII conversion: 8 us, ASCII reverse conversion: 9 us, hexadecimal conver-
sion: 17 us, hexadecimal reverse conversion: 17 us)

* Calculation Example of the Send Finish Monitoring Time, (Tfs)

The send finish monitoring time (Tfs) is set so as to perform monitoring from
the time the leading byte (start character) is sent to the time the last data byte
(end character) is sent. Therefore, in consideration of number 3 (send data
transmission time: number of data characters x number bits in one character/
transmission rate) in the table, the send finish monitoring time is Tfs > Number
of data characters x number of bits in one character x 2/transmission rate.

Example @ + 5 + hexadecimal data of 5 words + CRC-CCITT (BIN) 2 bytes + CR =15
characters (120 bits)
1+1+10+2+1=15
One character equals 12 bits under the following condition:
Start bit: 1 bit; Data: 8 bits; Parity: Yes; Stop Bit: 2 bits
Therefore, 15 x 2 = 180 bits
180/9,600 = 0.01875 seconds

In practice, however, it must be set to a value double the calculated time
because an idle time exists between characters sent from the PMSU as
shown below:

0.01875 x 2 = 0.0375 seconds

Since the unit of the monitoring time is in the range of from 0.01 seconds
(10 ms) to 99 minutes, users can set the Tfs to 0.04 seconds after which the
system executes the error process or the retry process.

» Example to Set Up the Receive Wait Monitoring Time (Tr)

The receive wait monitoring time (Tr) sets the monitoring time from the sys-
tem’s recognition of the received command in the applicable step and to the
receiving of the beginning one-byte (the start character). In the above table, it
refers to a total of 4+5 for the beginning character and it can be set in the
range where the following equation is satisfied:

The receive wait monitor time, Tr > 4+5 for the beginning character
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Operation Confirmation

Section 4-6

When this time is up, the system executes the error process or the retry pro-
cess.

» The Receive Finish Monitoring Time (Tfr)

The receive finish monitoring time (Tfr), monitors the receiving time from the
receipt of the beginning one-byte (the start character) to the receipt of the last
one-byte data (the end character). In the above table, it refers to 5. As in the
case of the send finish monitor time, an idle time exists between receive char-
acters and depending on devices to be connected, the time varies. Therefore,
it is recommended that the time be set to two to five times of the calculated
time. It can be set in the following range:

The receive finish monitor time, Tfr > 5 x (2 to 5)

When this time is expired, the system executes the error process or the retry
process.

4-6 Operation Confirmation
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“Tracing the Transmission Line” and “I/O Memory Monitor of the PLC” func-
tions are available with the Protocol Support Tool to confirm the operation of
the created protocol macro.

» Tracing the Transmission Line
Trace the transmission data and the control signals flowing on the trans-
mission line (RS-232C or RS-422A/485). With this function, users can
confirm the data and signals flowing on the transmission line, even if they
do not have the protocol analyzer.

Trace display for send message, receive
message, step number, and control signals.

( 17 T T 17T 1T T T \

@0 2R
Personal Compute/ Send message 40 30 32 52

Receive message @ 00
40 30 30
Step No. 0 0 0 O 00O

‘ RTS
39 cTS

\. J

PLC

External general-purpose device

L Tracing the send/receive message or control
signals that runs through the transmission line.
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/0O Memory Monitor of the PLC
Monitor or edit the I/O memory areas on the PLC. With this function,
users can set or edit the send data or receive data designated in the 3rd
and 4th operands of the PMCR instruction (2nd and 3rd operands for the
C200HX/HG/HE), monitor the receive data, and monitor the contents of
data in the auxiliary area.

4 N

/ Address| O 1 2

0000 | 0000 0002 | 0003
0010 | B3B4 | 0000 | 0004
0020 | 03B6| 0000 | 0000

Personal Computer

- J

PLC - External general-purpose device

e Displays I/0 memory
area of the PLC

When an error occurs while the ladder program is executed, users can search
for the cause of the error by checking various flags. Refer to 3-10 Auxiliary
Area and Allocated Data Areas.
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Errors at the Protocol Execution

Section 4-7

4-7 Errors at the Protocol Execution

When an error listed below occurs, take the appropriate action by referring to
the following table. Refer to the Serial Communications Board/Serial Commu-

nications Unit Operation Manual (W336).

4-7-1 CS/CJ
Note For the Serial Communications Board:
m = DM32000 (words)
n = 1900 (words)
For the Serial Communications Unit:
m = DM30000 + 100 x unit number (words)
n = 1500 + 25 x unit number (words)
Problem Allocated data Cause Action
Serial Indicator display Status area
communications information
mode setting

Serial Bits 12 to 15 Serial Set bits 11 to 08
communications (serial communications (serial
mode is not set to communications mode setting is communications
protocol macro. mode) of wrong. mode) of m/m+10

allocated data

in the allocated

condition, bit 15
(Protocol Macro
Execution Flag) in
the allocated data
area (n+9/n+19) is
set to normally
open.

area (n+5/n+15) DM are to 6
are not 6 hexadecimal
hexadecimal. (protocol macro).
Serial SDLI/RDL], Although PMCR Bits 00 to 07 of the | Either operand See table on
communications COM[] indicators |instruction is Communications | settings of the page 188.
mode is set to are not lit. executed, bit 15 Port Execution PMCR instruction
protocol macro. (Electrically not (Protocol Macro Error Flag (A219 |are wrong or
connected) Execution Flag) in | words) are setto 1 | execution timing is
the allocated data | (ON). not correct.
area (n+9/n+19) ~ FAg '3 PMCR Programming As a PMCR
does not turn ON. | jnstryction error instruction
execution execution

condition, set bit
15 (Protocol
Macro Execution
Flag) to normally
closed.

ER Flag (one of
the condition
flags) is ON.

C1 data range of
PMCR instruction
is illegal; number
of words in S or D
data exceeds 250;
or
Communications
Port Enabled Flag
is OFF.

Check if C1, S,
and D operands of
PMCR instruction
are properly set.

AER Flag (one of
the condition
flags) is ON.

Access prohibit
area is
designated in S or
D of PMCR
instruction.

Check if S and D
operands of
PMCR instruction
are properly set.
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Errors at the Protocol Execution Section 4-7
Problem Allocated data Cause Action
Serial Indicator display Status area
communications information
mode setting

Serial SDLI/RDL], Although PMCR Bits 00 to 03 (error | Sequence Set C2 of PMCR

communications COMLl indicators | instruction is codes) in the number instruction to 0000

mode is set to are not lit. executed, bit 15 allocated data designated in C2 |to O3E7

protocol macro. (Electrically not (Protocol Macro area (n+9/n+19) | of PMCR instruc- | hexadecimal (000

connected) Execution Flag) in |are setto 2 tionis setto a to 999 decimal)

the allocated data | hexadecimal value other than | check if
area (n+9/n+19) (sequence number | 000 to 3E7 communications
does not turn ON. | error). hexadecimal (000 sequence number

to 999 decimal).

Communications
sequence number
that does not exist
in the protocol
datais
designated.

is correct.

Bits 00 to 03 (error
codes) in the
allocated data
area (n+9/n+19)
are setto 3
hexadecimal (data
read/write range
over error).

When storing or
reading data from
1/0 area of CPU
Unit, designated
area range is
exceeded.

Designate another
area or reduce the
send/receive data
size.

Bits 00 to 03 (error | Protocol data in Using the
codes) in the the PMSU is CX-Protocol,
allocated data faulty. rewrite the
area (n+9/n+19) protocol data.
are setto 4

hexadecimal

(protocol data

syntax error).

Communications | SEND, RECYV, Use another

Port Enabled
Flags (A20200 to
A20207) are OFF
(unable to exe-
cute)

CMND or other
PMCR instruction
is being executed
using the same
communications
port number

communications
port not used for
SEND, RECV,
CMND, or other
PMCR instruction
being executed
(by changing the
setting of C1 bits
12 to 15) or wait
until the port

becomes

available.
As a PMCR Programming As a PMCR
instruction error instruction
execution execution

condition, the
Communications
Port Enabled Flag
(A20200 to
A20207) is set to
normally closed.

condition, set the
Communications
Port Enabled Flag
to normally open.

Bit 00 (port
operation) in the
allocated data
area (n+6/n+16) is
set to O (port stop)

Either protocol
data is being
transferred or
SUM value error
has occurred.

Wait until the
protocol data
transfer is com-
pleted or transfer
the protocol data
using the
CX-Protocol.
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Errors at the Protocol Execution Section 4-7
Problem Allocated data Cause Action
Serial Indicator display Status area
communications information
mode setting
Serial SDLI/RDL], Bit 15 (Protocol Send processing | Send wait time set | Using the
communications COML] indicators | Macro Execution |is not executed. for each step of CX-Protocaol,
mode is set to are not lit. Flag) in the the check if the send
protocol macro. (Electrically not allocated data communications | wait time is prop-
connected) area (n+9/n+19) sequence is erly set.
turns ON when extremely long.
PMCR instruction [gjt 10 (destination | RTS/CTS flow Clear the busy
is executed. busy receiving) in |control of trans- | state of the
However, data the allocated data | mission control destination so that
cannotbe properly | areq (n+7/n+17) is | parameter is set to |the local CTS
sentorreceived. | oN (destination | Yes and the CTS  |signal turns ON.
busy). signal from the
destination does
not turn ON.
Bit 09 (Sequence |Wait command Review the
Wait Flag) in the | cannot be cleared. | program so that
allocated data are bits 00 and 08
(n+9/n+19) is ON (wait clear switch)
(sequence wait). in the allocated
data area (n
words) turn from
OFF to ON.
Bit 15 (Protocol Bits 03 and 11 The forced abort | Clear the forced
Macro Execution | (forced abort switch is set to the |abort switch
Flag) in the switch) in the forced setting. setting.
allocated data allocated data (n)
area (n+9/n+19) are set to the
turns ON forced setting.
momentarily or
does not turn ON
at all.
SDLI/RDL], Bit 10 (Sequence | Sequence was Protocol macro Using the trans-

COMLI indicators
are lit. However,
communications
cannot be
performed.

Abort Termination
Flag) in the
protocol allocated
data area (n+9/
n+19) is ON.

subjected to abort
termination.

data is not
properly set.

System settings
such as baud rate
or frame format
are different from
those of the

mission line trace
function of the
CX-Protocol,
check if protocol
data or system
settings are cor-
rect.

destination.
Bit 15 (Protocol Sequence is being | Protocol macro Using the
Macro Execution | executed and data is not transmission line

Flag) in the
allocated data
area (n+9/n+19)
remains ON when
PMCR instruction
is executed
without setting the
monitor time for
each sequence.

cannot be
terminated (data
receiving state).

properly set.

System settings
such as baud rate
or frame format
are different from
those of the

destination device.

trace function of
the CX-Protocol,
check if protocol
data or system
settings are cor-
rect.

Send data is being
sent, but no
response is
received from the
destination device.

Allocated data
area (n+5/n+15)
(system settings
with port settings)
are different from
those of the
destination device.

Bits do not match
due to baud rate
exceeding the
permissible range,
mismatching stop
bits, etc.

Review the
system settings.
Review the
settings and
program of the
destination device
(baud rate, frame
format, etc.).
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Problem Allocated data Cause Action
Serial Indicator display Status area
communications information
mode setting
Serial SDUI/RDL, Send data is being | Bit 15 Cable connection | Check the cable

communications
mode is set to
protocol macro.

COML indicators
are lit. However,
communications
cannot be
performed.

SDUI/RDL,
COML indicators
are not lit.

sent, but no
response is
received from the
destination device.

(transmission
error) in the
allocated data
area (n+8/n+18)
turns ON.

One of bits 0 to 14
(errors) turns ON.

is faulty.

Setting of the
2-wire/4-wire
selection switch
on the port 2 of
RS-422/485 does
not match with the
wiring. (Only for
CS1W-SCB41)
Adapter
(NT-ALOO01, etc.)
wiring is faulty.

connection.

Turn ON the
terminating
resistance
(terminating resis-
tance ON/OFF
switch) on the
Board side and on
the final
destination device
and turn OFF the
terminating
resistances of
other destination
devices.

Hardware is faulty.

Set bits 11 to 08
(serial
communications
mode) in the allo-
cated DM are (m/
m+10) to F hexa-
decimal (cyclic
test serial commu-
nications mode),
connect the cycli-
cally wired con-
nectors, and
execute the cyclic
test (turn ON port
1: bit 06 and port
2: bit 14 of the n
word).

Test status is
reflected on n+9/
n+19.

If the test results
show an error,
replace the
PMSU.

SDLI/RDL,
COMLI indicators
are lit. However,
communications
cannot be per-
formed and com-
munications errors
occur from time to
time.

Transmission error
occurs.

Bit 15 (transmis-
sion error) in the
allocated data
area (n+8/n+18)
turns ON.

One of bits 0 to 14
(errors) turns ON.

Allocated data
area (n+5/n+15)
(system settings
with port settings)
are different from
those of the desti-
nation device.

System settings
such as baud rate
or frame format
are different from
those of the desti-
nation device.

Bits do not match
due to baud rate
exceeding the per-
missible range,
mismatching stop
bits, etc.

Review the
system settings.
Review the
settings and
program of the
destination device
(baud rate, frame
format, etc.).
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Problem

Serial
communications
mode setting

Indicator display

Status
information

Allocated data
area

Cause

Action

Serial
communications
mode is set to
protocol macro.

SDLI/RDL,
COML indicators
are lit. However,
communications
cannot be per-
formed and com-
munications errors
occur from time to
time.

Data is received
according to the
transmission line
trace of the CX-
Protocol. How-
ever, the protocol
macro does not
recognize data
reception.

Received data is
discarded during
the time lag
between the data
transmission com-
pletion and the
Send processing
completion
because the
response from the
destination device
was received too
early under the
half-duplex
setting.

Change to the
full-duplex setting.

Responses from
the destination
device are occa-
sionally not
received. How-
ever, response is
received when
retry processing is
conducted.

Data sending tim-
ing is too early for
the destination
device to receive
data.

Set or extend the
send wait time
(time until send
data is actually
sent out) set for
each step.

Transmission
error occurs
occasionally.

Bit 15
(transmission
error) in the
allocated data
area (n+8/n+18)
turns ON.

One of bits 0 to 14
(errors) turns ON.

Cable connection
is faulty.

Terminating resis-
tance on
RS-422/485 portis
not set properly.

Adapter
(NT-ALOO01, etc.)
wiring is faulty or
its terminating
resistance setting
is wrong.

Check the cable
connection.

Turn ON the termi-
nating resistance
(terminating resis-
tance ON/OFF
switch) on the
Board side and on
the final destina-
tion device and
turn OFF the ter-
minating resis-
tances of other
destination
devices.

Communications
error frequently
occurs due to
noise.

Change the cable
to twisted-pair
shielded cables.

Separate the
cables from power
lines.

Check the possi-
ble environmental
noise.

Both RDY and
ERC (ERR/ALM)
flash.

Bit 00 (protocol
data error) in the
allocated data
area (n+1) is ON.

Error in the proto-
col macro data
SUM value.

Using the
CX-Protocol,
transfer correct
protocol data.

Serial
communications
mode is set to
protocol macro.

RDY is lit and
ERC (ERR/ALM)
flashes.

Bits 00 to 03 (port
operation error
code) in the allo-
cated data area
(n+9/n+19) are not
set to 0 hexadeci-
mal.

Protocol macro
detected an error
to stop operation.

Refer to page 189.
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Note To enable changes in the system settings, reset the power supply and restart

the PMSU, restart the ports, or execute the STUP instruction.

Countermeasures for Errors Displayed as Network Communications Termination Codes

(A203 to A210)

Network communications termination code

Bits 08 to 15

Bits 00 to 07

Description

Action

02 hexadecimal

02 hexadecimal

PMSU that correspond to the
unit number address does
not exist.

Check if the PMCR
instruction (C1: communica-
tions port number) desig-
nates another PMSU or
serial port (physical port).

04 hexadecimal

01 hexadecimal

Designated service is not
supported.

Check if the PMCR
instruction (C1: communica-
tions port number) desig-
nates another PMSU or
serial port (physical port).
Check if the serial communi-
cations mode of the serial
port designated in C1 is set
to protocol macro. (Set the
serial communications mode
to protocol macro.)

02 hexadecimal

05 hexadecimal

Response has not been
returned from the destination
device and the monitor time
has timed out.

Check if the serial communi-
cations mode of the serial
port designated in C1 is set
to protocol macro. (Set the
serial communications mode
to protocol macro.)

11 hexadecimal

06 hexadecimal

No corresponding
communications sequence
number

A number not registered in
the PMCR instruction (C2:
communications sequence
number) has been
designated.

Using the CX-Protocol,
register the communications
sequence.

22 hexadecimal

01 hexadecimal

Impossible to execute
because protocol macro is
being executed.

An attempt is made to
execute the PMCR
instruction while protocol
macro is being executed.

Change the bit 15 (Protocol
Macro Execution Flag) in the
allocated data area (n+9/
n+19) to normally closed and
modify the ladder program to
execute the PMCR
instruction.

24 hexadecimal

01 hexadecimal

There is no registered table.

One of the following;

« Protocol macro (communi-
cations sequence) data
has not been registered.

» Protocol macro (communi-
cations sequence) data is
being registered (trans-
ferred).

» Protocol macro (communi-
cations sequence) data
has SUM value error.

Using the CX-Protocol,
transfer correct protocol
macro (communications
sequence) data.
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Countermeasures for Bits 00 to 03 of Protocol Macro Error Codes (n+9/n+19)
Error code Indicator Description Cause Action
0 hexadecimal Normal
1 hexadecimal Reserved for the - -
system
2 hexadecimal No indication Sequence number A number not  Correct the

error

registered in the
PMCR instruction
(C2: communications
sequence number)
has been designated.

communications
sequence number.
 Using the
CX-Protocaol,
register the
designated
sequence number.

3 hexadecimal

ERC flashes and ERR/
ALM flashes.

Data read/write range
over error

When storing or
reading data from the
CPU Unit, designated
area range is
exceeded.

In case of operand
addressing:

Check the contents
designated in S and D
operands of PMCR
instruction.

In case of link word/
direct addressing:
Using the CX-Protocol,
check the designated
range.
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Error code Indicator Description Cause Action
4 hexadecimal ERC flashes and Protocol data syntax | Some codes could not | Check and correct the
ERR/ALM flashes. error be executed during following items:
protocol execution. « Total of the areas

(01, 02,11, and 12)
designated by the
link word exceeded
500 words.

The same area
designated by the
link word was used
for ports 1 and 2.
Writing was desig-
nated for the param-
eter designation.
EM area read/write
was designated for
the interrupt notifica-
tion. (Only for the
Serial Communica-
tions Board)

Interrupt natification
was designated for
the Unit. (Only for
the Serial Communi-
cations Unit)

More than 30 write
attributes were set
for one message.

Send/receive
message length was
set to O bytes.
Send/receive
message length
exceeded the
maximum send/
receive bytes.

Message was not
registered for the
matrix reception.
Both the RTS/CTS
flow control and Xon/
Xoff control were
designated as
transmission control.
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4-7-2 C200HX/HG/HE
Problem Cause Action

PMSU does
not operate.

The RDY indicator turns OFF.

PMSU is abnormal

Replace the PMSU and
reconnect the power.

System error
FAL9C
occurred.

26800 is ON

PMSU is abnormal.

Replace the PMSU and
reconnect the power.

26801 is ON and the RDY indicator
turns OFF.

This error occurs when the RS-232C
port is not recognized when the power
is turned ON due to abnormal
hardware.

Replace the PMSU and
reconnect the power.

26802 is ON

PMSU protocol data is abnormal.

Rewrite the protocol
data by using the
Protocol Support Tool.

System errors
FAL9C and
FAL9B
occurred

26815 is ON and the RDY indicator
flashes.

« The PMSU system setting
(DM 6550 to DM 6559) has incorrect
setting values.
If 26813 is ON, the port B has a
problem.

e The PMSU does not support the
protocol macro function.

* Check the PMSU
system setting con-
tents of the problem
port and restart the
system.

» Use a PMSU which
supports the protocol
macro function.

System error
FALO9C
occurred when
the PMCR
instruction is
executed.

Instruction
Execution Flag
is not set to
ON. 28908 is
Port A. 28912
is Port B.

26811 is ON (Port B) or 26812 is ON
(Port A).

The protocol macro error (PMCR
instruction relating error) occurred.
The details are registered as error
codes.

Take necessary actions
in accordance with the
error codes.

Error codes Error code: 1
28608 to 11 (Port A)

28612 to 15 (Port B)

e The PMSU system (DM 6550 to DM
6559) is not set to the protocol
macro mode.

* The PMSU does not support the
protocol macro function.

¢ Check the PMSU sys-
tem setting contents of
the problem port.

e Use the PMSU which
supports the protocol
macro function.

Error code: 2

The sequence number is not present.

Reset the first operand
of the PMCR instruc-
tion. Otherwise, transfer
the sequence number to
the PMSU.

Error code: 3

The received data overflowed when
writing it in the I/O memory.

Specify another area.
Otherwise, reduce the
receive data size.

Error code: 4

The PMSU data error.

Rewrite the protocol
data by using the
Protocol Support Tool.
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Communications Response Time Performance

Section 4-8

Problem

Cause

Action

The data send/
receive is not
well executed
despite the
PMCR instruc-
tion execution.

28909 is ON (Port A) or 28913 is ON
(Port B).

The step is executed the error pro-
cess during the sequence because
the receive message does not match
with the expected receive message.

Search the error cause
and add the appropriate
process.

28304 is ON (Port A) or 28312 is ON
(Port B).

The communications error occurred
during the message receive.

Confirm the
communications

error codes.
28300 to 03 (Port A)
28608 to 11 (Port B)

The Instruc- route to the

tion Execution connected devices.
Flag is ON.

28908 is Port

A.28912is

Port B

Communica- |28304 is ON (Port A) or 28312 is ON | This error occurred due to an abnor- | Restart the problem
tions with the | (Port B). mal communications route to the con- | port or initialize each
connected nected devices or by a relay by executing the
devices is communications condition setting fail- | RXD and PMCR
impossible. ure. The details are registered as instructions.

* Confirm the communi-
cations route.

¢ Check the communi-
cations condition set-
ting.

PMCR instruc-
tions are not
executed.

ER Flag (25503) is ON.

This error occurs by the instruction
operand setting failure.

Check the instruction
operand.

4-8 Communications Response Time Performance

The response performance of communications with the external devices using
PMCR instruction, which varies according to the definition of the Protocol
Macro, is divided in the following four modes:

* Use the event (operand addressing) areas

* Use the interrupt mode for the response type
* Use the link word area

 Use the direct addressing
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Communications Response Time Performance Section 4-8

4-8-1 CS/CJ

The previous four modes are different in data transmission mode between the
CPU Unit and the Board/Unit. There are three kinds of data transfer modes
from the CPU Unit to the Board/Unit, while there are four kinds of data transfer
modes from the Board/Unit to the CPU Unit. The communications response
time varies according to the combination of those modes.

=

Use the event area

Use the event area

—

Use the interrupt mode

—

Use the link word area

—

Use the link word area

—

Use the direct addressing

—

Use the direct addressing

lun NdO
preog 1oddns j020101d

S

* Communications Response Time Using the Event (Operand Addressing)

Area
lllustrated below is the data flow when the communications area
addressed by the third and the fourth operand of the PMCR instruction is
used:

CPU Unit PMSU External device

PMCR #0110
#0000
DO0000
D1000

—* DO0000

_ PMCR
instruction
process

Send data
conversion
process

—> D1000

«————————— P +——>
External

1 2 3 device
process

Received
data
conversion
process

Received
data writing

The communications response time is the total time from 1 to 7 in the above
figure.
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Communications Response Time Performance Section 4-8
Number Function Time Required Description
1 PMCR instruction 15 ms + two-cycle time The internal process time from the
process time maximum start of PMCR instruction to the end
of the data transfer to the Board/Unit.
2 Send data conversion Depends on the number | The time required for the send data
process time of conversion bytes conversion based on the specified
conversion mode which finishes at
the start of data sending to the
external device.
3 Send data transmission | Number of data The time required for the send data
time characters x transmission to the external device.
one-character (Use double the calculated time
bit/ transmission rate because idle time exists between
send characters.)
4 External device process |Depends on the external | The time required for the external
time device process device process according to the
PLC’s command which finishes by
the start of the response data
sending.
5 Received data transmis- | Number of data The time required for the received
sion time characters x data transmission from the external
one-character device.
bit/ transmission rate (Use two to five times the calculated
time because idle time exists
between the receive characters.)
6 Received data Depends on the number | The time required for the received
conversion process time | of conversion bytes data conversion from the external
device based on the specified
conversion mode which finishes at
the end of data transfer
7 Received data writing Board: One-cycle time The time required to finish received
process time maximum data transfer to I/O memory.
Unit: Two-cycle time
maximum

Note Although the data conversion process times of 2 and 6 vary according to the

PLC operation status, the maximum values can roughly be estimated by the
following calculation formula:

2: The send data conversion process time = 10 ms + one-byte conversion
time x number of conversion bytes

Reverse conversion: 5 us, ASCIl reverse conversion: 4 us, hexadecimal
reverse conversion: 7 us

(One-byte conversion time — No conversion: 1 us, reverse conversion: 5 pus,
ASCII conversion: 10 us, ASCII reverse conversion: 4 us, hexadecimal con-
version: 7 us, hexadecimal reverse conversion: 7 us)

6: The receive data conversion process time = 2 ms + one-byte conversion
time x number of conversion bytes

(One-byte conversion time — No conversion: 1 us, reverse conversion: 4 us
ASCII conversion: 8 us, ASCII reverse conversion: 9 us, hexadecimal conver-
sion: 17 us, hexadecimal reverse conversion: 17 us)
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Communications Response Time Performance Section 4-8

* Communications Response Performance Using the Interrupt Notification
Mode
lllustrated below is the data flow when the event area (operand address-
ing) is used and the response type is the interrupt mode. The interrupt
notification mode is only available with the Serial Communications Board.

CPU Unit PMSU External devices

PMCR #01E1
#0000
D0000 [ ¥ DO0000
D1000 [

PMCR
instruction
process

Send data
conversion
process

External
» D1000 1 2 3 device
process

Received
data conversion
process

Board
interrupt
process

The communications response time is the total time from 1 to 7 in the above
figure.
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Communications Response Time Performance Section 4-8
Number Function Time Required Description
1 PMCR instruction 15 ms + two-cycle time The time from the start of PMCR
process time maximum instruction to the end of the data
transfer to the Board.
2 Send data conversion Depends on the number | The time required for the send data
process time of conversion bytes conversion based on the specified
conversion mode which finishes at
the start of data sending to the
external device.
3 Send data transmission | Number of data The time required for the send data
time characters x transmission to the external device.
one-character (Use double the calculated time
bit/ transmission rate because an idle time exists between
send characters.)
4 External device process |Depends on the external | The time required for the external
time device process device process according to the
PLC’s command which finishes by
the start of the response data
sending.
5 Received data Number of data The time required for the received
transmission time characters x data transmission from the external
one-character device.
bit/ transmission rate (Use two to five times the calculated
time because idle time exists
between the receive characters.)
6 Received data Depends on the number | The time required for the received
conversion process time | of conversion bytes data conversion from the external
device based on the specified
conversion mode which finishes at
the end of data transfer.
7 Board interrupt process | About 50 us The time from the response interrupt
time (+0 to 2 ms) (see note) notification to the end of the received
data transfer to I/O memory.
Note 1. When interrupt notifications are issued consecutively, a time lag of 2 ms

will occur between notifications. A time lag of 2 ms is provided between in-
terrupt notifications issued consecutively through the ports 1 and 2.

2. Although the data conversion process times of 2 and 6 vary according to
the PLC operation status, the maximum values can roughly be estimated
by the following calculation formula:

2: The send data conversion process time = 10 ms + one-byte conversion
time x number of conversion bytes

Reverse conversion: 5 us, ASCII reverse conversion: 4 us, hexadecimal re-
verse conversion: 7 us

(One-byte conversion time — No conversion: 1 us, reverse conversion:
5 us, ASCII conversion: 10 us, ASCII reverse conversion: 4 us, hexadeci-
mal conversion: 7 us, hexadecimal reverse conversion: 7 us)

6: The receive data conversion process time = 2 ms + one-byte conversion
time x number of conversion bytes

(One-byte conversion time — No conversion: 1 us, reverse conversion:
4 us ASCII conversion: 8 us, ASCII reverse conversion: 9 us, hexadecimal
conversion: 17 us, hexadecimal reverse conversion: 17 ps)
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Communications Response Time Performance Section 4-8

« Communications Response Performance Using the Link Word Area

Illustrated below is the data flow when the link word area is used for the
communications data storing area:

CPU Unit PMSU External devices
PMCR #0110 PMCR
#0000 instruction
#0000 process -
0000
< P Send data
1 conversion
process
ouT Send data
area notification

External
2 3 4 device
process

Received
data conversion
process

IN area

The communications response time is the total time from 1 to 8 in the above
figure.
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Communications Response Time Performance Section 4-8
Number Function Time Required Description
1 PMCR instruction execut- | 15 ms + two-cycle time The time from the start of PMCR
ing notification process maximum instruction to the end of the
time instruction notification to the PMSU.
2 Send data notification Board: One-cycle time The time required for the data
process time maximum transfer based on the PMSU
Unit: Two-cycle time max- | request.
imum
3 Send data conversion Depends on the number | The time required for the data
process time of conversion bytes conversion based on the specified
conversion mode which finishes at
the start of data sending to the
external device.
4 Send data transmission | Number of data The time required for the data
time characters x transmission to the external device.
one-character (Use double the calculated time
bit/ transmission rate because idle time exists between
send characters.)
5 External device process |Depends on the external | The time required for the external
time device process device process according to the
PLC’s command which finishes by
the start of the response data
sending.
6 Received data transmis- | Number of data The time required for the receive
sion time characters x data transmission from the external
one-character device.
bit/ transmission rate (Use two to five times the calculated
time because idle time exists
between the receive characters.)
7 Received data Depends on the number | The time required for the receive
conversion process time | of conversion bytes data conversion from the external
device based on the specified
conversion mode which finishes at
the end of data.
8 Received data writing Board: One-cycle time The time required for the received
process time maximum data transfer to I/O memory.
Unit: Two-cycle time
maximum

Note Although the data conversion process times of 2 and 6 vary according to the
PLC operation status, the maximum values can roughly be estimated by the
following calculation formula:

2: The send data conversion process time = 10 ms + one-byte conversion
time x number of conversion bytes

Reverse conversion: 5 ps, ASCII reverse conversion: 4 us, hexadecimal
reverse conversion: 7 us

(One-byte conversion time — No conversion: 1 us, reverse conversion: 5 pus,
ASCII conversion: 10 us, ASCII reverse conversion: 4 us, hexadecimal con-
version: 7 us, hexadecimal reverse conversion: 7 pus)

6: The receive data conversion process time = 2 ms + one-byte conversion
time x number of conversion bytes

(One-byte conversion time — No conversion: 1 us, reverse conversion: 4 us
ASCII conversion: 8 us, ASCII reverse conversion: 9 us, hexadecimal conver-
sion: 17 us, hexadecimal reverse conversion: 17 us)
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Communications Response Time Performance Section 4-8

* Communications Response Time Using the Direct Addressing
lllustrated below is the data flow when the direct addressing is used:

CPU Unit PMSU External devices

PMCR
instruction
PMCR #0110 process
#0000 |~ S 1 >
0000
< —>

Send data
conversion
process

Send data

memory notification

Repeat 2and 3 by the Edgsircr;al
number of variables of process

the direct addressing

Received
data conversion
process

Repeat 7and 8 by the
number of variables of
the direct addressing

The communications response time is the total time from 1 to 8 in the above
figure. The functions 2 and 3 are repeated by the number of variables of the
direct addressing of the send message while 7 and 8 are repeated by those of
the receive message.
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Communications Response Time Performance Section 4-8

Number Function Time Required Description
1 PMCR instruction executing |15 ms + two-cycle time The time from the start of
notification process time maximum PMCR instruction to the end
of the instruction notification
to the PMSU.
2 Send data notification pro- Board: One-cycle time The time required for the
cess time maximum send data transfer based on
Unit: Two-cycle time the PMSU request.
maximum
3 Send data conversion pro- Depends on the number of The time required for the sent
cess time conversion bytes data conversion based on the

specified conversion mode
which finishes at the start of
data sending to the external

device.
4 Send data transmission time | Number of data characters The time required for the data
X one-character transmission to the external
bit/ transmission rate device.

(Use double the calculated
time because idle time exists
between send characters.)

5 External device process time | Depends on the external The time required for the
device process external device process
according to the PLC’s
command which finishes by
the start of the response data

sending.
6 Received data transmission | Number of data characters The time required for the
time X one-character received data transmission
bit/ transmission rate from the external device.

(Use two to five times the
calculated time because idle
time exists between the
receive characters.)

7 Received data conversion Depends on the number of | The time required for the
process time conversion bytes received data conversion
from the external device
based on the specified
conversion mode which
finishes at the end of data.

8 Received data writing Board: One-cycle time The time required for the
process time maximum received data transfer to 1/0O
Unit: Two-cycle time memory.
maximum

Note Although the data conversion process times of 2 and 6 vary according to the
PLC operation status, the maximum values can roughly be estimated by the
following calculation formula:

2: The send data conversion process time = 10 ms + one-byte conversion
time x number of conversion bytes

Reverse conversion: 5 ps, ASCII reverse conversion: 4 us, hexadecimal
reverse conversion: 7 us

(One-byte conversion time — No conversion: 1 us, reverse conversion: 5 pus,
ASCII conversion: 10 us, ASCII reverse conversion: 4 us, hexadecimal con-
version: 7 us, hexadecimal reverse conversion: 7 pus)

6: The receive data conversion process time = 2 ms + one-byte conversion
time x number of conversion bytes

(One-byte conversion time — No conversion: 1 us, reverse conversion: 4 us
ASCII conversion: 8 us, ASCII reverse conversion: 9 us, hexadecimal conver-
sion: 17 us, hexadecimal reverse conversion: 17 us)
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Communications Response Time Performance Section 4-8

* The Overhead at 1:N Connection
When the link word area or the direct addressing area is used, the send
data is transferred from the CPU Unit at every step, therefore time will be
required before the actual start of the data sending as follows:

« When the link word area is used: The total time of 2 + 3 in the
above figure (the link word)
« When the direct addressing is used: The total time of 2 + 3 in the

above figure
(the direct addressing)

These times are not required if the event (operand addressing) area is used,
because the beginning of sequence only in the send data is transferred from
the PLC’s CPU Unit.

4-8-2 C200HX/HG/HE

» Communications Response Time Using the Event (Operand Addressing)
Area
lllustrated below is the data flow when the communications area
addressed by the second and the third operand of the PMCR instruction
is used:

CPU Unit Board External device

PMCR #1234
D0000 | —* DO0000
D1000 | |

Send data
conversion
process

_ PMCR
instruction
process

«—————————— ¢ +——>
External

1 2 3 device
process

—> D1000

Received
data
conversion

process

Received
data writing

7 6 5 4

The communications response time is the total time from 1 to 7 in the above
figure.
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Communications Response Time Performance Section 4-8
Number Function Time Required Description
1 PMCR instruction pro- About 40 to 70 us The time from the start of PMCR
cess time instruction to the end of the data
transfer
2 Send data conversion Depends on the number | The time required for the send data
process time of conversion bytes conversion based on the specified
conversion mode which finishes at
the start of data sending to the
external device.
3 Send data transmission | Number of data The time required for the send data
time characters x transmission to the external device.
one-character (Use double the calculated time
bit/ transmission rate because idle time exists between
send characters.)
4 External device process |Depends on the external | The time required for the external
time device process device process according to the
PLC’s command which finishes by
the start of the response data
sending.
5 Received data transmis- | Number of data The time required for the received
sion time characters x data transmission from the external
one-character device.
bit/ transmission rate (Use two to five times the calculated
time because idle time exists
between the receive characters.)
6 Received data conver- Depends on the number | The time required for the received
sion process time of conversion bytes data conversion from the external
device based on the specified
conversion mode which finishes at
the end of data transfer
7 Received data writing One-cycle time maximum | The time required to finish received
process time data transfer to I/O memory.
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Note Although the data conversion process times of 2 and 6 vary according to the
PLC operation status, the maximum values can roughly be estimated by the
following calculation formula:
2: The send data conversion process time = 10,000 us + one-byte conversion
time x number of conversion bytes
(one-byte conversion time — No conversion: 15 us, ASCII conversion: 40 ps,
hexadecimal conversion: 55 ps)
6: The receive data conversion process time = 100 us + one-byte conversion
time x number of conversion bytes (one-byte conversion time—No conver-
sion: 15 us, ASCII conversion: 30 us, hexadecimal conversion: 15 us)



Communications Response Time Performance Section 4-8

* Communications Response Performance Using the Interrupt Notification
Mode
lllustrated below is the data flow when the event area (operand address-
ing) is used and the response type is the interrupt mode:

CPU Unit Board External devices
PMCR #1345
D0000 — D0000
D1000

PMCR
instruction
process

Send data
conversion
process

1 2 3 External

device
D1000 process

Board
interrupt
process

Received
data conversion
process

The communications response time is total time from 1 to 7 in the above fig-
ure.
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Communications Response Time Performance Section 4-8
Number Function Time Required Description
1 PMCR instruction About 40 to 70 us The time from the start of PMCR
process time instruction to the end of the data
transfer.
2 Send data conversion Depends on the number | The time required for the send data
process time of conversion bytes conversion based on the specified
conversion mode which finishes at
the start of data sending to the exter-
nal device.
3 Send data transmission | Number of data The time required for the send data
time characters x transmission to the external device.
one-character (Use double the calculated time
bit/ transmission rate because idle time exists between
send characters.)
4 External device process |Depends on the external | The time required for the external
time device process device process according to the
PLC’s command which finishes by
the start of the response data send-
ing.
5 Received data Number of data The time required for the received
transmission time characters x data transmission from the external
one-character device.
bit/ transmission rate (Use two to five times the calculated
time because idle time exists
between the receive characters.)
6 Received data Depends on the number | The time required for the received
conversion process time | of conversion bytes data conversion from the external
device based on the specified con-
version mode which finishes at the
end of data transfer.
7 PMSU interrupt process | About 50 us The time from start of response
time interrupt notification to the end of the
received data transfer to
I/O memory.
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Note Although the data conversion process times of 2 and 6 vary according to the
PLC operation status, the maximum values can roughly be estimated by the
following calculation formula:
2: The send data conversion process time = 10,000 us + one-byte conversion
time x number of conversion bytes
(One-byte conversion time—No conversion: 15 ps, ASCII conversion: 40 pus,
hexadecimal conversion: 55 us)
6: The received data conversion process time = 100 ps + one-byte conversion
time x number of conversion bytes
(one-byte conversion time—No conversion: 15 us, ASCII conversion: 30 ps,
hexadecimal conversion: 15 ps)



Communications Response Time Performance Section 4-8

« Communications Response Performance Using the Link Word Area

Illustrated below is the data flow when the link word area is used for the
communications data storing area:

CPU Unit Board External devices
PMCR
PMCR #1456 instruction
#0000 process
000
< P Send data
1 conversion
process
ouT Send data
area notification

External
2 3 4 device
process

Received
data conversion
process

IN area

The communications response time is the total time from 1 to 8 in the above
figure.
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Communications Response Time Performance Section 4-8
Number Function Time Required Description
1 PMCR instruction About 40 ps The time from the start of PMCR
executing notification instruction to the end of the
process time instruction notification to the PMSU.
2 Send data natification One-cycle time maximum | The time required for the data trans-
process time fer based on the PMSU request.
3 Send data conversion Depends on the number | The time required for the data
process time of conversion bytes conversion based on the specified
conversion mode which finishes at
the start of data sending to the
external device.
4 Send data transmission | Number of data charac- | The time required for the data
time ters x one-character bit/ | transmission to the external device.
transmission rate (Use double the calculated time
because idle time exists between
send characters.)
5 External device process |Depends on the external | The time required for the external
time device process device process according to the
PLC’s command which finishes by
the start of the response data
sending.
6 Received data transmis- | Number of data charac- | The time required for the receive
sion time ters x one-character bit/ | data transmission from the external
transmission rate device.
(Use two to five times the calculated
time because idle time exists
between the receive characters.)
7 Received data conver- Depends on the number | The time required for the receive
sion process time of conversion bytes data conversion from the external
device based on the specified
conversion mode which finishes at
the end of data.
8 Received data writing One-cycle time maximum | The time required for the received
process time data transfer to I/O memory.

Note Although the data conversion process times of 2 and 6 vary according to the
PLC operation status, the maximum values can roughly be estimated by the
following calculation formula:

2: The send data conversion process time = 10,000 us + one-byte conversion
time x number of conversion bytes

(one-byte conversion time—No conversion: 15 us, ASCII conversion: 40 ps,
hexadecimal conversion: 55 ps)

6: The receive data conversion process time = 100 us + one-byte conversion
time x number of conversion bytes

(one-byte conversion time—No conversion: 15 ps, ASCII conversion: 30 ps,
hexadecimal conversion: 15 pus)

AUDIN - g,oagenue de la malle - 51370 Saint Brice Courcelles - Tel : 03.26.04.20.21 - Fax : 03.26.04.28.20 - Web : http: www.audin.fr - Email : info@audin.fr



Communications Response Time Performance

Section 4-8

* Communications Response Time Using the Direct Addressing
lllustrated below is the data flow when the direct addressing is used:

CPU Unit

Board

External devices

PMCR #1567
#0000
000

PMCR
instruction

process

Send data
notification

Received
data writing

Send data
conversion
process

Repeat 2and 3 by the
number of variables of
the direct addressing

Received
data conversion
process

Repeat 7and 8 by the
number of variables of

the direct addressing

R e

External
device
process

The communications response time is the total time from 1 to 8 in the above
figure. The functions 2 and 3 are repeated by the number of variables of the
direct addressing of the send message while 7 and 8 are repeated by those of
the receive message.
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Communications Response Time Performance

Section 4-8

Number

Function

Time Required

Description

1

PMCR instruction executing
notification process time

About 40 ps

The time from the start of
PMCR instruction to the end
of the instruction notification
to the PMSU.

Send data notification
process time

One-cycle time maximum

The time required for the
send data transfer based on
the PMSU request.

Send data conversion
process time

Depends on the number of
conversion bytes

The time required for the sent
data conversion based on the
specified conversion mode
which finishes at the start of
data sending to the external
device.

Send data transmission time

Number of data characters x
one-character bit/ transmis-
sion rate

The time required for the data
transmission to the external
device.

(Use double the calculated
time because idle time exists
between send characters.)

External device process time

Depends on the external
device process

The time required for the
external device process
according to the PLC's
command which finishes by
the start of the response data
sending.

Received data transmission
time

Number of data characters x
one-character bit/ transmis-
sion rate

The time required for the
received data transmission
from the external device.
(Use two to five times the
calculated time because idle
time exists between the
receive characters.)

Received data conversion
process time

Depends on the number of
conversion bytes

The time required for the
received data conversion
from the external device
based on the specified
conversion mode which
finishes at the end of data.

Received data writing
process time

One-cycle time maximum

The time required for the
received data transfer to I/O
memory.
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Note Although the data conversion process times of 2 and 6 vary according to the
PLC operation status, the maximum values can roughly be estimated by the
following calculation formula:
2: The send data conversion process time = 10,000 us + one-byte conversion
time x number of conversion bytes
(one-byte conversion time—No conversion: 15 ps, ASCII conversion: 40 pus,
hexadecimal conversion: 55 pus)
6: The receive data conversion process time = 100 us + one-byte conversion
time x number of conversion bytes
(one-byte conversion time—No conversion: 15 us, ASCII conversion: 30 ps,
hexadecimal conversion: 15 ps)
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» The Overhead at 1:N Connection
When the link word area or the direct addressing area is used, the send
data is transferred from the CPU Unit at every step, therefore time is
required before the actual start of the data sending as follows:

» When the link word area is used: The total time of 2 + 3 in the
above figure (the link word)
» When the direct addressing is used: The total time of 2 + 3 in the

above figure
(the direct addressing)

These times are not required if the event (operand addressing) area is used,
because the beginning of sequence only in the send data is transferred from
the PLC’s CPU Unit.

4-9 Cycle Time Performance

When using the protocol macro function with the PMSU, the cycle time for the
CPU Unit of the CS/CJ will vary within the ranges shown below. In order to fix
the cycle time, using the fixed cycle time function at the CPU Unit, set a fixed
cycle time based on the value for the maximum variation time.

 Serial Communications Board
Minimum variation time =  0.25 ms (common processing time)
Maximum variation time = 0.25 ms + 0.001 ms x maximum number of
words of send/receive data (0 to 500 words) + 1.3 ms

* Serial Communications Unit
Minimum variation time (per Unit) = 0.25 ms (common processing time)
Maximum variation time (per Unit) = 0.25 ms + 0.001 ms x maximum
number of words of send/receive data (0 to 500 words)
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SECTION 5
Object Creation

This section describes how to create objects, such as projects, protocols, sequences, steps, messages, and matrices.

5-1 Creating Projectsand Protocols. . ... 212
5-1-1 CreatingaNew Project . ..., 212
5-1-2 CreatingaNew Protocol ............ ..., 213
5-1-3 RenamingaProtocol ............c.coiiiiiiii 214
5-1-4  Setting the Protocol Sequence Number Range .. .............. 215
5-1-5 SettingtheBoardand Unit................................ 215
5-2 Creating Sequencesand StEPS . ... ..o oot 216
5-2-1 CreatingaNew SequenCe ... 216
5-2-2 CreatingaNew Step. . .. ..ot 216
5-3 Creating Messagesand Matrices .. ...t 217
5-3-1 CreatingaNewMessage .. .......oviiiiiiiii i 217
5-3-2  CreatingaNew MatrixX..........ccooviiiiiiniiinn.. 218
5-4 System Protocol Display and Editing. ... ........... ... ... ... ... .. 219
5-4-1 Displaying System Protocols. .. ... 219
5-4-2  Copying System Protocolsor Sequences. . ................... 219
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5-1 Creating Projects and Protocols

5-1-1 Creating a New Project

Use the following procedure to create a new project.

1,2,3... 1. Select New from the File menu or left-click the New button from the tool-
E bar. Alternatively, a new project is created by pressing the Ctrl+N Keys.
2. The following window will be displayed. Select the PC model and connec-
tion method.

Change PLZ

{F
{F

For details of settings, refer to 10-2 Communications Settings between
Personal Computer and PLC.
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3. The following project window will be displayed when the PC model is se-
lected.

A CG¥-Protocal - PSWH
File Edit Yiew Protocol PBLC Tools Window Help

e ERNEEOEEEEEE

EEE

| x| 4
@ Protocols
Protocol List Protocols 13

333 Mew Protocol List 0

* Trace List Traces

% Trace List 0
| PLG Name Model GPU

|siig PLC NewPLG1 G51H GPUGS

2P0, [B5v. | ek ]

E T —] \ [ [

I |Oifline

Each new project is given a default name “PSWL],” which is displayed in
the title bar, and may be changed prior to saving the project.

5-1-2 Creating a New Protocol
Use the following procedure to create a new protocol in the protocol list.

1,2,3... 1. Double-click the Project icon in the project workspace and select and high-
Iﬁ light the protocaol list. Alternatively, the protocol list is highlighted by left-

aaa clicking or double-clicking the Protocol List icon in the project window.
::: 2. Select Create by right-clicking the Protocol List icon in the project work-
war space. Alternatively, point to Create from the pop-up menu in the project

window and select Protocol or select Protocol from the Protocol menu.
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@ | 3. Select the protocol type by left-clicking the CS/CJ Protocol icon or the
C200HX/HG/HE Protocol icon according to the protocol type.

@

EREET
b hew Protoc
{ Trace List

i NewPLC1 [Offline] [C51H - CP

g tocol Name | Start Sequence End Sequence| Type Target
(@ Mew Pratocal Qoo 099 USER

L] |
#Prajects [Bsvstem | @Han |

For Help, press F1 Offline

5-1-3 Renaming a Protocol

The new protocol under the default name New Protocol will be displayed
in the project window. Use the following procedure to rename the protocol.

1,2,3... 1. Left-click the Protocol Name in the project window, or select the Protocol
Name and press the Enter Key. The current protocol name will become an
editable field.

n P

E Protocol Mame Start Sequence End Sequence

|@ Mew Protocal Qoo 0949

2. Input the new protocol name and press the Enter Key. The new protocol
name must not exceed 30 characters.

n P5iiA
= Protocol Mame Start Sequence End Sequence
|@] [Temp | oo 099
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5-1-4 Setting the Protocol Sequence Number Range

Use the following procedure to specify the sequence numbers that are used
by the specified protocol within a range between 000 and 999. The range of
sequence numbers used by system protocols cannot be changed.

1,2,3... 1. Left-click the Start Sequence associated with the protocol in the protocol
list. Alternatively, select the Start Sequence and press the Enter Key. The
current start sequence will become an editable field.

* Protocol Mame Start Sequence End Sequence
|@| Temp 00| aas

2. Input the starting number and press the Enter Key.
3. Input the end number and press the Enter Key.

Input the value within a range between 000 and 999 into the Start Se-
guence or End Sequence fields for the associated protocol.

5-1-5 Setting the Board and Unit

Set the PMSU, through which protocols are transferred online to the PC.

1,2,3... 1. Left-click the Target. Once the online connection is enabled, the names of
the PMSU actually mounted will be displayed.

| Target
|SCEI (Mot Fited) =

Comimunication Uit

Note If the project has not been used online yet, SCB (Not Fitted) for the
Serial Communications Board and No Unit [Unit No.] for the Serial
Communications Unit will be displayed.

2. Select the Board/Unit from the drop-down list. If the PC is CS/CJ, select
SCB for the Serial Communications Board and specify the unit number for
each Serial Communications Unit (SCU [ ]). If the PC is the C200HX/
C200HG/C200HE, select the Communications Board.

Example: The Serial Communications Unit with unit number 0 is selected
online for the CS/CJ.
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Tareet
SCU 0]

5-2 Creating Sequences and Steps

5-2-1 Creating a New Sequence

Use the following procedure to create a new sequence in the protocol.

233 1,2,3... 1. Double-click the Protocol List icon in the project workspace and select
T and highlight the protocol where the new sequence is to be created. Alter-
@ natively, left-click or double-click the CS/CJ Protocol icon or C200HX/
C200HG/C200HE Protocol icon in the project window according to the

protocol type.

2. Select Sequence by right-clicking the Protocol icon in the project work-
space. Alternatively, select the Create from the pop-up menu in the project
window or select Sequence from the Protocol menu.

3. The new protocol with the default name New Sequence will be displayed
in the protocol.

37 000 Mew Sequence - - Sean - -=
* | List Messages
g: Send Message List 0
* | List Messages
g Receive Message List 0
* | Matrix List Matrices
Matriz List 0
< | i
Note For details of each input item, refer to SECTION 7 Sequence Setting and Edit-

ing.
5-2-2 Creating a New Step

Use the following procedure to create a new step in the sequence.

i 1,2,3... 1. Double-click the Protocol icon in the project workspace and select and
highlight the sequence where the new step is created. Alternatively, dou-
ble-click the Sequence icon in the project window.

s 2. Right-click on the sequence icon in the project workspace or in the project

=

window, point at New in the pop-up menu, and select Step. The step can
also be selected from the Protocol menu. The new step will be added to
the list.
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*| Step Repeat Gommand Retry | Send Wait | Send Message | Recvy Message | Response | Next | Error
roﬂ Qo RSET/001 Send # - #RHS S YES End Abort

Note For details of each input item, refer to SECTION 8 Step Setting and Editing.

5-3 Creating Messages and Matrices

5-3-1 Creating a New Message
Use either of the following procedures to create a new message.

1,2,3... 1. Right-click the Send Message or Receive Message field in the step list,
and select New Message from the pop-up menu, when the Message Ed-
itor dialog box will be displayed. Specify each input item and order in the
dialog box.

2. Create the new message in the message list independently from the steps
and input each item in either of the following method.
a) Input the data for each item field beginning with the header. Specify
and input the order and items of the data in the data field.

b) Display the Message Editor dialog box from the data field. Specify
and input the order and items of the order in the dialog box.

Creating a New Message in Send Message or Receive Message Field for a Step
Use the following procedure to create a new message for a step.

1,2,3... 1. Right-click the Send Message or Receive Message field for a step and
select New Message from pop-up menu.

2. The Message Editor menu dialog box will be displayed. Input the mes-
sage name in the Name field.

MName IMBSSSQB <« >y | Delete |

5 |
—Message Data

Color Key
IConstant Hex j I Edit | ligi=izisr

.Normal
—Header <h> Terminatar <t Address <a> . Lo

Edit... | Inser‘tl ’7 Edit... | Inser‘tl ’7 Ediit... | Insertl
Wl check

—Length <> .|_ -
[ -4 T = Eoit.. | | Insert e e

—Check Code <c> (8] I
i 4 T = Eat. | [ireer Carcel |

3. Create the message as appropriate. Refer to 9-1 Message Setting for de-
tails on how to construct a message.

4. Left-click the OK button to accept the settings. Click the Cancel button to
leave the settings unchanged.
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Creating a New Message from the Message List
Use the following procedure to create a new message from the message list.

@

1,2,3... 1. Double-click the Protocol icon in the project workspace and select and
highlight the receive message or send message list. Alternatively, double-
oiH click the Receive Message List icon or Send Message List icon in the
R project window.

t},,_}" 2. Select the send message or receive message references by right-clicking

the Send Message List icon in the project workspace. Alternatively, select
the Create from the pop-up menu in the project window and select the
send message or receive message references or select the send message
or receive message references from the Protocol menu.

*| Send Message | Header <{h> | Terminator {t> | CGheck code <c> | Leneth <I> | Address {aZ* | Data |
b Message

E 3. Left-click Data and left-click the Enter button or press the Enter Key. The
Message Editor menu dialog box will be displayed. For details of how to
create a message, refer to 9-1 Message Setting.

5-3-2 Creating a New Matrix

@ Use the following procedure to create a new matrix.

1,2,3... 1. Left-click the Protocol icon in the project workspace and select and high-

i light the Matrix List. Alternatively, double-click the Matrix List icon in the
bl project window.

2. Right-click either the Matrix List in the project workspace or right-click the
project window, select Create from the pop-up menu, and select Matrix.
Matrix can also be selected from the Protocol menu.

x | Matrix | Cases |
oae -
332 |Matrlx | 1

Note A new matrix cannot be created from any step. Create it in the matrix list.

Creating a New Case for a Matrix
Use the following procedure to create a new message in a matrix.

i 1,2,3... 1. Left-click the Matrix List icon in the project workspace and select and
2 highlight the matrix, for which a new case is created. Alternatively, double-
E;E;E click the Matrix icon in the project window.
2. Select Matrix Case by right-clicking the matrix position in the project work-
space. Alternatively, select the Create from the pop-up menu and select
Matrix or select Matrix from the Protocol menu.
| t| Gase Number | Receive Meszage | Mext Process |
[@] 00 End
(@, 15 Other End
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5-4 System Protocol Display and Editing
5-4-1 Displaying System Protocols

System protocols are available for communications with OMRON’s Units,
'&System | such as the Temperature Controller, Panel Meter, Bar-code Reader, and
_— Modem. By clicking the System tab on the bottom of the project workspace,
the system protocol list will be displayed. By double-clicking the Project icon
in the project workspace and double-clicking the Protocol List icon, the pro-

L3

EZEZE tocol list will be displayed in the project window. Alternatively, the protocol list
will be displayed by double-clicking the Protocol List icon in the project win-
dow.

4# C¥-Protocol - System Protocols [—[51x%]

File Edit “iew Protocol PLC Tools “Window Help

R EEDR R EEEEEEE]
==l L System Protocols |_ (O] x]
E‘& System P”' =1 Protocol Hame Start Sequence | End Sequence Type Target
&= e ntr_K read] @ Contraller (E5_K resd) 000 040 SVETEM i,
@ Cortroller [E5_K wite] @ Controller (ES_K write) 050 i) S STEM B,
@ Temp Contraller [ESZE rea @ Temp Cortraller (ESZE reac) 100 148 SVETEM BiA,
B @ Temp Controller [ESZE wiit @) Temp Controller (ESZE write) 150 188 S STEM B,
---@ Temp Controller [E5_J] @ Temp Cortraller (ES_J) 200 249 SVSTEM Mig,
(- @ Controller (E5100_) @ Cortroller (ES100_) 250 293 SWSTEM iz,
1@ Intel Signal Processor (K37 @ Intell Sicnal Processor (K37 3 300 340 SYETEM N,
© Bar Code Aeader 500/ @ Bar Code Resdsr (vS00A520) 350 359 SWETEM N,
Lazer Micro Meter [Z24L) -
Visual Inspe Sys{F2004300 @) Lazer Micro Meter (37410 400 449 SYSTEM [SEE
2@ 1D Contraler (VEO0/E20) @ visual Inspe Sys(F2000300/350] 450 433 SYSTEM [0y
@ Hayes modem AT comman @10 Controler (VENDA2T) &0 549 SYETEM R,
B @ Compow ap/F @ Hayes madem AT commands 550 539 SVSTEM i,
@ Compoiviay F 2] it SYETEM R,

< | &
% Proj. @Sys... |@He|p I

x|

-

[RTTRTEN consio 101 21 | PRI

For Help, press F1 [ COiffine
iaSlalll I 2 Cx-Protocol - Spstem .. |2 Exploring - C:4 | T Microsoft Word - Document‘ll DH 244PM

Note The system protocol varies with the System. The contents of the protocol
cannot be edited directly or displayed on screen in the right pane.

The contents can be edited or displayed by copying the system protocol to a
user defined protocol, but the protocol type changes to User once pasted into
a new protocol list. A sequence as well as a system protocol can be copied.

5-4-2 Copying System Protocols or Sequences
Use the following procedure to copy system protocols.

Copying and Pasting All the Protocols in the List to New Project

,@ I 1,2,3.. 1. Select New from the File menu or left-click the New icon from the toolbar

Byt and create a new project.
%] 2. Left-click the System tab on the bottom of the project workspace, select
a the protocol list icon in the project workspace, and press the Ctrl+C Keys
219
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or right-click and select Copy from the pop-up menu. Alternatively, select
Copy from the Edit menu.

% Praojects 3. Left-click the Project tab on the bottom of the project workspace. After left-
_— clicking the the Project icon, press the Ctrl+V Keys or left-click the Paste
@ icon or right-click and select the Paste button from the pop-up menu in the
project window or select Paste from the Edit menu. The protocols will be

|EI copied to the new project.

Copying and Pasting Selected Protocol(s) to New Project
,@ 1,2,3... 1. Select New from the File menu or left-click the New button from the toolbar
| and create a new project.

' B System | 2. Left-click the System tab on the bottom of the project workspace, select
= the Protocol List icon in the project workspace, and select the protocol to

E:E:E be copied in the project window. More than one protocol can be selected
by pressing the Shift Key and selecting another protocol to extend the se-
lection, or by pressing the Ctrl Key and selecting another protocol to add
to the selection.

3. Pressthe Ctrl+C Keys or left-click the Copy icon and select Copy from the
pop-up menu. Alternatively, select Copy from the Edit menu.

22a 4. After selecting the new project and selecting the Protocol List icon to be

Hopk

pasted into the project workspace, press the Ctrl+V Keys or left-click the
Paste icon or right-click and select Paste from the pop-up menu or select
Paste from the Edit menu. The system protocol or system protocols se-
lected will be copied to the protocol list in the new project.

[

Copying and Pasting a Sequence to a Specified Protocol

,@ 1,2,3... 1. Select New from the File menu or left-click the New button from the toolbar
| and create a new project.
@ System 2. Left-click the System tab on the bottom of the project workspace and se-
_— lect the sequence.
3. Press the Ctrl+C Keys or left-click the Copy icon or right-click and select
Copy from the pop-up menu. Alternatively, select Copy from the Edit
@ menu.
4. Select the Protocol icon of the destination and press the Ctrl+V Keys or
left-click the Paste icon or right-click and select Paste from the pop-up
|E| menu. Alternatively, select Paste from the Edit menu. The selected se-

guence will be placed at the end of the protocol. Send or receive messages
will not be copied together with the sequence.

Note Standard system protocol sequences cannot be pasted into an a protocol.
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SECTION 6
Project and Protocol Editing

This section describes details of the editing of projects and protocols.

6-1 Editing Projects. . . ..ot 222
6-1-1 Adding InformationtoaProject............. ... ... ... ... 222
6-1-2 OpeningaProject . ... ...t 222
6-1-3  Opening Project Windows . ..., 223
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6-1-5 SavingaProject ....... ... ... 223
6-1-6 ClosingaProject. . ... 224
6-2 Editing Protocols. . . ... .. 224
6-2-1 DisplayingaProtocol List ... 224
6-2-2 Renaming aProtocol intheList............................ 224
6-2-3 Deleting aProtocol fromthelist........................... 224
6-2-4 CopyingaProtocol . ............ i 225
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6-1 Editing Projects

A project consists of a protocol list, trace list, and PLC. The protocol list
includes all the protocols in the project. A protocol consists of sequences. The
PLC is in control of the system setup and the tracing of send and receive mes-
sages. The trace list is data of trace results added to the project. The CX-Pro-
tocol uses each project as a single file for the control and management of the
protocols, trace list, and PLC.

Refer to 10-1 PLC System Configuration for details of the PLC. Refer to 12-1
Tracing Transmission Lines for details of the trace.

Note Keep the following in mind before using a floppy disk.

* Be sure to copy the project files in the floppy disk to the hard disk before
using the project files.

* Do not save project files directly to the floppy disk. Save the project files in
the hard disk first. Then use an appropriate Windows program, such as
the Explorer, to copy the project files to the floppy disk.

* Do not eject the floppy disk from the disk drive while the projects in the
floppy disk are in use.

* If a message is displayed advising the user that the disk is full while over-
writing the projects, it means that the floppy disk does not have adequate
space and the project files cannot be saved. If this happens, be sure to
save the project files in the hard disk.

6-1-1 Adding Information to a Project
Use the following procedure to add information to a project.
1,2,3... 1. Right-click the project name in the project workspace and select Proper-
ties from the pop-up menu. The Properties dialog box will be displayed.

2. Input the information on the project and left-click the Apply button. Left-
click the Cancel button to leave the settings unchanged.

6-1-2 Opening a Project
Use the following procedure to open an existing project.
- 1,2,3... 1. Select Open from the File menu or left-click the Open icon from the toolbar
Ej or press the Ctrl+O Keys.

2. The Open dialog box will be displayed.
Select the project from the list in the dialog box. The project file *.psw will
be displayed as a default project file. If any other type of file is required, se-
lect it from the File of Type drop-down list.
The following types of files are available. If opening any file other than
project files, refer to 11-3 Importing Protocol Data from PST/PSS Files.
The CX-Protocol project file is created by the CX-Protocol, the PST project
file is created by the SYSMAC-PST, and the PSS files are created by DOS
Protocol Support Software.

File type Contents File Read Write
extension

CX-Protocol project file Project file created by the CX-Protocol | *.psw ad I

PST project file Project file created by the *. psw O X
SYSMAC-PST

PSS system setup file Setup data file of communications ports | *.pts ad X
A and B of PSS communications board

PSS protocol file File with PSS protocol data only *ptl ad X

PSS trace data file File with PSS or SYSMAC-PST trace *.ptr ad X
data only
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To change the current folder for another one, select the folder from File
Look in in the drop-down list.

3. Left-click the Open button or double-click the selected project. The project
will open. Left-click the Cancel button to leave the settings unchanged.

Note The icons on the right-hand side in the File Look in field have the following
functions.

* By left-clicking the Up One Level icon, the folder one level higher is
opened.

* By left-clicking the Create New Folder icon, the new folder is created in
the current folder.

* By left-clicking the List icon, the folder name and the file names in the
current folder are listed on screen.

* By left-clicking the Details icon, the folder name and the names, sizes,
types, and last-modified dates of the files in the current folder will be dis-
played.

6-1-3 Opening Project Windows
The CX-Protocol makes it possible to open more than one project window.

After opening a new window, it is possible to display the projects currently
opened in other windows and other projects can be displayed in the new win-
dow.

To add a new project window for the projects currently opened, select New
Window from the Window menu. The new project window will be displayed
on the front side and each of the previous project windows will be placed
behind. Each window is given a unique identifier.

6-1-4 Overwriting and Renaming a Project

Use the following procedure to overwrite a project.

E!j 1,2,3... 1. Select Save from the File menu or left-click the Save icon from the toolbar,
: or select Save from the pop-up menu after right-clicking the Project icon
or pressing the Ctrl+S Keys.

2. The project will be saved under the present project name.

When saving a new project in this method, the Save as dialog box will be
displayed with the default file name, “PSWL." Change the default name to
an appropriate name.

Note Input the project name in the File name field of the Save as dialog box.

6-1-5 Saving a Project
To save an existing project under a different project name or save a new
@ project under a new name, right-click the Project icon and select Save as
from the pop-up menu.
Use the following procedure to save the project under a different name.

@ 1,2,3... 1. Select Save as from the File menu or right-click the Project icon and se-
lect Save as from the pop-up menu. The Save as dialog box will be dis-
played on screen.

2. To change the current folder for another one, select the folder from File
Save in in the drop-down list. Then change the Save as type field to CX-
Protocol project file (*.psw).
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Input the project name in the File name field. To overwrite a project, select
the project from the list.

3. Left-click the Save button or press the Enter Key. Left-click the Cancel but-
ton to close the Save as dialog box without saving the project.

6-1-6 Closing a Project

To close a currently open project, select Close from the File menu or left-click
the Close button from the project window. Closing a project will require confir-
mation if the project has not been saved since its last edit. Select Yes button
to save the project.

6-2 Editing Protocols
6-2-1 Displaying a Protocol List

Use either of the following procedures to display a protocol list for the current
project.

* By double-clicking the Project icon in the project workspace and double-
clicking the Protocol List icon, the protocol list will be displayed in the

[

LA . .
e project window.

- * By double-clicking the Protocol List icon in the project window, all the
e protocols in the protocol list will be displayed on screen.

6-2-2 Renaming a Protocol in the List
Use the following procedure to rename a registered protocol.

Note System protocol names cannot be changed.

1,2,3... 1. Left-click the Protocol Name setting in the protocol list or select the Pro-
tocol Name setting. Press the Enter Key.

2. The current protocol name will become an editable field. Input the new pro-
tocol name and press the Enter Key. The new protocol name must not ex-
ceed 30 characters.

Note Once a protocol has been deleted it cannot be recovered.

6-2-3 Deleting a Protocol from the List
Use the following procedure to delete a protocol.
Note System protocols cannot be deleted.

1,2,3... 1. Left-click the icon of the protocol to be deleted from the protocol list. More
than one protocol can be selected by pressing the Shift Key and selecting
another protocol to extend the selection, or by pressing the Ctrl Key and
selecting another protocol to add to the selection.

2. Left-click the Delete icon from the toolbar or press the Delete Key or left-

= click the Cut icon from the toolbar or press the Ctrl+X Keys to delete the

.;'ﬁ': protocol. The project can be deleted by right-clicking and selecting Delete
from the pop-up menu.

Note Once a protocol has been deleted it cannot be recovered.
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6-2-4 Copying a Protocol
Use the following procedure to copy a protocol.

Note System protocols can be copied, but the protocol type will change to User
once pasted into a new protocol list.

1,2,3... 1. Left-click the icon of the protocol to be copied from the protocol list. More
than one protocol can be selected by pressing the Shift Key and selecting
another protocol to extend the selection, or by pressing the Ctrl Key and
selecting another protocol to add to the selection.

=8 2. Left-click the Copy icon from the toolbar or press the Ctrl+C Keys. Alter-
natively, right-click and select Copy from the pop-up menu or select Copy
from the Edit menu.

3. Display a protocol in the project window so that the copied protocol or pro-
tocols can be pasted into the protocol.

4. Left-click the Paste icon from the toolbar or press the Ctrl+V Keys. Alter-
natively, right-click and select Paste from the pop-up menu or select Paste
from the Edit menu. The pasted protocols will be placed at the end of the
protocol list.
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SECTION 7
Sequence Setting and Editing

This section describes details of the setting and editing of sequences.
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7-1 Setting Sequences
7-1-1 Sequence Setting Screen
Refer to 3-2 Sequence Attributes (Common to All Steps) for details on setting.

Transmission control method ~ Receive wait time Tr Send finish time Tfs

Response type

Sequence name
Receive finish time Tfr

Link word setting

Eij EXAMPLE paw
x F Communication Sequence Link Word | CGontrol | Response Timer Tr | Timer Tfr | Timer Tfs | =
2 000 Procces value read --- Set Scan 3 zec 3 zec 3 zec
' 001 Lamp set point read --- Set Scan 3zec 3 zec 3 zec
s’ 002 Manipulated variable read --- Set Scan 3 zec 3 zec 3 sec
2 003 Set point read --= Set Scan 3zec 3zec 3 zec
e 004 Alarm value read --= Set Scan 3=zec 3 zec 3 zec
2 005 Propo bandlnte/Deri time read - Set Scan 3zec 3 zec 3 =zec
30 008 Gooling coefficient read --- Set Scan 3 szec 3zec 3 zec
s’ 007 Dead band read --- Set Scan 3zec 3 zec 3 zec
7-1-2  Setting Sequences
Settings that can be made for sequences using the CX-Protocol are shown in
the following table.
Attribute Content
Link Word Link 1 IN IN Area None, CIO, WR™, LR, HR, AR, DM, EM.
Address Refer to Link Word Area Designation in the fol-
Length lowing section.
out OUT Area None, CIO, WR™, LR, HR, AR, DM, EM.
Address Refer to Link Word Area Designation in the fol-
Length lowing section.
Link 2 IN IN Area None, CIO, WR™, LR™, HR, AR, DM, EM.
Address Refer to Link Word Area Designation in the fol-
Length lowing section.
ouT OUT Area None, CIO, WR™, LR", HR, AR, DM, EM.
Address Refer to Link Word Area Designation in the fol-
Length lowing section.
Transmission RTS/ICTS None, Send, Receive, Send & Receive
Control Xon/Xoff None, Send, Receive, Send & Receive
Modem Select With/without using the check box.
Contention Send Request | Code, ASCII, hexadecimal
Code
Delimiters Delimiter Send | Code, ASCII, hexadecimal
Code
Delimiter Code, ASCII, hexadecimal
Receive Code
Response Type Scan’®, Interrupt: Fixed #, Interrupt: Receive Case #
Timer Tr Value 00 to 99
Timer Unit 0.01s, 0.1s, 1s, 1 min
Timer Tfr Value 00 to 99
Timer Unit 0.01s, 0.1s, 1s, 1 min
Timer Tfs Value 00 to 99
Timer Unit 0.01s, 0.1s, 1s, 1 min
Note 1. WRis only for the CS/CJ.
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2. LRs only for the C200HX/HG/HE.
3. Default setting for the CX-Protocol.

Link Relay Area Designate the data area shared between the PLC and Board/Unit. This set-
Designation ting is made for every sequence (common to steps).

When using the Link Channel Designation for designating the storage areas
for send/receive data, the code numbers (11, 12, O1, O2) designated here will

be used.
1,2,3... 1. Left-click the Link Word field of the sequence and then left-click the Enter
3 button or press the Enter Key.

The Link Channel Information dialog box will be displayed.

Limk Chanmel Information

—Link 1 —Link 2 Ok
I Ares Addr Len M Ares Addr Len
0 0 Mone =) [0 0 Cancel
OUT Area Addr Len OUT Area Addr Len
INDr‘IE j 0 0 Mane j | 0

Perform Link 1 setting according to the following procedure. Follow the same
procedure for the Link 2.

2. Select an appropriate area (ClO, WR, LR, HR, AR, DM) from the IN Area
drop-down list in the Link 1 field. Select None if setting is not required.

3. Input the first word address of the IN Area of Link 1 in the Addr field.
4. Input the number of words of the IN Area of Link 1 into the Len field.

5. Setthe areatype, beginning address, and length for the OUT Area accord-
ing to the same procedure.

6. Either press the OK button to accept the setting or press the Cancel button
to leave the settings unchanged.

The areas and setting ranges that can be used for link words are shown in
the following list.

PLC model CS-series C200HX/HG/HE
Area and CIO: 0000 to 6143 CIO (note 1): 000 to 511
addressthatcan | WR: 000 to 511 LR: 00 to 63
be used for link |HR: 000 to 511 HR: 00 to 99
word setting AR: 000 to 959 AR: 00 to 27

DM: 00000 to 32767 DM: 0000 to 6655
EM (note 2): 00000 to 32767 |EM (note 2): 0000 to 6143
Ranges |I1 0 to 500 0to 128
oflink 51 o to 500 0to 128
words
12 0 to 500 0to 128
02 0 to 500 0to 128
The sum of 11+0O1+I2+02 The sum of 11+0O1+I2+02
must be equal to or less than | must be equal to or less than
500 words. 128 words.

Note 1. ClO indicates the I/O area, IR area, and AR area.
2. EM bank cannot be used for link words.
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Setting Transmission Set the same transmission control method as that designated by the external
Control Method device (communications partner).
The transmission control method can be set to more than one method (for
example, RTS/CTS flow control and modem control).

1,2,3... 1. Left-click the Control field of the sequence and then left-click the Enter
button or press the Enter Key.
The Transmission Control dialog box will be displayed.

Transmission Control

2. Setthe parameters in the Transmission Control dialog box.

3. Left-click the OK button to accept the settings or left-click the Cancel but-
ton to leave the settings unchanged. If any of the following settings are
made, “Set” will be displayed in the Control field of the sequence.

RTS/CTS Flow Control

Data can be transmitted through the RTS/CTS flow control. Select an RTS/
CTS control method from the drop-down list.

If the RTS/CTS field is set to None, RTS/CTS flow control will not be per-
formed.

If the RTS/CTS field is set to Send, RTS/CTS flow control will be performed
only when sending.

If the RTS/CTS field is set to Receive, RTS/CTS flow control will be per-
formed only when receiving.

If the RTS/CTS field is set to Send & Receive, RTS/CTS flow control will be
performed for both send and receive processing.
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Xon/Xoff Flow Control

Data can be transmitted through the Xon/Xoff flow control. Select an Xon/Xoff
control method from the drop-down list: None, Send, Receive and
Send & Receive are available.

If the Xon/Xoff field is set to None, Xon/Xoff flow control will not be per-
formed.

If the Xon/Xoff field is set to Send, Xon/Xoff flow control will be performed
only when sending.

If the Xon/Xoff field is set to Receive, Xon/Xoff flow control will be performed
only when receiving.

If the Xon/Xoff field is set to Send & Receive, Xon/Xoff flow control will be
performed for both send and receive processing.

Note If both the RTS/CTS flow control and Xon/Xoff control are set for the CS/CJ
Series, a Protocol Macro Syntax Error will be displayed when protocol
macro is executed.

Modem Control
Data can be transmitted through the modem control. Left-click the Modem
check box to either enable or disable the modem control.

If the Modem check box is not checked, modem control will not be performed.
If the Modem check box is checked, modem control will be performed.

Contention Control
Data can be transmitted under the contention control. Left-click the Conten-
tion check box to either enable or disable contention control.

If the Contention check box is not checked, contention control will not be per-
formed.

If the Contention check box is checked, contention control will be performed.
This means that in order to obtain the right to send, a Send Request Code
must be transmitted.

A send request code can be specified in Code, ASCII or Hexadecimal. Select
a code from the Contention Send Request Code drop-down list. Select one
from Code, ASCII, or HEX.

[Code]

1,2,3... 1. Select Code from the drop-down list.
2. Left-click the Edit button. The Code Entry dialog box will be displayed.

Code Entry

NULL 0x00 =] << nsert. | Clear |

(] I Cancel |

3. Select Special Code. Up to four special codes may be entered. Select the
codes from the drop-down list and left-click the Insert button to input the
code(s) indicated.
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Note Five or more special codes cannot be input. Left-click the Clear but-
ton to clear all the special codes and input them again from the be-
ginning. Left-click the Delete button to delete the special code where
the cursor is located. Left-click the << or >> button to move the cursor
position.

4. Press the OK button to accept the settings or press the Cancel button to
leave the settings unchanged.

[ASCII]

1,2,3... 1. Select ASCII from the drop-down list.
2. Type in ASCII characters (up to four characters) in the right field.

[Hexadecimal]

1,2,3... 1. Select HEX from the drop-down list.

2. Left-click the Edit button.
The HEX Entry dialog box will be displayed.

3. Select a button that corresponds to one digit of the hexadecimal digit. Up
to eight digits may be entered. They will be displayed at the top of the dia-
log box. (If the 9th digit is entered, the 1st digit will be deleted.)

Note Left-click the CLR button to clear all the special codes. After clearing
all the special codes, input them again from the beginning. Left-click
the DEL button to delete the special code where the cursor is locat-
ed.

4. Left-click the Enter button to accept the settings or the Cancel button to
leave the settings unchanged.

Delimiters

Data can be transmitted through the delimiter control. Left-click the Delimit-
ers check box to either enable or disable the delimiter control.

If the Delimiters check box is not checked, delimiter control will not be per-
formed.

If the Delimiters check box is checked, the delimiter control will be performed.

The delimiter set in the send and receive code can be designated in Code,
ASCII, or Hexadecimal. Select one of them from the Delimiter Send Code or
Delimiter Receive Code drop-down list. The input methods for the Code,
ASCII, and Hexadecimal are the same as for the contention control.

Response Type Use the following procedure to set the timing for writing received data in the I/
O memory (designated by the fourth operand of the PMCR instruction for the
CS/CJ and by the third operand of the PMCR instruction for the C200HX/HG/
HE) and also to set the method for notifying the setting to the PLC.

This setting will be valid only when the write area is designated by the oper-
and of the PMCR instruction and when the setting of the with/without
response writing is set to Yes.

The notification types include Scan, Interrupt: Fixed # and Interrupt:
Receive Case #.
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E 1,2,3... 1. Left-click the Response field of the sequence and then left-click the Enter
button or press the Enter Key.
The Response Type dialog box will be displayed.

Response Type

—Maotification Type
@ Scan
Cancel |

 Interrupt Fixed # ID

 |nterrupt Receive Case #
The interrupt Mo, to the PLC will be set
to automatic for the camm board status.

2. Select one of the notification types: Scan, Interrupt mode: Fixed # or In-
terrupt mode: Receive Case #. When the Interrupt mode: Fixed # but-
ton is left-clicked, designate the external interrupt task number for the CS/
CJ or the interrupt subroutine number for the C200HX/HG/HE in a range
from 0 to 255.

3. Left-click the OK button to accept the settings or the Cancel button to leave
the settings unchanged.

Scan Mode

The data in the receive buffer is written in the 1/O memory (after conversion)
when scanned by the CPU Unit. Refer to 3-2 Sequence Attributes (Common
to All Steps) for the writing timing.

Interrupt Mode: Fixed No.

The data in the receive buffer is written in the I/O memory immediately after it
is converted in the designated conversion method. After the received data is
completely written in the 1/O memory, designate the external interrupt task
number for the CS/CJ or the interrupt subroutine number for the C200HX/HG/
HE in a range from 0O to 255 to execute the interrupt processing for the CPU
Unit.

Note This mode is valid only with the Serial Communications Board for the CS and
with the Communications Board for the C200HX/HG/HE. The mode cannot be
used with the Serial Communications Unit for the CS/CJ. (If used, a protocol
data error will occur when the sequence is executed.)

Interrupt Mode: Receive Case No.

The data in the receive buffer is written in the I/O memory immediately after it
is converted in the designated conversion method. After the received data is
completely written in the I/O memory, the external interrupt task number for
the CS/CJ or the subroutine number for the C200HX/HG/HE is calculated
based on the step number and the receive case number executed according
to the following procedure to execute the interrupt processing for the CPU
Unit. The interrupt task number or subroutine number (0 to 255) will be auto-
matically calculated depending on the execution status of the Communica-

tions Board.
Setting Monitor Times The following procedure can be used to set monitor times for transmission
(Tr, Tfr, Tfs) processing.

Note The receive wait time (Ts) is set for every step. Refer to SECTION 8 Step Set-
ting and Editing.
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3 1,2,3... 1. Left-click the Timer Tr, Timer Tfr, or Timer Tfs field and then left-click the
Enter button or press the Enter Key.
The Timer (Tr/Tfr/Tfs) dialog box will be displayed.
The following shows a dialog box for the receive wait time (Tr).

Timer Tir EE
Iﬂ ¥ |1 second j
Cancel |

2. Forreceive wait time (Tr), set in the Value field a monitor time (0 to 99) from
recognition of a receive command to reception of the first byte of data.
For receive finish time (Tfr), set in the Value field a monitor time (0 to 99)
from reception of the first byte of the data to the last byte of the data.
For send finish time (Tfs), set in the Value field a monitor time (0 to 99)
from the transmission of the first byte of the data to the last byte of the data.

3. Set atime unitin the Time Unit field.

4. Select the OK button to accept the settings or the Cancel button to leave
the settings unchanged.

Note The receive wait time (Tr) and receive finish time (Tfr) cannot be set
alone.

Monitor Time Ranges
The following table lists the units and ranges of monitor times that can be set.

Values Time unit
00 to 99 0.01 s (10 ms)
00 to 99 0.1 s (100 ms)
00 to 99 1s
00 to 99 1m

Note Monitoring will not be performed if “00” is input as the value.

7-2 Editing Sequences
7-2-1 Displaying a Sequence List

Use one of the following procedures to display a sequence list within a proto-
col.

2 * Double-click the Protocol List icon in the project workspace and then
FaE left-click the protocol to display the sequence list in the project window.
E] * Double-click the Protocol icon that includes the desired sequence to dis-
play all the sequences within the protocol.

7-2-2 Renaming Sequences
Use the following procedure to rename a sequence that has been registered.
Note Sequences belonging to the System type protocols cannot be renamed.

1,2,3... 1. Left-click an appropriate Communication Sequence or select an appro-
priate Communication Sequence and press the Enter Key. The current
sequence name will become editable.

2. Type in a new name for the sequence and press the Enter Key. It is possi-
ble to select and overwrite a portion of the current sequence name. The
new sequence name may not exceed 30 characters.
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7-2-3 Changing an Existing Sequence Number

1,2,3... 1. Left-click the # field within the sequence or select the # field and press the
Enter Key. The current sequence number will become editable.

2. Type in a new sequence number and press the Enter Key. It is possible to
select and overwrite a portion of the current sequence number. The new
sequence number must be within the Start Sequence and End Sequence
and also different from those currently used.

7-2-4  Copying/Pasting Sequences

Sequences can be copied between protocols or within a protocol. Use the fol-
lowing procedure to copy a sequence.

1,2,3... 1. Select a sequence to be copied. More than one sequence can be selected
by pressing the Shift Key and selecting another sequence to extend the
selection or by pressing the Ctrl Key and selecting another sequence to
add to the selection.

: 2. Select the Copy icon from the toolbar or press the Ctrl+C Keys. Alterna-
tively, right-click to display the pop-up menu and select Copy from the
menu. It can also be selected from the Edit menu.

3. Select a protocol or display the sequence list in the project window where
the copied sequence is pasted.

|EI 4. Select the Paste icon from the toolbar or press Ctrl+V Keys. Alternatively,
right-click to display the pop-up menu and select Paste from the menu. It
can also be selected from the Edit menu.
The pasted sequences inherit the sequence numbers that existed before
being copied. If the sequence number already exists or if the number is
outside the sequence number range, the next available sequence number
will be newly given to the pasted sequence.

7-2-5 Deleting Sequences
Use the following procedure to delete a sequence.
Note Sequences belonging to the System protocols cannot be deleted.

1,2,3... 1. Selectasequence to be deleted. More than one sequence can be selected
by pressing the Shift Key and selecting another sequence to extend the
selection or by pressing the Ctrl Key and selecting another sequence to
add to the selection.

= 2. Left-click the Delete icon on the toolbar or press the Delete Key. Alterna-
=4 tively, right-click, and select Delete from the pop-up menu. It can also be
selected from the Edit menu. A sequence can also be deleted by selecting
the Cut icon on the toolbar or pressing the Ctrl+X Keys. It can also be se-

-:Iﬁla lected from the Edit menu. Alternatively, right-click to display the pop-up
— menu and select Cut from the menu.

To undo the last delete action processed using the Cut operation, left-click

|EI the Paste icon on the toolbar or press the Ctrl+V Keys. Alternatively, right-

click to display the edit pop-up menu and select Paste. The pasted se-

guences inherit the sequence numbers existed before being cut. If the se-
guence number already exists or if the number is outside the sequence
number range, the next available sequence number will be newly given to
the pasted sequence.
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SECTION 8
Step Setting and Editing

This section describes details of the setting and editing of steps.
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8-1 Step Setting

This section describes procedure for setting steps with the CX-Protocol.
8-1-1 Step Setting Screen

For details about settings, refer to 3-3 Step Attributes.

With/Without
Message repeat counter Retry count Send message response writing Error process

Command Send wait time Receive message Next process

Repeat Gommand Retry | Send Wait | Send Mext | Error
@, 00 REET/ 001 Send & Receive 3 - S0Di0a3 1 SLUE VR TES Mext Mext
@ 01 RSET/ 00 Send & Receive 3 - SO 1 R420 1 YES End Abort

8-1-2 Setting the Attributes

The following table shows step attributes that can be set using the CX-Proto-

col.
Attribute Content

Repeat Type Reset / Hold (Reserve)

Counter Constant (1 to 255)
Channel (word)

Command Send, Receive, Send & Receive, Open*?, Close"?,
Flush™2, Wait™

Retry Oto9

Send Wait Time (Ts) Value 00 to 99
Time Unit 0.01s, 0.1s, 1s, 1 min

Send Message Refer to 9-1 Message Setting.

Receive Message Refer to 9-1 Message Setting.

Response Yes'!, No

Next End"!, Next, Goto, Abort

Error End, Next, Goto, Abort™

Note 1. Default settings with the CX-Protocol.
2. Forthe CS/CJ protocol macro.

Message Repeat Counter Set the number of times the step is to be repeated. The count can be set by
entering a constant (1 to 255) or by designating the address of a word. When
a constant is set in the repeat counter, the value of counter N will be incre-
mented whenever the step is executed. The Type includes Reset and Hold
and the Counter includes Constant or Channel.

1,2,3... 1. Left-click the Repeat Counter field and then left-click the Enter button or
E press the Enter Key.
The Repeat Counter Information dialog box will be displayed.

Fepeat Counter Information

Counter Cancel |
@ Copstant |1

" Channel [Ra1 Edit.. |
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2. Set the initial value for the repeat counter N in the Type drop-down list.

If the Reset is selected, the step is executed the designated number of
times after the value of counter N will be initialized to 0.

If the Hold is selected, the step will be executed the designated number of
times while retaining the current value of the counter N.

3. To designate a repeat counter, select the Constant button and enter the
number of times (1 to 255) the step is to be repeated in the Constant field.

To designate a word (channel) to be read, select the Channel button and
select the Edit... button to set the word address.
The Channel dialog box will be displayed.

Channel

ot [R(D) oK |
Type
) Bead BT ) ilrite 1 Oyl E o Ok ‘ Cancel |
~ Data
Aderaze Area EM Bank #  Channel #

Operand

CIo -] oo~ [ooo0o

— Primary Expression (yhl+x

IDDDD Mo+ IDDDl

Select the address type (Channel, 11, 12, O1, O2, or Operand) from the

drop-down list.

If Channel is selected as the address type, select an area (CIO, WR (CS/

CJ only), LR (C200HX/HG/HE only), HR, AR, DM or EMxx) from the Area

drop-down list.

Input a value in the Channel #.

Note If EMxx is selected from the Area drop-down list, be sure to input a
bank number in the EM Bank # field. The maximum value that can
be input in the EM Bank # field varies depending on the PLC used.

The parameters for the Primary Expression (yN+x) fields define the

channel offset. Input the parameter x.

Change the settings as necessary, provided in the following, and select the

OK button to accept the settings from the Channel dialog box, or the Can-

cel button to leave the settings unchanged.

4. Select the OK button to accept the settings from the Channel dialog box
or the Cancel button to leave the settings unchanged.

Command Set one of the following commands for step execution.

Send
Sends the send messages set in the step.

Receive

Receives the receive messages that were set in the step or messages that
were sent based on the receive matrix.

Send & Receive

After sending the send messages that were set in the step, receives the
receive messages that are set in the step and the messages that were sent
based on the receive matrix.
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Open (for CS/CJ protocol macro)
Turns ON the DTR signal.

Close (for CS/CJ protocol macro)
Turns OFF the DTR signal.

Flush (for CS/CJ protocol macro)
Clears the data within the receive buffer.

Wait (for CS/CJ protocol macro)

Sets to a standby state in the step and keeps that state until the Wait Clear
switch turns from OFF to ON.

The following table lists the items that can be set for each command.

Setting item Command
Send Receive Send & Open Close Flush Wait
Receive

Sequence | Transmission | Yes Yes Yes
control
Link words Yes Yes Yes -—- -—- -
Receive wait | --- Yes Yes
time: Tr
Receive finish | --- Yes Yes - --- - -
time: Tfr
Send finish Yes - Yes - - - -
time: Tfs
Response Yes Yes
Type

Step Repeat Yes Yes Yes No No No No
counter
Retry count No No Yes No No No No
Send wait time | Yes No Yes No No No No
Send mes- Yes No Yes No No No No
sages
Receive mes- | No Yes Yes No No No No
sages
With/Without | Yes Yes Yes No No No No
response writ-
ing
Next process | Yes Yes Yes Yes Yes Yes Yes
Error process | Yes Yes Yes No No No No

1,2,3... 1. Left-click the Command field.
Example: CS/CJ

Gommand Ret
Send v| #

Cormmand Type

Feceive
Send & Receive —

Cipen

st =

2. Left-click an appropriate command on the drop-down list.
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Retry Count The retry can only be set when the command is set to Send&Receive. When
the retry occurs, the current step will be executed again. If the retry occurs
again after the step is repeated the number of designated times, a processing
error will occur.

Effective retry factor: 0 to 9 (0: Retry will not be executed.)

Retry Factors * The send finish time has been reached.
* The receive wait time has been reached.
* The receive finish time has been reached.
* A transmission error occurred during receive processing.
For the CS/CJ: Transmission error of the following address causes a retry.
 Serial Communications Board: Bit 15 of word 1908 or 1918

¢ Serial Communications Unit: Bit 15 of word n+8 or n+18 (n = 1500 +
25 x Unit No.)

For the C200HX/HG/HE: The bit 04 of word 283 or bit 12 (communications
error) of word 283 causes a retry.

* A message, excepting the message set in receive messages, is received.
* An error occurred in the Error Check code.

Note For retries, send processing is executed regardless of the wait time.

1,2,3... 1. Left-click on the Retry field or select the Retry field and press the Enter
Key.
2. Input the number of retries (0 to 9) and press the Enter Key.
Send Wait Time: Ts Sets the time to be waited until a send message is sent for send processing.
The accuracy of the Ts is 10 ms maximum.

The send wait time setting range is from 0 to 99 (0: No wait time). The setting
unit can be selected from the following four units.

Time unit Value
10 ms (0.01 s) 00 to 99
100 ms (0.1 s) 00 to 99
1s 00 to 99
1 min 00 to 99

Note When 00 is set as the value, waiting will not occur.

1,2,3... 1. Left-click the Send Wait setting for the step and then left-click the Enter
3 button or press the Enter Key.
The Transmission Wait Time (Ts) dialog box will be displayed.

Transmission Wait Time

YWalue Time LUnit 0K

[ x [10milisecond ]

Cancel

2. Enter a value for the wait time in the Value field.
3. Enter a time unit in the Time Unit field.

4. Select the OK button to accept the settings or the Cancel button to leave
the settings unchanged.
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Step Setting Section 8-1

Setting the Send /Receive Message

Send/Receive Message If a send message, receive message, or receive matrix has already been cre-

and Receive Matrix ated in the send/receive message list or the receive matrix list, a message or
receive matrix can be selected from the Send/Receive Message field of the
step.

Use the following procedure to select a send message reference for the step.
1,2,3... 1. Left-click on the Send Message or Receive Message field.

Example: )
Setting screen for a receive message

Recv Message |_l
SO ENR -

Meszage Matrix

2. Left-click a desired send message name, receive message name, or re-
ceive matrix on the drop-down list.

Note Select the receive matrix from the Receive Message field. The receive matrix
name is indicated with brackets (< >).

Creating Send/Receive A send message or receive message can be newly created in the Send Mes-
Messages sage/Receive Message field of the step even when the messages are not
created in the send message/receive message list.
Use the following procedure to create a send message or receive message.

1,2,3... 1. Right-click the Send Message or Receive Message field of the step to
display a pop-up menu. Select New Message from the menu.

2. The Message Editor dialog box will be displayed. Input a message name
in the Name field.

3. Referto 9-1 Message Setting for creating messages.
4. Left-click the OK button to accept the settings or left-click the Cancel but-
ton to leave the settings unchanged.

Note The receive matrix cannot be newly created or monitored in the Receive Mes-
sage field of the step. It can be created or monitored only in the receive matrix

list.
Editing Send/Receive The send message or receive message can be edited in the Send Message/
Message in Send/Receive Receive Message field of the step.

Field . .
Use the following procedure to edit the messages.

1,2,3... 1. Right-click the Send Message or Receive Message field of the step to
display a pop-up menu. Select Edit Message from the menu.

2. The Message Editor dialog box will be displayed. Refer to 9-1 Message
Setting for editing messages.

3. Left-click the OK button to accept the settings or left-click the Cancel but-
ton to leave the settings unchanged.
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Section 8-1

With/Without Response
Writing

1,2,3...

Next Process

E 1,2,3...

Sets whether received data is to be stored in the /O memory area of the PLC.
This setting is valid only when received data is stored by the fourth operand
(for the CS-series) or third operand (for the C200HX/HG/HE) of the PMCR
instruction.

* Response: Yes
Received data is stored in the I/O memory area of the PLC. A response
type must be set in the sequence list attributes.

* Response: No
Received data is Read-only (not stored in the I/O memory).

1. Left-click the Response field of the step.

Response
YES -

Fezponze \

2. Left-click either Yes or No on the drop-down list.

—1

Use the following procedure to set the next step to be executed.

If a receive matrix is set for the receive message, control will be passed to the
next step based on the next process set in the receive matrix.

The following four processes can be set.

Next process Processing details
Goto ** When this step is terminated, control will be passed to the step
number designated in **,
Next When this step is terminated, the next step will be executed.
End When this step is terminated, the sequence will be terminated.
Abort When this step is terminated, the step will be aborted and the
sequence will be terminated.

1. Left-click the Next Process field of the step and left-click the Enter button
or press the Enter Key.
The Next Process dialog box will be displayed.

. Q_Dtcu IDD Cancel |

2. Select Next Process from the Jump field. When Goto is selected, input a
step number in the empty field.
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Step Editing Section 8-2

3. Select the OK button to accept the settings or the Cancel button to leave
the settings unchanged.

Error Process When the step is terminated abnormally, use the following procedure to set
the next step to be executed. When a step is terminated normally, control will
be passed to the next step according to the next process settings.

If a receive matrix is set in a receive message, control will be passed to the
next step according to the setting that determines the error processing in the
event of abnormal termination.

The following four processes can be set.

Error process Processing details

Goto ** When this step is abnormally terminated, control will be passed to
the step number designated in **.

Next When this step is abnormally terminated, the next step will be exe-
cuted.

End When this step is abnormally terminated, the sequence will be ter-
minated.

Abort When this step is abnormally terminated, the step will be aborted
and the sequence will be terminated.

1,2,3... 1. Left-click the Error Process field of the step and then left-click the Enter
E button or press the Enter Key.
The Error Process dialog box will be displayed. The display is the same
as the one for the next process.

2. Select Next Process from the Jump field. When Goto is selected, input a
step number in the empty field.

3. Select the OK button to accept the settings or the Cancel button to leave
the settings unchanged.

8-2 Step Editing
8-2-1 Displaying the Step List

Use one of the following procedures to display the step of the sequence.

\@ * Double-click the Protocol icon in the project workspace and then left-click
a desired sequence for displaying the step. The step will be displayed in

the project window.
i * Double-click the Sequence icon that includes the step in the project win-
2 dow to display the step list that contains all the steps within the sequence.

8-2-2 Moving the Steps

The order of steps can be changed by moving the selected step. Use the fol-
lowing icons to reorder the steps.

Note Steps within the System protocols cannot be edited.

1,2,3... 1. Select a step and use the Up icon on the toolbar to move up the step by
level. It can also be moved by selecting the Move from the pop-up menu
that can be displayed by right-clicking.

2. Select a step and use the Down icon on the toolbar to move down the step
by level. It can also be moved by selecting the Move from the pop-up menu
that can be displayed by right-clicking.

3. Select a step and use the Top icon on the toolbar to move the step to the
top level. It can also be moved by selecting the Move from the pop-up
menu that can be displayed by right-clicking.

{1111}
i

1[]11]]
]
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Step Editing Section 8-2

4. Select a step and use the Bottom icon on the toolbar to move the step to
=2 the bottom level. It can also be moved by selecting the Move from the pop-
up menu that can be displayed by right-clicking.

8-2-3 Deleting the Steps
Use the following procedure to delete the steps.
Note Steps within the System protocols cannot be deleted.

1,2,3... 1. Left-click the icon of the step to be deleted. More than one step can be se-
lected by pressing the Shift Key and selecting another step to extend the
selection or by pressing the Ctrl Key and selecting another step to add to
the selection.

2. Left-click the Delete icon on the toolbar or press the Delete Key. Alterna-
tively, right-click and select Delete from the pop-up menu. Delete can also
be selected from the Edit menu. The step can also be deleted by left-click-
ing the Cut icon on the toolbar or by pressing the Ctrl+X Keys. Alternative-

.;'ﬁ': ly, right-click to display the pop-up menu and select Cut from the menu.
- Cut can also be selected from the Edit menu.
When canceling the last deletion using Cut, left-click the Paste icon on the
toolbar or press the Ctrl+V Keys. Alternatively, right-click to display the

|EI pop-up menu and select Paste from the menu. Paste can also be selected
from the Edit menu.

The pasted step will be positioned at the end of the sequence and the next

step number available will be given to that step.

If another object is copied or cut during the above procedure, the originally

cut object will be lost.

11T
|2

Note Once a step has been deleted, it cannot be recovered.

8-2-4 Copying the Steps

Use the following procedure to copy the steps within the step field or between
the sequences.

1,2,3... 1. Left-click the icon of the step to be copied. More than one step can be se-
lected by pressing the Shift Key and selecting another step to extend the
selection or by pressing the Ctrl Key and selecting another step to add to
the selection.

a 2. Left-click the Copy icon on the toolbar or press the Ctrl+C Keys.
Alternatively, right-click to display the pop-up menu and select Copy from
the menu. It can also be selected from the Edit menu.

3. Selectthe sequence or display in the project window the step list where the
copied step is to be pasted.

4. Left-click the Paste icon on the toolbar or press the Ctrl+V Keys. Alterna-
|EI tively, right-click to display the pop-up menu and select Paste from the
menu. It can also be selected from the Edit menu. The pasted step will be
positioned at the end of the sequence and the next step number available
will be given to that step.
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SECTION 9
Setting and Editing M essagesand Matrix Lists

This section describes details of the setting and editing of messages and matrix lists.
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Message Setting_j Section 9-1

9-1 Message Setting
9-1-1 Message Setting Screen

For details about message settings, refer to 3-4 Communication Message

Attributes.
Header | Address | Length | Data | Check code | Terminator |
Message name Header Terminator Error check code Length  Address Data

x |Send 'Messagel Header <h>| Terminator <t>| Gheck code <c> |Lengfh <I}|Hddréss (a}l ' -
ke SO0 1 @t [2a0D] LRGC {H parity 0} (2Byte ASCID FiR032) Chir+dar+"1"
b SO0BED 1 @ [2a0D] LRGC (H parity)0) (2Byte ASCID FRO2D Chredar+"1"
ki SO0 1 @ [2a0D] LRGC (H parity)0) (2Byte ASCID FRO2D Chredar+"1"

hal S A @ Toarird [ = T I IR Y SR LT R T Y T LT =TE R Fla s A1

9-1-2 Contents of Messages

The settings that can be made for messages using the CX-Protocol are
shown in the following table.

Attribute Content
Header <h> Type None, Code, ASCII, Hexadecimal
Data One of Code, ASCII, or Hexadecimal
Terminator <t> Type None, Code, ASCII, Hexadecimal
Data One of ASCII, Hexadecimal, or Variable
Check Code <c> Type None, LRC, LRC2™!, CRC-CCITT, CRC-16, SUM (1 byte), SUM (2 bytes),
SUML1 (1 byte)l, SUM1 (2 bytes), SUM2 (1 byte), SUM2 (2 bytes)
Default 0 to 255 if Type is 1 byte; O to 65535 if Type is 2 bytes
Conversion Reverse Order
Data Type: Binary, ASCII
Length <I> Type None, 1 byte, 2 bytes
Default 0 to 255 if Type is 1 byte; O to 65535 if Type is 2 bytes
Conversion Binary, ASCII
Address <a> Type None, Constant, ASCII, Constant Hexadecimal, Variable, Variable ASCII,
Variable Hexadecimal, Variable (Reverse), Variable ASCII (Reverse), Variable
Hexadecimal (Reverse)
Data One of ASCII, Hexadecimal, or Variable
Data Message Order Order setting: <h>, <t>, <¢c>, <I>, <a>
Type/data Data (code, ASCII, Hexadecimal, Variables)

Note *1: For the CS/CJ protocol macro only.

Use either one of the following procedures to create a message.

» Set each attribute (header, terminator, error check code, address) using
its respective setting screen and display the Message Editor dialog box
from the Data field to edit the message.

Data can be created only in the Message Editor dialog box.

Example: <h>+<a>+----+<c>+<t> Edit the following order using the dialog box.
Input data from this dialog box.

* Display the Message Editor dialog box from the Data field, and perform
all the settings (header, terminator, error check code, address) from there,
before editing.

AUDIN - g,4a§enue de la malle - 51370 Saint Brice Courcelles - Tel : 03.26.04.20.21 - Fax : 03.26.04.28.20 - Web : http: www.audin.fr - Email : info@audin.fr



Mmge Setting_; Section 9-1

Header <h> Use the following procedure to set the header (data that indicates the begin-
ning of the message). Select one of the following data types: ASCII, Hexadec-
imal, or Code.

1,2,3... 1. Left-click the Header <h> field and then left-click the Enter button or press
the Enter Key. The Header <h> dialog box will be displayed.

Select a header type from the Type drop-down list (refer to Code, ASCII,
and Hexadecimal in the following section) and set the Data field.

This dialog box can also be displayed by left-clicking the Data field and
then left-clicking the Enter button or pressing the Enter Key to display the
Message Editor dialog box, where the Header <h> dialog box can be dis-
played by left-clicking the Edit button in the Header <h> field.

2. Left-click the OK button to accept the settings or the Cancel button to leave
the settings unchanged.

None

If None is selected from the Type drop-down list, no data will be set to a
header.

Code
1,2,3... 1. Select Code from the Type drop-down list.
2. Left-click the Edit button. The Code Entry dialog box will be displayed.

Code Entry
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3. Select Special Code. Up to four special codes may be entered. Select the
codes from the drop-down list and left-click the Insert button to input the
code indicated.

Note Five or more special codes cannot be input. Left-click the Clear but-
ton to clear all the special codes and input them again from the be-
ginning. Left-click the Delete button to delete the special code where
the cursor is located. Left-click the << or >> button to move the cursor
position.

4. Left-click the OK button to accept the special codes entered or the Cancel
button to leave the settings unchanged.
The input code that is set will be displayed in the Data field of the Header

<h> dialog box.
ASCII

1,2,3... 1. Select ASCII from the Type drop-down list.

2. Input ASCII characters (maximum of 4 characters) in the Data field. The
input ASCII characters will be displayed with a prefix “[” and suffix “I” in the
message header field. For example, if “@” is input, “[@]” will be displayed.

Hexadecimal

1,2,3... 1. Select HEX from the Type drop-down list.
2. Left-click the Edit button. The Hex Entry dialog box will be displayed.

4 E3

B EES
oo fole]r

ENEEENES
EN KX

Enterec: 0Bytes  Max4Bytes |

3. Input the required hexadecimal value by left-clicking the button for each
digit of that value. Up to eight digits may be entered, and they are displayed
at the top of the dialog box. (If a ninth digit is entered, the first digit will be
deleted.)

Note Left-click the CLR button to clear all codes and start again. Left-click
the DEL button to delete the last code entered.
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4. Left-click the Enter button to accept the settings or the Cancel button to
leave the settings unchanged.
The input code confirmed by left-clicking the Enter button will be displayed
in the Data field of the Header <h> dialog box.
The input code will be displayed with a prefix “[" and suffix “]” in the data
field. For example, if 2A0D is input, “[2A0D]” will be displayed.

Terminator <t> Use the following procedure to set the terminator (data that indicates the end
of the message). Select one of the following data types: ASCII, Hexadecimal,
or Code.

E 1,2,3... 1. Left-click the Terminator <t> field and then left-click the Enter button or
press the Enter Key. The Message Terminator <t> dialog box will be dis-
played.
The dialog box can also be displayed from the Message Editor dialog box.
(Refer to the previous Header <h> section.)

rminator 1> E |

ok |

Cancel |

I= Edit |

Select a terminator type from the Type drop-down list and set the Data
field. (For inputting the Code, ASCII, or Hexadecimal, refer to the previous
Header <h> section.)

2. Left-click the OK button to accept the settings or the Cancel button to leave
the settings unchanged.

Check Code <c> Use the following procedure to designate an error check code calculation
method. The check code types LRC, LRC2"!, CRC-CCITT, CRC-16, SUM (1

byte), SUM (2 bytes), SUM1 (1 byte)™?, SUM1 (2 bytes)?, SUM2 (1 byte), and
SUM2 (2 bytes) are available. Data types available are binary and ASCII. Ini-
tial values and conversion directions can be designated.

Note Only for the CS/CJ protocol macro.
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1,2,3... 1. Left-click the Check code <c> field and then left-click the Enter button or
press the Enter Key. The Message Check Code <c> dialog box will be
displayed.

The dialog box can also be displayed from the Message Editor dialog box.
(Refer to the previous Header <h> section.)

Select a check code type from the Type drop-down list.

For LRC, LRC2, CRC-16, SUM (1 byte/2 bytes), SUM1 (1 byte/2 bytes),
and SUM2 (1 byte/2 bytes), all fields of the dialog box become active. For
CRC-CCITT, the Conversion field becomes active.

2. Input values in the Default field.

For LRC, LRC2, CRC-16, SUM (1 byte), SUM1 (1 byte), and SUM2 (1
byte), enter a default value from 0 to 255. For SUM (2 bytes), SUM1 (2
bytes), SUM2 (2 bytes), CRC-16, enter a default value from 0 to 65535.

3. Select the Reverse Order check box to set the reverse check code.

4. For all types other than None, set BIN or ASCII in the Data Type field.
For LRC, LRC2, SUM (1 byte), SUM1 (1 byte), and SUM2 (1 byte), BIN in-
dicates binary data (1 byte) and ASCII indicates ASCII data (2 bytes).

For CRC-CCITT, CRC-16, SUM (2 bytes), SUM1 (2 bytes), and SUM2 (2
bytes), BIN indicates binary data (2 bytes) and ASCII indicates ASCII data
(4 bytes).

5. Left-click the OK button to accept the settings or the Cancel button to leave
the settings unchanged.

The display in the Check Code field will be as shown below.

Example | ¢ (horizontal parity) (0) (2 Byte ASCII)
- Data type (BIN or ASCII)

Default
Check code

Note Set the calculation range of the error check code <c> in the Data field
of the Message Editor dialog box.
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Length <I> Use the following procedure to set the length (the number of bytes of the mes-
sage). The data length is automatically calculated in send processing accord-
ing to the Length <I> setting in a frame. The length <I> data will be added
when data is sent. The Length types of 1 byte or 2 bytes are available and the
Conversion types of BIN or ASCII are available.

1,2,3... 1. Left-click the Length <I> field for a message and then left-click the Enter
E button or press the Enter Key. The Message Length <I> dialog box will be
displayed. The dialog box can also be displayed from the Message Editor

dialog box. (Refer to the previous descriptions for the Header <h>.)

Type Default ‘ Ok I

I Mone - I ]

Cancel |

Conversion
= B C AEE

Select a length type from the Size drop-down list. For 1 Byte, the length is
set to one byte. For 2 Bytes, the length is set to two bytes.

2. Enter the length in the Default field. The range is 0 to 255 for 1 Byte or O
to 65535 for 2 Bytes.

3. Selectthe BIN conversion type or ASCII conversion type from the Conver-
sion field.

4. Left-click the OK button to accept the settings or the Cancel button to leave
the settings unchanged.

Note The display in the Length field will be as shown below.

Example
0) (1Byte BIN)

Conversion type
Size

Default value

Note Set the calculation range in the Data field of the Message Editor di-

alog box.
Address <a> Use the following procedure to set the address. The address types are as
shown in the following table.
Type Drop-down list item Default format
Constants | Constant ASCII
Constant hexadecimal []
Variables Variable (1,2)
Variables Variable ASCII (with ASCII conversion) $(1,1)
Variables Variable hexadecimal (with hexadecimal conversion) | &(1,1)
Variables Variable (reverse) ~(1,2)
Variables Variable ASCII (with reverse conversion) $7(1,1)
Variables Variable hexadecimal (with reverse conversion) &(1,1)
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1,2,3... 1. Left-click the Address <a> field and then left-click the Enter button or
press the Enter Key. The Message Address <a> dialog box will be dis-
played. The dialog box can also be displayed from the Message Editor di-
alog box. (Refer to the previous descriptions for the header <h>.)

Constant ASCI]
Constant HEX

Wariable HEX
“Wariable Reverse

11, ||

Select an address type from the Type drop-down list.
2. For Constant ASCII, enter characters in the Data field.

For Constant HEX, left-click the HEX button to enter hexadecimal values
into the Data field.

Note For the input methods, refer to the previous descriptions for the head-
er <h>))

For the Variable types, left-click the Variable and Length buttons to com-
pose variables (X, Y). The Channel dialog box will be displayed.

Channe|
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Setting of Variables

X, Y

Editing Length (Y)

- Type: R ()
(Byte unit) Type: yN+x

— Type: * (see note 2)

Variable
(Word unit)

Type: R (), W () (see note 3)

Top address

— Dbata ——————— — Linear expres- -
sion including N
Address:
. yN+x
When selecting + .
words: Designate Designate y and x
the area (CIO, LR, For CS/CJ
HR, AR, DM, EM) _
(see note 1) and the y=010 1000
word. x=0 to 1000
For C200HX/HG/HE

No designation 3
when 11, 12, O1, or y:0 to 255
02 is selected. x=0to 255

No designation
when an operand is
selected.

Example
Direct designation: R (CIO 0000+N+1)
Link word designation: R (I1+2N+1)

Type: yN+x

For CS/CJ

y=0 to 1000

x=0 to 1000

For C200HX/HG/HE
y=0 to 255

x=0 to 255

Type: * (see note 3)

Note 1. Area codes for word designation

CIO: I/O relay, internal auxiliary relay, and special auxiliary relay
WR: Internal auxiliary relay (For CS/CJ only)

LR: Link relay (For C200HX/HG/HE only)

HR: Holding relay

AR: Auxiliary memory relay

DM: Data memory

EM: EM area

2. Cannot be selected in the address setting or send message.
3. Cannot be selected in the send message.

Setting Channel Dialog Box

a) Select Read R (), Write W (), yN+x, or * in the Type field.

b) If Read R () or Write () is selected in the Type field, select an variable
(Channel, 11, 12, O1, O2, or Operand) from the Address drop-down
list in the Data field. If Channel is selected, select an area code (CIO,
WR, LR, HR, AR, DM or EMxx) from the Area drop-down list. Set a
value in the Channel # field.

255
AUDIN - 8, avenue de la malle - 51370 Saint Brice Courcelles - Tel : 03.26.04.20.21 - Fax : 03.26.04.28.20 - Web : http: www.audin.fr - Email : info@audin.fr



Mmge Setting Section 9-1

c) Designate an offset from the top word (designated in the above Data
field) in the Primary Expression (yN+x) field. Input y and x.

d) Press the OK button to confirm the Channel dialog box or Cancel but-
ton to cancel the process.

Note If the EMxx option is selected from the Area drop-down list, be sure
to input the bank number (0 to F) in the EM Bank # field. The maxi-
mum number of the EM bank that can be designated in the EM Bank
# field depends on the selected PLC.

Address Setting Examples

Yy =]

i a ASCI
Wariahle HEX
Yarishle Reverse
Yariahle ASCIl Reverse
Yariable HEX Rewverse

Variable (Left-click the button.) Length (Left-click the button.)

ooeo b+ oo |

3. Press the OK button to confirm the setting or Cancel button to cancel the
process.
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Data Use the following procedure to edit the message.

1,2,3... 1. Enter a message name.
2. Retrieve each item already set and reorder them.

Example: Edit the following in this dialog box.

<h>+<a>+eeeeee+<C>+<t>

Input data from this dialog box.

Note If data has not been input into any of the items (header <h>, address
<a>, check code <c>, or terminator <t>), left-click the Edit button of
each field to display a data input dialog box and to enter data.

If data has been input in any one of these items, the Insert button for
each one of them will become active.

3. Set the data.
Combine the following to designate the data using the Message Data
drop-down list.
Hexadecimal, ASCII, Code, Variable
Example: "RX0"+&(N,1)+"00"
— ASCIl data

— Variable
ASCII data

4. Set the error check code and length calculation range (items). Items sub-
ject to calculation are shown in the following color in the Data field.
Set as length calculation: Red
Set as check code calculation: Blue
Set as length and check code calculation: Purple
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Use the following procedure to edit messages and to enter data.

1,2,3... 1. Left-click the Data field for a message and then left-click the Enter button
E or press the Enter Key. The Message Editor dialog box will be displayed.
Using this dialog box, create data and edit messages.

2. Enter a message name in the Name field.

3. Left-click the Insert button on each field to insert data for each item. Mes-
sage elements will be displayed from left to right in the screen field.

Mes=age Editor |
Name [SD@7)._f «| » Delste |

R < o+ 1T AT T A 0000 + e+ 1
4

[

a) Left-click the Insert button in the order of insertion. This item selected
with the Insert button will be inserted prior to the highlighted item. Use
the << or >> button to move the cursor to left or right.

The header <h> can be inserted only at the beginning of a message.
For deleting an item, move the cursor using the << or >> putton until it
is over the item to be deleted and then left-click Delete.

Note a) <h>, <t>, <c>, <I>, or <a> can be deleted from the message con-
figuration, not from the data. It can be inserted again by left-click-
ing the Insert button.

b) As for <h>, <t>, <c>, <I>, and <a>, only one item can be positioned
in one message.

A header can be inserted into a message by left-clicking the Insert
button on the Header field. If a header already exists in a message or
if the cursor is not at the beginning of the message, this button cannot
be used.

If a header is to be inserted or if it needs to be modified, left-click the
Edit button to display the Header <h> dialog box and then enter or edit
the header.

A terminator can be inserted into a message by left-clicking the Insert
button on the Terminator field. If a terminator already exists in a mes-
sage, this button cannot be used.

A terminator can be inserted before the check code unless there is
data after the check code. If a terminator is to be inserted or if it needs
to be modified, left-click the Edit button to display the Terminator <t>
dialog box and then enter or edit the terminator.

A check code can be inserted into a message by left-clicking the Insert
button on the Check Code field. If a check code already exists or if an
attempt is made to insert the check code before the header, this button
cannot be used.

If a check code is to be inserted or if it needs to be modified, left-click
the Edit button to display the Check Code <c> dialog box and then en-
ter or edit the check code.

An address can be inserted into a message by left-clicking the Insert
button on the Address field. If an address already exists or if an at-
tempt is made to insert the address before the header or after the ter-
minator, this button cannot be used.

If an address is to be inserted or if it needs to be modified, left-click the
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Edit button to display the Address <a> dialog box and then enter or
edit the address.

A length can be inserted into a message by left-clicking the Insert but-
ton on the Length field. If a length already exists or if an attempt is
made to insert the length before the header or after the terminator, this
button cannot be used.

If an address is to be inserted or if it needs to be modified, left-click the
Edit button to display the Length <I> dialog box and then enter or edit
the length.

b) Create or insert data items of a message in the Message Data field.
Using the << or >> button, move the cursor to a place where data items
are to be inserted.

« Select one of the items from the drop-down list in the Message Data
field.

—Message Data

Constant Hex =

. |Constant Hex L
Constant ASCH

Constant Code
“ariable

* When either the Constant Hex or Constant Code is selected, left-
click the Edit button to display the HEX Entry or Code Entry dialog
box. Using the dialog box, enter data and left-click the Insert to insert
hexadecimal numbers or code in the message.

Note For the input methods, refer to the previous descriptions for the
Header <h>. In the Message Data field, up to 48 units of hexadeci-
mal can be input.

* When ASCII is selected, input ASCII characters in the right field and
then left-click the Insert button to insert the data in the message.

« When Variable is selected, left-click the Edit button to display the Mes-
sage Variable dialog box. Left-click the Insert button to insert the vari-
able in the message. (For the input methods, refer to the previous
descriptions for the address <a>.)

Note Message data cannot be inserted before the header or after the terminator.

Check Code and Length If the check code or length is designated for a message, its range can be des-
Ranges ignated in the Length <I> or Check Code <c> field.
Use the following procedure to designate the ranges.
1,2,3... 1. Left-click the Up button or Down button to designate the beginning or end
F j item (in the order of 1, 2, 3, etc. from the left of a message) of the range.

The display color of the designated item changes.
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For example, when changing the check code from “3" to “5,” the display will
change as shown below.

The character color changes from black to blue.

-+ a>+"_1|_" +1 AT 0000+ e

T T

|gi=i=ins

|gf=i=ins

Press the OK button to confirm the message data or press the Cancel but-
ton to leave the settings unchanged. Input message will be displayed on
the Data field.

9-2 Matrix Creation

Use the procedures described in the following paragraphs to set a matrix
when more than one received message is expected and the next process is to
be changed for each receive message.

9-2-1 Creating a New Matrix

Use the following procedure to create a new matrix.

1,2,3... 1. Double-click the Matrix List icon on the project workspace or project win-
dow.

2. Right-click the Matrix List on the project workspace or right-click in the
project window to display a pop-up menu. Point at Create on the pop-up
menu and select Matrix. Create can also be selected from the Protocol
menu.

9-2-2 Creating a New Matrix Case

Use the following procedure to create a new matrix case in a matrix.

1,2,3... 1. Double-click the Matrix icon on the project window.

2. Right-click in the project window to display a pop-up menu. Point at the
Create on the pop-up menu and select Matrix. Create can also be select-
ed from the Protocol menu.

[
=i
=
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9-2-3 Editing a Message in the Matrix Case

Use the following procedure to set a receive message.

1,2,3... 1. Double-click the Matrix icon on the project window.
2. Left-click the Receive Message field on the Matrix Case.

3. When setting an existing receive message, left-click a desired receive
message on the drop-down list.
When creating a new receive message, right-click the Receive Message
field and then left-click New Message.
When editing a set receive message, right-click the Receive Message
field and then left-click Edit Message.

frr
i
-

9-2-4 Defining the Next Matrix Case Process

Use the following procedure to edit the next process.

2a2 1,2,3... 1. Double-click the Matrix icon on the project window.
i 2. Left-click the Next Process field on the Matrix Case and then left-click the
E Enter button or press the Enter Key.

The Next Process dialog box will be displayed.

3. Select Next Process on the Jump field. If Goto is selected, enter a se-
guence step number that will be referred to.

4. Left-click the OK button to confirm the setting or Cancel button to cancel
the process.

9-3 Message and Matrix Editing
9-3-1 Displaying Messages within the Protocol

Use the following procedure to display all the messages within the protocol.

1,2,3... 1. Left-click the protocol in the project workspace to highlight the protocol or
@ double-click the Protocol icons containing a sequence in the project win-
dow.
2. Double-click the Send Message List icon or Receive Message List icon
o i on the project window to display all the messages contained in the mes-
o sage list.

9-3-2 Renaming a Message

Use the following procedure to rename a message in the send or receive
message lists. Messages belonging to System protocols cannot be changed.

1,2,3... 1. Left-click the Message Name field to be renamed from the message list.
Alternatively, select Message Name and press the Enter Key.

2. Type in a new name for the message and press the Enter Key. The new
message name must not exceed 10 characters.

Note The name given to a send message cannot be used for the receive message
within a protocol.
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9-3-3 Copying a Message

Use the following procedure to copy a message within a protocol or between
protocols.

Note Messages within the System protocols can be copied, but the message
becomes editable once pasted into a message list in a User category proto-
col.

1,2,3... 1. Selectthe icon of the message to be copied, either from the send message
list or the receive message list. More than one message can be selected
by pressing the Shift Key and selecting another message to extend the se-
lection or by pressing the Ctrl Key and selecting another message to add
to the selection.

_ 2. Left-click the Copy icon on the toolbar or press the Ctrl+C Keys. Alterna-
tively, right-click to display a pop-up menu and then select Copy in the pop-
up menu. It can also be selected from the Edit menu.

3. Left-click the Message List icon in the project workspace or display the
message in the project window and designate the destination where the
message is to be pasted.

4. Left-click the Paste icon on the toolbar or press the Ctrl + V Keys. Alterna-

|EI tively, right-click to display a pop-up menu and then select Paste in the
pop-up menu. Paste can also be selected from the Edit menu. The pasted

message will be positioned at the end of the corresponding message list.

Note Make sure that another Copy or Cut operation does not take place
during this procedure as this deletes the original copy.

9-3-4 Deleting a Message

Use the following procedure to delete messages. Messages within the Sys-
tem protocols cannot be deleted.

1,2,3... 1. Select the icon of the message to be deleted, either from the send mes-
sage list or the receive message list. More than one message can be se-
lected by pressing the Shift Key and selecting another message to extend
the selection or by pressing the Ctrl Key and selecting another message
to add to the selection.

2. Left-click the Delete icon on the toolbar or press the Delete Key. Another
method is to right-click and select Delete from the pop-up menu. Delete
can also be selected from the Edit menu.

Alternatively, left-click the Cut button on the toolbar or press the Ctrl+X
u_-:lu’_":a__ Keys. Right-click to display a pop-up menu and then select Delete in the
pop-up menu.
Left-click the Paste icon from the toolbar or press the Ctrl+V Keys to re-
|EI trieve the last delete action using the Cut operation. The pasted message
will be positioned at the end of the corresponding message list.

11T
ar!

Note Once a message has been deleted, it cannot be recovered.

9-3-5 Displaying the Matrix within the Protocol

Use the same procedure as described in 9-3-1 Displaying Messages within
the Protocol.
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9-3-6 Displaying the Matrix Case within the Matrix

Use the following procedure to display the matrix case within the matrix.

1,2,3... 1. Left-click the protocol list in the project workspace to display all the proto-
cols in the project window.
@ 2. Left-click the Protocol icons that contains the matrix list.
3. Double-click the Matrix List icon to display the matrix in the project win-
_ dow.
4. Double-click the Matrix icon to display each matrix case in the project win-
s dow.

)
i

9-3-7 Copying the Matrix Case

Use the following procedure to copy a matrix case in the matrix or between

matrices.
1,2,3... 1. Left-click the Matrix Case icon to be copied. More than one case can be
-"@ selected by pressing the Shift Key and selecting another case to extend
o the selection or by pressing the Ctrl Key and selecting another case to add

to the selection.

: 2. Left-click the Copy icon on the toolbar or press the Ctrl+C Keys. Alterna-
tively, right-click to display a pop-up menu and then select Copy in the pop-
up menu. Copy can also be selected from the Edit menu.

3. Select a matrix case or display in the project window and designate the
destination where the matrix case is to be pasted.

4. Left-click the Paste icon on the toolbar or press the Ctrl+V Keys. Alterna-
|EI tively, right-click to display a pop-up menu and then select Paste in the
pop-up menu. Paste can also be selected from the Edit menu. The pasted
matrix case will be positioned at the end of the matrix case list except the
case number 15.

9-3-8 Moving the Matrix Case

Move the selected matrix case to change the order of matrix cases. Use the
following icons to change the order of matrix cases. (The matrix case list
belonging to the System protocols cannot be edited.)

Select a matrix case and press the Up icon on the toolbar to move up the
selected matrix case by one. It can also be selected by right-clicking to display
the pop-up menu and then selecting Move from the menu list.

Select a matrix case and press the Down icon on the toolbar to move down
the selected matrix case by one. It can also be selected by right-clicking to
display the pop-up menu and then selecting Move from the menu list.

Select the matrix case and press the Top icon on the toolbar to move the
matrix case to the case number 00 position. It can also be selected by right-
clicking to display the pop-up menu and then selecting Move from the menu
list.

{11
(k]
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]
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SECTION 10
Communications PLC Setup and Online Connections

This section describes details of the communications settings and online connections.
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10-1 PLC System Configuration
Left-click the PLC icon before making the following settings.

1,2,3... 1. PLC model, communications between the personal computer and PLC,
and Board and Unit settings.

2. Left-click the required PMSU icon (Board/Unit) before performing the trace
memory 1 (A), trace memory 2 (B), communications port 1 (A), or commu-
nications port 2 (B) settings.

Note Use icons in parentheses if the C200HX/HG/HE is used.

. [ Trace memory 1 (A)/2 (B): Starts tracing/reading
PLC model Board icon ﬁ Communications port 1 (A)/2 (B)| Board communications
e port settings
PLC icon Communications between TSt ,
personal computer and — Trace memory 1/2 . Starts tracing/reading
PLC I
L 4 Communications port 1/2 | Unit 0 communications
Unit 0 icon ; port settings
:,T,ra,C?memorx 1/2 7: Starts tracing/reading
[{ Lt Unit F communications
Unit E icon Communications port 1/2 port settings
— PLC mﬁeimio[yf PLC 1/0 memory monitoring/editing
— I/0 table creation/editin
/O table fonieciting
— ' Error lo : .
|:| : Set by users. ,Efreriog PLC error log display

: Monitor

Note Those in brackets are for the C200HX/HG/HE.
Units O to F are for the CS/CJ.

10-1-1 Outline of Operation

The following operations are possible by right-clicking the PLC icon in the
am) PLC menu, toolbar, or project workspace (i.e., the left pane of the window)
and selecting the items from the pop-up menu that is displayed.

« Settings for communications between the personal computer and PLC.
* PLC online connections and changes in PLC operating mode.
* Reading and displaying protocol data from the Boards and Units.

* PMSU communications setting data transfer and trace memory starting
and reading.

* /O table creation, PLC I/O memory monitoring and editing, and error log
display.
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10-2 Communications Settings between Personal Computer
and PLC

10-2-1 Outline of Connection Methods

The following three methods are available for PLC connections for online com-
munications.
Direct Connections to PLC for Online Communications

The following shows how the personal computer can be connected directly for
online communications with the PLC using the toolbus or host link.

Connections to PLC through built-in Connecting to PLC through Serial Communica-
port for online communications tions Board or Unit
CX-Protocol CX-Protocol
/‘ CPU Unit /_ Serial Communications Board or Unit
| . | .
Toolbus or Host Link Host Link T CPU Unit

Connections to PLC via Network for Online Communications

The following shows how the personal computer can be connected online to a
PLC on the network via another PLC that is connected to the personal com-
puter using the toolbus or host link.

CX-Protocol

/——‘ Gateway

Toolbus or Host Link

Network

Connections to PLC via Modem for Online Communications

The following shows how the personal computer can be connected online to a
PLC via a telephone line using a modem. The PLC connected to via a modem
can also be used as a gateway for online connection to other PLCs on the net-
work. For settings, refer to 10-4 Modem Connections.

CX-Protocol

Telephone line

0
_./ Z’/. | Modem
Modem
Toolbus or Host Link

Toolbus or Host Link
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10-2-2 Direct Connections to PLC for Online Communications
Setting PLC Model Use the following procedure to set the PLC model.

o 1,2,3... 1. Right-click the PLC icon and select Edit PC-PLC Comms Settings from
the pop-up menu, or select Edit PC-PLC Comms Setting from the PLC
menu.

Change PLC

2. Select the PLC Series from the Device Type drop-down list.
3. Left-click the Settings button to enter the setting.
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Section 10-2

Communications Settings

1,2,3...

1. After selecting the PLC using the above procedure, select Toolbus or
SYSMAC WAY from the Network Type drop-down list. In this example,

SYSMAC WAY is selected.
2. Left-click the Settings..

. button on the right-hand side. The Network Set-
ting dialog box will be displayed.

Metwork Settings [SYSMAC WAY] |
Metwork, I Diriver I Mu:u:lernl
= ElHE Saunce wddiess
W etk I':' _Ij = I':' _Ij {1 it I':I _%
= Bl E ek aticmsddress
| |2t I':' _lj I il I':' _lj (it I':I _%
= Erane Lerath — Rezponze Timeout [z]
T =
— Huoszt Link Unit Mumber = [Hetwartk Wperating Lewe]
||:| _l: = 4 gy
k. I Cancel Help
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Communications Settings between Personal Computer and PLC Section 10-2

3. Left-click the Driver tab in order to change the communications conditions.
The name of port, baud rate, data length, parity, and number of stop bits
can be set.

Hetwork Settings [SYSMALC WAY]

Petwark,  Ciriver lMDdem]

Connection [rata Format

Fort Mame: - [ata Bits: 7 - |
Baud Bate: |3600 - Faritw: Ewen i |
r Stop Bits: 2 - |

bl ake D efault

0k, | Cancel Help

Note The communications conditions must coincide with those in the PLC
Setup of the CPU Unit. For details, refer to the Operation Manual of
the PLC.

4. Left-click the OK button.

Note With the C200HX/HG/HE, the baud rate cannot be set to 1,200 bps
for connections using the toolbus.

10-2-3 Connections to PLC on Network via Online Communications

Outline By making simple settings with the CX-Protocaol, it is possible for the personal
computer to connect online to a PLC on the network via another PLC that is
directly connected to the personal computer.

The following explains the settings required for the personal computer to com-
municate with a PLC on the network.
These settings make available all online functions (e.g., protocol transfer,
communications port setting transfer, and tracing) for the control of PMSU
mounted to the PLC on the network.
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Communications Settings between Personal Computer and PLC Section 10-2

Settings The following system example shows how to make the settings required to
connect the personal computer to a PLC on the network.

The CX-Protocol connects the personal computer online to a PLC (PC100 in
this example) on the network through another PLC (PCO000 in this example),
that has been registered with the project by using the CX-Protocol.

CX-Protocol

Device name: PC100
Device type: CS1G
)—K Gateway Node address: 1
Device name: PC000
o | Device type: CS1H
R R - -|< | Node address: 0 e

Toolbus or Host Link S

Network
Example: Controller Link

1,2,3... 1. In this example, a new project is created for the PC100, which is a CS1G
type. Left-click New in the File menu or left-click the New icon on the tool-
bar.

2. Make settings in the Change PLC and the Network Settings [Toolbus]
dialog boxes as shown below.

3. Click the OK button.
Settings

for
PC100

Change PLC

|7 P00
oot o gt
: —————— |

By left-clicking this button, the Network Settings
dialog box will be displayed as shown below.
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Communications Settings between Personal Computer and PLC Section 10-2

MHetwork Settings [Toolbus] E3

Mebwork. I Crriver I Mu:--:leml

[ Set to 0 for local network communications.|

= Bl & Seunce Address

F | 2iine e I':I _% | |ejef= I':' _I? e (L _%

[ Set the node address to 1.]

—FINS D Estinatinqﬁddress

Va
Metwork: IE _% Mode: F _I? e | L2 _IQ

— Frame Length — Rezponze Timeout [z
—=1 =1
1004 = 2 =

I f
| Increase the response monitor time if the time elapses
before the establishment of network connections.

— H et ke [ it e e

III_:l o 5

Use the default value normally. If communications are made over
two or more networks, set the value to the shorter frame length.

. I Cancel Help

4. Left-click CX-Net in the Tool menu.
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5. Select Add Device from the Project menu. Make settings for Network
Type and Network Settings as shown below.
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Communications Settings between Personal Computer and PLC Section 10-2

6. Close the CX-Net (CX-Programmer). Right-click the PLC icon in the
project workspace and select Edit PC-PLC Comms Setting. Alternatively,
select Edit PC-PLC Comms Setting from the PLC menu.

7. Change the Network Type in the Change PLC dialog box to PC000.

Changin
Settinggsg Change PLC
for PC100 Device Mame
[PC100
made via PC000 ||:5-| G ﬂ Seltings. .
Metwork, Tppe
PCOOO Settings. ..
Cornment
] | Cancel | Help

By making the above settings, PC000 becomes the gateway for communica-
tions with PC100. To make an online connection, right-click PC100 in the
project workspace and select Connect to PLC, or select Connect to PLC
from the PLC menu.

Note 1. CX-Net (PC Network Configuration Tool) is used for performing construc-
tion, debugging, and applications for OMRON PC networks. It is used for
the following:

e Connecting a PC to a network

¢ Routing table settings

 Data link table settings

* Network Support Board (NSB) settings

« Communications Unit software switch settings

For details about CX-Net, refer to Section 13 PC Network Configuration
Tool in the SYSMAC WS02-CXPC1 CX-Programmer Operation Manual.

2. By using the following Network Support Boards (NSB), CX-Protocol con-
nection is possible between a personal computer directly connected to the
network and a PC on the network.

« Controller Link Support Board
¢« SYSMAC LINK Support Board

In this case, however, settings in the CX-Net must be made through the

FinsGateway Service Manager.

For details of setting procedures for the FinsGateway Service Manager, re-

fer to Section 13 PC Network Configuration Tool in the SYSMAC WS02-

CXPC1 CX-Programmer Operation Manual.

Note To use the FinsGateway Service Manager, a FinsGateway NSB Driv-
er must be installed when installing the CX-Server.
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Online Connections and Mode Changeﬁ Section 10-3

10-3 Online Connections and Mode Changes
10-3-1 Online Connection Method

Use the following procedure for online connections.
i 1,2,3... 1. Right-click the PLC icon and select Connect to PLC from the pop-up
menu, or select Connect to PLC from the PLC menu.

2. When the establishment of online connections is successful, the PLC
mode (RUN, PROGRAM, or MONITOR) will be displayed next to the PLC
icon in the project workspace (i.e., the left pane of the window).

E- [ EXAMPLE1 paw

LI

@'"Eﬁ Ex Protocol List
: EI@' TEMP ZChARA
rt! Temp comm  Seguence

e :ﬂ: mend Message List

& Receive Message List
=-E Matrix List

B Matrin

=8 EX1 Protocol List

@ Cantraller (E5_K read

------ % Trace List_

8 1 MewPLC! [Fun] [CS1G — CPU4S]

If the establishment of online connections is unsuccessful, the following
screen will be displayed. Check the communications settings.

CX-Protocol o

! E Failed to connect to the PLC. Ty reconnecting ta the PLEC.

Betm i Cancel |

.................................

Note The personal computer and PLC must be connected to each other for online
communications before the following items are performed.

* Transfer of communications port setting data from PMSU (Data transfer
from PLC to personal computer)

* Transfer of communications port setting data to PMSU (Data transfer from
personal computer to PLC)

* Transfer of protocol data from PMSU (Data transfer from PLC to personal
computer)

* Transfer of protocol data to PMSU (Data transfer from personal computer
to PLC)
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Modem Connections Section 10-4

* Transfer of protocol list data from PMSU (Data transfer from PLC to per-
sonal computer)
« Start, stop, and transfer of tracing data (Data transfer from PLC to per-
sonal computer)
* |/O table creation
* I/O memory display/editing
* Error log display
&Caution Online connection of the CX-Protocol cannot be made to a PLC which is con-
nected online to SYSMAC-CPT or SYSMAC-PST. Simultaneous online con-
nections cannot be made regardless of whether there is only one personal
computer (i.e.: the communications port is the same) or there are several per-
sonal computers (i.e.: the communications ports are separate). Therefore,
when SYSMAC-CPT or SYSMAC-PST is running and connected online to a
PLC, it must be made offline before making online connection to the CX-Pro-
tocol. Similarly, when the CX-Protocol is connected online to a PLC, it must be
switched to offline before making online connection to SYSMAC-CPT or SYS-
MAC-PST.

10-3-2 Changing to Offline
Use the following procedure to set the CX-Protocol from online (i.e., PRO-
GRAM, MONITOR, or RUN mode) to offline.
iun| Right-click the PLC icon and select Disconnect from PLC from the pop-up
menu, or select Disconnect from PLC from the PLC menu.

10-3-3 PLC Operating Mode Changes
Before transferring protocol data or communications port setting data, be sure
to set the PLC to PROGRAM mode by using the following procedure.

T Right-click the PLC icon, select Operating mode, and select PROGRAM
mode. Alternatively, select Operating mode from the PLC menu and select
the PROGRAM mode.

&Caution Confirm that no adverse effect will occur in the system before changing the
operating mode of the CPU Unit. Not doing so may result in an unexpected
operation.

10-4 Modem Connections
10-4-1 Outline

Online connection can be made to a remote PLC via telephone line using
modems.

Telephone line
W Modem /\/ Modem

Modem for per- Modem for PLC \J
sonal computer

Personal computer PLC
(CX-Protocol)

The modem can be connected to the
PLC's peripheral port, built-in host link
‘ port, or PMSU.

Connection can also be made to other PLCs on the
network by using the PLC directly connected to the
PLC PLC modem as a gateway.
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Modem Connections Section 10-4

The setting procedures required to make connections to a remote PLC using
modems are shown below.

Settings at the PLC side

e Setting the modem at the PLC side
e Connecting the PLC to the modem
e Making settings for the PLC connections port

Settings at the personal computer (CX-Protocol) side
e Setting the modem at the personal computer side
(made in Windows)
e Connecting the personal computer to the modem

e Making settings for the CX-Protocol (includes set-
ting the telephone number)

Online connection

Make the settings so that the following conditions are satisfied.

* Baud rate: Set the same baud rate for the PLC communications port and
the personal computer communications port.
+ Serial communications mode: host link (SYSMAC WAY) or toolbus
+ Communications conditions:
When serial communications mode is set to host link:
Data length: 7 bits
Parity: even
Stop bits: 2 bits
When serial communications mode is set to toolbus:
Data length: 8 bits
Parity: none
Stop bits: 1 bit

10-4-2 Settings at the PLC Side

Modem Settings Make settings for the modem to be connected to the PLC using personal com-
puter communications software (terminal software). Before performing the
operations given below, connect a personal computer to the modem.

As an example, the operating method will be explained for OMRON’s
ME5614E modem.

1,2,3... 1. Turn ON the power supply for the modem.
2. Start-up the personal computer communications software.

3. Setthe baud rate and communications format for the communications soft-
ware in the following way.

* Set the same baud rate as that of the PLC.
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Modem Connections Section 10-4

« Set the communications format to one of the following:

When serial communications mode is host link:
Data length: 7 bits
Parity: even
Stop bit: 2 bits
When serial communications mode is toolbus:
Data length: 8 bits
Parity: none
Stop bit: 1 bit
Note When the above settings are made and communications are per-
formed, OMRON’s ME5614E Modem will automatically recognize
and record the settings. If a modem without this feature is used,
make the above settings using AT commands.

4. Make settings for the modem by sending AT commands as shown below.
Example: for ME5614E

AT&F [Enter]

ok

ATYC0\ N3&K3S0=1S30=60X4E0&D0&Y1 [ Ent er]
ok

AT&W. [Enter]

ok

» The “[Enter]” indicates where the Enter Key should be pressed.
» The “ok” means that the modem has accepted the command.

Meanings of AT Commands and S Registers Used in the Previous

Example
Command Setting item Settings

AT&F Return to factory setting -

AT%CO Data compression setting No data compression

AT\N3 Error correction setting V.42 auto-reliable mode

AT&K3 Flow control Available
For C200HX/HG/HE, set to O
(not available)

ATSO0=1 Automatic reception Available (for 1 call)

ATS30=60 Abort timer (ex. 1 minute)

ATX4 Baud rate display Baud rate display, busy, dial
tone detection

ATEO Command echo Not available

AT&DO DTR signal control Constantly ON

AT&Y1 Setting at power ON Load setting for profile 1 at
power ON

AT&W1 Storage of present value area Stored as profile 1

contents in non-volatile memory
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Connecting the PLC to the After the modem settings have been completed, connect the PLC to the
Modem modem.

Connect the PLC to the modem referring to the example below.

Connecting to the Host Link Port or PMSU

Modem CS1
Connector hood FG ‘| |‘ Connector hood FG
FG 1 1 FG
SD 2 2 SD
RD 3 3 RD
RTS 4 4 RTS
CTS 5 5 CTS
SG 7 9 SG
DSR 6 7 DSR
DTR 20 :| 8 DTR

Connecting to the Peripheral Port

Connect a peripheral interface cable (for IBM PC/AT or compatible) to the
peripheral port of the PLC, and connect the other end of the cable to a cable
connected to the modem. For details on peripheral interface cables, refer to 2-
2 Connecting to a PLC.

Create a connection cable. Peripheral interface cable (for

D——: ‘ iﬂi IBM PC/AT or compatible) ::D
- e
Modem PLC

| D-sub 25-pin (male) | | D-sub 9-pin (male)
Modem Programming Device

Connector hood FG ‘| |‘ Connector hood FG

FG 1 1 FG

SD 2 >< 2 SD

RD 3 3 RD

RTS 4 >< 4 RTS

CTS 5 5 CTS

SG 7 9 SG

DSR 6 :| 7 DSR

DTR 20 8 DTR
Settings for PLC Communications conditions settings for the PLC port to be connected to the
Connections Port modem are made on a PLC Programming Device (CX-Programmer or per-

sonal computer). After the settings have been made, direct online connection
is made between the Programming Device and the PLC, and the settings are
transferred.

As an example, the setting procedure for a CS/CJ-series PLC, using a CX-
Programmer, is shown below. For details, refer to the CX-Programmer Opera-
tion Manual.
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Connecting the Built-in Host Link Port to the Modem

Settings for the host link port are performed in the PLC Settings window of
the CX-Programmer, as shown below. Set the serial communications mode to
Host Link or ToolBus. With the CS/CJ Series, when making connections
with the toolbus, connections cannot be made via the modem using automatic
recognition of the baud rate. Connections must be made using the toolbus
settings in the PLC system settings.

Set pin 5 of the DIP switch on the front side of the CS/CJ-series CPU Unit to
OFF (to follow the PLC system settings) and set the serial communications
mode for the RS-232C port in the PLC Settings to ToolBus.

=2 PLC Settings - NewPLC1 M= E3
File  Options  Help

Select baud rate.

Set to a baud rate less :
PLC Startup | Settings || PLE | than the maximum baud jit Settings ~ Host Link Fort | Peripheral Part |
rate for the modem.

Cormmunication Settings Select ToolBUs or Host

aud Faormat Mode Link.

|00 7|72 =|[Hostiik =]

Start Code Ernd Code
Remove the checkmark to | Set to 7,2,E if in host link mode, and to

allow baud rate setting. [0v0000 = 8,1,N if in toolbus mode.

g These settings refer to the data length,
the number of stop bits and the parity
(E=even, N=none).

it Mumber [relay MT Link tax

0 _| _|:I “10 ms _|:|

C51H-CPUEY Oftlire:

Connecting the Peripheral Port to the Modem

Settings for the peripheral port are made in the PLC Settings window of the
CX-Programmer. The setting method is the same as for the host link port
above. Set the serial communications mode to Host Link or Toolbus. When
making connections with the toolbus for the CS/CJ Series, connections can-
not be made via the modem using automatic recognition of the baud rate.
Connections must be made using the toolbus settings in the PLC system set-
tings.

Set pin 4 of the DIP switch on the front side of the CS/CJ-series CPU Unit to
ON (to follow the PLC system settings) and set the serial communications
mode for the peripheral port in the PLC Settings to ToolBus.

Note With the C200HX/HG/HE, there is no automatic recognition function for the
baud rate.
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Connecting the PMSU (Ports 1, 2) to the Modem

Settings for the communications port of the PMSU are made in the I/O Table
window of the CX-Programmer. Set the serial communications mode to Host
Link.

It is also possible to make the settings for the PMSU communications port and
transfer them using the CX-Protocol. In Communications Port Settings
Edit, set the Mode in the Communications Port Settings dialog box of the
PMSU to Host link. For details refer to 10-6 PMSU Communications Port Set-
tings and 10-7 Transfer of Communications Port Setting Data to PLC.

Note Toolbus connection is not supported by the PMSU.

Transferring the Settings

After the communications conditions for the port have been set, transfer the
settings to the PLC. Make direct online connection to the PLC to be connected
to the modem and transfer the settings in the following way.

Using the CX-Programmer:
* In the PLC Settings window, select Options/Transfer to PLC.
* In the I/O Table window, select Options/Transfer to PLC.
Using the CX-Protocol:

* For details refer to 10-6 PMSU Communications Port Settings and 10-7
Transfer of Communications Port Setting Data to PLC.

10-4-3 Settings at the Personal Computer

Modem Settings This section explains how to make the settings for the modem to be con-
nected to the personal computer. As an example, the setting procedure for the
OMRON Modems (ME5614E, ME5614C) are given.

MES614E

1,2,3... 1. Connect the modem to COM1 or COM 2 of the personal computer using a
straight cable.

2. Turn ON the power supply for the personal computer.
Windows will recognize the modem and the Wizard will be displayed.

3. Make settings according to the instructions given by the Wizard.
On completion of the above, the modem can be used from the personal com-
puter.

MES5614C

1,2,3... 1. Insert the modem card in the PLC card slot.

2. Turn ON the power supply for the personal computer.
Windows will recognize the modem and the Wizard will be displayed.

3. Make settings according to the instructions given by the Wizard.

On completion of the above, the modem can be used from the personal com-
puter.
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Connecting the Personal Connect the personal computer (CX-Protocol) to the modem using the
Computer to the Modem modem’s RS-232C cable.

CX-Protocol Settings

1,2,3... 1. Display the Change PLC dialog box with the CX-Protocol.

2. Select SYSMAC WAY (host link) or Toolbus from the Network Type se-
lection box.

Change PLC =]

— Device Hame
|MewPLLT

— Device Type
IES1 H j Setftings... |

— Metwork, Tope
|SYSMAC wiky

— Comment

] Cancel | Help |

3. Left-click the Settings... button to the right of the Network Type selection
box. The Network Setting dialog box will be displayed.

4. Specify the PLC to be connected to in the Network tab.

* When making connections to a PLC that is connected directly to the
modem, set Network to “0” and Node to “0” (default settings).

* When making connections from a PLC directly connected to a tele-
phone to another PLC on the network, make the appropriate settings
for the network address and the node address. For details of network
communications, refer to 10-2 Communications Settings between Per-
sonal Computer and PLC.
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5. Left-click the Modem tab, and make settings for the modem driver, the
present address, and the destination telephone number.

Hetwork Settings [SYSMAL WAY]
Netwurkl Driver  Modem | lect the driver for the modem. Left-click here to dis-
play the dialog box re
— Modem ferred to in step 7.

IEIMFEEIN_MEEE1 4E_EEK_FM_Dﬁ.'ﬂ Configure. .. |/
Left-click here to dis-

— Current Location play the dialog box

IDMHDN j Canfigure... | = referred to in step 11.

— Connect To

Country Code: I-'EIF'EIFI [51) I

Area Code: IDEEE

Telephone Mumber: I??*i?'l 7

k., I Cancel Help

Use the following procedure to make settings for the modem and the
present address.

6. Left-click the Configure... button to the right of the Modem selection box.
The following screen, which is used to set the properties for the modem,
will be displayed.
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7. Left-click the General tab and set the baud rate for communications be-
tween the personal computer and the modem.

OMRON_MESG14E_56K_FAX DATA MODEM Pro._. |

General IEDnnectiDnl Dptiu:unsl

@ OMROMN_MESET4E_SEK_FAx_DATA MOD

Port; CORT

— Speaker volume |

. Set the baud rate for commu-

ofF — J— High nications between the personal
computer and the modem.

This setting should be the

same as that for the commu-
nications port of the PLC.

— M auirnum speed

| 3600 =1

[™ Only connect at thiz zpeed

] I Cancel |

8. Left-click the Connection tab and set the communications conditions.

DMRON_MESG14E_56K_FAX_DATA_MODEM Pro...

General Connection | I:Ipti-:unsl

— Connechion preferences |

[rata bits: I? j Communications conditions settings

7 bits, even, 2 stop bits

e For toolbus connections:.
Stop bits: |2 j 8 bits, no parity, 1 stop bit

. e For host link connections:
Bariby: IE'”"E” j

— Call preferences

[v it ait for dial tone before dialing

[T Cancel the call if not connected within IED IBCE

[T Disconnect a callif idle far more than |3D mir

Port Settings... | Advanced... |

]S I Cancel |
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Note These dialog boxes take priority in making the settings for the modem. The
settings made in the Driver tab of the Network Setting dialog box (see step 4
above) will be ignored if they are different.

9. Left-click the Advanced button.
The Advanced Connection Settings dialog box will be displayed.

10. Make settings for error control and flow control. Make the settings as fol-
lows.

e Use Error Control: Only select Compress data
e Use Flow Control: Select Hardware (RTS/CTS)

Advanced Connection Settings |

v |ze flow control

[ Required to connect % Hardware [RTS/CTS)

I Compress data ™ Software [{ONAOFF]

I} 0ze eeluler pratacsl

— M odulation type
I Standard j

— Extra zettings

[ FRecord a log file

| k., I Cancel

« After the settings have been made, double-click the OK button to re-
turn the Network Setting dialog box.
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11. From the Network Setting dialog box, left-click the Configure... button to
the right of the Current Location selection box.
The Dialing properties dialog box, shown below, will be displayed.

Dialing Properties

by Locations l

Where | am:

| am dialing from: ~ [AMRON ] hew. | |
The area code iz (0554

| an in: |Japan [81] ﬂ

Haowa | dial from thiz location;

To access an outzide ine, first dial: |_ for local, |_ for lang distance.

[ Dial wzsing Calling Card:

[ iThiz location has call waiting. To dizable it, dial; | J

The phone spstern at thiz location uees; & Tone disling © Pulze disling

0k, | Cancel

12. Set the information for the modem to be connected to the CX-Protocol.
Make the appropriate settings for the types of modem and telephone line.

On completion of the above, the settings for the personal computer are made.

10-4-4 Online Connection

When online connection operations are performed from the CX-Protocol,
autodial will be executed, and connection to the remote PLC will be made via
the modem.

10-5 1/0O Table Creation

When mounting the CS/CJ-series Serial Communications Unit to the Back-
plane for the first time, use the following procedure to create an /O table.

10-5-1 1/0O Table

Note When the Serial Communications Unit is mounted to the PLC for the first time
and the CPU Unit is turned ON, the ERR/ALM indicator of the CPU Unit will
flash. When online connections are established, an error log window will be
displayed. Ignore the PLC Errors window and use the following procedure to
create an I/O table.

When the I/O table is created, the ERR/ALM indicator will turn OFF. Close the
PLC Errors window.
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1,2,3... 1. Connect the personal computer to the PLC for online communications.
2. Setthe PLC to PROGRAM mode.
D 3. Right-click the PLC icon and select I/O table from the pop-up menu.

T 1 PLC 1D Table

File Options  Help

1 JCS1G-CPU45S
-, [0000] Main Rack
(-, [0000] Rack 01
-, [0000] Rack 02
-, [0000] Rack 03
(-4 [0000] Rack 04
-, [0000] Rack 05
-, [0000] Rack 06
[+, [0000] Rack 07

4. Select Create from the Option menu.

For details of I/O table functions, refer to CX-Programmer Operation Man-
ual.

10-6 PMSU Communications Port Settings

Use the following procedure for the PMSU communications port settings.

D 1,2,3... 1. Double-click the PLC icon in the project workspace (left pane).

i EXAMPLE1 psw

* Inner Board Type
ll#= SCE (Mot Fitted)

Serial Gommunications Unit Type
SGU 0] CE1W - SCU21
Mo Unit [1]
Mo Unit [2]
Mo Unit [3]
Mo Unit [4]
Mo Unit [5]
Mo Unit [6]
Mo Unit [7]

e e e He s H e R Y
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PMSU Communications Port Setting_;s Section 10-6

2. In the project window (right pane), double-click the PMSU icon for which
L the communications port settings are to be made. Alternatively, left-click
the PMSU icon in the project workspace (left pane).

Trace 1

Trace 2

Communications Port 1

ID Communications Port 2

3. Double-click the Communications Port icon, or right-click the Communi-
E[ﬁ" cations Port icon and select Edit Communications Port Settings from
the pop-up menu. Alternatively, left-click the Communications Port icon
and select Edit Communications Port Settings from the PLC menu. The
Communications Port Settings dialog box will be displayed with Port
1/2 ifthe CS/CJis used and Port A/B if the C200HX/HG/HE is used. These
dialog boxes are the same in appearance.

Cammunications Port Settings

—

Half Duple:x |_

200

[C| E15 Eqskle

Jesco -]
[ 6its -]

—
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4. Setthe Communication Method field to Protocol Macro.

5. If the standard communications conditions are used, leave the Standard
Comms Format check box in the Communication field as is.

If the communications conditions are changed, turn OFF the check mark
of the check box and set the baud rate, data length, parity, and number of
stop bits.

6. Left-click the OK button to enter the settings. Left-click the Cancel button
to leave the settings unchanged.

Note If the PLC is CS/CJ and the Communication Method field is set to Protocol
Macro, a communications baud rate higher than that designated by the proto-
col macro specifications (38,400 bps max.) can be set. However, if this setting
is actually made, a PLC Setup error will occur, and the CS/CJ will operate at
the default baud rate of 9,600 bps.

10-7 Transfer of Communications Port Setting Data to PLC
10-7-1 Transfer of Communications Port Setting Data to PLC

Use the following procedure to transfer the data on the communications port
settings in the PMSU to the PLC.

1,2,3... 1. Connect the personal computer to the PLC for online communications.
2. Setthe PLC to PROGRAM mode.

3. Left-click the PMSU icon for the corresponding communications port or
left-click the desired Communications Port icon. If a PMSU icon is select-
ed, data on the settings of both communications ports will be transferred.
If a Communications Port icon is selected, the settings for that commu-
nications port will be transferred.

4. Left-click the Download Communications Port Setting icon from the

Ii‘ toolbar, or right-click and select Download Communications Port Set-
ting from the pop-up menu. Alternatively, select Download Communica-
tions Port Setting from the PLC menu after selecting the desired
communications port.

5. On completion of the transfer, the message Communications port set-
ting download completed will be displayed. Left-click the OK button.

&Caution Confirm that no adverse effect will occur in the system before changing the
operating mode of the CPU Unit. Not doing so may result in an unexpected
operation.

&Caution Confirm that no adverse effect will occur in the system before transferring the
communications port A/B settings to the Protocol Macro Support Unit
(PMSU). Not doing so may result in an unexpected operation.

10-7-2 Reading Communications Port Setting Data from PLC

Use the following procedure to read the data on the communications port set-
tings in the PMSU from the PLC.

1,2,3... 1. Connect the personal computer to the PLC for online communications.
2. Setthe PLC to PROGRAM mode.
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3. Left-click the PMSU icon for the corresponding communications port or
left-click the desired communications port. If a PMSU icon is selected, data
on the settings of both communications ports will be read. If a communica-
tions port is selected, the settings in the corresponding communications
port will be read.

4. Left-click the Upload Communications Port Setting icon from the tool-
‘?ﬁi bar, or right-click and select Upload Communications Port Setting from
the pop-up menu. Alternatively, select Upload Communications Port

Setting from the PLC menu after selecting the communications port.

5. On completion of the transfer, the message Communications port set-
tings upload completed. will be displayed. Left-click the OK button.

Note Use the above procedures to read and write data from and to the following
areas of the CPU Unit.

« CS/CJ
Board: D32000 to D32009 (port 1) and D32010 to D32019 (port 2)
Unit mtom + 9 (port1) and m+ 10 to m + 19 (port 2)
[m =D 30000 + 100 x Unit No.] (Unit No. O to F (15))

* C200HX/HG/HE
PLC Setup data in DM 6550 to DM 6654 (port B) and DM 6555 to DM
6559 (port A)
Data can be read and written from and to the above areas with a Pro-
gramming Device of the PLC or the PLC memory window of CX-Protocol.
Refer to 12-2 Outline of PLC Memory Window for details.
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SECTION 11
Protocol Data Transferring and Printing

This section describes details of the transferring, converting, and printing of protocol data.

11-1 Transferring and Reading Protocol Data between the Computer and PM SU 292
11-1-1 Transferring Data from the Computer tothePMSU ............ 292
11-1-2 Displaying Protocol DatawithinthePMSU .................. 293
11-1-3 Transferring Protocol Data from the PMSU to the Computer . . . .. 294

11-2 Printing Protocols. . ... ..o 296
11-2-1 SettingthePrinter. .. ... 296
11-2-2 PrintingaProtocol . .......... .. 296

11-3 Importing Protocol Datafrom PST/PSSFiles. ....................... 297

11-4 CS/CJIProtocol and o Protocol . ... 299
11-4-1 DownloadingtheProtocol . ...............coiiiiiiin.. 299
11-4-2 Convertingthel/OMemory Area . ..., 299
11-4-3 Converting o Protocol into CS/CI Protocol. .. ................ 300
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Transferring and Reading Protocol Data between the Computer and PM SU Section 11-1

11-1 Transferring and Reading Protocol Data between the
Computer and PMSU
11-1-1 Transferring Data from the Computer to the PMSU
&Caution Confirm safety at the destination node before transferring a protocol to
another node or editing the 1/O area. Doing either of these without confirming
safety may result in injury.
&Caution Confirm that no adverse effect will occur in the system before changing the
operating mode of the CPU Unit. Not doing so may result in an unexpected

operation.

&Caution Check the user protocol for proper execution before actually running it in the
Unit. Not checking the protocol may result in an unexpected operation.

Use the following procedure to download protocols to the PMSU from the

computer.
1,2,3... 1. Connect to the PLC online and set the PLC operating mode to Program
mode.

2. Double-click the Protocol List icon in the project workspace (left pane) to
list the protocols in the project window (right pane).

3. Select a protocol to download. More than one protocol can be selected by

o pressing the Shift Key and selecting another protocol to extend the selec-

) tion or by pressing the Ctrl Key and selecting another protocol to add to
the selection.

s
L
-,
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Transferring and Reading Protocol Data between the Computer and PM SU Section 11-1

Download Protocol icon on the toolbar.
The Protocol Compile/Download dialog box will be displayed.

Note Transfer a protocol to the PMSU only after selecting a protocol.

‘il 4. Select Download Protocols from the Protocol menu or left-click the

Frotocol Compile & Download E |
m Frotocol password protection Close
™ Password
Confirm

[T Include Source Information

Cornpile | St Dnmpilerl | B el =r=le | Stop DAL |
Target | Compiled % | Downloaded % |
1 scu (o] 000% 000,

5. Prior to download, a password can be applied to protect the protocol. Se-
lect the Protocol password protection check box to enable password
protection. Enter a password in the Password field (up to eight charac-
ters). Enter the password in the Confirm field.

6. When adding a source code, select Include Source Information. If the
source code is not to be added, the amount of data transferred to the
PMSU will be small, but the protocol data that is read to the personal com-
puter when performing read (PLC to computer) will vary. Refer to 11-1-3
Transferring Protocol Data from the PMSU to the Computer.

7. Left-click the Compile button. Errors or alarms that occurred during com-
piling will be displayed in the output window (bottom left of the screen).

8. When the compile is normally completed, the Download button will be-
come active. Left-click this button. Transfer status will be displayed on the
indicator. Press the Download Cancel button to stop transfer processing.

9. When the transfer is completed, the message Download Completed OK
will be displayed. Left-click the OK button.

10. Close the Protocol Compile/Download dialog box.

11-1-2 Displaying Protocol Data within the PMSU
Use the following procedure to display protocol data within the PMSU.

1,2,3... 1. Connect to the PLC online.
anm| 2. Double-click the PLC icon.
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Transferring and Reading Protocol Data between the Computer and PM SU Section 11-1

3. Left-click the PMSU icon in the project workspace (left pane) or in the
project window (right pane), and then right-click to display a pop-up menu.
Select Upload Protocol List from the pop-up menu.

Ei EXAMPLEA psw
* Trace Status
{Trace 1 | Mot Tracing
i Trace 2 Mot Tracing
¥| Communications Port Tvpe
ﬁ@r Communications Port 1 RE2520
HE Comrmunications Port 2 RE2520
1'fl Protocol Hame Start Sequence | End Sequence Type Source | Timestamp
@ Sequence Step Edit 13 650 G99 USER Ma TL2598 11:45:07 Ak

The trace, communications port, and protocol list will be displayed in the
Project Window.

11-1-3 Transferring Protocol Data from the PMSU to the Computer

Use the following procedure to upload protocol data to the computer from the
PMSU.

1,2,3... 1. Connect to the PLC online.
2. Double-click the PLC icon.

3. Left-click the PMSU icon in the project workspace (left pane) or in the

project window (right pane) and then right-click to display a pop-up menu.

a7 Alternatively, select Upload Protocol from the pop-up menu or left-click
the Upload Protocol icon.

If protocol data is transferred with the password protection, input a pass-
word prior to uploading protocol data.

A message indicating that protocol data is being transferred and the
progress will be displayed on the status bar.

When transfer is completed, the message Decompiler Compiled OK will
be displayed. Left-click the OK button.
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Section 11-1

The transferred protocol data will be displayed in the project workspace
(left pane) with date and time of the transfer displayed after Uploaded Pro-

tocols.

::
g

EXAMPLE pow

~#5 BEX¥ Protocol List

E-@ TEMP COMM
-2 Temp comm Seguence
----- H mend Message List
----- H Feceive Message List
=B Matrix List
..... Ty MEItr'iI
31 BE¥1 Protocol List
f- @ Controller (E5_K read)

Trace List

Uploaded Protocols 1113598 7:56:35 P

MewPLC1 [Program] [C51G - CPU45]

Note If the source code is not attached to the protocol data and the data format of
each message item is set to the constant control code/ASCII format, that por-

tion will be displayed as follows:

Item

With source code

Without source code

Protocol name

Same as when transferring
from computer to PLC.

Same as when transferring from
computer to PLC.

Sequence name

Same as when transferring
from computer to PLC.

Allocated automatically.
(NewSequence 1,
NewSequence 2, etc.)

Send message
name

Same as when transferring
from computer to PLC.

Allocated automatically.
(SD(0)_1, SD(1)_1, etc.)

Receive message
name

Same as when transferring
from computer to PLC.

Allocated automatically.
(RV(2)_1, RV(3)_1, etc.)

Matrix name

Same as when transferring
from computer to PLC.

Allocated automatically.
(Matrix, Matrix 1 etc.)

Constraint
attributes in the
message

Same as when transferring
from computer to PLC.

Allocated automatically.

Note 00 Hexadecimal to 1F Hexadecimal (Control Code)

Example:

00 Hexadecimal to NUL
1F Hexadecimal to US

20 Hexadecimal to 7E Hexadecimal (ASCIl Format)

Example:

H@H to H@H
[31] to "1"

7F Hexadecimal (Control Code)

Example:

[7F] to DEL
DEL to DEL
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Printing Protocols Section 11-2

80 Hexadecimal to FF Hexadecimal (Hexadecimal Format)
Example:

[80] to [80]

[FF] to [80]

11-2 Printing Protocols

Each protocol can be printed with the following contents.

1,2,3... 1. Sequence number, sequence name, each sequence settings.
2. Settings of all the steps (in table format)
3. Send/receive message name and message settings.
4. Matrix name and contents of the matrix case.

11-2-1 Setting the Printer

Set the printer settings using the Print Setup dialog box. With the CX-Proto-
col, use the following procedure.
1,2,3... 1. Select Print Setup from the File menu.

2. The Print Setup dialog box will be displayed. Select a printer from the
Name drop-down list. Use the Properties button to set the printer.

Select a paper size from the Paper drop-down list in the Base field.
Select a paper feed method from the Paper Source drop-down list.
Select either Port or Land in the Paper field.

Left-click the OK button to confirm the settings or the Cancel button to
leave the settings unchanged.

For further details about the printer settings, refer to the instruction manual of
the printer.

11-2-2 Printing a Protocol

Use the following procedure to print a protocol.

o0k w

1,2,3... 1. Double-click the Protocol List icon to list the protocols in the project win-
dow (right pane).

2. Select a protocol to print. More than one protocol can be selected for print-
ing by pressing the Shift Key and selecting another protocol to extend the
selection or by pressing the Ctrl Key and selecting another protocol to add
to the selection.

3. Printout images of protocols can be previewed by right-clicking and select-
ing Print, then Print Preview from the pop-up menu. The preview window
will be displayed and the desired protocol can be previewed. The selection
can also be made from the File menu. The following functions are avail-
able.

* Press the Next Page button or Prev Page button to navigate through
the pages of the print-out.

* Press the Two Page button to view two pages of the print-out at once.
This button will then change to the One Page button to revert back.

* Press the Zoom In button and the Zoom Out button to zoom in and
out of the print-out.

 Press the Close button to close the dialog box.

 Press the Print button from the toolbar to display the Print dialog box.

After designating the printer name, printing range, number of copies, left-
click the OK button to print the data.
4. Alternatively, right-click to display a pop-up menu and select Print from the
f@j Print menu or left-click the Print icon on the toolbar. Print can also be se-
lected from the File menu.
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Section 11-3

5. The Print dialog box will be displayed. Set the printer name, printing range,
and number of copies. Press the OK button to print the data.

6. Printing will start.
Printout example of protocol data is as shown below.

Protocol: Hayes modem AT commands [ Comm Seguences ]

Comm sequence Mo 570 Conm seguence name: Modem intialize (MO 44FB5Y

Link weards: IMarest: — Macldr: - Iriend: - OUTareal: - QUTacdr: — QUTlent -
IMaresZ: — Macldr2: --- IMlen: --- OUTareaz: --- QUTacdr2: - QUTlen2 ---
Control psrameter: RTSICTS Contraol: Receive HOMMOSF Control: - hodem contral: Yes
Delimiter:  Send code: ----------—- Receive coder —----—-—---
Contertion:  Send request Code: -----em----
Recy wal time: 1U ses Recy frish time: --- Send timsh time: - Response method: Scan
Mo, |Repest Comman Retry [Senchiait | Send Messsge Receive Message Rsp [Mext Errar
a0 (RSE™001 Send & Receive | 0 - MO 44FBSY =Initisl-F1= Mo [Matriz  |Goto 1
0 |RSE™001 Send & Receive | 0 1 zec  |MD144FBSY =Initizl-F2= Mo [Matriz  |Goto 2
02 |RSE™001 Send & Receive [ 0 1 zec  |MOD44FBSY =Initizl-F3= Mo [Matriz | Akort
Comm sequence Mo 571 Conm seguence name: Did (MO 44FB53Y)
Link weords: IMarest: — Macldr: --- Mt --- OUTareal: --- OUTacdr: - QUTlent ---
IMareaz: — Maddr2: --- IMienz: --- OUTareaz: --- OUTacdr2: --- OUTlen2 ---
Control psrameter: RTSICTS Contraol: Receive HOMMOTF Control: - hodem contral: Yes
Celiniler.  Serd cude, —---mmmeee- Reueive cude, ——-oeemeee
Contertion:  Send request code; —--—-------
Recy vweail time: 90 ez Recy finish time: --- Send finish time: --- Rezponse method: Scan
Mo, |Repeat Command Retry |SendvVait | Send Messsge Receive Message Rsp |Mext Errar
00 (RSE™O01 Send & Receive | 0 -—- Dail (5) =m0 44FB-F1= Mo [hatriz  |Goto 1
01 |RSE™001 Send & Receive | O 90 zec |Dail (2) =m0 44FB-F2= Mo |Matriz  |Goto 2
02 [RSE™AM Send & Receive | 0 90 zec |Dail (S =MD 44FB-R 3= Mo |Matriz | Short

Note Message data may extend beyond the printing frame depending on its length.
If this happens, select Print Setup from the File menu and change the print-
ing setting to landscape or change the printer type.

11-3 Importing Protocol Data from PST/PSS Files

With the CX-Protocol, SYSMAC-PST and PSS (DOS version) file data can be
imported. However, the imported PSS files cannot be edited with the CX-Pro-
tocol. Copy the data into the project and then edit the data. (Copying is only
possible for PST project files and PSS protocol files.)

The following files can be imported.

Type of PSS files Description File extension
PST project files SYSMAC-PST projects *.psw
PSS system setting files PMSU communications *.pts
port (A, B) setting data
PSS protocol files Only PSS protocol data * ptl
PSS trace data files Only PSS or SYSMAC- *.ptr
PST trace data

Use the following procedure to import a SYSMAC-PST project file.

1. Select Open from the File menu or left-click the Open icon on the toolbar.
Alternatively, the file can be opened by pressing the Ctrl+O Keys.

2. The Open dialog box will be displayed.
Select a SYSMAC-PST project file from the list in the Open dialog box.

3. Left-click the Open button or double left-click the selected project to con-
vert the SYSMAC-PST project file into one that can be edited with the CX-
Protocol. The message, Convert old file will be displayed. Left-click the
OK button.

1,2,3...

=4
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4. |If there is no setting for PLC model in the SYSMAC-PST project file to be
imported, set applicable PLC model and communications settings. Left-
click the OK button. The data can be edited with the CX-Protocol. The pro-
tocol attribute will change to “a.” Refer to 11-4 CS/CJ Protocol and a Pro-
tocol for protocol attributes.

Note When Save is left-clicked to save the imported file, it will be saved as a CX-
Protocol file. Once it is saved, the file cannot be read with the SYSMAC-PST.
Therefore, if the file needs to be saved as a SYSMAC-PST file, select Save
As and enter a different name.

When Save is selected, a confirmation dialog box will be displayed. Left-click
the OK button if the data can be overwritten.

Use the following procedure to import data from a PSS file.

- 1,2,3... 1. Select Open from the File menu or left-click the Open icon on the toolbar.
E‘"i Alternatively, the file can be opened by pressing the Ctrl+O Keys.

2. The Open dialog box will be displayed.

Select a file type from the Type of File drop-down list box.

3. Select a PSS file from the list in the Open dialog box. The current folder
can be modified by selecting another folder from the Look in drop-down
list.

4. Left-click the Open button or double-click the selected file to open the file.
The contents of the PSS file will be displayed in the project window (right

pane).
:j ¥s3961223. ptl B E i
% Protocol List Protocols

Note 1. This data cannot be edited with the CX-Protocol. Copy it once and paste it
into another project window to edit the data.

2. The data imported from the PSS system setting file cannot be copied to
the communications port for the CX-Protocol.
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Section 11-4

11-4 CS/CJ Protocol and a Protocol

The protocol macro for the CS/CJ-series PLCs is called the “CS/CJ Protocol”
and the protocol macro for the C200HX/HG/HE PLCs is called the “a Proto-
col.” With the CX-Protocol, the o Protocol created with the SYSMAC-PST can
be downloaded to a CS/CJ PMSU so that it can be used with the CS/CJ. In
this case, the 1/O memory area will be converted to one for the CS-series. In
the same manner, the CS-series Protocol can be downloaded so that it can be
used with a C200HX/HG/HE PSB.

With the CX-Protocol, either the CS/CJ Protocol or o Protocol can be selected
when creating a new project file.

Since the commands and I/O memory area designation are different between
the CS/CJ Protocol and o Protocol, observe the following precautions when
downloading the protocol.

The standard system protocol of the CX-Protocol is provided with the CS/CJ
Protocol.

11-4-1 Downloading the Protocol

Transferring a Protocol
to CS/CJ (CS/CJ Protocol)
PMSU

Transferring CS/CJ
Protocol to
C200HX/HG/HE PMSU

The o Protocol can be transferred to the Serial Communications Board/Unit
for CS/CJ by setting the PLC model to the CS/CJ Series, and setting the tar-
get for the protocol to the CS/CJ Serial Communications Board/Unit.

The 1/0 memory area will be converted to one for the CS/CJ. Refer to the fol-
lowing section for further details about conversion.

If o Protocol is used as CS/CJ Protocol, there will be limitations in the use of
EM (expanded data memory). It is recommended that CS/CJ Protocol be
used from the start.

The CS/CJ Protocol can be transferred to the Communications Board for
C200HX/HG/HE by setting the PLC model to the C200HX/HG/HE, and setting
the target for the protocol to the Communications Board.

The 1/0O memory area will be converted to one for the C200HX/HG/HE. Refer
to the following section for further details about conversion.

If CS/CJ Protocol is used as o Protocol, there will be limitations in the use of
commands and I/O memory area. It is recommended that o Protocol be used
from the start.

11-4-2 Converting the /O Memory Area

The 1/0O memory area will be converted as shown below when the CS/CJ Pro-
tocol is converted into the o Protocol or vice versa.

CS/CJ Protocol

o Protocol

H (Holding relay)

HR (Holding relay)

W (Internal auxiliary relay)

LR (Link relay)

A (Special auxiliary relay)

AR (Auxiliary memory relay)

D (Data memory)

DM (Data memory)

E (Expanded data memory)

EM (Expanded data memory)

When converting the CS/CJ Protocol into the o Protocol, the commands
(Wait, Flush, Open, or Close) and the check codes (LRC2, SUM1 (1 byte/2
bytes)) used exclusively for the CS/CJ Protocol will cause errors during com-
pilation. Therefore, create a protocol without using them.

If the I/O memory area extends beyond that for the C200HX/HG/HE, an error
will occur. If so, correct the protocol.
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11-4-3 Converting a Protocol into CS/CJ Protocol

Download the o Protocol with source code to the CS/CJ PMSU and upload
the protocol to change its attributes to those for the CS/CJ Protocol.

CX-Protocol
Download Protocol — PMSU
; with source code.
D\
Upload to change to the CS/CJ Protocol! I CPU Unit
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SECTION 12
Tracing and Monitoring

This section describes details of PLC memory area monitoring and the transmission line tracing.
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12-1-1 TracingMethod .. ... 303
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12-1 Tracing Transmission Lines

Transmission or reception data and signals of a maximum of 670 characters
that the Board or Unit exchanges with external devices can be traced if the
PLC is the C200HX/HG/HE. Transmission or reception data and signals of a
maximum of 1,700 characters can be traced if the PLC is the CS/CJ.

By tracing the transmission or reception data and signals, the contents of
each message transmitted or received per step can be checked and com-
pared with the preset sequence. The results of tracing can be saved as data
in project files or printed.

The following types of data can be traced.

Data type

Display

Send message

Character strings

Send and receive messages

Hexadecimal data

of a maximum of 670

Receive message

Character strings

characters (with
C200HX/HG/HE) and a

Hexadecimal data

maximum of 1,700 characters
(with CS/CJ)

Sequence No.

0 to 999 (CS/CJ only)

Oto 15
ON/OFF transitions of RTS, CTS, DTR, and DSR signals
Parity error (P), framing error (F), and overrun error (O)

Step No.
Control signal

Communications
error (CS/CJ only)

CS/CJ Tracing Screen

%8 Dust_ul
Trace Mumber 2 2 2 2 2 2 2 2 2 2 2 2 2 2 2 2 2
Send Message @ 0 0 R L 4 7 * .
(HE 40 a0 30 52 55 34 37 28 0D
Receive Messagze ? . - i . . - 0]
THED 3F 06 26 2F 0D 0f 26 4F
Seguence Mumber | 338 338 338 338 338 338 338 338 338 338 338 338 338 338 338 338 336
step Mumber 0 0 0 0 0 0 0 0 0 0 0 u} 0 0 0 0 0
RTS [
CTS |
OTR
DSR
Cornm. Error F =3 F PF = FF
| | [
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C200HX/HG/HE Tracing Screen

Sand Message ] 0 2
[HE=] 0 3 32 B

Receiva Mezszge
[HEX]

Step Mumbe I} i 1}

@0 2 R ® 0 0o C 2 k] 1 4
a0 031 3@ B2 82 W oowW 30 W3 WA M
a I a il o o o1 1 1 1 1 1 1 1 1 1 1 1

RTS

LTS

DTR

DSR

Note

» Transmission or reception data and signals are traced from left to right
starting from the leftmost point.

» The figures at the top row represent 10-byte units.

* The send message is shown above and the receive message below. Both
send and receive messages are in ASCII statements followed by hexa-
decimal data.

* The step number is displayed. If the PLC is the C200HX/HG/HE, the letter
“e” or “f” will be displayed in the step number.

* The RTS, CTS, DTR, and DSR signals are indicated in red above the dot-
ted baseline and in blue below the dotted baseline.

* In addition to the above tracing items, the trace number, execution
sequence number, and communications error will be displayed if the PLC
is the CS/CJ. The trace number changes with the change of the sequence
number.

If a communications error occurs, the screen will display the letter “P,” “F,”
or“0.

1. The ON or OFF state of the control signal is not sampled correctly. Use the
state result for reference only.

The sampling of the ON or OFF states of the RTS, CTS, DTR, and DSR
signals starts when the transmission or reception of a single character of
data has been completed. Changes in signals without transmission or re-
ception data or changes in signals while a single character is being trans-
mitted or received are not sampled.

The ON or OFF state of the CTS or DSR signal may differ depending on
whether the transmission has been completed or not.

2. Provided that the PLC is the CS/CJ, the screen will display “---" as both the
sequence number and step number when a message is received before
the execution of the sequence.

3. If the PLC model is the CS/CJ, the displayed position of the sequence or
step number may shift forward or backwards or “---" may be displayed in-
stead when transmission and reception data and signals are traced at a
baud rate of 19,200 bps or higher. This is due to the data collection perfor-
mance of the tracing function.

12-1-1 Tracing Method

Continuous Traces

The following two tracing methods are available.

The trace is executed until stopped. When the PMSU trace buffer becomes
full during tracing, data will be discarded starting from the oldest data.
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One-shot Traces The trace is terminated when the trace buffer becomes full. The entire trace

data from the start of trace remains in the PMSU trace buffer.

12-1-2 Trace-related Bits

Trace-related flags are listed in the following table.
n = 1500 + 25 x Unit No. (words)

CSs/CJ
Flag Port Effective address State

Continuous Port 1 190001 The continuous trace starts on the rising edge and the trace is
Trade Start/Stop Word n bit 01 terminated on the falling edge.
Bit Port 2 190009 This bit is invalid during one-shot traces.

Word n bit 09
One-shot Trace |Port 1 190002 The one-shot trace starts on the rising edge and is terminated
Start/Stop Bit Word n bit 02 on the falling edge. This bit is invalid during continuous traces.

Port 2 190010

Word n bit 10
Trace Execu- Port 1 190912 ON: Continuous or one-shot trace being executed.
tion/Completion Word n+9 bit 12 OFF: One-shot trace is stopped by a full buffer when One-shot
Flag Port 2 191912 Trace Start/Stop Bit is still ON.

Word n+19 bit 12
C200HX/HG/HE

Flag Port Effective address State

Continuous Port A 28902 The continuous trace starts on the rising edge and the trace is
Trade Start/Stop terminated on the falling edge.
Bit Port B 28903 This bit is invalid during one-shot traces.
One-shot Trace |Port A 28904 The one-shot trace starts on the rising edge and is terminated
Start/Stop Bit Port B 28905 on the falling edge. This bit is invalid during continuous traces.
Trace Execu- Port A 28600 ON: Continuous or one-shot trace being executed.
tion/Completion OFF: One-shot trace is stopped by a full buffer when One-shot
Flag Port B 28601 Trace Start/Stop Bit is still ON.

12-1-3 Starting and Stopping a Trace

Use the following procedure to start and stop a trace.

1,2,3... 1. Connect the PLC for online communications and set the PLC to Monitor
mode.
) 2. Double-click the PLC icon.

3. Either left-click the PMSU icon of the communications port to be traced in
the project workspace (left pane) or double-click the PMSU icon in the
project window (right pane).

4. Left-click the Trace 1 or Trace 2 for the CS/CJ and Trace A or Trace B for
the C200HX/HG/HE to select a desired item. Right-click to display a pop-
up menu and point to Start Trace and select Continuous Trace or One-
shot Trace from the submenu. Alternatively, left-click the Start Continu-
ous Trace icon or Start One-shot Trace icon on the toolbar. It can also be
selected from the PLC menu.

Tracing conditions of the Communications Board will be displayed on the
Status field. Once the trace is started, Performing Continuous Trace or
Performing One-shot Trace will be displayed. When the trace is stopped,
Trace Stop will be displayed.

5. To stop tracing, left-click the Trace 1 or Trace 2 for the CS/CJ and Trace
A or Trace B for the C200HX/HG/HE to select a desired item. Right-click
to display a pop-up menu and select Stop Trace from the pop-up menu.
Alternatively, left-click the Stop Trace icon on the toolbar. It can also be se-
lected from the PLC menu.

g =
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12-1-4 Reading Trace Data from PMSU

The trade data in the buffer of the PMSU can be uploaded to the project by
using the following procedure.

1,2,3... 1. Connect the PLC for online communications and set the PLC to Monitor
mode or Program mode.
2. Double-click the PLC icon.
3. Left-click the PMSU icon for the communications port to be traced in the

project workspace (i.e., the left pane of the window) or double-click the
PMSU icon in the project window (i.e., the right pane).

4. Left-click and select the Trace 1 or Trace 2 icon if the PLC is the CS/CJ or

Trace A or Trace B icon if the PLC is the C200HX/HG/HE. Right-click and

select Trace transfer (PLC to personal computer) from the pop-up

:J menu. Alternatively, left-click the Trace transfer (PLC to personal com-
i puter) from the toolbar or select the same item from the PLC menu.

The selected trace data will be displayed. Use the scroll bar on the bottom
of the window in order to scroll the trace data left and right.

12-1-5 Adding and Saving Trace Data to Project File

An uploaded trace can be added to and saved as part of a project by using the
following procedure.

1,2,3... 1. Upload the trace from the PMSU as described in 12-1-4 Reading Trace
Data from PMSU.

2. The trace will be displayed and automatically added to the project.
3. Select Save or Save As from the File menu and save it as project file

(*.psw).
Use the following procedure to add information to the properties of the trace.
1,2,3... 1. Right-click in the field where the trace is displayed. Select Properties from

the pop-up menu. The Trace Properties dialog box be displayed.

2. Input the information on the trace and left-click the OK button. Left-click the
Cancel button to close the dialog box without saving the information.

12-1-6 Retrieving Trace Data
Trace data can be retrieved from project files or from trace data files.

Retrieving Trace Data from Trace List of Project
Use the following procedure to to retrieve trace data from the trace list in a
project file.
1,2,3... 1. Left-click the Project icon to show the trace list.
2. Left-click the Trace List icon.
3. Double-click the desired trace within the trace list.

Retrieving Existing PSS Trace Data Files
Use the following procedure to open an existing PSS trace data file. The trace
data retrieved from the file cannot be added to projects.
1,2,3... 1. Select Open from the File menu or click on the Open icon from the toolbar.

2. The Open dialog box will be displayed.
Check that the Files of type field is preset to PSSDOS Trace Files (*.ptr).
The current folder can be changed by selecting another folder from the
Look in drop-down list.

3. Left-click the Open button or double-click the selected trace data file to
open the trace. In order to close the Open dialog box without the trace data
file opened, left-click the Cancel button.
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12-1-7 Printing Trace Data
Traces can be printed directly from the CX-Protocol. Use the following proce-
dure to print a trace.
1,2,3... 1. Double-click the Trace List icon to list the traces in the project window (i.e.,
the right pane).
2. Double-click on a trace to display it.

3. If desired, the trace can be previewed by selecting Print Preview from the
File menu. The preview window will be displayed.

* Select the Next Page button or Prev Page button to navigate through
the pages of the printout.

* Select the Two Page button to view two pages of the printout at once.
This button will change to the One Page button to revert back.

* Select the Zoom In button or Zoom Out button to zoom the printout
image in or out.

« Select the Close button to close the dialog box.

« The Print dialog box will be displayed by selecting the Print button.
Designate the printer name, print range, and number of copies and
left-click the OK button to print the trace.

%i 4. Select Print from the File menu or left-click the Print icon from the toolbar.

5. The Print dialog box will be displayed. Designate the printer name, print
range, and number of copies and left-click the OK button to print the trace.

6. The printing of the trace will start. The following is an example printout of
a trace.

Marnr Aftergper? pewe Deaeciptioe 20RT-A

Send wlassace i} 4 .
{HEXi GG T G . S | =~ 1D o J

Hecewe Messzne v} L u ] 1 | ) .
(HEX] 0 30 0 47 8 54 42 4 43 24 0D
1

Step Marbe 0 0 0 0 0 a 1 1 1 1 1 1 1 1 1 0 0
RTS

CTs
DTR

12-2 Outline of PLC Memory Window
12-2-1 PLC Memory Window and PLC Data Table

The PLC memory window is used for displaying and editing /O memory data,
such as bit, timer/counter, and DM data.

The table-type window called the PLC data table, which has a list of data clas-
sified according to I/O memory area, will be displayed in the PLC memory
window.

If the PLC is connected online, the I/O memory data of the PLC can be moni-
tored. Furthermore, I/O memory data edited in the PLC memory window can
be transferred to the PLC. The Board and Unit system settings can be per-
formed and the data can be transferred to the PLC.

Note 1. Do not monitor EM area used for file memory. If monitoring is performed
for this area, it will become impossible to display any present values.
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2. Each1/O memory area varies with the PLC or CPU model. For details, refer
to the Operation Manual of the PLC in use.

3. Alll/O memory data that can be transferred varies with the PLC mode. For
details, refer to 12-5 1/O Memory Transfer and Comparison.

12-2-2 Main Functions

The I/O memory window has the following main functions.
* I/0O memory display
* I/O memory editing
* [/O memory monitor
* I/O memory data transfer (personal computer to PLC and vice versa)
* I/O memory data comparison

12-2-3 List of Areas

The following table shows a list of I/O memory areas that can be displayed or
edited in the PLC memory window. The abbreviations in the table are used in
the PLC memory window.

Ccs/CJ C200HX/HG/HE
CIO: I/O Area, Work Area, Data Link IR: 1/0 Area and AR Area
Area, CPU Bus Area, Special I/O Unit
Area, Inner Board Area, SYSMAC BUS
Area, I/O Link Area, C200H Special I/O
Unit Area, and CompoBus/D Area
A: Auxiliary Area AR: AR Area
T: Timer Area LR: LR Area
C: Counter Area HR: HR Area
IR: IR Area TC: Timer/Counter Area
DR: DR Area DM: DM Area
D: DM Area EM: EM Area
TK: Task Flat Area
H: HR Area
W: Work Area
E: EM Area

Note The above areas are listed in the order of display in the data area workspace
located in the I/O memory window. All I/O memory areas displayed vary with
the PLC model or CPU model.

12-2-4 Starting and Quitting PLC Memory Window
Starting PLC Memory Window and Displaying PLC Data Table

1,2,3... 1. Right-click the PLC icon and select Memory from the pop-up menu or from

the PLC menu.
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The following initial screen will be displayed.

i5 PLC Memorp o] x|
File  Miew ‘wWindow  Help

Eelm s

el = a2
o

1=l
e CI0
A
n'ﬁ T Data Area Workspace
o C e The area displayed will depend on the
et IR PLC model and CPU Unit type.
ot DR « For more details about area names,
bl ?K refer to the area names list.
i H
el
- IE
 EO
G E1
w E2 ﬂ
o \m'r\!‘Mem“r}-" T Address

Ready ZS1H - CPLUEY Program MM

2. Double-click the name of the desired area in the data area workspace.

The PLC data table will be displayed. The following example is the PLC
data table of the CIO area of the CS/CJ Series.

#* CI0 M=l E3

1] 1 2 k- 4 L]

F

Cloooo
clooo
clooo:
CIO00%
Cloo04
CIO00%
Clo00G
cloooy
Clo00E
clooog
ciooio

10011 ~|
1| | W

Quitting PLC Memory Select Exit from the File menu in the PLC memory window. The PLC memory
Window window will close.
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12-2-5 Changing Display and Input Formats

The display and input formats are selectable per I/O memory area in the fol-
lowing methods, provided that the PLC data table is active.

Selecting from Menu

Grid  Window

Always On Top
Toolbars._.

v Status Bar

v Data Area WorkSpace

* Decimal

Select Display from the View menu.

Help

Zoom In Cirl+PgDn
Zoom Qut Cirl-PglUp
100%

Resize Columns

Selecting from Pop-up

Menu pop-up menu.

Hexadecimal

Signed Decimal

Right-click a cell in the PLC data table and select the display format from the

2 3 5 i}
-GEEE FmoCo MaCo M Co "o
03ER Ll ey =
UZES il Data Area.. LeemEl 9
ORER Elear - signed Decimal a
Q3ED - a
3ER Cut Hexadecimal e
02E2  Copy g
Q3ER T3ED TZER
Q3ED Q3ED Q2ED
Q3ER Properties._.. Q3ER Q3ER
Selecting from Toolbar Left-click the icon on the toolbar.
2 |8 Bblle]a]
‘ ‘ I— Text )

Hexadecimal

Floating point

Signed decimal

Decimal

Binary coded decimal

Binary

Note The default data display format in the PLC data table can be changed by
selecting the new default data display format from the Display tab in Prefer-
ences in the Display menu.

309

AUDIN - 8, avenue de la malle - 51370 Saint Brice Courcelles - Tel : 03.26.04.20.21 - Fax : 03.26.04.28.20 - Web : http: www.audin.fr - Email : info@audin.fr



Outline of PLC Memory Window Section 12-2

12-2-6 PLC Memory Window Settings

Properties, such as the default data display format and monitor refresh cycle
of the PLC memory window can be changed.

Displaying Properties Dialog Box

1,2,3... 1. Select Preferences from the View Menu.

Properties - For New Windaow:

Clizplay ]Mnnit:nring] Genera ] File ]

whord Lhzpley Fornat bit Lhzplay ormat
" Bray * Tt [On /D6
e Erh:l_'.-'_ELILI:IJ Creci 14l " [1/0]
* Lecmd
" S gred Decimal Forl
T Floaling Point Arial, St
" Hexadecimal
- Lhange Fon.... |
OF Cancel | | l=lp

2. Left-click the buttons of the items to be set.

3. Left-click the OK button to enter the settings. The details of tab settings are
explained below.

Settings in Display Tab Use the following procedure to set the default data display format in the PLC
data table.
1,2,3... 1. Select the Display tab from the Properties - For New Windows dialog

box. The above window will be displayed.

2. Select the default word and bit display formats. It is also possible to change
the font.
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Settings in Monitoring Tab Use the following procedure to set the monitor update interval.

1,2,3... 1. Selectthe Monitoring tab from the Properties - For New Windows dialog
box.
Properties - For New Windows

Display  Monitoring lEeneraI] File ]

Mornitar Llpdate Interval

5|:II: ill Millizeconds j

k. Cancel Help

2. Set the refresh period and unit and left-click the OK button.
Settings in General Tab

1,2,3... 1. Select the General tab from the Properties - For New Windows dialog
box.
Properties - For Hew Window:

Displa_l,l] Monitoning Beneral lFiIe ]

General

v Frompt before closing an active monitor window
[w Baap oninyealid input

[ Fast window update

Ik, Cancel Help
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Automatically resize column widths: The column widths will be auto-
matically adjusted according to the window size of the PLC data table.

Prompt before closing an active monitor window: A prompt message
will be displayed when closing the window being monitored.

Beep on invalid input: An alarm is sounded when an inappropriate input
is made.

Fast window update: Makes the renewal speed for display data faster.

Note If the Fast window update setting is enabled, the speed at which
data is renewed will increase but the display may flicker.

2. Select the function and left-click the OK button.

Settings in File Tab Use the following procedure to edit the comment. The file name and comment
will be displayed when I/O memory data is saved in the file by selecting Save
to File from the File menu.

1,2,3... 1. Select the File tab from the Property - For New Windows dialog box.

Properties - For New Window:
Displa_l,ll Mu:nnitu:uring] General  File l

File Mame
|E:"~F‘n:|gram Files\Omron\CFProtocolC51H.m |

Camment

PLC Memary (DM, EM] of C5TH-CPUEE i

The comment input when saving
the data will be displayed. This
comment can be edited from this

| screen.

Ik, LCahcel Help

2. Enter comments in the Comment field.
3. Click the OK button.

Note With the CX-Protocol, the Delete button is not available in the File property.
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12-3 1/0 Memory Display and Editing

12-3-1 Displaying I/O Memory

1,2,3...

o

space. The data table will be displayed.

wthemory  [S5 rdarece

The following example is the data memory area of the CS/CJ Series.

# D =] E3

L m TITdoog3p 0 —F=0
wTETRYET =

m
)

& E1
G E2

e

z

3

Data Area Workspace

e The area displayed will depend on the

PLC model and CPU Unit type.

e For more details about area names,

refer to the area names list.

4

Caoon

Lao10

Laozo

Laoz0

Cao40

COos0

Ca0a0

Laoyo

1

12-3-2 Editing I/O Memory Data

Editing Data
1,2,3...

Input or edit the data according to the display format.

i

1. Double-click the name of the area to be displayed in the data area work-

1. Left-click the cell of the address to be edited in the PLC data window. Mul-
tiple cells, lines, or rows can be selected.

The PLC data table can be displayed and edited offline or online. The edited
data can be transferred to a PLC that is connected online so that the data in
the PLC will be changed. Refer to 12-5 I/O Memory Transfer and Comparison
if the edited data needs to be transferred to the PLC.

Note The cells corresponding to read-only areas (e.g. parts of SR area), are dis-

Data Storage

played in gray. Editing cannot be performed in gray cells.
I/O memory data can be stored using either of the following methods.
» Saving in project: Select Save in Project from File menu.
» Saving as a different file (MEM file): Select Save to File from File menu.
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Saving in Project

1,2,3... 1. Select Save in project from the File menu in /O memory window.
The Save dialog box will be displayed.

N |

Areas to Sawve: File Comment;

The area presently
open is displayed.

Ok, I Cancel

A comment can be entered in File Comment, if required.

2. Select the area to be saved. Left-click the OK button to start saving the ar-
ea.

Note When deleting PLC data in project, select Properties from the Display menu
and perform the deletion from the File tab.
Saving as Different File (MEM File)
1,2,3... 1. Select Save to File from the File menu in the PLC memory window.

The Save dialog box will be displayed.

2. Select the area to be saved and left-click the OK button.
The Save dialog box will be displayed.

Save As
Save in; I {4 C¥-Protocol j ﬁ{l
File name: Save I
Save az bwpe: | Data Monitor Memary [* mem) j Camcel |

3. Set the file name and location where the file is to be saved. Left-click the
Save button to start saving the data.

12-3-3 Writing Same Data to Successive Addresses
Use the following procedure to write the same data to the designated cell,

line, or row.
Writing Same Data to As an example, the procedure for writing FFFF (hexadecimal) into DO030 is
Designated Line given.
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1,2,3... 1. Select and highlight the cell. In the following example, row D0030 is select-
ed and highlighted. Drag the cursor to the left to select the entire line.

DO000 | 0700 0005 FFFF B0 0007
DO07 0| 01 616 '

2. Select Fill Data Area from the Grid menu.
The Fill Memory Area dialog box will be displayed.

Fill Memory Area

Walue

v ||:|

" Binary
~ Binary Coded Decima

* Decimal

" Signed Decimal

(" Heradecimal

Fill Fanige
&l Status value
" izible area anly F
* Selection i Fil Cancel
Note In this example, the Fill Range settings should not be changed.
3. Select the input format and enter the Value field. In this example, Hexa-
decimal is selected and FFFF is entered.
4. Left-click the Fill button.
The data set in step 3 will be written to the cell designated in step 1.
# D _[O]
0 2 i
D000 | 077 D0 Q005 FFFF 1500 0001
DO0T0 | 000
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Writing Same Data to Use the following procedure to write the same data to the whole data table
Whole Bit Areas or currently opened or the displayed range of the data table (i.e., the range dis-
Display Areas played in the window).

1,2,3... 1. Select Fill Data Area from the Grid menu.
The Fill Memory Area dialog box will be displayed.

2. Make the area, Fill Range, Value, and Status Value settings.

Fill Memory Area
£r Walue
Same o e, o000
b " Binamy
" Binam Coded Decima
" Decimal
" Signed Decimal

&+ Heradecimal

Fill Harge
¢ al Status Walue
By selecting All, the same £
data will be written to all o+ vizsible area anly (v
the selected areas. :
By selecting Visible area ¢ Selection e Fill Cancel
only, the same data will 3

be written to the range of
the above areas displayed
in the PLC data table.

3. Left-click the Fill button.

12-4 1/0O Memory Monitor

While the PLC is connected online, the I/O memory status per area of the
PLC can be monitored. The value displayed on screen varies with the I/O
memory status of the PLC.

Note 1. Do not monitor EM area used for file memory. If monitoring is performed
for this area, it will become impossible to display any present values.

2. When in MONITOR or RUN mode, only data in the data in the data mem-
ory area (D) and extended data memory area (E) can be transferred to the

PLC.
12-4-1 Monitoring Whole I/O Memory
1,2,3... 1. Connectthe PLC online. This step can be taken after step 2 if desired.

2. Double-click the name of the area to be displayed in the data area work-
space and display the PLC data table. Multiple areas can be monitored si-
multaneously.
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3. Right-click a cell in the PLC data table and select Monitor from the Online

menu.
—_ R Download...
Ll Compare...
PN Monitor |
Clear Grid T
R .
Cut :
Copy
Paste !IE :
) 4
Properties... o 4
The following dialog box will be displayed.
M onitor Memory Areas
Clo
C Cancel |

4. Select the area to be monitored and left-click the Monitor button.
The displayed range of the selected area in the PLC data window will be
monitored.
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Example: Data Memory Monitor Screen

AV

Note If monitoring is performed, the data read from the PLC will be over-
written with the edited data displayed on the screen. For this reason,
if there is edited data in the PLC data table, a save confirmation mes-
sage will be displayed when monitoring is executed.

12-4-2 Address Monitor
The address or I/O name can be designated in the address monitor table to
monitor the data. This function is convenient in the following cases.

* Monitoring the data in bits or words of multiple areas in a single table for
the purpose of debugging.

* Monitoring the data in bits or words that are not adjacent in the same area
(e.g., the data in DO0001 and D1000).

1,2,3... 1. Left-click the Address tab in the data area workspace.

2z

Bl CsiH- CcPUsT
-|I,I'|..- [BETiie® — | 2. Double-click here |

ot hlemory [E5 Dddress

1. Click here
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Symbol

2. Double-click Monitor.

The following Address Monitor table will be displayed.

Attribute Propertes

..............................................................................................................................................................................

3. Input the address or variable and press the Enter Key.
The data in the designated bits or words will be displayed.

Example:
Symbol Address Walue Attribute | Propertes For mat -

1 Ca 14765 RO0 m= Crecima

2 Ti Qoo 00 m= BCLC

3 100100 Off ROO ms= Crecima

4 1 Qoo 500 m= ECC

A Ci00 4096 RO0 m= Crecima

A Crecima ;I
1] | 2

Note Set the monitor refreshing cycle in the Monitor tab by selecting Preferences
in the View menu.

Select the address to be force-set/reset, and from the Address menu, select
Set or Reset as required from the Force Status menu. Alternatively, the
Force Status menu can be selected from the pop-up menu displayed by right-
clicking. Similarly, when clearing, select Clear.

- Address Monitor

Force-set/reset in Address
Monitor

Window  Help
Inzert
Remove
Hemove Al | |
Set Value. . i
E | Cancel

Select the address for which the present value is to be changed and from the
Address menu select Set Value. Alternatively, Set Value can be selected
from the pop-up menu displayed by right-clicking.

Changing Present Values
in Address Monitor
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» For word addresses, after specifying the data format (binary, BCD, deci-
mal, signed decimal, hexadecimal), enter the new value in the Word
Value field.

* For contact addresses, specify “ON” or “OFF” in the Bit Value field.

Set Yalue

Word Value

=l

" Binary
" Binary Coded Decimal

{~ Decimal

k.

Cancel

(" Signed Decimal

o+ Hexadecinal

12-4-3 Finding Force-set or Force-reset Bits

Use the following procedure to find and display the force-set or force-reset
bits.

1,2,3... 1. Click the Address tab in the data area workspace.

2=l

Bl csiH- crus?

-»-IIIIII,- Ml 2. Double-click here |

- H Forced Status

ot Memory [E¥ fddress

1. Click here
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.« Force Status — [Not Monitored]

2. Double-click Forced Status.
* The search operation will start.

» The following window will be displayed on completion of the search op-
eration.

m] B3

Address | Walue | Attribute
4.0 i Farced
5.0 i Farzed
5.0 i Faoroed

« If Refresh is selected from the Force Status menu, the search oper-
ation will be performed again, and the bits that have been force-set/re-
set will be displayed.

12-5 1/0 Memory Transfer and Comparison

/\ WARNING

& Caution
& Caution

& Caution

& Caution

The following description provides information on how to transfer edited data
from the PLC data table to the PLC, transfer data from the PLC to the PLC
data table, and compare data in the PLC with data edited in the PLC data
table.

Confirm safety before transferring the 1/0O memory area state to the CIO area
of the PLC using the PLC memory window function of the CX-Protocol. Not
doing so may cause malfunction in devices connected to the I/O Units regard-
less of the operating mode of the CPU Unit.

Confirm that no adverse effect will occur in the system before transferring data
to the PLC. Not doing so may result in an unexpected operation.

Confirm that the PLC is connected online before transferring or comparing the
data. Not doing so may result in an unexpected operation.

Confirm that no adverse effect will occur in the system before changing the
present value of any word in memory. Not doing so may result in an unex-
pected operation.

Confirm that no adverse effect will occur in the system before force-setting/
force-resetting any bit in memory. Not doing so may result in an unexpected
operation.

12-5-1 Precautions for Transfer of Data to PLC

Note

The following tables list the available PLC modes and 1/O memory areas for
data transfer to the PLC.

Before changing the operating mode, make sure that the change will not affect
the installation.

1/0 memory Operating mode
PROGRAM MONITOR RUN
Data memory (D), extended Transfer sup- Transfer sup- | Transfer not
data memory (E) ported ported supported
All other memory areas Transfer sup- Transfer not Transfer not
ported supported supported
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12-5-2 Data Transfer

Connect the PLC online before transferring I/O memory data.

Downloading (Personal Use the following procedure to transfer the data of the PLC data table from the
Computer to PLC) personal computer to the PLC.
1,2,3... 1. Inthe data area workspace, display the PLC data table by double-clicking

the name of the area to be downloaded. When downloading part of the
PLC data table, specify the range of the area to be downloaded.
The range can also be specified in step 2.

Transfer to PLC |

Setting the range to be downloaded:

All: Everything in the areas selected
in the box above, will be transferred.

Selection: The range of data set in
step 1 (PLC data table) in one area,
will be transferred to the PLC.
Range setting: Specify an address
and a transfer range for the areas
selected in the box above. The data

Download

Cancel

Select Al

E L

in that range will be transferred to — Tranzfer Range
the PLC. I f;" E”
" Gelection
" Range [eg. 10-90,93,95-100]
|0-32767

2. Right-click a cell in the PLC data table and select Transfer To PLC via On-
line from the pop-up menu or from the Online menu in the PLC memory
window.

3. Setthe area and the range of the area to be transferred.

4. Click the Download button.
Transfer of the data will start.

Uploading (Personal Use the following procedure to transfer the data of the PLC data table from the
Computer from PLC) PLC to the personal computer.
1,2,3... 1. Open the PLC data table of the area to be uploaded. In order to designate

the range to be uploaded, highlight the range.
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2. Right-click a cell in the PLC data table and select Transfer From PLC via
Online from the pop-up menu or from the Online menu in the PLC mem-
ory window.

Transfer From PLC

The area currently open is displayed.
Check the area to be transferred. DD

[w]ED

Uplaad

Cancel

Designate the range of the area to be trans
ferred.

.

Select Al
All: All data of the selected area. \ —
Visible area only: The range of data cur- — Tranzfer Range—————
rently displayed in the window. Al
Only if the range is selected in step 1, =
Selection is available. o isible area anly
= Selection

3. Setthe area and the range of the area to be transferred.

4. Left-click the Upload button.
Transfer of the data will start.

12-5-3 Comparison with Datain PLC

Use the following procedure to compare the data of the PLC data table with
the data in the PLC after connecting the PLC online.

1,2,3... 1. Open the PLC data table in the area to be compared. To designate the
range to be compared, highlight the range.

2. Right-click a cell in the PLC data table and select Compare with PLC via
Online from the pop-up menu or from the Online menu in the PLC mem-

ory window.
Compare Memory |
tl Compare
The area currently open is displayed. ; :
Check the area to be transferred. |:|E|:|
Cancel

Designate the range of the area to be transferred.
All: All data of the selected area.
Visible area only: The range of data currently L mpare H-EII'IEZE
displayed in the window.

Selection will be available only if the range is r. &”
selected in step 1.

& isible area anly
£ Selection

3. Setthe area and the range of the area to be transferred.
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4. Left-click the Compare button.

The comparison of the data will start. One of the following messages will
be displayed according to the comparison result.
Data Coincident

Data Monitor |

@ Mo differences found In compare

Data Not Coincident

Data Monitor E

@ Differences were found during compare. Do vou want to view these differences now?

...Yes ... No

By left-clicking the Yes button, the address of the data in the PLC will be
displayed in parentheses.

#* D

1 o 2 4 5
Doooo [C5 24 {FFFF DG 2E) (1100 3565) 0010 0000
Cooio [oozo ‘0000 1000 ;0000 ‘0000
mmen ninininl Hulnlnln] Hulnlnlyl Hulnluly] Hulnlnln]

When there is data that is not coinci-
dent, the data for the PLC side will be
displayed in parentheses.
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SECTION 13
Error and Error Log Display

This section describes details of the displaying of errors and the error log.
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Current Error and Error Log Display

This section provides information on functions that display or clear the current
errors and error log. These functions are available only when the PLC is con-
nected online.

The errors and error log are displayed in the error log window. A message can
be displayed in the PLC Errors window by executing the MSG instruction.

Displaying Errors
1,2,3... 1. Connectthe PLC online.

2. Right-click the PLC icon and select Error Log from the pop-up menu or
from the PLC menu.

* The following Errors tab will be displayed in the PLC Errors window.

B PLC Errars

—
ltem | Code |Status [Detals |

Mo Errar

« All the errors currently resulting are displayed in the Errors tab in the
PLC Errors window.

e The display of errors will be automatically refreshed whenever a new
error occurs.

« Each error is displayed with its error type (i.e., fatal error or non-fatal
error).

* The following errors will be displayed if they result.

Fatal Errors (in Order of Priority)
Memory Error
1/0 Bus Error
Unit/Rack Number Duplication Error
Inner Board Fatal Error
1/0 Points Over
1/0 Setting Error
Program Error
Cycle Time Over
FALS Error
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Non-fatal Errors (in Order of Priority)
FAL Error
Interrupt Input Unit Error
Basic 1/O Error
PLC Setup Error
I/O Table Verification Error
Inner Board Nonfatal Error
CPU Bus Unit Error
Special /0O Unit Error
SYSMAC BUS Error
Battery Error
CPU Bus Unit Setup Error
Special /0 Unit Setup Error

Note Itis possible to display the PLC Errors window whenever an error oc-
curs. Furthermore, it is possible keep displaying the PLC Errors win-
dow on top or keep displaying the clock of the PLC on the status bar
of the error log window. For details, refer to page 330, Setting PLC
Errors Window Conditions.

3. Whenever an error is displayed, remedy the error.
4. Left-click the Clear All button and delete the error display.

Note If a memory error has resulted, the error display will not disappear
when the Clear All button is left-clicked in step 3. Instead, the follow-
ing dialog box will be displayed.

Clear Hemory Error o

"-_-. WaRMIMNG: Tozucceszsfully clear a PLC 'Memary Errar’ the

FPLE requires complete intializatior of all areas, this includes
Frogram &rea, Paramater Area and |0 &rea, ALL PLE data
will be destroped.

Select Yes' to CLEAR ALL AREAS and Bemave Errcr.
Select Mo to Femaove Ermar DMLY,

Mo Cancel

« Left-click Yes to clear all memory areas of the CPU Unit. The memory
areas will be initialized.

« Left-click No to clear the error display only. The memory areas will not
be initialized.
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Displaying the Error Log Use the following procedure to display the log of errors that have resulted.

Left-click the Error Log tab in the error log window.
The following error log will be displayed.

F. PLC Errors EE =

File  Cphion:  Help

Errors Eror Log l Mezsages]

Non-fatal error\ E ntry | D ate | Time | Code Dretails -~
BNl 121548 035227 mMOODET 10 Verfication Emar
S, 12 121548 035243 mOODET 10 Verfication Emar
ENE 121548 035258 MO0OET 10 Verfication Emar

Fatateror \ [ 4 12/15/8 035427  BOF1  MemaryErmor -
[&;]E 12158 0354:28 =301 b ermary Errar
BN 121548 0365704 OOET 10 “erfication Emar
I_'%TIT-" 12158498 0367526 k4100 Syztem dlarmn [FALT Eror 1 X
4 b
Marimum Log Capacite 20 Llear &l |
C31H - CPUEY F aritor Clock: 14:06: 42

» The items of errors displayed in the Error Log tab are the same as
those in the Errors tab. Refer to the previous subsection for details.
* Left-click the Clear All button. The error log will be cleared.

» A maximum of 20 errors can be recorded in the error log. If the 21st
error results, the oldest recorded error will be deleted.

Note When in CPU Standby (fatal error), errors will not be displayed in the errors in
progress or error log. Errors can be determined if the POWER indicator on the
Power Supply Unit is lit and the RUN and ERR/ALM indicators on the CS/CJ-
series CPU Unit are not lit.
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Displaying Messages Use the following procedure to display messages by executing the MSG
instruction.

Double-click the Messages tab in the PLC Errors window.
The following Messages tab will be displayed.

F. PLC Errors i ¥
File  Cptionz Help

Errors ] Error Log  Messages l

teszage # Mezzage Text
[ 10 "Servamator Error 1°
Clear Clear alf
C31H - CPUE? tdaritor Clock: 14:20:30

* Message numbers and message texts are displayed.
« Up to eight messages are displayed.
« Messages selected are cleared by left-clicking the Clear button.

« All the messages displayed are cleared by left-clicking the Clear All
button.

Note 1. Control codes other than ASCII will be displayed with a space.
2. Two-byte code can be displayed.
3. Messages designated by FAL or FALS instructions cannot be displayed.
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Setting PLC Errors Use the following procedure to set PLC Errors window conditions.
Window Conditions ) ] )
Opening the Option Dialog Box

Select Settings via Option menu from the PLC Errors window.

Settings

General l Ermor Log | Clock |

[ Activate when Error detected

OF Cancel Help

General Tab Settings

1,2,3... 1. Select General tab from the Settings dialog box.
The above screen will be displayed.
» Always On Top will always display the error log window on top.

* Activate when Error detected will automatically display the PLC Er-
rors window that is open with the PLC connected online but located
behind other windows or minimized on top when an error is detected.
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Error Log Tab Settings
Select the Error Log tab from the Setting dialog box.

Settings

General ErmmorLog l Clock ]

-

-
Dizplay

[ Hide Ermar Log Time Calumn
[ Hide Emor Log Date Calurmn

OF Cancel Help

e Update Error Log Entries Automatically will automatically refresh
the error log.

* Hide Error Log Time Column will hide the time display of the error
log.

* Hide Error Log Date Column will hide the date display of the error
log.
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Clock Tab Settings

Select the Clock tab from the Settings dialog box.
The following screen will be displayed.

Settings

General | EmorLog  Clock l

-

[ iMonitor the PLC Cloc

..................................................... E

OF Cancel Help

« Monitor the PLC Clock will monitor and display the PLC clock on the
bottom right of the PLC Errors window as shown below.

L51H - CPUE? Frogram Clock: 10:04:17
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SECTION 14
Troubleshooting

This section lists the error messages and describes their causes and remedies.
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Troubleshooting_j

Section 14

Error Messages

The following error messages are listed alphabetically.

Error Message/Symptom

Cause

Action

A | Aborting download. PMSU is
not valid for any of the selected
protocols.

The target specified within all
selected protocols is not valid.

Change the Target setting to a valid PMSU.

Address is larger than the
selected data area size...

Effective starting address out of per-
mitted range for a selected area.

Change the effective starting address so it
is within range demonstrated by the error
message.

Another application has locked
access to the PLC.

Cannot complete the operation.

Another application has locked
access to the PLC or CX-Protocol
has not become the condition to gain
the access rights of the PLC.

Release the access rights of the PLC from
Another application.

Disconnect from the PLC and then connect
to the PLC again.

C | Can not select O1 or O2 when
variable type is write.

The address O1 or O2 has been
selected for a Write channel type.
This is not permitted.

Select a different address for a Write chan-
nel type.

Cannot accept a negative num-
ber in this field.

A negative number has been
entered.

Enter a positive number.

Cannot download Protocol(s) to
the PMSU: Too large

Protocol size: xxx

PMSU Memory Size: yyy

The protocol data selected for down-
load to the PMSU is in excess of the
capacity of the PMSU.

Ensure the Include Source Information
option is not set and try again.

Cannot edit PC — PLC comms
settings while CX-Net is open

Attempting to change PLC settings
which CX-Net is active.

Close CX-Net and retry.

Cannot open/create another
project. The maximum number
of projects are already open.

The current CX-Protocol session has
the maximum number of projects
open.

Close one or more projects and try again.

Cannot perform trace operation
using PMSU configuration.

The selected port is not correctly set
up for Protocol Macro operation.

Set the port setting to Protocol Macro
mode for the selected port.

Cannot proceed — connected to

The connected PLC does not match

Select a different PLC.

Wrong PLC... the PLC settings.
Cannot set a repeat count of The Repeat count specified is invalid. | Enter a valid value.
zero.

Channel number is larger than
the selected data area size...

A Channel Number has been entered
for the Repeat Counter that is outside
the range for the selected Channel
area.

Enter a valid Channel Number.

Check Code <c> defined in
message but no check code
area selected.

A Check Code <c> entry has been
made in the Message Data dialog,
but the check code has not been
specified for an appropriate entry.

Specify a Check code area to an entry.

Combination of address and
length extend beyond the
selected data area.

Attempting to specify a Length or an
effective address that is larger than
the data area.

Enter valid data.

Communications Port Settings
download failed.

Communications have failed.

Retry the connection or cancel the dialog
and check the PC to PLC communications
settings.

Contention Send Request Code
not valid.

The Contention Send Request Code
has been selected but not entered.

Enter the Contention Send Request.

CX-Server failed to initialize.

CX-Protocol could not initialize the
communications driver CX-Server
and cannot function properly.

Exit the application and try again. If the fail-
ure continues, reboot the computer and try
again. If the failure persists, reinstall CX-
Protocol.

D Delimiter send code not valid/

Delimiter receive code not valid.

The Delimiter Send Request Code or
Delimiter Receive Request Code has
been selected but not entered.

Enter the Delimiter Send Request or
Delimiter Receive Request code.
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Error Message/Symptom

Cause

Action

E | End Sequence number must be
greater than the Start

The sequence end value must be
greater than the sequence start

Enter a sequence end value greater than
the sequence start value.

Sequence. value.
Error displaying the Data Moni- | An error has occurred with the Reinstall CX-Server.
tor. CX-Server communications driver.

Error displaying the Error Log.

An error has occurred with the
CX-Server communications driver.

Reinstall CX-Server.

Error displaying the 10 Table.

An error has occurred with the
CX-Server communications driver.

Reinstall CX-Server.

Error occurred during the
upload of Trace data from the
PMSU.

A communications error occurred
while uploading the trace data.

Retry the upload operation.

Attempting to upload a trace without
the expected response from the
PMSU.

Check the connections and try again.

Error: Could not run the com-
piler for target...

The protocol data selected for down-
load could not be compiled prior to
download.

Check the connections and PMSU settings
and try again.

Error: No valid compiler for tar-
get...

The protocol data selected for down-
load could not be compiled prior to
download because of no compiler
module in the application folder.

Install CX-Protocol and try again.

Expression constant/factor
value is outside the permitted
range...

A primary expression constant/coeffi-
cient in variable has been entered
exceeding allowed value.

Enter a valid expression constant/coeffi-
cient demonstrated by the error message.

F Failed to connect to the PLC.

Communications have failed.

Retry the connection or cancel the dialog
and check the PC to PLC communications
settings.

Failed to create the Data Moni-

An error has occurred with the

Reinstall CX-Server.

tor OCX... CX-Server communications driver.

Failed to create the Error Log An error has occurred with the Reinstall CX-Server.

OCX... CX-Server communications driver.

Failed to create the IO Table An error has occurred with the Reinstall CX-Server.

OCX... CX-Server communications driver.

Failed to gain the access rights | Attempting to download to protected |Release access right by using CX-Pro-
of the PLC. PLC without sufficient access privi- | grammer.

lege.

Another application has locked
access to the PLC or CX-Protocol
has not become the condition to gain
the access rights of the PLC.

Release the access rights of the PLC from
Another application.

Disconnect from the PLC and then connect
to the PLC again.

Failed to load help contents.

The help file associated with
CX-Protocol is missing from the
application folder.

Locate the help file and move back to
application folder. If the help file cannot be
found, reinstall CX-Protocol.

Failed to open communications
with the PLC. The device may

Communications have failed.

Shut down any other application that may
be accessing the PLC or switch them

be busy. offline.
Failed to Open the CX-Server | Connection has failed. Reboot the computer and try again.
project file

Failed to release the access
rights of the PLC.

Attempting to upload to protected
PLC without sufficient access privi-
lege.

Obtain the correct password or select a dif-
ferent PLC.

Failed to save the CX-Server
project file

Connection has failed.

Reboot the computer and try again.

G | Goto number is too large.

The GOTO setting is invalid.

Enter a valid value.
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Error Message/Symptom

Cause

Action

Incorrect object code specifica-
tion ... on unit ...

CX-Protocol does not support con-

nected Protocol Macro specification
or CX-Protocol does not recognize

the PMSU.

Try a different PMSU or establish connec-
tion with PLC again.

Interrupt number is larger than
the maximum allowed value...

Interrupt Address longer than the
maximum.

Change the Interrupt Address so it is within
the permissible range demonstrated by the
error message.

Invalid constant data — Setting
message address type to
NONE.

Constant ASCII or Constant selected
for Address <a> but no valid data
entered.

Specify valid constant type and enter valid
data again.

L Length <I> defined in message
but no length area selected.

A Length <I> entry has been made in
the Message Data dialog, but the
length has not been specified for an
appropriate entry.

Specify a Length area to an entry.

Length is larger than the maxi-
mum allowed values...

Link Channel Address length longer
than the maximum of 128 words.

Change the Length so it is within the per-
missible range demonstrated by the error
message.

M | Maximum items within message
data is 96.

Too many items have been supplied
to the message data.

Reconfigure the message data so the
items limit is not exceeded.

Maximum number of communi-
cation sequences already cre-
ated.

The protocol limit of sequences has
been reached.

Reconfigure the project to ensure the prob-
lem is not encountered in the future. For
instance, move sequences to another pro-
tocol.

Maximum number of protocols
already created.

The project limit of protocols has
been reached.

Reconfigure the project to ensure the prob-
lem is not encountered in the future.

Maximum of 300 messages per
protocol.

The protocol limit of Send/Receive
messages has been reached.

Reconfigure the project to ensure the prob-
lem is not encountered in the future. For
instance, create a new protocol for the
additional messages.

N | Name already in use! Choose
another name or ESC to cancel
edit.

A name has been supplied to a set-
ting which is identical for an existing
setting.

Specify a different name in the specified
protocol.

No sequence numbers avail-
able within this protocol.

The protocol limit of sequences has
been reached.

If required, reconfigure the project to
ensure the problem is not encountered in
the future. For instance, move sequences
to another protocol.

No sequence numbers avail-
able within this protocol...

The sequence start and sequence
end of a protocol does not permit the
addition of new sequences.

Increase the range of the sequence start
and sequence end for the protocol and try
again. Increase the sequence end first.

No valid header data — setting
header data type to NONE.

Header <h> dialog has been selected
but no valid data entered.

Enter valid data.

No valid terminator data — set-
ting terminator data type to
NONE.

Terminator <t> dialog has been
selected but no valid data entered.

Enter valid data.
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Error Message/Symptom

Cause

Action

O | One or more of the PMSUs are
not fitted to the currently
selected PLC. Not all selected
communications port settings
will be downloaded.

The scope of the download port set-
tings command includes one or more
PMSUs that are not fitted.

Clear the error message. CX-Protocol will
continue and download port settings to the
PMSUs that are fitted.

One or more of the PMSUs are
not fitted to the currently
selected PLC. Not all selected
communications port settings
will be uploaded.

The scope of the upload port settings
command includes one or more
PMSUSs that are not fitted.

Clear the error message. CX-Protocol will
continue and upload port settings to the
PMSUs that are fitted.

Only 100 Matrices are allowed.

The protocol limit of matrices has
been reached.

Reconfigure the project to ensure the prob-
lem is not encountered in the future. For
instance, create a new protocol for the
additional matrices.

Only 16 Steps are allowed.

The limit of steps for a sequence has
been reached.

Reconfigure the project to ensure the prob-
lem is not encountered in the future. For
instance, move steps to another sequence.

P PMSU does not support Proto-
col Macro. Download cannot
proceed.

The selected PMSU does not support
the Protocol Macro function.

Try a different PMSU.

PMSU does not support Proto-
col Macro. Upload cannot pro-
ceed.

The selected PMSU does not support
the Protocol Macro function or
CX-Protocol does not recognize the
PMSU.

Try a different PMSU or establish connec-
tion with PLC again.

PMSU ... is not fitted to the cur-
rently selected PLC. Not all
selected Protocols will be
downloaded.

One or more of the selected proto-
cols contains a target PMSU not fit-
ted to the PLC.

Continue with the download, but ensure
the target setting for associated PMSUs
are correct.

Protocol list upload failed.

Communications have failed.

Retry operation.

Protocol upload/download
failed.

Communications have failed.

Retry operation.

Protocol.spp was not found.

The file protocol.spp is not in applica-
tion folder.

Locate protocol.spp and move back to
application folder. If protocol.spp cannot be
found, reinstall CX-Protocol.

....psw was not found.

An attempt was made to open file
project.psw from the Recently Used
File List from the File menu, but
project.psw no longer exists in that
folder.

Locate and open project.psw.

R | Repeat count is larger than the
maximum allowed value...

A value greater than 255 has been
entered for the Repeat Counter con-
stant.

Enter a valid value demonstrated by the
error message.

S | Sequence End Number out of
range because a sequence
exists with a greater sequence
number.

The sequence end value is invalid.

Enter valid data for the Seq End setting.

Setting the Start Sequence to
this value will cause the
Sequence to exceed its maxi-
mum limit...

The sequence start value is invalid.

Reduce the sequence value or reduce the
sequence range.
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Error Message/Symptom

Cause

Action

T | Target for protocol ... must be
set.

A target must exist for a protocol.

Specify a target PMSU for the protocol.

Total number of IN and OUT
channels, for Link Channel
Areas 1 and 2 combined,
should be ...

The total length is beyond the limit.

Change the starting address and/or the
Length so that they are within the permitted
range as demonstrated by the error mes-
sage.

The CX-Server project file is
invalid, cannot proceed.

Connection has failed.

Reboot the computer and try again.

The Length must be between 1
and 256.

The Length specified is out of range.

Enter a valid value.

The PLC must be in PRO-
GRAM mode to download the
Protocol to the PMSU...

Attempting to download protocols to
the PMSU while in “Run” mode or
“Monitor” mode.

Select the Yes push-button to switch the
PLC to “Program” mode.

The PMSU Protocol password
has not been correctly entered.
The PMSU transfer cannot pro-

The protocol in the PMSU has a
password assigned to it. An incorrect
password has been entered.

To upload the protocol from the PMSU or to
download a new protocol to the PMSU,
type in the correct password.

ceed.
The PMSU contains no protocol | Uploading a protocol list from a Download protocols to the PMSU.
data. PMSU that contains no protocols.

The PMSU does not support
the PMCR instruction.

The selected PMSU does not support
the Protocol Macro function.

Try a different PMSU.

The PMSU has a Sum Check
Error. The transfer cannot pro-
ceed.

The selected PMSU has a sum check
error. The upload of protocols or pro-
tocol list cannot proceed.

Download protocols to PMSU to clear sum
check error and try again.

The PMSU has a Sum Check
Error. The Protocol download
will proceed anyway.

The selected PMSU has a sum check
error.

Proceed with the download to clear the
error.

The PMSU protocol password
has not been entered. The

PMSU transfer cannot proceed.

The user cancelled the password
entry.

Retry the operation and enter the correct
password.

The Unit Number must be
between 0 and 31.

The Unit Number specified is out of
range.

Enter a valid value.

The communications port set-
tings for this port are currently
being changed by another
device...

A Programming Console may be
accessing the PLC.

Check the new port settings and try again.

The following list of item(s)
have references to the selected
object which you tried to Delete
/ Cut. Remove all references
first.

Attempting to remove a matrix or
message from the project that is
referred to by steps within the project.

Check the message or matrix references
within each step that refers to each mes-
sage/matrix. If desired, remove the step
and try again.

The maximum length must be
between 200 and 1000 bytes.

The specified communications port
setting is out of range.

Enter a valid value.

The PLC must be in PRO-
GRAM mode to download the
communications port settings.

An attempt was made to download
the communications port settings to
the PMSU while the PLC was set to a
mode other than PROGRAM mode.

Change the operating mode of the PLC to
PROGRAM mode.
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Error Message/Symptom Cause Action
T | The sequence number is The sequence number specified is Specify a sequence number not used by
already in use by ..... the same as another sequence. the other sequences in the protocol.
The sequence number must be | The sequence number is out of Increase the range of the sequence by
in the range xxx to yyy inclu- range. changing the sequence start or end num-
sive... bers for the protocol. Increase the

sequence end first.

There is no Communications Attempting to stop a trace before it Start a new trace. Check connections.
Trace in progress on this port. | has started for the selected port.

There is no Trace data avail- Attempting to access trace data for a | Start a new trace for that port.
able for the specified Port. port that has no trace data.

This protocol cannot be found | Object code temporary file is corrupt. | Try compiling/downloading again.
and cannot be downloaded to
the PMSU.

This protocol file is of zero Object code temporary file is corrupt. | Try compiling/downloading again.
length and cannot be down-
loaded to the PMSU.

Transfer failed. Communications have failed. Check the connections and try again.
U | Unable to complete protocol Communications have failed. Check PLC connections and try again.

upload.

Unable to establish communi- | Communications have failed. Check the PMSU installation and try again

cations to the PMSU ... as demonstrated by the error message.

Unable to establish communi- | Communications have failed. Check connections and baud rate setting.

cations to the selected PLC...

Unable to register PLC Communications have failed. Retry the connection or cancel the dialog

Devices ... and check the PC to PLC communications

settings.

Unexpected file format An attempt was made to open a file | Check that the file format is one that can
that cannot be opened with the be opened with the CX-Protocol.
CX-Protocol.

W | Warning ... ? ... The selected A PLC has been selected that does | Select a different PLC.
PLC does not support the Pro- | not support Protocol Macro function.
tocol Macro function. Connec-
tion to the device from CX-
Protocol will not be allowed.

Errors
Symptom Cause Action
PLC Error light. SYSMAC Alpha: If FAL code is 9C, SYSMAC Alpha: check 268CH value by
Communication Board error occurs. referring page 147 in this manual. CS/
CSI/CJ: If A40208 is ON, Inner Board CJ: check A424CH value by
error occurs. referring page 147 in this manual.
PMSU RDY light flashing. PMSU Error. Confirm downloaded protocol and

download again.
Unexpected delay transferring proto- Either: more data is being transferred | Disconnect the cable to stop the trans-

cols to or from the PMSU. than was expected; communications fer.
have failed; slow performance com-
puter.
Unable to find a file to open from the | The Open dialog is not displaying the | Check the folder name described in the
Open dialog. correct folder and/or file type. Look in: field is the right folder. Check
the file type described in the Files of
type: field.
Start, Stop and Upload Trace opera- The PLC is offline or the PMSU trace is | Re-establish PLC communications or
tions disabled on buttons menu. not selected. select the PMSU Trace Port.
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Error Messages in Output Window

Error/Warning in Output Window

Description

E1001: ... Total Link Channels out of range...

The Link Channel setting is invalid.

E1005: No data in message.

A message contains no data.

E1006: Check code <c> after Terminator <t> not supported
on this unit.

The target unit does not support message data that
includes a Check Code <c> after a Terminator <t>.

E1007: Check code <c> ~LRC not supported on this unit.

The target unit does not support message data that
includes a ~LRC Check Code <c>.

E1008: Check code <c> ~CCITT not supported on this unit.

The target unit does not support message data that
includes a ~CCITT Check Code <c>.

E1009: Check code <c> CRC16 not supported on this unit.

The target unit does not support message data that
includes a CRC16 Check Code <c>.

E1010: Check code <c> ~SUM (1 byte) not supported on
this unit.

The target unit does not support message data that
includes a ~SUM (1-byte) Check Code <c>.

E1011: Check code <c>~SUM (2 bytes) not supported on
this unit.

The target unit does not support message data that
includes a SUM (2-byte) Check Code <c>.

E1012: Check code <c> SUM2 (1 byte) not supported on
this unit.

The target unit does not support message data that
includes a SUM2 (1-byte) Check Code <c>.

E1013: Check code <c> SUM2 (2 bytes) not supported on
this unit.

The target unit does not support message data that
includes a SUM2 (2-byte) Check Code <c>.

E1014: Overlap in sequence range with protocol...

A sequence’s start and end settings conflict with another
protocol which is being compiled.

E1022: Communication Sequence contains no step data. A sequence exists but has no steps.

E1026: Step contains invalid command. Invalid command setting in step

E1035: Link Channel out of range. Alpha protocols only error. The Link Channel setting is out
of range.

E1037: Repeat Counter contains invalid channel. Alpha protocols only error. The Repeat Counter contains a
channel out of range.

E1042: Length part primary expression constant out of Alpha protocols only error. Part of the Length primary

range. expression is out of range.

E1043: Object code too large... The amount of data to be downloaded is too large.

E1044: Matrix Goto out of range. The GOTO setting within a matrix is out of range.

E1045: Matrix next statement out of range.

The Next setting within a matrix is used by the last step in a
communication sequence.

E1048: Protocol contains no message data.

A protocol contains no message data.

E1049: Protocol contains no communication sequences.

A protocol contains no sequences.

E1050: Step contains invalid message/matrix reference

A message has not been specified in a step requiring a
message.

E1051: PLC xxx CPUyy does not support EM banks.

Information including EM data areas has been supplied for
download to a PLC which does not support EM data areas.

E1052: PLC xxx CPUyy supports zz EM banks.

Information including EM data areas has been supplied for
download to a PLC which supports EM data areas but
exceeds number of EM bank.

E1053: Link Word IN1 is not defined or invalid.

Link channel 11 is specified in message but not specified in
Link channel information or invalid setting in Link channel
information.

E1054: Link Word OUT1 is not defined or invalid.

Link channel O1 is specified in message but not specified in
Link channel information or invalid setting in Link channel
information.

E1055: Link Word IN2 is not defined or invalid.

Link channel 12 is specified in message but not specified in
Link channel information or invalid setting in Link channel
information.

E1056: Link Word OUT2 is not defined or invalid.

Link channel O2 is specified in message but not specified in
Link channel information or invalid setting in Link channel
information.

E1058: Area xxx Channel yyy out of range ...

Channel address is out of range for target PLC.
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Description

E1060: Check code <c> LRC2 not supported on this unit.

CSI/CJ protocols only error. The Check Code type is invalid
for PSB.

E1061: Check code <c> SUM1 (1byte) not supported on
this unit.

CSI/CJ protocols only error. The Check Code type is invalid
for PSB.

E1062: Check code <c> SUML1 (2 byte) not supported on
this unit.

CSI/CJ protocols only error. The Check Code type is invalid
for PSB.

E1063: Header <h> found after Terminator <t>.

Error by protocol imported from PSS. PSS allows to create
the message prohibited by CX-Protocol.

E1064: Header <h> not at the start of the message.

Error by protocol imported from PSS. PSS allows to create
the message prohibited by CX-Protocol.

E1065: Terminator <t> not at the end of the message /
before check code <c>

Error by protocol imported from PSS. PSS allows to create
the message prohibited by CX-Protocol.

WO0006: Protocol will be converted.

A CS/CJ protocol will be downloaded to a SYSMAC-Alpha
PLC, or a SYSMAC-Alpha protocol will be downloaded to a
CS/CJ PC.
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SECTION 15
Help

This section describes the online help services.
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Help by Topic

Procedures for using the CX-Protocol and protocol macro functions can be
verified using the online help. Use either one of the following procedures to
access the online help.

.‘91 Using the Help Tab

The desired help screen can be displayed by left-clicking the Help tab (or the
Help menu), and choosing from the help items that appear in the project
workspace.

Using the Help Icon

Left-click the Help icon on the toolbar or press the F1 Key to display a help
screen for an item (element) on the screen.

Searching by Keyword

Left-click the Index tab in the Help Topics: CX-Protocol help dialog box, and
display the desired screen by making a keyword search.

Using the Help Tab Left-click the Help tab at the bottom of the project workspace or select Help
topics from the Help menu to display a help item in the project workspace.
@ Double-click the Book icon to display help items in the lower hierarchy and

then left-click a desired item to display a help screen.
Using the Help Icon Select one of the elements displayed on the screen to display a corresponding

help screen.
k‘)i Press the Help icon on the toolbar or the F1 Key.

1,2,3... 1. Left-click the Help icon on the toolbar. The cursor pointer will change to

one with a question mark. Move the cursor to an item (icon or object dis-
played on the screen) and left-click the mouse button. Alternatively, select
an item displayed on the screen and press the F1 Key.

2. A help screen associated with the selected element will be displayed.
Displayed elements include icons on the toolbar, projects, protocols, devic-
es, and status bars.

Searching by Keyword

1,2,3... 1. Left-click the Help Topics button in the Help screen.
The Help Topics: CX-Protocol help dialog box will be displayed.

3. Left-click the Index tab and enter some starting characters of a term to be
searched into the top text field.

4. The top topic that includes the entered keyword will be highlighted and dis-
played in the list box.
Depending on the topic, another search dialog box will be displayed. Select
the desired one from the displayed topics.

5. Left-click the Display button or press the Enter Key to display the help
screen of the topic.

Using the Help Screens

Jumping to an Associated Topic

Left-click an underlined term to jump to a help screen associated with the
term.

Returning to Index
Press the Help topics button.
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Changing Character Size
Select Font from the Option menu and then select Small, Normal, or Large.

Printing the Help Screen

Select Print topic from the File menu. Enter the number of copies and left-
click the OK button.
Displaying the Topics History

Select Display History window from the Option menu. The Windows Help
History dialog box will be displayed with a list of topics beginning from the lat-

est one.
CX-Protocol Version Use the following procedure to find out the version of CX-Protocol.
1,2,3... 1. Select About CX-Protocol... from the Help menu or left-click the About

icon on the toolbar.

2. The About CX-Protocol dialog will be displayed. This dialog provides the
CX-Protocol copyright and version number.
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Appendix A
Creating the Protocol Applications

Communication between PLCs via Modems: Example

In this appendix, a protocol is created which initiates communications between PLCs via a telephone line using
modems. The connection structure and the flow of the protocol creation procedure are as shown below:

Connection Structure

PLC Public line PLC

il +{X) - ftn

Transmmission rate: 2400bps

Protocol Creation Procedure

Creating the status transition
chart of communications
sequence.

4

Disassembling of the process

contents into the sequences

and the steps editable by the
CX-Protocol

4

Configuring of the communication
messages contents.

4

Setting the transmission control
mode

Setting the monitor time

4

Describing the ladder program
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Creating the Status Transition Chart of Communications

Sequence

When the data sending and receiving between PLCs are conducted via a telephone line using modems, the
outline of the communications sequences is as shown below:

If not 0 (OK), retry.

If 0 (OK), end.

If not 1 nor 23X,
redial after one
minute.

If 1 or 23X, end.

If receiving error,
retry three times.

Write the received
data and End.

If not O, retry.

If 0, End.

If not 8, retry.

If 8, end

Note

PLC  Send the modem
initialization command

Receive the result code

Send the dial number

Modem Modem  geng the modem

initialization command

PLC

Receive the result code

Send the message (SendOK)

Receive the result code

If not 0, retry.

Receive the message

Send the escape code

Receive the result code

Send the line disconnection
command

Receive the result code

Receive the result code

Switch to the
escape mode

Execute the line

disconnection

If 0, end.

-If SendOK is received,

send the content of from
DMO0100 to 0105.

Information about the AT commands to be sent to the modem i.e. the initialization command, dial com-

mand, escape code sending, line disconnection command, etc. and result codes (response) is
described in the manual of the modem in use. The modem used in this example is MD24FB10V (made
by OMRON). AT commands and result codes supported by the modem are listed in the following tables.
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List of Commands Used in this Example

AT command

Modem initialization
ATEOV0X4\V2\N3%CO*CO\X1

Setting item Settings
Command echo Not available
Result code display format Numerical
Speed display when connection has Available
been completed
Busy, dial tone detection Available
Display of error corrections and com- | Available

pressed data when connection has
been completed

MNP setting Available (auto reliable mode)
MNP class Class 4
V.42 compression, error setting Not available
Flow control between terminal modems | Not available
DTR signal control Always ON
Escape code +
Dial command ATDT dial number Dial class Tone
Escape signal code transmission +++ | Mode selection Online mode to escape mode
Line off command ATHO Line off

List of Result Codes

Numerical format

Character format

Content

0 OK Properly ended

1 CONNECT Connection completed

2 RING Signal receive detection
3 NO CARRIER Line off

4 ERROR Command error

5 CONNECT 1200 Connection to 1,200 bps
6 NO DIAL TONE No-dial-tone detection

7 BUSY Busy detection

8 NO ANSWER No answer detection

9 HAND SET IN USE Busy

234 CONNECT 2400/REL4 Connection to 2400 MNP class

Disassembling of the Process Contents into the Sequences and
the Steps Editable by the CX-Protocol

First, the above communications sequences are disassembled into the following sequences by the process

block.
Sequence No. 000: Modem initialization
001: Dial operation
002: Send message/Receive data, switch modes, line disconnection

Then, the steps are configured for each sequence.
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Sequence No. 000: Modem Initialization

Step No. 00
Step No. 00
Send initialization oommanu]| - Retry three times
retry count
(Matrix)
Result code
lReceive Ol { Receive4oroﬁ1e§ [ Error l
Cabort]  [CAbort |
Normal

The system sends the modem initialization command and waits the result code from the modem. Since there is
more than one result code, the following matrix is set:

0: End for the normal end of the initialization.

4: This is a command error. The cause will be a wrong setup for the initialization command. The abort
and the correct setup for the initialization command are necessary.

Other: Abort.
Note Even though the next process of “4” (command error) is same with that of “Other,” it is set as a separate

matrix case. This is because the checking of the matrix number from the flag at an error occurrence
allows the confirmation of the error cause and easier debugging.

Abnormal
By the setting of the retry count (three times), the system automatically retries the same step up to three times
at the following error occurrences:

* The send finish monitoring time Tfs, the receive wait monitoring time Tr, or the receive finish monitoring
time Tfr is up.

+ A transmission error (ClO28304 or 28312 is ON) occurs upon receiving.
* Wrong receive message
» An error occurs in the error check code
If the initialization fails even after the maximum three retry times, it will be handled by the error process.

An error at this stage may be caused by wrong PLC Setup or wrong wiring, in which case it cannot be handled
by the step description. Therefore, the abort is set for this error process.

Sequence No. 000: Modem Initialization

Step Repeat Command Retry | Send Send Receive message Response Next Error
No. counter count | wait message type process | process
00 R/001 Send&Receive |3 Initialization 0 End --- Abort
Command 2 Abort
Other Abort

Note The partner machine creates similar steps and executes the initialization of the local modem.
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Sequence No. 001: Dial Operation

Normal

Step No. 00
[ Send dial command }~
1 Send&Receive
(Matrix)
Result code

Error

|Receive 7 or 9| |Receive 1or 234” Receive 4, 6, 8, or others

| ) —

Retry
three times

(Matrix)
Result code

IReceive 1or 234| | Receive 4, 6, 7, 8, 9, or others

l | [
Abort Abort

[Abort | [Abort |
Step No. 01
- Send wait one minute
Send dial command [
Retry
three times
(Matrix)
Result code
|Receive 7 or 9| Receive 1 or 234” Receive 4, 6, 8, or others | | Error
i 1
[Abort ] [Abort |
Step No. 02
1 Send wait one minute
Send dial command |+
Retry
three times

When the modem is initialized, the system dials the telephone number and secures the communication line
with the partner PLC. Besides the line connection completion “1 (CONNECT),” there are several result codes
for the dial command. For example, 7 (BUSY) is the connection failure because of the busy line. In this case, if
the other step (to redial after one minute) is configured by designating its step number with “goto,” the
sequence execution will not be aborted but can be continued.

1 (CONNECT):
4 (ERRORY):

6 (NO DIALTONE):

7 (BUSY):

8 (NO ANSWER):

9 (HAND SET IN USE):

234 (CONNECT 2400/REL4):

Others:

Line connection completion...........ccceeoiiieeni i,

Command error
Confirm the contents of the dial command setup
No dialtone detected
Confirm the dial type (tone or pulse)
Connection failure for the busy line.
Redial after one minute
No answer tone detected
Confirm if the partner modem is receivable.
Connection failure for the telephone calling.
Redial after one minute
Line connection completion
Abort
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Note In the second and later retry process executions, the send wait time is ignored. Therefore, another step
01 is created whose send wait time is one minute when the result code is 7 (BUSY). Thus the retry pro-
cess should not be set within a process that requires the send wait time.

Abnormal

Errors other than that caused by the matrix may be caused by wrong modem’s transmission rate or abnormal
line status. Since a step description cannot avoid these errors, it is necessary to abort and to confirm the trans-
mission rate and line condition when the communication fails, even in the third retry.

Sequence No. 001: Dial Operation

Step Repeat Command Retry Send Send Receive message | Response Next Error
No. counter count wait message type process process
00 R/001 Send&Receive |3 Dial number | 1 End --- Abort
4 Abort
6 Abort
7 Goto01
8 Abort
9 Goto01
234 End
Other Abort
01 R/001 Send&Receive |3 One Dial number | 1 End - Abort
minute 4 Abort
6 Abort
7 Goto02
8 Abort
9 Goto02
234 End
Other Abort
02 R/001 Send&Receive |3 One Dial number | 1 End - Abort
minute 2 Abort
6 Abort
7 Goto01
8 Abort
9 Goto01
234 End
Other Abort
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Send OK Message Sending/Data Receiving, Mode Switch, Line
Disconnection (Sequence No. 002)

Partner machine
Step No. 00 Step No. 00
Send “SendOK"
Receive - Ermor
"SendOK"
Receive data for iy t?\eeoee%eected
four words message
Receive
the expected
message . |__Abort_] oot
Step No. 01 | Next Step No. 01 | Next
Error
| Sendescape code |-y Rely [ send data for four word———
t Retry count
Other than
0 or error End Abort
If0

=N

Step No. 02 | Next

Send line Retry
disconnection comman three times

Retry count

Other than
8 or error

Receive the
result code

i 8
| End || Apon

Normal

When the connection with the communications partner is established, the system sends the message (Sen-
dOK) and waits the data from the partner machine. The communications partner sends four words of data
stored in DM 0100 to DM 0104 after the receipt of the “SendOK” message.

When the system receives the four words of data, it writes them from DM 0200, and sends the escape code
(+++) after the end of reception. Then, it switches the escape mode to receive the AT command from the online
mode and sends the line disconnection command.

Abnormal

Most errors here are presumed to be a time-up error of the monitoring time, receiving error on the transmis-
sion, wrong message reception, or error check code error. For these errors, the retry process is set to three
times. If another error occurs, the system will abort and check the modem’s transmission rate and line condi-

tion.
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Following are configurations of both steps:
(The sequence configuration of the sending PLC)

Sequence No. 002: Message Sending, Data Receiving, Mode Switch, and Line Disconnection

Step Repeat Command Retry | Send | Send message Receive Response Next Error
No. counter count | wait message type process process
00 R/001 Send&Receive |3 --- SendOK Writing from Next Abort
DM0200 (W(1),
8)
01 R/001 Send&Receive |3 Escape code 0 (result code) Next Abort
02 R/001 Send&Receive |3 - Line disconnec- | 8 (result code) End Abort
tion command
(The sequence configuration of the receiving PLC.)
Sequence No. 000: Message Receiving and Data Sending
Step Repeat Command Retry | Send | Send message Receive Response Next Error
No. counter count | wait message type process process
00 R/001 Receive 3 SendOK Next Abort
01 R/005 Send 3 - Contents of four | --- End Abort
words starting
from DM0101
(R(1), 8)

Configuring the Communication Messages Contents

For the communications messages setup, the send and receive data storing mode and the message format
must be set up.

Send and Receive Data Storing Mode

There are four kinds of send and receive data storing modes as follows:
» Constant addressing
* Operand addressing (with/without response type)
* Link word addressing
* Direct addressing
In this example, each mode is differentiated according to the characteristics of communications data as follows:

Feature

It is directly set up in the message because there is no
need for change during use of the same modem.

It is desirable to be dynamically set up for a possible
change in accordance with the environment.

It is directly set up in the message because there is no
need for change.

It is desirable to be dynamically set up for a possible
change in accordance with the environment.

Storing method
Constant addressing

Communications data
Initialization command

Dial command Operand addressing

Send data (SendOK) Constant addressing

Five words of send data Operand addressing

Five words of receive data

It is directly set up in the message because there no need | Constant addressing

for change during use of the same modem.

Receive result code

Message Format

In the modem control procedure, communications are performed with an instruction (AT command) from a ter-
minal (the PLC in this example) and the modem’s response (result code) to the instruction. Since AT com-
mands and result codes consist of a character string delimited by CR and CR/LF, the message format is as

follows:
Data + Terminator (CR or CR/LF)

Note The header, the address, the length, and the error check code are not set.
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Constant Addressing
In the constant addressing communications message, CR or CR/LF will be set at the end of the initialization
command, send data (SendOK), receive result code, etc.

Example of the Initialization Command Setting:

ATEOVOX4\ V2\ N3%CO* COL X1+CR or CR/LF

AT command Terminator

Example of the Send Data (SendOK) Setting:
SENDCK+CR or CR/LF

SENDOK Terminator
(Message)

Example of the Result Code Setting:
1+CR or CR/LF

Result code Terminator

Operand Addressing

For the operand addressing communications data, the communications data must be stored in the area set by
the PMCR instruction after PMCR instruction designation (both the first word numbers of the send data storing
and the received data storing) are determined. The configuration of the operand addressing communications
data used in this example is as follows:

Example of the Dial Command Setting:

* The send message content to be described in the step numbers 00 to 02 of the sequence number 001 for
the PLC which sends SendOK message.

(R(1), 16) + CR or CR/LF
L Number of bytes Terminator

to be sent

The first word to be sent (CH (DM0010)+1CH addressed by
the second operand of the PMCR instruction)

— Read option (non-conversion, forward direction)
 Actual data sent and stored in the addressed word.

DM0010  DM0011  DM0012  DMO0013  DMO0014  DM0015  DMO0016  DMO0017  DMO0018
[ 0009 [ 4154 [ 4454 [ 3033 [ 2D30 3132 332D 3435 3637
9 AT DT 03 -0 12 3- 45 67

Set in the first word is the total number of words of the data to be sent
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Example of the Setting for Four-word Receive Data Stored in DM 0201 to DM 0204:

* The received message described in the step number 00 of the sequence number 002 for the PLC which
sent the SendOK message.

(W1),8) + CRor CRILF

| | Terminator

Number of received bytes

The first word received (CH (DM0200)+1CH addressed by
the third operand of the PMCR instruction)

— Read option (non-conversion, forward direction writing)
* The received data actually written in the addressed word.

DM0200  DM0201  DM0202  DM0203  DMO0204
[ 0005 [ 3130 [ 3135 [ 3230 3532
5 10 15 20 52

Number of words to be received (set automatically)

Example of Setting for Four Words Data Sending (DM 0101 to DM 0104):

* The send message described in the step number 01 of the sequence number 000 for the PLC which
receives SendOK message.

(R(1),8) + CRor CRLF

| | Terminator
Number of bytes

to be sent

The first word to be sent (CH (DM0100)+1CH addressed by
the second operand of the PMCR instruction)

—— Read option (non-conversion, forward direction)
* The send data content to be actually stored in the addressed word.

DM0100  DM0101  DM0102  DMO0103  DMO0104
[ 0005 [ 3130 [ 3135 [ 3230 [ 3532
5 10 15 20 52

Set the total number of words of the data to be sent

Setting the Transmission Control Mode

“Modem Control” is designated as the transmission control mode for the one-to-one communications between
PLCs via modems. The modem control mode is held by the instructions from terminals (PLCs) and the
modems’ responses to the instructions. Those instructions (AT commands) and the responses (result codes)
consist of a character string delimited by delimiters, CR and CR/LF.

For the modem control, the RTS/CTS flow control or the Xon/Xoff flow control can be set as a flow control.
However, these flow controls are not set in this example because the communication messages are short.

Note 1. Forthe details of the setup method for the transmission control modes, refer to 4-3 Transmission Con-
trol Mode Setup.
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2. The protocol is created by the Hayes-compatible AT mode in this example. The AT mode and V.25bis
mode are also available for modem control.

Setting Monitoring Time

If the monitor time (send finish monitoring time: Tfs, receive wait monitoring time: Tr, and receive finish monitor-
ing time: Tfr) has been set, the error will be detected and the process can be switched to the error process or
the retry process immediately before the step finishes (in the send or receive step) when the send or receive
process is not executed within the monitor time.

If used in the combination with the retry process, the step can be re-executed without any description of the
error process and protocol or the ladder program description can remarkably be simplified when the following
retry factors occur.

* The send finish monitoring time Tfs, receive wait time Tr, or receive finish monitoring time Tfr is up.

* A transmission error (CS/CJ: bit 15 in word 1908/1918/n+8/n+18 is ON, C200HX/HG/HE: 28304 or 28312
is ON) occurs upon reception.

* The received message is different from the one that was setup.

+ An error occurs with the error check code.
In this example, the monitoring time is set as shown below. For the calculation method of the monitoring time,
refer to 4-5 Calculation Method of Monitoring Time.

One minute when redialing

1
Sending 0.02 seconds i

'
'
1
t
i
i
i
1

! Tr Tir
! - - -——>l

0.01 seconds 0.02 seconds

Receiving r

1. The retry count can be set only for steps in which Send&Receive command is set.

2. If both the repeat counter and the retry count are set, the counter will not increment while the step is
being retried by the retry count number. When the retry factor is resolved or the step is executed by
the retry count number, the counter will increment.
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Creating the Ladder Program

The ladder program to execute the created protocol is described and transferred to the PLC. An example of the
ladder program is shown below:

CS/CJ

000000
i i DIFU (013)
Port 2 Instruction Communications Port 000100
Execution Flag Enable Flag
000100 191915 A20207
11 ()4 (P4 initializati
i1 W p4i PMCR Send initialization command
#72E1 Communications port No.7, serial port No.2,
destination unit address E1: Inner Board
#0064 Sequence No.100
#0000 Constant
#0000 Constant
RSET
000100
SET
Communications Port 000101
Enable Flag
000000 191915 A20207
i | W W PMCR Send the dial number
H72E1 Communications port No.7, serial port No.2,
destination unit address E1: Inner Board
#0065 Sequence No.101
DMO00010 The first word of the send data
#0000 Constant
RSET
000101
SET
Communications Port 000102
Enable Flag
000000 191915 A20207
: : }f }{ PMCR Communication data
Communications port No.7, serial port No.2,
#72E1 destination unit address E1: Inner Board
#0066 Sequence No.102
#0000 Constant
DM00200 The first word of the received data stored
RSET
000102
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C200HX/HG/HE

00000
i | DIFU (013)
Port A Instruction 00100
Execution Flag
00100 28908
i i ,H’ PMCR Send initialization command
#1000 Execute sequence No. 000 by using Port A
#0000 Constant
DMO000 Dummy word
RSET
00100
SET
00101
00101 28908
i | W PMCR Send the dial number
#1001 Execute sequence No. 001 by using Port A
DMO0010 The first word number of the send data
DMO0000 Dummy word
RSET
00101
SET
00102
00102 28908
: : }f PMCR Communication data
#1002 Execute sequence No. 002 by using Port A
#0000 Constant
DM0200 The first word of the received data stored
RSET
00102

359
AUDIN - 8, avenue de la malle - 51370 Saint Brice Courcelles - Tel : 03.26.04.20.21 - Fax : 03.26.04.28.20 - Web : http: www.audin.fr - Email : info@audin.fr



AUDIN - 8, avenue de la malle - 51370 Saint Brice Courcelles - Tel : 03.26.04.20.21 - Fax : 03.26.04.28.20 - Web : http: www.audin.fr - Email : info@audin.fr



Appendix B
PLC Setup and PMSU Settings

PMSU System Settings
CS/CJ

With the CS/CJ Series, PLC Setup settings for using a Serial Communications Board or a Serial Communica-
tions Unit in protocol macro mode are made in the allocated DM area of the PMSU.

Serial Communications Board
Allocated DM area: Use the following areas in words D32000 to D32099.

D32000 to D32001 PLC Setup settings for port 1
D32008 to D32009

D32010 to D32011 PLC Setup settings for port 2
D32018 to D32019

D32002 to D32007 Not used in protocol macro mode
D32012 to D32017

D32020 to D32767 Reserved for system use

Serial Communications Unit
Allocated DM area: Use the following areas in words D30000 to D31599.

Unit number DM area
D30000 to D30099
D30100 to D30199
D30200 to D30299
D30300 to D30399
D30400 to D30499
D30500 to D30599
D30600 to D30699
D30700 to D30799
D30800 to D30899
D30900 to D30999
D31000 to D31099
D31100 to D31199
D31200 to D31299
D31300 to D31399
D31400 to D31499
D31500 to D31599

Tnlmlololo|>|o|lo|~|ojals|w|[NvF|o

Note The allocation within each DM area is as follows (m=D30000 + 100 x Unit Number):
m to m+1, m+8 to m+9: PLC Setup settings for port 1
m+10 to m+11, m+18 to m+19: PLC Setup settings for port 2
m+2 to m+27, m+212 to m+217: Not used
m+20 to m+99: Not used
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Contents of PLC Setup Area
m=D30000 + 100 x Unit Number

DM area Bit Contents of setting
Board Unit
Port 1 Port 2 Port 1 Port 2
D32000 D32010 m m+10 15 Port setting 0:Default, 1:Setting required
14t0 12 Reserved
11to 08 Serial communications mode

(6 Hexadecimal: Protocol macro)
07 to 05 Reserved

04 Start Bit
0: 1 bit, 1:1 bit
(whether it is set to 0 or 1 it will be fixed at 1 bit)
03 Data length 0: 7 bits, 1: 8 bits
02 Stop bit 0: 2 bits, 1: 1 bit
01 Parity  0: with, 1: without
00 Parity  0: even, 1: odd
D32001 D32011 m+1 m+11 15to 04 Reserved

03 to 00 Baud rate (bps)
0: Default (9,600), 3: 1,200, 4: 2,400, 5: 4,800,
6: 9,600, 7: 19,200, 8: 38,400

D32008 D32018 m+8 m+18 15 Transmission mode 0: Half-duplex, 1: Full-duplex

Note: When using standard system protocol, be sure
to set to 0 (half-duplex)

14 to 00 Reserved

D32009 D32019 m+9 m+19 15to0 00 Maximum number of bytes of send/receive data: 00C8
to 03E8 (Hexadecimal)

Note: When using standard system protocol, be sure
to set to 03E8 Hexadecimal (1,000 bytes)

AUDIN - §%€enue de la malle - 51370 Saint Brice Courcelles - Tel : 03.26.04.20.21 - Fax : 03.26.04.28.20 - Web : http: www.audin.fr - Email : info@audin.fr



PLC Setup and PMSU Settings Appendix B

C200HX/HG/HE

With the C200HX/HG/HE PLC, PLC Setup settings for using a Communications Board in protocol macro
mode, are made in the PLC Setup settings of the PSB.

Settings Related to the RS-232C Port
Word number Bit Function (initial values: factory-set)

DM 6645 00to 03 RS-232C port communications conditions settings
00: Standard settings (initial values)
Start bit: 1 bit, Data length: 7 bits, Parity: even
Stop bit: 2 bits, Baud rate: 9,600bps
1: As set for DM 6646

04 to 07 CTS control enable/disable settings
0:  Without (initial value)
1:  With

08to 11 Area used for 1:1 link

0: LROO to 63 (initial value), 1:LR0O0 to 31, 2: LROO to 15
Maximum PT number for NT link 1:N connection
1to 7 (BCD) (for C200HE: 1 to 3)

12to 15 RS-232C port mode settings
0: Host link (initial value), 1: No RS-232C procedure, 2: 1:1 link for Slave
3: 1:1 link for Master, 4: NT link (1:1), 5: NT link (1:N)

DM 6646 00 to 07 RS-232C port baud rate setting
00: 1,200 (initial value), 01: 2,400, 02: 4,800, 03: 9,600, 04: 19,200
08 to 15 RS-232C port frame format settings
Start bit  Data length Stop bit Parity
00: 1 bit 7 bits 1 bit Even (initial value)
01: 1 bit 7 bits 1 hit Odd
02: 1 bit 7 bits 1 bit Without
03: 1 bit 7 bits 2 bits Even
04: 1 hit 7 bits 2 bits Odd
05: 1 bit 7 bits 2 bits Without
06: 1 bit 8 bits 1 bit Even
07: 1 hit 8 bits 1 bit Odd
08: 1 bit 8 bits 1 bit Without
09: 1 bit 8 bits 2 bits Even
10: 1 hit 8 bits 2 bits Odd
11: 1 bit 8 bits 2 bits Without
DM 6647 00to 15 RS-232C port send delay time settings
0000 (initial value) to 9999 (BCD, unit: 10ms)
DM 6648 00 to 07 Unit number settings for RS-232C port host link mode

00 (initial value) to 31 (BCD)
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Settings Related to Peripheral Port

Word number Bit Function (initial values: factory set)
DM 6650 00to 03 Peripheral port communications conditions standard format settings
00: Standard settings (initial values)
Start bit: 1 bit, Data length: 7 bits, Parity: even
Stop bit: 2 bits, Baud rate: 9,600bps
1: Set separately
04 to 11 Reserved for system
12to 15 Peripheral port mode settings
0: Host link (initial value), 1: No RS-232C procedure
DM 6651 00 to 07 Peripheral port baud rate settings (bps)
00: 1,200 (initial value), 01: 2,400, 02: 4,800, 03: 9,600, 04: 19,200
08to 15 Peripheral port frame format settings
Start bit  Data length Stop bit Parity
00: 1 bit 7 bits 1 bit Even (initial value)
01: 1 bit 7 bits 1 bit Odd
02: 1 hit 7 bits 1 bit Without
03: 1 bit 7 bits 2 bits Even
04: 1 bit 7 bits 2 bits Odd
05: 1 bit 7 bits 2 hits Without
06: 1 bit 8 hits 1 bit Even
07: 1 bit 8 bits 1 bit Odd
08: 1 hit 8 bits 1 bit Without
09: 1 hit 8 bits 2 bits Even
10: 1 bit 8 bits 2 bits Odd
11: 1 hit 8 bits 2 bits Without
DM 6652 00 to 15 Peripheral port send delay settings (host link):
0000 (initial value) to 9999 (units: 10ms)
DM 6653 00 to 07 Unit number settings for peripheral port host link mode

00 (initial value) to 31 (unit number)
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Communications Board Settings
Settings Related to Port B

Word Bit Mode Function Note
number
DM 6550 00 to 03 Host link Port B communications conditions standard format set-

No procedure | tings o
0: Standard settings (initial values)

Protocol macro Start bit: 1 bit, Data length: 7 bits, Parity: even
Stop bit: 2 bits, Baud rate: 9,600bps
01: Set separately - DM 6551: 00 to 15 enabled

04 to 07 Host link CTS control enable/disable settings
No procedure 0: Without (initial value)
. 1: With
1:1 link
08to 11 1:1 link Port B 1:1 link area Once a 1:1 link
(Master) 0: LROO to 63 (initial value), 1:LROO to 31, with a Master
NT link (1:N) 2: LR0OO to 15 has been set, it
Maximum PT unit number for port B, NT link 1:N cannot be
1to 7 (BCD) (for C200HE: 1 to 3) changed.
12to 15 All modes Port B mode setting

0: Host link (initial value), 1: No RS-232 procedure
2: 1:1 link for Slave, 3: 1:1 link for Master,
4:NT link (1:1), 5: NT link (1:N), 6: Protocol macro

DM 6551 00 to 07 Host link Port B baud rate settings (bps) Only valid when
No procedure 00: 1,200 (initial value), 01: 2,400, 02: 4,800, set separately.
03: 9,600, 04: 19,200

Protocol macro

08 to 15 Host link Port B frame format settings

No procedure Start bit Data length Stop bit Parity

Protocol macro |00: 1 bit 7 bits 1bit  Even (initial value)
01: 1 bit 7 bits 1 bit Odd
02: 1 bit 7 bits 1 bit Without
03: 1 hit 7 bits 2 bits Even
04: 1 bit 7 bits 2 bits Odd
05: 1 bit 7 bits 2 hits Without
06: 1 hit 8 bits 1 bit Even
07: 1 bit 8 hits 1 bit Odd
08: 1 bit 8 hits 1 bit Without
09: 1 bit 8 bits 2 bits Even
10: 1 bit 8 bits 2 bits Odd
11: 1 bit 8 hits 2 hits Without
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Settings Related to Port A

No procedure
Protocol macro

Start bit Data length Stop bit Parity
00: 1 hit 7 bits 1bit  Even (initial value)
01: 1 hit 7 bits 1 bit Odd
02: 1 bit 7 bits 1 bit Without
03: 1 bit 7 bits 2 bits Even
04: 1 hit 7 bits 2 bits Odd
05: 1 hit 7 bits 2 bits Without
06: 1 bit 8 bits 1 bit Even
07: 1 hit 8 hits 1 bit Odd
08: 1 hit 8 bits 1 bit Without
09: 1 bit 8 bits 2 bits Even
10: 1 bit 8 bits 2 bits Odd
11: 1 hit 8 hits 2 bits Without

Word Bit Mode Function Note
number
DM 6555 00to 03 Host link Port A communications conditions standard format set-
No procedure | tngs o
Protocol 0: Standard settings (initial values)
rotocol macro Start bit: 1 bit, Data length: 7 bits, Parity: even
Stop bit: 2 bits, Baud rate: 9,600bps
01: Set separately — DM 6556: 00 to 15 enabled
04 to 07 Host link CTS control enable/disable settings
No procedure 0: Without (initial value)
. 1: With
1:1 link
08to 11 1:1 link (Master) | Port A 1:1 link area Once 1:1 link
NT link (1:N) 0: LROO to 63 (initial value), 1:LR0O to 31, with a Master
2: LROO to 15 has been set, it
Maximum PT unit number for port A, NT link 1:N cannot be
1to 7 (BCD) (for C200HE: 1 to 3) changed.
12to 15 All modes Port A mode setting
0: Host link (initial value), 1: No RS-232 procedure
2: 1:1 link for Slave, 3: 1:1 link for Master,
4:NT link (1:1), 5: NT link (1:N), 6: Protocol macro
DM 6556 00 to 07 Host link Port A baud rate settings (bps) Only valid when
No procedure 00: 1,200 (initial value), 01: 2,400, 02: 4,800, set separately.
03: 9,600, 04: 19,200
Protocol macro
08 to 15 Host link Port A frame format settings
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Appendix C
Wiring RS-232C Cable Connectors

Cable Processing (End Connected to FG)

See the diagrams for the lengths required in each set.

1,2,3... 1. Cutthe cable to the required length.

2. Peel the sheath using a razor blade without damaging the shield weaving.

«— 40 mm (RS-232C) ——»|
25 mm (RS-422)

3. Remove the shield using scissors.

«— 10 mm —

4. Peel the core wire of each wire using a stripper.

Aluminum
foil tape
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Soldering
Solder as described next.

1,2,3... 1. Place a heat-shrinking tube around each wire.
2. Pre-solder each wire and to its connector pin.
3. Solder each wire firmly in place.

Soldering iron

Heat-shrinking tube
(Internal diameter: 1.5, r=10)

4. Move the heat-shrinking tube to the soldered section and shrink the tube by heating it.

____________________________

Heat-shrinking tube

Assembling Hood

Assemble the connector hood as shown below.

CS/CJ

B

=lo:

7 \

Connected to FG Not connected to FG

Aluminum foil tape

Ground plate
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C200HX/HG/HE

N . . 2
- Aluminum foil tape \%—ﬁ

Connected to FG

Not connected to FG
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Revision History

A manual revision code appears as a suffix to the catalog number on the front cover of the manual.

Cat. No. W344-E1-03

Revision code

The following table outlines the changes made to the manual during each revision. Page numbers refer to the
previous version.

Revision code Date Revised content
01 February 1999 | Original production
02 April 1999 Pages xi, 2, 5, 24, 25, 38, 114, 268, 333, 339, and 343: Minor corrections which
include those to the software version, ladder program examples, general wording,
etc.
03 September 2001 | Information on CJ-series PCs was added and “CS1” was globally changed to “CS”

or “CS/CJ" as applicable.

Pages xi, xii, 2, 5, 6, 33, 38, 42, 46, 47, 48, 54, 109, 207 to 212, 214, 228, 238,
255, 256, 260, 262, 270, 281, 283, 284, 287, 288, 298, 299, and 334: Minor correc-
tions and additions (including changes to icon graphics).
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